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Welcome 
 
Whether you are a beginner or an expert, Scala® Designer can turn you 
into a multimedia producer. With Designer you can create polished, 
professional on-screen productions that combine text, sound, graphics and 
animation for maximum impact. And only Designer, when used with its 
powerful companion application Content Manager5, lets you easily publish 
and distribute your productions to networks of Scala Players over the 
Internet, to deliver true worldwide multimedia. 
 
Designer’s many publication and playback options make the environment 
a powerful distribution medium.  And when combined with Scala’s high-
performance Player software in a Network, Designer brings broadcast 
multimedia to the world. 
 
Designer is easy 
 
Most multimedia programs give you hurdles to jump. Designer has a better 
idea: stay out of your way! It offers a refreshingly intuitive way for you to 
lay out a production, experiment with effects and transitions, and preview 
the results.  
 
Designer panels and menus are carefully designed to guide you through 
the process of creating a production. Options and functions are clear, 
specific and straightforward.   
 
Designer’s extraordinary “hands-on” feel makes it easy to explore the 
depths of its potential, and fine-tune your production quickly and 
confidently. 
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Designer means performance 
 
If you are often frustrated because your PC could once provide only 
crude, jerky approximations of the animated effects you had in mind, 
Designer will change your mind about multimedia authoring. It’s fast and 
smooth. 
 
Scala’s software engineers have been working with high-performance 
real-time graphics and sound on personal computers longer than anyone. 
Designer and the Scala’s highly tuned playback technology are the result 
of this accumulated expertise. With its own multimedia-optimized 
operating system, Scala software has been crafted to bring out the 
maximum performance from any hardware. The speed and crisp response 
of Scala software benefit both author and audience. 
 
Designer can work for you 
 
Designer offers you a variety of presentation formats so you can use 
whatever fits your purpose. For example, use Designer: 
 

• to design and publish content for digital signage networks 
• to enliven community bulletin board channels for local cable TV 

systems—make advertising more compelling, increase sales and 
grow your business 

• to inform a hotel’s guests of the many services it makes available 
• to distribute news and publicize products and events on your 

corporate information channel 
 

Because Designer productions can be transmitted and updated through 
the Internet, up-to-the-minute information can reach all your sites almost 
instantly. The time and expense of sending people or bulky media to each 
site when the displays need to change is a thing of the past. And your 



Designer5 
 

 
41 

 

training and production costs for creating productions and managing an 
Designer installation are low, thanks to Scala’s easy-to-use graphical user 
interface. 
 
Whatever the type of production, you can use computer monitors, plasma 
panels, televisions or video projectors to show your finished product. 

1.1 Designer resources on the web 
 
Scala’s Web site, http://www.scala.com, is an important resource for 
Designer customers, dealers, and partners. For answers to questions you 
can’t find in the User’s Guides, as well as downloads and additional 
information relevant to Designer users, the Scala Web site should be your 
first stop. 
 
Pages you will find at the Scala Web site provide: 
 

1. General product information, press releases, contact data 
 

2. Technical support: 
 

• Troubleshooting FAQs 
• Discussion groups 
• Recommended hardware configuration 
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3. Downloads:  
� Software updates and demos 
• Bonus art packs 
• Sample scripts 
• Additional documentation 

 
4. Partner  resources: 

 
• Sales and marketing information 
• Software Updates 
• Technical support and training 

 
5. Customer case studies 

 
6. Third-party support links 

 

1.2 Installing Designer 
 
Installing Scala Designer is a relatively simple process when 
followed closely.  The install wizard will allow the user to 
quickly install the product. 
  
Insert the Designer DVD into your computer.  The installer 
should run automatically.   
 
If the installer does not automatically begin, another option is 
to right click on Start button and select Explore. 
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Identify the drive that contains the DVD and select it. 
 
The list of items on the DVD includes everything you need to 
install Designer. 
 

  
 
Select the setup.exe by double clicking on the icon. 
 
The dialog box will appear allowing you to begin the 
installation from the DVD. 
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The Welcome dialog box offers the option of opening the 
Designer Quick Start Guide.  Click on the Quick Start Guide 
button and the guide will open in .pdf format. 
 
Once you are ready to install Scala Player, click Next to 
continue. 
 

 
 
You must select the “I accept the agreement” button in the 
Scala End User License Agreement box.  The full EULA can be 
read here or is also available at the end of this document. 
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Select Next to continue. 
 
Choose the appropriate language. 
 

 
 
Select Next to continue. 
 

 
 
The Designer system will default to install under the Program 
Files folder.  If you want to change that location select the 
Browse button and select another location.  
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Select Next to continue. 
 

 
 
The “Select Components” dialog box allows you to select the 
specific components of Designer that you want to install. 
 
This list includes the User Guide, Clipart library, and additional 
typefaces.   
 
Click Next to continue. 
 

   
 



Designer5 
 

 
47 

 

The system default is to install the Clipart to Program Files. 
Choose the appropriate location and select Next to continue. 
   

 
 
In “additional tasks”, you can choose to “Add shortcut to Quick 
Launch toolbar”.  Select Next to continue. 
 
A few other options are available for installation. 
 
The installer can install the ScalaScript Export Plug-in available 
for Adobe Photoshop.  
 
Scala Designer now comes bundled with the ScalaScript Export 
plug-in for Adobe Photoshop. If you have Adobe Photoshop 
installed, this plug-in lets you export your Photoshop 
document as a ScalaScript, and preserves the individual clips 
and layers as editable elements, which you can embellish with 
effects in Scala Designer. 
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To install this, select Next to continue. 
 
Video decoders are also needed for Designer.  Setup 
recommends installing MainConcept’s MPEG-2 and H.264 
decoders. 
 

 
 
Select Next to continue. 
 
Designer provides installation of Python scripting support. 
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Select Next to continue. 
 
The Microsoft Internet Connection Firewall must allow 
Designer to access network connections. 
 

 
 
Select Next to continue. 
 
Note:  Scala Player installation also requires Windows 
Media Player 9 or newer to be installed.  You may already 
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have a version installed or you can go to the following site to 
download Windows Media Player 11. 
 
http://www.microsoft.com/windows/windowsmedia/player
/download/download.aspx 
 
You are now ready to install Designer. 
 

   
 
 Select Install to continue. 
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Designer will now be installed on your system.  The file 
extraction process can be monitored with the progress bar.  
This may take several minutes. 
 

 
 
Once the install is complete, the progress bar will be at the 
100% line and the Cancel option will no longer be available. 
 
The ScalaScript Export Plug-in v3 setup will then start 
automatically.  
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Select Next to start the installation. 
 
The EULA is available here to review. 
 

 
 
Choose Agree to continue. 
 
If Adobe Photoshop is on the local computer, the ScalaScript 
Exporter Photoshop Plug-in will install in the correct folder.  If 
you want to select a different location, choose Browse, select 
the location and select Next to continue. 
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Select Finish to continue. 
 
The Python scripting support setup will then start 
automatically. 
 
The Python scripting support will default to install under the 
Program Files folder.  If you want to change that location 
select the Browse button and select another location.  Click 
Next to continue. 
 

    
 
When the installer has finished, it will automatically close. 
 



Designer5 
 

 
54 

 

 
 
Once the file extraction is complete, you will have the option 
of viewing the release notes and starting Designer. 
 
Your Designer software comes with a USB key that you must 
insert into a USB slot on your computer in order to use Scala 
Designer5.  Do this first BEFORE clicking Finish. 
 

 
 
You must activate Designer with a license file.  You can install 
the license file now or choose to defer installing the file for up 
to 30 days. 
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If you select “Get New License File Online” – you will have the 
option to save a copy of your License File in the My Document 
folder. 
 

 
 
You can also select the “I have It” if you have a copy of your 
license file or defer by selecting “Get it Later”. 

1.3 Logging On To Designer 
 
To access Designer, find the Scala Designer 5 program in the 
list of Programs and select Scala Designer 5. 
 

 
 
This will bring the user to the primary screen in Designer. 
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With Designer you can create polished, professional on-screen 
productions that combine text, sound, graphics and animation for 
maximum impact. Designer lets you easily publish and distribute your 
productions to networks of Players over the Internet, to deliver true 
worldwide multimedia. 
 
You can view the Quick Start Guide by clicking the button on the 
dialog box that opens. 
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||||| 2 Designer5 Overview 
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Chapter Overview 
 
Scala Designer5 is a truly unique and diverse application which allows you 
to create stunning and imaginative multimedia productions - utilizing 
motion, color, graphics, text animation, sound design and special effects - 
while creatively highlighting the message you want to emphasize. 
 
Although it can be used with still images, the real purpose of Designer is to 
create a rich environment of sounds and images that flow like a 
professional video effectively responding to outside input. 
 
Designer facilitates virtually any type of production, regardless of your 
background or level of experience. Whether you are an independent, one-
person multimedia producer and need these facilities only occasionally, or 
have a department of media professionals with a daily roster of projects, 
you can use Designer’s capabilities to make your work more lively and 
informative. 
 
For tasks that range from designing product advertisements for digital 
signage that run continuously in storefronts, to creating engaging business 
presentations for corporate communications; from creating informational 
programming for hotels, universities, airports, or offices, to running a 
community information channel for a cable television supplier, Designer’s 
creative palette of designer tools is ideal!  

2.1 Getting Started 
 
This chapter will introduce you to the Scala Designer User Interface (UI), 
views, menus, panels, buttons and a variety of basic terms, features and 
functions you will need to begin your exciting journey with this program!  
 
The section that appears later in this chapter, “Content ready to use with 
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Designer5”, will explain how to start the demonstration productions 
designed by Scala so you can immediately see and hear some examples of 
the powerful potential of this innovative application. These demonstrations 
can be utilized as a resource to stimulate your imagination and offer 
potential ideas as you creatively plan your original productions.  
 

 
 
Online information and quick-reference help is always available in Designer 
through the Toolbar. To access this feature, simply click Help > Help or press 
F1. You will immediately notice the pointer changes to the Help pointer, 
allowing you to click on any item to receive additional information. Please 
refer to Appendix B for further details about Designer’s online help. 

2.2 Glossary of Terms Introduced in this Chapter 
 

� Script – The page-by-page definition of a presentation or project 
created in Scala Designer. The script specifies the actions and 
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properties of the image files, text, sound, video and other 
elements on a page. It also identifies the settings which control 
how the page is displayed. 
 

� View – In Designer, a partial or full-screen panel containing 
buttons, scroll bars, text boxes and other controls that set options 
and perform operations to create a script. 
 

� Page – The basic unit of a script. A page may be a screen page with 
one or more elements, such as a background, text, clip, sound, 
transition, etc.; it may also represent a group of pages or 
another script. 

 
NOTE: In the beginning of each chapter of this manual, there is a Chapter 
Overview with introductive glossary of new terms. There is also be an 
Advanced Features section at the end of each chapter, with tips, tricks and 
alternative configurations, settings and procedures described in that 
chapter. 

2.3 Starting Designer5 
 
Once Designer has been properly installed on your PC running the 
supported Microsoft® Windows® operating system, you can start the 
program. 
 
From the Windows Start menu, choose Programs > Scala Designer 5 
>Designer 5. 
 
While you are in the Start menu, you will notice that in addition to the 
program, there is a shortcut to the Linked Content folder, a shortcut to the 
Logs folder, and several links to Scala’s Web site, for your convenience. 
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As Designer loads, a title window will appear.  
 
When the program opens, and before you begin to create a new production 
or work with one that already exists, you will see the Designer Main view. 
The Main view looks like this: 
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2.3.1 Scripts and the Main View 
 
In Designer, your production is defined by a script. A script in Designer is a 
file that specifies a series of events and their timing. The events in a script 
are the individual image files, sound files, text lines, and other items that 
appear in the final production. The events in a script contain all the settings 
and options that describe how and when things happen in the final 
production. 
 
However, you don’t have to work with a Designer script the way a 
programmer works - through a series of text commands. You may write and 
edit the script entirely through the Scala graphical user interface, 
HumanTouch.  
 
HumanTouch shows you the script as one or more pages of information, 
each of which can be created or designed graphically and arranged in any 
order you choose. 
 
As you work with a production and compose the script, each page is listed 
separately in the Main view. A page number is assigned based on its 
position in the production sequence including a short title for easy 
identification. Thus, the Designer Main view shows you an outline of your 
script and an overview of its structure. 
 
From the Main view you can navigate to other Designer views which may 
be necessary to create the script.  
 
There are also many tasks you can perform directly from this view to 
manipulate and refine the script. These tasks, and further instructions 
regarding work flow, are discussed in detail in Chapter 3: Working in the 
Main View. 
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2.3.2 The Designer Interface 
 
The options and commands available in any Designer panel depend on the 
purpose of the panel, but most Main view elements are common features 
in Designer. 
 
For example, unlike other PC applications, some choices in the panel are 
buttons rather than text items in a list. Some buttons lead to other panels 
and dialog boxes. Buttons that lead to a dialog or another panel with 
additional choices have three dots (...) following the button name. 
 
Other common elements (shown in the Main view on the previous page) 
are briefly defined below: 
 
Title Bar – shows the name of the panel, script, or dialog box in which you 
are working. Occasionally, additional information is provided. 
 

 
 
Toolbar – like popular Web browsers, toolbars in   
Designer contain icon buttons for common functions in that panel or 
dialog. Toolbar items can toggle special options, present drop-down lists, 
or navigate to another panel. 
 

 
 
Tabbed Panels – allow you to access different sets of related controls, to 
prevent panels from becoming too large or crowded. Ctrl+Tab moves to the 
next tab. Shift+Ctrl+Tab moves to the previous tab.  Click the tab header to 
display the panel of options for that type of operation. 
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Close Button – closes the active panel      
or script the button is associated with. In the Main view, the Close button 
is located in the upper right corner of the application window; choosing it 
quits the application. The other (smaller) Close button is associated with the 
script you are working with; choosing it closes the script. 
 

Up Button – moves up one level out       
of an open page group. 
 

Value Control – lets you cycle through   
a series of values, or change a value  
directly. Click the arrows to go to the  
previous or next value, or click in the text box between the arrows, type a 
value and press Enter. Some value controls have more than one value, or 
more than one text box between the arrows. Before using the arrows, click 
in the text box you want to change. 

Multistyle Button – similar to a value control, this     
button lets you choose from a variety of several  
options. Simply by clicking the arrows you can  
navigate to the previous or following choice. You can then adjust the setting 
for the current option in the button to the left of the arrows.  
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Scroll Bar – scrolls vertically through a list or     
horizontally across columns revealing items  
which cannot fit into the available screen space. The Scroll Bar will also 
proportionately change size to indicate the total number of visible items.  
 
Pop-up Button (Selector) – opens a pop-up list allowing a choice from a 
series of option values. Additionally, the Selector Button will facilitate 
access to other functions and panels. If the pop-up list shows option values, 
the current selection is highlighted when you open the list. 
 

 
 
To choose a value or function, click on the Selector button, then click on 
your desired choice. Or, simply click and hold the mouse button while 
moving the pointer through the list, then release the mouse button when 
the desired choice is highlighted. 
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Pull-down Menu        
-opens a pull-down  
list of options or  
functions from a top menu item, allowing your choice of a particular  
function or navigation to another panel. 
 
 

Combination Icon – lets you either       
choose a default action or select from  
a list of actions. A single click on the main  
part of the icon will choose the default. By clicking on the down arrow (d) 
part of the icon, a drop-down list of related actions will be displayed. 
 

List Icon – lets you choose how you want          
to view pages in a script. Normally  
you would see thumbnails: miniature pictures of graphic items. When the 
icon is depressed, the List mode is opened, with pages listed by name. 
 

On/Off Button – when clicked, this         
button will turn an option on or off.  If the label for this type of button 
ends in a question mark (?), then a check mark appears after the label 
when the option is on. Some buttons of this type can be pressed in to turn 
their option on and released with another click to turn it off. 
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Close and OK Buttons – All panels and dialogs have a Close button. When the 
button is pressed, any changes made to the settings are saved rather than 
undone. The OK button, will accept any changes you make in the dialog, 
then the dialog will close. In a dialog, the close button is located in the 
upper right corner of the screen. It is essentially the same as the Cancel 
button. 
 

Nudge with Arrow Keys – Ctrl+Arrow Key allows you to move/nudge 
elements by one pixel in whatever direction the arrow key is depressed. 
Shift+Ctrl+Arrow Key allows you to jump 10 pixels at a time. 

2.4 Working in Designer – Some Helpful Hints 
 
Unlike many applications on your PC, Designer has its own on-screen 
working environment. Although working with this program is similar to 
working with other PC applications, Designer’s design environment makes 
it unique. 
 
The following is a quick summary of some important similarities and 
differences to common PC terms and techniques used in Designer. 
 
2.4.1 Mouse and keyboard 
 
Although this guide assumes you are using a mouse, almost all Designer 
operations can be accomplished with the keyboard. Occasionally, using a 
keyboard shortcut is simply more convenient and at times may be your 
only option. See Chapter 23: Keyboard and Mouse Shortcuts, for a 
complete list of keyboard alternatives.  
 
2.4.2 Mouse buttons 
 
Designer supports any type of mouse or other pointing device that has at 
least two buttons. Pointing devices can include traditional mice, trackballs, 
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drawing tablets, joysticks, to name a few. 
 
The main (left) mouse button is the button you will use most frequently, so 
an instruction such as “Click on OK” always means to use your main (left) 
mouse button. If you have a programmable or left-handed mouse, then you 
will need to know how that mouse is configured to deliver the main button 
command. 
Designer also has certain functions, such as a Context Menu, that uses the 
secondary (right) mouse button. 
 
Additional mouse buttons will be ignored. If necessary, refer to the 
documentation that came with your mouse and/or PC to ensure that your 
mouse behaves as it should when using Designer. 
 
2.4.3 Full screen and windowed operation 
 
Designer is designed to be used both in a windowed operation while 
authoring, and as a full screen previewer during playback. 
 
In the windowed operation, you can resize the Designer window as 
desired, using familiar drag-and-drop techniques to add graphics and 
other files to a script. The flexible user interface design adapts itself to 
different window sizes and shapes providing maximum versatility. It is 
possible to size the application window so small that some controls are 
obscured or too small to use, but the application functions correctly 
regardless, and keyboard shortcuts can still be used for all controls. 
 
When playing back in full screen mode, Designer allows you to specify 
screen resolution, color depth, and refresh rate for optimal multimedia 
performance and adaptability.  

2.5 Advanced Features 
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New Designer Features: 
 
Following is a list of new and features and exciting changes we’ve 
included in Designer. 
 
 
 
Usability Improvements 
 

• New look and feel, with selectable skins — Use Tools > 
Options then choose Authoring tab and the Skin selector pop-
up button to change the look and feel of the Designer 
application by selecting a different skin preset.  

• Pull-down menus in Main and Design screens. Pull-down 
menus allow easy and familiar access to Designer functions, as 
well as improved function organization.  

• Right-click context menus on objects — This adds the ability to 
quickly access certain features that before would take more 
time to navigate to.  

• Windows file dialog — A standard Windows system file dialog is 
used throughout Designer 5. This replaces the old file dialog 
box in InfoChannel Designer 3. 

• "Tabbed document view" for multiple scripts — Many 
standard Windows applications use a tabbed document 
interface. Designer 5 now has this capability.  

• Save from within Page view — It's no longer required that the 
user exit back to the main view to save their changes. Changes 
can now be saved directly from the Page view.  

• Snap to guides — In InfoChannel Designer 3 it was possible to 
create guides, but there was not a way to "snap" an element 
to a guide. This is now possible in Designer 5.  

• Semi-transparent selection marquee — The selection 
marquee has now been made semi-transparent in order to 
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improve the visibility of other elements.  
• Selection boxes hidden during move/resize — The selection 

rectangles are now hidden when resizing an element or 
moving an element.  

• Simpler Export function — The ability to export anything from 
Designer 5 has been greatly simplified. From the Page view, 
choose File > Export.  
 

• Enhanced View > Hide element controls — Various view/hide 
elements have now been joined in a new “view” pull-down 
menu.  

• Collect Files feature to simplify gathering up a script and its 
media and placing it together in one location. This replaces  
InfoChannel Designer 3’s Save Advanced and Publish to File 
functions.  

• Publish to Content Manager — Support for publishing directly to 
the new Content Manager 5.  

• Publish via HTTP/HTTPS — It's now possible to publish over 
HTTP/HTTPS, in addition to FTP and UNC. In InfoChannel 
Designer 3, FTP and UNC were the only options.  

• Publishing Targets — When publishing to Network, a script now 
remembers where it was published, for simplified re-
publishing.

 

2.6 Functional Improvements 

 
• Timeslot schedule type — New schedule type used to specify a 

range of time when content is only supposed to play.  
• Much smoother effects (due to higher performance, sub-pixel 

positioning).  
• Higher video playback performance (e.g. three 720x480 
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MPEG2s with opacity on a mid-class system).  
• Very smooth scaling effects (no "pixilation").  
• Any element can be global (even with opacity). Use the 

Global? button on the Misc tab.  
• Elements can now play over background movies. 
• Unlimited mixing of transitions, video & layers.  
• Elements keep playing while the next page is transitioning in.  
• Wait=off on page transitions so elements can play as the page 

enters  
• Export of clips or text preserves alpha-channel.  
• Template Creation (Bind the contents of a text element to a 

data field or bind a filename of a clip, movie, background to a 
data field. Play and Preview in Designer use the placeholder 
values. When publishing to Content Manager, it automatically 
recognizes the script as a template.)  

• Rotation available — It is now possible to create a script in 
portrait mode but playback in rotated-landscape mode.  

• Rescaling — It is now possible to dynamically rescale a script during 
playback (e.g. 800x600 script at 1024x768, or vice-versa).  

• Anamorphic scaling - Anamorphic scaling is now possible.  
• Script timing is much more consistent. 
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||||| 3 Working in the Main 
  View 
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Chapter Overview 
 
The Main view allows access to views and functions within Scala Designer, 
opening the Main view when the application is first started. 
 

 
 
When you open Designer, the Main view is blank, as shown above. To 
begin work, you need to either create a script (using the New icon) or 
load an existing script (using the Open icon). 
 
Once there are page or event thumbnails showing in the Main view, more 
items on the screen will become available and you can click on them to 
perform various functions. Additionally, the Thumbnail mode in the Main 
view, is the List mode, where items are listed in columns instead of 
thumbnails.
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3.1 Glossary of Terms in this Chapter 
 

Group – A collection of pages, sub-scripts or special events 
represented by a single thumbnail in the Main view. 
 
Sub-script – A completed script file that is imported into another 
script and is represented by a thumbnail with the Scala logo in the 
Main view. 
 
Transition – A timed graphic blending effect for making transitions 
from one page to another, or for moving elements on and off the 
screen. 
 
Thumbnail mode – The view of small graphic images in the Main 
view which represent pages, groups, sub-scripts and special 
events. 
 
List mode – The Main view mode which presents all of the items 
of a script and their properties in columns; such as sequential 
order, name, background, transition, etc. 

3.2 A Look at the Main View 
 
The Main view gives you an overview of everything your script will display 
or execute. The view below shows the Main view thumbnails in a typical 
script. 
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A thumbnail in the Main view may represent one of several  
things: 
 

• a page, containing elements such as text, clips and sounds. 
• a group – a collection of pages that you can treat as a unit. 
• a sub-script – another script that is run from within the  

current script. 
• a special-event – an event, such as a timing event, sound, or  
• a command to control an external device. 

 
Most thumbnails are pages: a background upon which you may place 
elements such as text, graphics, and video. These pages may also include 
non-graphic elements, such as sounds and timing events. Designer’s Page 
view is used to create and manipulate a page. (The Page view, described in 
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Chapter 10: Working in the Page View List panel, gives you an overview of 
the contents of individual pages.) 

3.3 Creating a New Script 
 
To create a new script, click the New icon. Opening the Script Settings 
dialog, as shown. 
 
This dialog allows you to specify  
the size of a script’s pages. The Page 
Size setting typically matches  
the screen resolution (pixel  
dimensions) which is used when  
you play back the script. It also  
determines the pixel dimensions  
of any page background. If the  
background image doesn’t match  
the Page Size, the background may  
be resized accordingly.  
 
The  Common Sizes list  gives  the  most  
common choices. Clicking one of these  
selects it.  If you require a specific size which is not listed, you can enter it 
directly by using the Page Size value control. To begin adding pages to 
create a new script, simply click OK.  
 
Whatever size you set in the dialog will also appear in the script  
title bar and immediately apply to the entire script. The Script Settings 
button, to the right of the size in the title bar, can be used to change the 
page size at any time.  
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3.3.1 Opening an Existing Script 
 
You can easily open an existing or saved script file while in the  
Main view. 
 

1. In the Main view, click Open. This opens the Windows File 
dialog. 

2. Navigate to the folder on your hard drive containing your 
desired script.  

3. Scroll through the files in the list box, then double-click on 
that name. You may also select the script and click OK. 
Thumbnails of the script you just opened will appear in the 
Main view. 

3.3.2 Multiple scripts 
 
It is possible to have more than one script open at a time. If you already 
have one script open in the Main view, and you want to begin another, 
simply click the New icon. You may also load another script by clicking 
Open.  
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Tabs in the Main view title bar indicate the scripts which are currently open. 
Different scripts can be selected by clicking on the associated tab, which 
will bring that script to the foreground.  
 
You can cut or copy a page, sound, or event from one script and paste it into 
another open script. Simply select the thumbnail(s) of the item(s) you wish 
to copy and select Copy from the Edit pull-down menu or the Copy icon in 
the toolbar (discussed in the next section) to copy the information to the 
clipboard. Then select the thumbnail of the script you wish to place within 
the clipboard and select Paste from either the Edit pull-down menu or the 
Paste button in the toolbar.  

3.3.3 Thumbnails in the Main view 
 
When you select the thumbnail of a page, the column buttons for that page 
are shown above the rows of thumbnails.  
Pages have the page name shown underneath them to help distinguish the 
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different types of thumbnails in the Main view. A page, group of pages, 
sub-script, or a special event, reveal different thumbnails, as shown in this 
illustration.  
 

 

3.3.4 The Thumbnail and List Modes 
 
The List icon in the Main view toolbar enables you to choose how 
the pages of the script appear. In Thumbnail mode, you will see 
thumb nails of each page, group, sub-script or special event in the 
script. In List mode, the script in the Main view is presented as 
a list of page names. The details and columns are the same in the 
List mode, however, the column buttons of all the visible pages 
are readily available for each page. The following examples show 
the two views of a sample script. 
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When you open a page in Page view, the mode in which you 
are working will stay the same when you return to the Main 
view. The same is true when you create a new script or close 
and reopen Designer. 
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3.3.5 Adjusting the size of the thumbnails 
 
Designer enables you to adjust the size of the thumbnails in the 
Main view. In the Thumbnail mode, shown above, there are seven 
thumbnails per row. 
 
Although the thumbnails in the preceding example are larger 
and more readable, you will notice there are fewer rows. In a 
script containing more than six pages, it will be necessary to use the 
vertical scroll bar. 
 
In the Thumbnail mode, by default, thumbnails are 100 pixels wide. 
The number of columns and rows available in the Thumbnail mode 
varies according to the thumbnail size and the current size of the 
Main view. You can change the width of the thumbnails by selecting 
Options from the Tools pull-down menu (Tools > Options) and 
clicking on the Authoring tab in the dialog box. At the bottom of the 
list you will see the option for Thumbnail Width (in pixels). You can 
increase or decrease the width by clicking on the arrows as show 
below: 
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When the width of the thumbnails is decreased, the Thumbnail 
mode of the same script looks like this: 
 

 
 
In this case, the thumbnails are smaller but there is more available 
space in each row, as well as additional rows. In a large script the 
details may be difficult to read, however, you will have the 
opportunity to view many pages at once. Following is an example of 
the same script with larger thumbnails: 
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In this case the thumbnails are large enough to read the text on the 
pages without having to open the pages themselves. 

3.3.6 The Pull Down Menu 
 
At the very top of the Main view window, the Pull-down Menu has similar 
functionality and options common to most Windows applications. The 
familiarity of these pull-down menus will accommodate new users, as well 
as power users who wish to incorporate keyboard shortcuts for commonly 
used functions like Save, Copy & Paste. It also contains several of the same 
tools that are located on the Toolbar, such as the Add and List mode.  
The Pull-down Menu also offers more precise options, such as individual 
selection of the page or event you’d like to add to your script. This offers 
greater flexibility for users of all levels. 
 
3.3.7 The Toolbar 
 
Toward the top of the Main view, just under the pull-down menu, is a 
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toolbar similar to what you would see in popular Web browsers. The icon 
buttons on the toolbar allow quick visual access to major functions of 
Designer. 
 
Upon opening the application, some of the icons are visibly disabled. Once 
you have opened or created a new script with at least one page, most 
icons are enabled. There are two kinds of toolbar icons: 
 

• The New, Open, Save, Add, Edit Page, Cut, Copy, Paste, Undo, Redo, 
Publish, and Print icons work instantaneously and will either 
open the associated dialog or immediately perform the desired 
action.  

• The List icon acts like a toggle, remaining in either the pressed-in, 
highlighted state or the raised, un-highlighted state after it is 
clicked. 

• The Preview and Play icons launch the playback in a window  
or full-screen mode. 

 

3.4 Script Tabs and the Title Bar 
 
Just below the toolbar, is the title bar where the Document tabs with the 
names of each open script are located. These tabs allow you to quickly 
access any open script in Designer while displaying the names of the open 
scripts or groups. If a group is entered, the tab will show the group  
hierarchy in the format “<scriptname>/<groupname>/<groupname>…” 
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On the far right side of the Title bar, you will see the info display of the 
currently selected script. The pixel dimensions of the script are displayed, 
as well as a Script Properties button, a Script Up button and the close box, 
which closes only the currently selected script. 
 
The Script Up button moves you up the path out of the last group shown in 
the script tab title. If there are no groups currently open then this button is 
disabled. 
 
3.4.1 Thumbnail Rows and Columns 
 
In the Main view, every item listed, regardless of type— page, group, sub-
script, or special event—is represented by a row, consisting of a separate 
columns.  
 
NOTE:  Rows are the same for either List mode or Thumbnail mode. 
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Columns represent previously selected thumbnails. To view the column 
information of more than one selected item in the Main view, switch to 
the List mode. 
 
The first two columns in the row are identified by number and name. The 
remaining columns to the right are Module columns. The column buttons 
open different panels at the bottom of the Main view, allowing you to 
make settings which are associated with the entire script. Settings made in 
the Module panels are reflected in text or graphic form on the column 
buttons. This will allow a quick overview of the various settings, such as 
transitions and sound effects. You can also examine the settings in 
greater detail and make changes to refine the script by clicking the column 
button to open the associated panel. 
 
3.4.2 No. (Number) 
 
A number on a button in the No. (number) column indicates the position of 
the page in the sequence of the script. It also indicates that the page is 
“on” and is enabled as part of the script. In contrast, when Off is visible on 
the button, it means that the page is not shown when the script is run. You 
use this when you need to prevent the execution of a page, but you don’t 
want to lose or change the contents of the page, so that it is easily  
available in the future. To change the setting so that a page is included or 
excluded accordingly, click on the page’s No. button, opening the Page  
Control panel as shown below: 
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The Enabled? button is marked with a checkmark when the page is 
included in the script; otherwise it is excluded and “off ”. Click on the 
button to either include or exclude the page. Unless you specifically choose 
to exclude the page, it is numbered in the Main view according to its 
position in the script. You can set the status of other pages without closing 
the panel by clicking in the No. or Name columns of the pages. To close 
the panel, click on the Close button or the “X” box in the upper-right  
corner of the panel to confirm the setting or Cancel to leave it unchanged. 
Simply clicking outside the panel after making a change will confirm the 
action, therefore, if you choose to make changes to other pages, it is not 
necessary to close the panel. 
 
3.4.3 Name 
 
The buttons in the Name column display a unique name for each page. If 
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the name is referring to a page, then the original name of the page will be 
displayed. Initially, the page is given a default name based upon the file 
name of the background, or the first element which was placed on the 
page. 
 
Designer handles each page as a distinct entity separate from the file or 
files therein. The name used to identify a page is not dependent upon a 
specific file name. Page names can be as long as the space in a button 
permits. It may also contain spaces and dots (.). The only restriction is 
that the name must be unique within the script. 
 
3.4.4 Changing a Page Name 
 
You can change a page’s name at any time when you are in the  
Main view. 
 
To change the name of a page, click on the page’s No. (number) button 
and, in the Page Control panel, edit the name as desired.  
 
Remember, the name should be short but descriptive enough so that at a 
glance, it conveys the contents or purpose of the page. 
 
The specific name of a page and script will not affect any other pages or 
page names, nor will it affect any file name. This means that although the 
name Designer provides may be based upon the name of a file, you can 
change the name to something more descriptive in the Main view without 
affecting the name of the original file. 
 
3.4.5 Transition 
 
The icon on the button in the Transition column represents the page 
transition which is currently being applied to each page; that is, the way 
the page moves onto the screen and replaces the previous page in the 
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script. In most cases, there is also a number on the button which represents 
the duration of the transition. 
 
By default, Designer applies the Cut transition (the next page simply 
appears all at once). 
 
You may edit the page transition by clicking on the Transition button, 
opening the Page Transition panel, which looks like this: 
 

 
 
When you select a transition, the Transition button will immediately reflect 
the icon, transition duration or speed, and direction (if any). You may also 
change the transition for additional pages in the script before clicking on 
Close, to close the panel. When adjusting each page, simply click on the 
page to select it, then choose a transition and/or set a duration or speed. 
 
Buttons in the Transition column are blank and disabled for pages in the 
Main view which represent a group, a special event or a sub-script. 
Transitions cannot be applied to those items. 
 
Working in the Page Transition panel is discussed in detail in Chapter 12: 
Using Transitions. 

3.5 Timing 
 
The Timing button indicates how pages automatically advance. Pages can 
have a fixed time duration, a wait for the elements in the page (however 
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long that may take), or wait forever (interrupted by mouse click, or by 
scheduling or programming. 
 
The Duration setting is defined in hours, minutes, seconds and 
hundredths of a second. Depending on the current width of the column, 
however, the value can be displayed as either seconds only (up to 999), or 
in hh:mm:ss.hh format.  
 
You can change the width of the Timing column if you can’t see the entire 
setting (see the “Customizing Columns” topic in the Advanced Features 
section of this chapter). You can also adjust the position of the mouse 
pointer over the column to reveal a Tool Tip showing the entire timing 
setting. Designer uses the default setting Wait For Elements for a new 
page.  
 
However, it also assumes that a new page should have the same timing 
setting as the previously selected page. You should always look at the 
Timing button to verify the setting. To change the timing setting, click on 
the Timing button for the desired page, opening the Timing panel:  
 

 
 
When a thumbnail in the Main view represents a group of pages, a script, or 
a special event, Designer automatically uses Wait For Elements as the 
timing setting, indicating no delay between the current page and the 
following page. If the thumbnail represents a group, the timing setting for 
the last page in the group determines when the next page in the script is 
displayed. 
 
Regardless of the timing setting, the viewer of the script can always 
override the timing of a page by pressing the secondary mouse button to 
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see the previous page, or by simply pressing the main mouse button to see 
the following page. 
 
For details about using the Timing panel and to make adjustments in the 
timing of your script, please review Chapter 11: Timing. 

3.6 Input 
 
Clicking a button in the Input column opens the Input panel. This panel 
contains options related to how the mouse and keyboard input are handled 
on any given page. 
 

 
 
Designer's default settings are generally appropriate for most situations. 

3.7 Branch 
 
The Branch column button allows access to the panel which defines 
variables and controls the flow of a script.  
 
Clicking a button in the Branch column opens the Branch panel. 
 

 
 
The Branch panel lets you control the sequence of the script when pages 
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are not necessarily shown in the order they appear in the script. You can 
also define and name variables in this panel. 
 
The Branch panel makes it possible for you to produce sophisticated, 
flexible scripts which can respond to a variety of input. For more 
information about the Branch panel, see Chapter 15: Branching, Variables 
and Scheduling.  

3.8 Sound 
 
Clicking a button in the Sound column opens the Sound panel. 
 

 
 
When a sound is added to a page, the corresponding button in the Sound 
column is labeled with text which describes the sound event; for example 
Play or Stop. If there is no sound event on the page, the button will be 
blank. 
 
A sound event for a page might be music, a sound effect, or a voice. 
 
As with the Page Transition and Timing panels, you can change the sound 
setting for other pages in the script without closing the Sound panel. Simply 
click on the following page.  
 
When the thumbnail or row in the Main view represents a group of pages 
or a script, the Sound button is blank, even when sound is an element of 
one or more individual pages. You may however, click on the button to 
define sound elements that affect the entire group or script. For example, if 
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you want music to begin with the first page in the series and end with the 
last page; that is, before the next page in the script in the Main view is 
presented, this option would be very useful. 
 
For more information about the Sound panel and its controls, see Chapter 
14: Using Animation, Digital Video & Sound. 

3.9 Background 
 
Clicking a button in the Background column opens the Background panel. 
 

 
 
The Background panel allows sizing and other adjustments to  
background images from the Main view. It is essentially identical to the 
Design Background panel, described in Chapter 4: Working with 
Backgrounds, however, it also offers the advantage of being able to work 
with more than one page at a time. 

3.10 Other Module Columns 
 
In addition to these “basic” columns in the Main view, you will see 
additional columns for more specialized uses. Designer contains 
additional Modules: 
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The integrated Modules are always available. Optional Modules may be 
enabled in the Options dialog. Each Module extends your script's 
capabilities Other Modules may be purchased separately.  

3.10.1 Enlarging the Designer Window on the Desktop 
 
When Designer is run on the desktop in its own window, the window can 
easily be resized. Resizing the window causes the application to readjust the 
panels to fit within the resized window. 
  
If the window is enlarged, the script title bar and thumbnail layout expand 
to fill the new space. The thumbnail images stay the same size, but the 
number of columns and rows adjust according to the size of the window. If 
you make the window smaller, the contents are compressed accordingly. 
 
Note: If you make the window too small, some items may be obscured. 
 
If your thumbnail settings are changed in the Options dialog, it will take a 
certain amount of time for the Thumbnail mode to generate its images, or 
to regenerate them to a new size. The Thumbnail mode will display a small 
icon of meshing gears in the lower right-hand corner until it has finished 
generating the Thumbnail images.  
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The icon will disappear when an image has been completely generated.  
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3.11 Context Menus 
 
A new feature to Designer 5 is the inclusion of right-click Context Menus, 
which effectively increases the ability to quickly access certain features. 
 
For example, right-clicking on a  
thumbnail or list item in the Main  
view, will reveal a context menu  
allowing you to Cut, Copy, Paste,  
Delete, Group, Ungroup, Disable and  
Preview in one motion. Combined  
with keyboard shortcuts, this will  
greatly increase your productivity. .  
More information on context menus  
and keyboard shortcuts can be found  
in Appendix A: Keyboard and Mouse  
Shortcuts. 

3.12 Working with Pages 
 
In addition to using the Main view to define page elements such as 
transitions, pauses and sounds, there are many other ways in which you 
can work with pages in the Main view to refine the script. Generally, the 
basic techniques for handling pages are the same whether you are 
working in the List or Thumbnail mode. 
 
3.12.1 Adding Pages 
 
To add a new page of any type (script, animation, etc.), use the Add icon in 
the Main view toolbar, or drag and drop. If the Main view is empty, as it is 
when you create a new script, you will be adding the first page. Otherwise, 
the page you add will be inserted in the script after the page that is 



Designer5 
 

 
99 

 

currently selected. 
 
If you use the Add button in the toolbar, you can only add a new page 
from a media file or script. This is the same as using the Add pull-down 
menu and selecting Add Page From Media File. To add a new blank page, 
special event, or a streaming video page, use the Add pull-down menu.  
 
3.12.2 Adding a page that is based on a file 
 
When you click the main part of the Add icon, or choose Add Page From 
Media File from the Add pull-down menu, opening the standard 
Windows File dialog. The File dialog enables access to all existing files—
scripts, backgrounds, animations, and sound effects, etc. 
 

1. In the File dialog, click on the folder which contains the type of file 
you want to add; or navigate through your file structure until you 
see the file name in the list box. 
 

2. Double-click on the file name in the list box or select the file and 
click Open. 
 
If the file is a picture background, Designer assumes you want to 
start composing the page, therefore, the Page view will appear 
with your chosen background. Usually you will see the Design Text 
panel, however, when adding an animation or movie, you will see 
the Design Background panel. 

 
3. When your page is completed, and you click the Main icon in the 

Page view, you will see the page thumbnail listed in the Main view. 
 

4. If the file is not a picture background, you will see the Main view. 
The new page is automatically selected and Designer will assign a 
name which you can change at any time. You will also see the 
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panel for the type of page element represented by the file you 
have selected. For example, if you selected a sound file, the 
Sound panel is already open, allowing immediate refining of the 
sound settings. 
 

Designer also has the ability to select several files from the same folder 
and add them to the script at the same time. You can select a range of 
consecutive files, (Shift-click) or randomly select files, (Ctrl-click). The new 
pages are automatically selected in the Main view. 
 
When you add a page to a script, the contents of the file, chosen from the 
File dialog, become the contents of the page. If the file is a script, all of its 
pages, sub-scripts, sound effects, etc. will be included in the definition of 
the page. 
 
3.12.3 Adding a Plain background page 

 
The Add Plain Page choice enables you to quickly create a page that has a 
single color background. As with other backgrounds, Designer assumes you 
want to begin designing the page immediately, therefore, when you 
choose Add>Add Plain Page, you will see the Design Text panel in 
addition to a plain background. You also have the option of changing the 
color of the background. For more information please review Chapter 4: 
Working with Backgrounds. 
 
3.12.4 Adding a Special Event page 
 
A Special Event page allows you to add elements to a script which may not 
be associated with a file. A special event may be used to reset a variable 
value. For example, in a script which accompanies a speech, a special 
event could be used to control the volume of a microphone, or music 
playing in the background, without affecting the currently displayed page.  
From the Add drop-down, choose Add Special Event. The Special Event page 
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is automatically assigned a generic name.  You can then click the Timing, 
Input, Branch, Sound, or other Module columns to specify the action of the 
special event. As with any page, you can click on the No. button and edit 
the name in the Page Control panel. When you double-click on a Special 
Event page in the Main view, opening the File dialog. 
 
The Special Event page is unique because it enables you to insert an event 
which controls a device or an action and work with it just as you would any 
other page although it may not be associated with a file. 
 
3.12.5 Adding a Streaming Video page 
 
You can only add a streaming video page from the Add pull-down menu, by 
selecting Add>Add Streaming Video Page and entering the URL of the 
active media. The page may also be edited in Page view with additional 
elements and text after which the media will stream to the page as a 
background movie.  
 
3.12.6 Adding pages with drag and drop 
 
You can also add pages to the script using ordinary drag and drop 
methods. Drag a file icon for a background image, sound, sub-script, or 
other file from its window into the Designer window showing the Main 
view. The file is subsequently added as a new page. The new page will 
follow whichever page you originally selected. There are certain types  
of pages that cannot be created using drag and drop. Plain pages, for 
example, and Special Event pages which are not file-based (such as a 
branch event) must be created as described in the Adding a Special Event 
section.  
 

3.13 Selecting Pages 
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To select a page, click on its thumbnail; in List mode you will click on the 
corresponding Name button. The page may also be selected by clicking on 
one of its other buttons. Additionally, the corresponding panel of each 
button’s function will appear.  
 
3.13.1 Selecting multiple pages 
 
In either List mode or Thumbnail mode, Designer allows the selection of 
more than one page at a time. You may select pages which are listed 
consecutively in the panel, or randomly positioned in the list. Following 
are several opportunities for selecting multiple pages: 
 

� to copy and paste them into another script 
� to move them to another location in the script 
� to group them 
� to delete them 
� to collectively apply settings, such as a transition or pause 

 
The order in which you select the pages is maintained when they are 
copied, moved, or grouped. 
 
To select a series of consecutive pages, simply click on the first page, then 
Shift-click on the last page. Every page between and including the first and 
last page, will automatically be selected. To select every page in the script, 
choose Select All from the Edit drop down menu, or press Ctrl+A. To select 
a series of pages that are not consecutive, click on the first page, then Ctrl-
click on each additional page. 
 
To deselect a page simply Ctrl-click on that page. The page or pages you 
have selected, will remain selected and will also be affected by any 
subsequent actions, until you click on another page in the Main view. 
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3.13.2 Making settings for several pages at once 
 
You can save time and effort by creating settings for several pages.  
 
To make settings for multiple pages, select the desired pages, then click 
the corresponding column for the selected pages. This will open the 
appropriate panel for those pages. Any settings you create in this panel will 
be automatically applied to your selected pages. 
 
The settings you see initially in the panel are those for the page in whose 
column you clicked to open the panel. If the selected pages have settings in 
that panel that differ from one another, only those settings that you 
explicitly change are affected by your actions. 
 
For example, if you select five pages, each of which have a different 
assigned transition, then open the Page Transition panel and edit just the 
transition speed. Each page will subsequently receive the new transition 
speed value, but they will also retain their five individual transitions.  
 
3.13.4 Leaving Module panels open 
 
Once you have created settings for a given selection of pages, you are not 
required to close an Module panel. With the Module panel still open, you 
can click in the Main view and select additional pages. You may also make 
changes to their settings.  
 
Additionally, you don't have to close one Module panel before opening 
another. Simply click in a different column to open another Module panel. 
The settings you create in any panel will immediately be applied and 
subsequently will not be discarded unless you explicitly click Cancel or 
Undo. 
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3.14 Modifying a page 
 
The quickest way to begin modifying the contents or design of a page listed 
in the Main view is to double-click on the corresponding thumbnail, or its 
Name button. 
 
If this represents a page in the script, you will see the page—its 
background, text, clips, etc.—and a Page view. The revealed Page view is 
dependent upon two things. For most backgrounds, it is controlled by the 
type of element which initially appears on the page. If there are no existing 
elements on the page when you first open it, you will see the Design  
Background panel. If you click anywhere in the page canvas (the visible 
design area of the page), you will see the Design Text panel: 
 

 
 
If the first element on the page is a clip, you will see the Design Clip 
panel. If the first element is a drawn object, you will see the Design Oval, 
Design Box, or Design Line panel. The other factor associated with Page view 
is the type of background. If the page background is an animation or movie, 
you will see the Design Background panel regardless of what is on the 
page. 
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If the page represents a group of pages, after double-clicking you see the 
contents of the group which may, in turn, be pages, groups or sub-scripts. 
Depending on the structure of the group, you may need to continue to 
double-click on the appropriate thumbnail or the Name button until the 
page in the list represents the page in which you want to work. 
 

 
 
In any case, when the page in the Main view represents a page, you can 
double-click on the Name button to obtain the appropriate Page view as 
mentioned above, or you can select the page in the panel and use the 
Design drop-down to choose the specific Page view you want to use. 
Please refer to Chapter 5: Using Design Panels in Page View for more 
information regarding Page views. 
 
If the page represents a script, you will see the Windows File dialog when 
you double-click on the Name button. 
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3.15 Moving pages 
 
You can quickly revise a production by changing the order of the script’s 
pages, whether or not a page in the Main view represents a page, a group 
of pages, or a script.  
 
To move a page, point to its thumbnail and drag it to a different position. 
With the exception of the page number (in the No. column), all of the 
information defined for the page will also be moved. All other pages will be 
moved accordingly, and their corresponding page numbers will be adjusted. 
 
In List view, you may move a page by dragging the Name button. 
 
Designer also allows several pages to be moved simultaneously. Whether 
or not your selected pages are in a consecutive series, they will be handled 
collectively, and inserted together in their new position.  
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1. Select the pages you want to move. 
 

 
 

2. Point to the thumbnail for one of the selected pages and  
select it with the Main (Left) mouse button. 
 

3. Click-drag this page, representing the entire series, to the  
position where you want the first page in the series to be  
placed. 
 

4. Release the mouse button. You will see the pages inserted 
together in the script according to the order in which they were 
selected. 

 
In the List mode, you can drag several Name buttons using the identical 
thumbnail process noted above.  
 
NOTE: In Designer, dragging can always be interrupted to cancel the movie 
in-progress by pressing the secondary (Right) mouse button while the main 
(Left) mouse button is still pressed. 
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3.15.1 Previewing pages 
 
Using the tools of the Main view, you can click on Preview at any  
time to test and review your adjustments. 
  
Preview is different from Play in that Preview allows specific access to a 
selected part of the script. Additionally, Preview is available in the 
majority of Designer panels. Play is available only in the Main view, and 
always starts the script from the beginning and plays it to the end (or until 
you stop it). 
 
You can preview one page (click on it, then click on Preview) or a range of 
pages (Shift-click or Ctrl-click to select the pages you want to preview). 
Although you can preview a series of pages that are not consecutive, it is 
recommended to preview pages in sequence.  
 
If you are previewing several pages, you must press the main mouse 
button to see the next page, if a specific duration is not defined. You can 
also press the secondary mouse button to see the previous page in the 
series. After previewing the last page, you will automatically return to the 
Main view. You can exit the preview at any time by pressing Esc. 

3.16 Copying pages 
 
You can create a new page in Designer by copying an existing page and 
pasting it elsewhere in the current script, or in another script of your 
choice. You may also copy one page or a series of selected pages, 
regardless if they are consecutive.  
 

1. Select the page or pages you want to copy. 
 

2. In the Main view, click on Edit and choose Copy (Ctrl+C). A  
copy of each selected page will be placed on the clipboard. 
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3. If necessary, use the tabs to navigate to the script where you 

want to place the duplicate(s) or, if the script is not available, 
click on Open and select it from the File dialog. 
  

4. In the script, select the page where you want to place the  
duplicate(s). 
 

5. Click on Edit and choose Paste (Ctrl+V). Each copied page will be 
listed in the panel in the order in which it was originally selected. 
 

6. Designer applies the same name as the original to the copy. 
Additionally, a number which uniquely identifies the duplicate, 
will be added. For example, if the original name of a page is 
“Info”, the name of the first copy is “Info.1”. If the page is copied 
again, the second copy will be titled “Info.2”, and so forth. 

 
A copy of the original selection(s) will remain on the clipboard and may be 
pasted as many times as necessary until the next time you choose Cut or 
Copy from the list of Edit options. 

3.17 Cutting and deleting pages 
 
To remove one or more pages from a script, begin by selecting a page, 
then click on Edit and choose Delete or Cut (Ctrl+X). If you choose Cut, the 
pages will be placed on the clipboard. If you choose Delete, the pages will 
not be placed on the clipboard. The only way a deleted page can be 
recovered is by using undo. 
 
You can replace what you cut, move it to another position in the same 
script, or move it to a different script with the following sequence. Select 
the page in the script that is to precede the cut page(s) then click on Edit 
and choose Paste. If you selected and cut several pages, they will be 
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inserted in the order in which they were selected. 
 
NOTE: Information which is cut or copied to the clipboard, will remain 
there until you choose Cut or Copy again. When you quit Designer, the 
clipboard is automatically cleared – however, any text that exists will 
remain. 
 
You can repeat the pasting process as often as necessary. You may also use 
the pasting process in multiple scripts. However, you must paste the cut 
information before additional cutting or copying can be performed, 
otherwise, the page or pages will be permanently deleted. Deleting one or 
more pages from a script affects only the current script. Files are not 
deleted. For example, if a deleted page represented a script, that script file 
will not be deleted and be available for other uses. 
 
3.17.1 The clipboard and programs outside Designer 
 
Designer uses the Windows clipboard to facilitate the transfer of 
information to and from your projects, using simple cut and paste 
techniques. You can use the clipboard to transfer images such as 
backgrounds and clips, sound files, animations, and text.  
 
However, there are limitations regarding copying information from one 
application to another. For example, pages which are cut or copied from 
the Main view cannot be pasted into other applications. Similarly, 
information placed on the clipboard by any other application cannot be 
pasted on the Main view, for the simple reason that only Designer can 
create pages. However, Clip files and text which are placed on the 
clipboard, may be pasted onto a page when you are in one of the Page 
views.  
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3.18 Grouping pages 
 
To help you structure and organize a script, Designer makes it possible to 
organize pages into groups. This can be especially useful in large scripts, 
where grouping pages which may be related by topic or purpose, will be 
easier to manage; allowing a quick overview of their contents. 
 
A group may include any number or combination of pages, scripts or other 
groups of pages. Whether the selected pages are or are not listed 
consecutively in the Main view, the group's position in the script will be that 
of the first page you select. Similarly, within the group, pages are 
sequenced according to the order in which they were selected. 
 

1. Select the pages you want to include in the group in the  
Main view. 
 

2. Right-click on one of the selected thumbnails or listed page  
names, and select Group from the context menu (or click on the 
Edit pull-down menu and choose Group). 
 

A thumbnail/Name button representing the group appears in the position 
of the first page you selected. That page and the other pages you selected 
are now in the group. Designer assigns a generic name to the group, 
which will also appear on the group’s Name button. 
 
Buttons for a group are generally darker in color than buttons for a page. 
The thumbnail for a group looks like a stack of pages with the first page in 
the group located on top. 
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1. Click on the group’s No. (page number) button, opening the 
Page Control panel. 
 

 
 
In the Name text box, type a short descriptive name for the group and click 
on Close. You will return to the Main view and, on the group’s Name button, 
you will see the name you have assigned. 
 
3.18.1 Editing in a group 
 
When you double-click on a group’s Name button, you will see the Main 
view with the individual pages, scripts or groups of pages that are included 
in the group. The page number for each represents the sequence of pages 
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within the group based upon their selected order.  
 
The path in the script title bar reflects the position of the group in the 
structure of the script. You can refine the elements of the group and work 
in the panel as usual. When you are done, click on the Script Up button in 
the script title bar, as necessary, until you see the top level of the script 
structure.  
 
3.18.2 Ungrouping 
 
To dissolve the group and leave its contents as individual items in the 
script, select the page representing the group, then click on the Edit pull-
down menu in the Main view and choose Ungroup. The items in the group 
are listed individually and consecutively, beginning at the position in the 
script previously occupied by the group. 

3.19 Using Undo/Redo 
 
The ability to take back actions is provided by the Undo feature. Its 
complement is Redo, which takes back an Undo. Undo and Redo are 
options which are available on the Edit pull-down menu and the toolbar 
panel in the Main view and the Page views. You can also use the keyboard 
shortcut, Ctrl+Z for the Undo function, and Ctrl+Y for Redo. 
 
Designer features multi-leveled undo capability. The traditional simple undo 
is limited to taking back only your last action. Multi-leveled undo allows you 
to take back as many preceding actions as necessary. The Redo function is  
also unlimited. You can freely move forward through the series of actions 
which you have just undone, to arrive at exactly the desired point in your 
editing history. 
 
3.19.1 What can be undone 
 



Designer5 
 

 
114 

 

Any change you make in Designer that makes a visible difference in a 
script’s structure, appearance, or behavior is an action that can be undone. 
 
Following are examples of actions that are affected by Undo/Redo: 
 

1. turning a style option on or off 
2. adjusting a style value control 
3. typing and editing text 
4. cutting, pasting, and deleting 
5. moving pages or elements 
6. grouping and ungrouping 

 
3.19.2 What can’t be undone 
 
Changes to settings that affect only the application’s working environment 
and not the script itself, are not tracked by the undo system. 
 
Examples of changes that cannot be undone include: 
 

1. changes made in the Options dialog 
2. opening or closing a panel or dialog (apart from changes made 

within it) 
3. actions that cause some form of output, such as ScalaPrint printing 

or publishing 
4. changing the Designer window size or position 

 
3.19.3 What is an undoable action? 
 
Designer tries to make sensible judgments about what you would 
consider to be a single action. This will give you an indication of what to 
expect when using Undo/Redo. 
 
For example, as suggested by the preceding lists of what can and cannot 
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be undone, if you open a panel, change a single setting, and then close the 
panel, that is considered a single action, not three. If you had adjusted two 
settings while in the panel, it would be interpreted as two actions. If you 
had changed only one of those settings several times while in the panel, 
that would still be considered two actions. Therefore, in some cases, several 
clicks or drags on a particular control are consolidated into a single action.  

3.20 Undo/Redo feedback 
 
Designer always attempts to show you the results of Undo and Redo via 
the status bar, so that you can see whether they had their intended effect.  
 
3.20.1 Panel and page changes 
 
The contents of panels and the appearance of pages are updated by 
Undo/Redo to reflect their current state. If a change was to adjust a control 
in a panel that you subsequently closed, and the change would not 
otherwise be visible, the panel is opened to show the control at its previous 
setting. 
 
3.20.2 Status bar messages 
 
Messages in the Status Bar at the bottom of the Designer screen, describe 
any action(s) which have just been undone or redone. For example, if 
you delete a page, then choose Undo, the message “Undid Delete” appears. 
The message is “Undid changes” if what is referred to can’t be easily 
described with a single action label. Using Redo produces “Redid...” 
messages. 

3.21 Running a script 
 
The Preview icon helps you test and preview one or more pages of the 
script. However, what you see and hear is not necessarily everything that 
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will appear on the selected pages; while using preview, events continuing 
from earlier pages will not be included in the playback. 
 
To see how everything flows and functions together, it is necessary to use 
Play. Play always shows the entire script, regardless of the selected pages. 
 

 
 

 
 
3.21.1 Options during playback 
 
You can stop script playback at any time by pressing Esc. Pressing Ctrl+P 
pauses script playback. Press Ctrl+P again to resume playback. 
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3.21.2 Advancing 
 
You can override any timing settings by pressing the main mouse button to 
reveal the next page in the sequence, or by using the secondary mouse 
button to return to the previous page. If you use the mouse buttons during 
the presentation of a page which represents another script, you will 
advance (or move back) through each page of the sub-script. 
 
Using the mouse to advance when the script has reached the last event, by 
default, it will loop back to the beginning of the script.  

3.21.3 Jumping to a particular page 
 
As the script is playing, you can jump directly to any page by entering its 
page number (as shown on the Main view) and pressing Enter on the 
numeric keypad.  

3.22 Saving a Script 
 
As you compose and manipulate the pages in a script, you should 
periodically save the script so that your work is not accidentally lost. You 
can save a script at any time from any level of the script structure in which 
you are working. 
 
In the Main view, click on the File pull-down menu and click Save As… 
opening the File dialog. 
 
The File pull-down menu now has a list of Recent Scripts. Select a recent 
script to open it. 
 
Ensure that the File dialog shows that you are on the drive and in the folder 
where you want to save the script. (You can create a folder with the New 
Folder icon.) 
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If you have not opened a folder during the current working session, you will 
see the My Documents folder. 
 
If necessary, navigate to the folder where you want to save the script. 
 
File name:, where there may or may not be an existing name. You can 
either edit the existing name of the script, or type any name you choose.  
 
If the script is new, the File name: text box is empty; otherwise File name: 
indicates the name you gave the script the last time it was saved. 
 
File names in Designer (unlike page names) must follow Windows 
standards: the File name can have up to 256 alphanumeric characters 
which can be upper or lowercase, it must start with a letter or a number, 
and it cannot contain any backslashes (\), colons (:), semicolons (;), asterisks 
(*) or question marks (?). Designer adds the proper file-type extension 
(.SCA for scripts) unless you choose to include it in the name.  

3.23 Closing a script 
 
Click on the close button in the script title bar to close your script. 
 
When you attempt to close a script that has been edited since your last 
save, you will see a dialog box asking if you want to save changes to the 
script. Click Yes in the dialog to save the script before closing it. If you want 
to close the script, discarding any changes to the script you made since 
you last saved, click No. To leave the script open, click Cancel. 

3.24 Designer Tools 
 
The Tools drop-down on the Main view gives you access to additional 
Designer utilities. 
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3.25 Options 
 
Click Options from the Tools pull-down menu to open the Options dialog. 
From this dialog you can effectively change and save options which control 
the look of Designer panels, including toolbar, fonts and Main view column 
layout.  
 

 
 
This dialog will also allow: 
 

• enable, disable, and configure Designer Modules 
• control the spell checker  
• view module versions and other information about the system 
• change selectable skins — you may change the look and  

 feel of Designer by selecting a different skin. 
• thumbnails in the Main view 

 
The Options dialog is discussed in Chapter 17: Customizing  
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Designer 5. 

3.26 Scala on the Web 
 
You can open your default web browser to Scala’s web site, by  
choosing this option: http://www.scala.com, You may also click on  
the Scala logo at the end of any toolbar in Designer.  
 

 
 

3.27 Spelling 
 
Designer includes a full-featured spell checker for your script text. Spell 
checker is initiated by choosing Spelling from the Tools pull down menu. 
The spell checker is further discussed in Chapter 6: Working with Text. 

3.28 Multi-tile Editor 
 
Click Tools > Multi-tile Editor to open the tool of the same name. This 
program allows you to create and edit multi-tiles, which are graphic objects 
similar to clips, but may also be resized without distorting their contents. 
This makes multi-tiles ideal for use as text backdrops, which must change 
size to fit their contents. The Multi-tile Editor is discussed in Chapter 17: 
Customizing Designer 5. 



Designer5 
 

 
121 

 

3.29 About Designer 
 
Choosing About Designer brings up a dialog box which reveals various 
copyright, trademark, and license information. You can run a script that 
lists the names of Scala’s development team by clicking on the credits 
button. 
 

 
 

3.30 Publishing a Designer script 
 
Use the Publish icon button on the toolbar to publish your script. This 
publishes the script to a location that Content Manager can distribute for 
playback on Player systems. The Publish button launches a dialog which 
asks for your target location; once you have your network set up it 
becomes a nearly instantaneous process to update your scripts. The 
Publish Script process is discussed in Chapter 16: Publishing, Exporting and 
Printing. 

3.31 Printing from Designer 
 
Although Designer is oriented toward dynamic presentations, it may be 
advantageous to create a printed version of a script. To do so, simply click 
the Print icon to open the dialog revealing the settings from which to print. 
Print functions are discussed in further detail in Chapter 16: Publishing, 
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Exporting and Printing. 

3.32 Quitting Designer 
 
To stop working in Designer and quit your current session, simply click on 
the close button in the title bar. You may also double-click the Designer icon 
on the left-hand side of the title bar. 
 
If you attempt to close Designer when an open script has been edited 
since your last save, you will see a dialog box asking if you want to save the 
changes you made to your script. If you want to save the script before 
closing the application, click Yes in the dialog. If you want to close the 
application, discarding any changes to the script you have made since you 
last saved, click No. If you do not want to close Designer, click Cancel. You 
will see this dialog for each open script that has been edited since the 
last time it was saved. 

3.33 Advanced Features 
 

3.33.1 Changing page size for a script 
 
The Script Properties button is a special button in the script title bar used 
for specifying page size.  
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The current size is displayed to the left of the button.  
 
Clicking this button opens a dialog specifying the size (in pixels) of a script’s 
pages. The size you set in this dialog will apply to the entire script. Designer 
has the ability to adapt page back-grounds of different sizes to the 
specifications of your script page size. 
 
The playback display mode can be controlled in several ways, and might 
have a resolution that differs from the size setting for a given script. 
Regardless of the resolution of the display mode, the size of the pages 
shown within any display mode will always correspond to the settings in the 
Script Settings dialog.  See Chapter 17: Customizing Designer 5 for setting 
display modes for playback. 

3.33.2 Collect Files 
 
Selecting the Collect Files option from the File pull-down menu allows you 
to gather all of your media, fonts, sub-scripts and transitions and save them 
into one location. You can either choose Collect For: Playback, or 
Authoring. This is a convenient way to share your projects with other 
departments, or for general archiving purposes. 
 
Some of your other options are to include transitions or fonts, package as a 
single file, or edit the project collect manually. You can also choose to 
password protect your collected project. For more information, please 
review Chapter 16: Publishing, Exporting and Printing.
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3.33.3 Scala Artwork Folder 
 
Typically located in the Scala program directory on your hard drive, is a Clip 
Art folder where a diverse and exciting assortment of media may be 
easily accessed for use in your projects.  
 
From the My Computer  
icon, go to Local Disk  
(C: ) > Program Files >  
Scala > ClipArt. In this  
location, there is a vast  
array of folders containing  
backgrounds, clips, sounds,  
mutli-tiles and more!  
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3.34 Customizing Columns 
 
Designer enables you to adjust the width of the columns in the Main view 
and change the sequence of the columns that represent page elements, 
(Transition, Timing, etc.). 
 
3.34.1 Adjusting column width 
 
Changing the width of a column affects the number of columns which can 
be seen at one time in the Main view. For example, if you make the Name 
column narrower, you can see additional Module columns without using 
the scroll bar. 
 
Adjusting the width will also determine the amount of visible information 
on one or more buttons. For example, if the Timing column is wide 
enough, a full time value such as 00:03:45.50 can be shown. 
 

1. Point to the vertical space between the column you want to  
adjust, and the column to its right. 
 

2. Press and hold the main (left) mouse button. The space between 
the columns will be highlighted. 
 

3. Drag the right edge of the column to your desired width, then 
release the mouse button. 
 



Designer5 
 

 
126 

 

 
 
3.34.2 Adjusting column order 
 
Although you cannot adjust the position of the No. and Name columns, you 
can rearrange the order of any of the other columns. For example, if you 
need to work more frequently than usual within a column adjusting the 
column order would be desirable.  
 
To rearrange the columns of page elements, point to the column heading 
and drag the name to the left or right until it is in the new position. Do this 
as necessary until the columns are in the desired order.  
 
You can also choose not to display the columns of optional Modules. This 
may be accomplished in the Options dialog. For additional details, please 
review Chapter 17: Customizing Designer.
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||||| 4 Working with    
  Backgrounds 
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Chapter Overview  
 
Once a new page is added, the background becomes a backdrop for 
elements such as text, clip art, special photographs, pre-designed 
graphics, and video clips, enhancing the creative design of your page.  
 
Designer includes a wide variety of backgrounds with different themes, 
colors and styles. Additionally, virtually any picture or animation that is 
available as a bitmap file may also be used as a background. Designer 
supports many bitmap and movie file-formats, including BMP, JPG, TIF,  
GIF, PNG, SWF, WMF, AVI, and MPG as background images. 

4.1 Glossary of Terms Introduced in this Chapter 
 

Multi-Tile – A special type of bitmap image in Designer which can 
be resized without distorting the image. Using the Multi-Tile 
Editor, you can divide the source image into several “slices”, 
which are seamlessly tiled together to produce a final image of 
a pre-determined size. 
 
Animation – a sequence of frames that, when played in order at 
sufficient speed, present a smoothly moving image effect similar 
to film or video. Sources of animations can be from digitized 
video sequences, Flash animations or animated GIF files. 

4.2 Terminology 
 
In this application, still images are referred to as “Picture” backgrounds; 
AnimGIF animations and SWF files are “Animation” backgrounds. Digital 
video (AVI, WMV and MPG) are referred to as “Movie” backgrounds. There 
are also “Multi-tile” backgrounds, which are similar to picture back-
grounds, and “Plain” backgrounds, which consist simply of a solid color. 
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Any type of background, other than a Plain background, is referred to as an 
“image” background. “Animation” and “Movie” backgrounds are generally 
referred to as animations. 

4.3 Types of Backgrounds  
 
There are many sources which are commonly used to obtain or  
create bitmap graphic and movie files: 

 
• Scanners and digital cameras which save digitized images, (also 

referred to as TWAIN devices). With the exception of RAW files, 
images can be used in their captured form, from digital cameras. 
RAW files must be reformatted to JPG, TIF or PNG files. Images 
must also be in RGB format - CMYK color space is not supported. 

• Rasterized vector files that were originally created in a vector 
(lines, fills and blends) drawing program, that can save and/or 
export rasterized bitmap files. 

• Video editing and effects software that can export to a 
compatible video format. Video processing & encoding 
programs are also supported. 

• SWF Flash movies. When used as a background, these will 
automatically be resized to the longest dimension of the page size.  

• Image processing programs that can manipulate or enhance 
existing graphic images. 

• Modeling and rendering programs, which create three-
dimensional objects and apply color and shading to their surfaces, 
giving them a realistic look. Such software can often generate 
animations, which also can be saved as digital video files. 

• Designer’s Multi-tile Editor, which gives you the ability to create 
and edit multi-tiles. These graphic images will resize without 
distortion. Multi-tiles are frequently used for blocks of text, but 
they can also be useful as page backgrounds, especially when it is 
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important to conserve the storage space used by a script’s media 
files. 

• Clip-art libraries (such as the media included with Designer), which 
may contain images from any of the aforementioned sources. 
These are ordinarily categorized according to subject or 
function, and in many cases, they are specially adapted for tiling in 
Web authoring. 

• Virtually any image that is available as a bitmap file can be used as 
a background for a page. 

4.4 The Design Background panel 
 
Designer has the ability to make special adjustments to the background of 
a page, where you can: 
 

• adjust the size. 
• change the color. 
• crop or trim away graphic areas you do not want to include. 
• make a full page background from a smaller image by tiling. 
• adjust the background size to ensure that it matches the page size. 

 
You can tailor a background to meet specific needs of the script, or the 
display medium. If you are working in the Main view, select the page you 
want to change and click on the Background column. If you are working in 
the Page view, click the Background icon.  
 
You will now see the page with the current background with the Design 
Background panel at the bottom of the screen. 
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The panel has several tabs to facilitate a variety of background 
operations. The buttons and options available on the Image Type tab, 
depend upon the background type. For example, the Background panel 
shown above, looks as it does, when the background is a picture. The Type: 
selector in the upper left corner indicates the type of background—
Picture, Animation, Movie, or Plain. The name of an associated graphic file 
is shown on the File: button. 
 
If you choose a Plain background, the panel will look like this: 
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In the example shown above, since there isn’t a file associated with the 
page, a File: button is not necessary. Located on the Image Settings tab, 
you will find a color bar along with the Background button with a color chip 
which will allow you to change the Background color. For additional 
information, please review Chapter 13: Adjusting Colors. 
 

 
 
Other tabs are disabled, because their options are not applicable to Plain 
backgrounds. 
 
When the page represents an AnimGIF animation, you will see the first 
frame of the animation. The Image Type tab will look like this: 
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If the file is a digital video animation (an AVI, WMV, or MPG file), there 
will be different options available. Animation-specific controls which are 
visible in this panel, are not present with other backgrounds. See Chapter 
14: Using Animation, Digital Video and Sound for information on using 
the options in this panel.  

4.5 Choosing a background: Video, Image or 
Animation 
 
Before you compose a page with elements such as text or clips or 
drawings, you must first create the page by selecting a background. 
 
4.5.1 Picking an image background 
 

1. In the Main view, click on Add to open the Windows File dialog. 
 

2. In the File dialog click on the drop-down selector for Files of 
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Type: to limit your selection to only the Backgrounds, Movies, 
Animations etc., or navigate as necessary to the location 
containing the background(s) you want to use. 
 

3. When you are ready, select the background file(s). You may 
select one file to create only one page, or several files to create 
several pages.  

 
To create only one page: 
 
Double-click on the file name or select the file and click OK.  You will see 
a page with your selected background, along with the available Design Text 
panel. However, if you chose an animation file, you will see the Design 
Background panel. For information on the animation-specific options in this 
panel, see Chapter 13: Adjusting Colors. 
 
To create several pages: 
 
Select your background, then Shift-click on another file to select it and all 
files between them, or Ctrl-click to select files that are randomly positioned 
in the list. 
 
You may also use Select All to select all available backgrounds. If you do not 
want to use all of the backgrounds in the folder, Ctrl-click on those 
backgrounds to deselect them. 
 
With each additional background, you will see the Main view as a new page 
in the script. Designer gives each new page the same name as its 
background file, however, you can change the name at any time by clicking  
on the No. (number) button. There are two ways to begin designing a page: 
 

• double-click on the Name button or the page thumbnail to see 
your selected background, along with the Design Text panel
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• select the page, then click the edit pull-down menu and choose 

Edit Page
 
4.5.2 Replacing a background 
 
Replacing a background in Designer can be easily accomplished without 
disturbing other elements located on the page, or in the animation frame. 
 
To replace an image background (a picture, multi-tile or an animation) with 
another image background: 
 

1. In the Image Type tab of the Design Background panel, click the 
File: button. 
 

2. You will see the Windows File dialog showing the contents of the 
folder in which the current background is located. 
 

3. Navigate as necessary to the folder containing the new 
background you want to use. 
 

4. Double-click on the file name of the new image file. Depending on 
your selection, you will see the page with the new picture, or the 
first frame of the animation. You will also see the Design 
Background panel with the settings of the new background  

 
To replace a background with a background of another type (for example, 
changing an image background into a Plain background, or vice versa): 
 

1. In the Image Type tab of the Design Background panel, click the 
Type: pop-up. 
 

2. Choose the type of your new background
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• If you choose Plain, you will immediately see the Plain page.  
 

• If you choose anything other than Plain, or the current type, 
you will see the File dialog, after which you can pick a file 
described above. You don’t necessarily have to pick the same 
file. —For example, if you choose Animation, you could still 
navigate to the Movies folder and load one of those as your 
new background. 
 

After your file has loaded and exited the File dialog, you will see the page 
with the new background. 
 
4.5.3 Using a plain background 
 
To create a page with a plain background: 
 
Choose Add Plain Page from the drop-down list. 
 
This will open up the Design Text panel, with a solid color background. 
 

4.6 Changing the Color of a Plain Background 
 
Designer enables you to manipulate the colors of backgrounds.  
 
4.6.1 Changing the Background color 
 
Every page has a Background color, specified by the color chip on the 
Background button on the Page Settings tab of the Background panel. 
 
For a plain background, the Background color is the background of the 
page. For other types of background, the Background color is seen 
surrounding the background image only if the image is smaller than the 



Designer5 
 

 
138 

 

page in at least one dimension. In many cases, the Background color is not 
visible. The color bar is used to set the Background color: 
 

1. In the Page Settings tab of the Design Background tab, find a color 
you want to use in the color bar. You can edit the colors, or create 
new colors, in the Design Palette tab. Use the Color Set Switcher to 
move through the color sets. 
 

2. Drag the color to the Background button. The Background color 
will immediately change without affecting any other elements on 
the page. 

 
Designer uses a medium blue as the default Background color. The 
Background color is saved as the default when you choose Save as Defaults 
in the Misc tab of a Design panel. For more information see Chapter 6: 
Working with Text. 

4.7 Adjusting Background Size 
 
The size of a background (that is, its dimensions rather than the number 
of bytes of data it contains) is measured in pixels, the smallest unit of a 
screen picture. Size is expressed in terms of the number of pixels which are 
used, both horizontally and vertically, for display on a computer monitor or 
other display medium. A common size for Designer backgrounds, for 
example, is 640 pixels (screen width) by 480 pixels (screen height), or 
simply 640 × 480. 
 
The size of a background image is determined when it is created. In most 
cases, you do not have a choice in the size of a given graphic image, such 
as using clip-art from a pre-produced CD-ROM. 
 
Designer has the ability to change the size of picture, multi-tile and anim 
backgrounds. (Plain backgrounds are always the same size as the page.) 
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Picture and anim background size may be changed by scaling, cropping, or 
both. 
 
4.7.1 Reducing and enlarging backgrounds 
 
If you typically work in different resolutions, you may want to enlarge or 
reduce a background. If it is too small, the number of pixels in the width and 
height will be less than the number of pixels in the page size (as set in the 
Script Size dialog on the Main view). As a result, you will see a border of 
the Background color surrounding the image. 
 
If the background is too large (the number of pixels in the width and height 
are greater than the page size), parts of the background will extend beyond 
the page size limits. Although you may want the background to fit the page, 
there may also be occasions when you intentionally want it to be smaller or 
larger than the available space.  
 
Designer offers several ways to adjust the background, thereby meeting 
your individual page and resolution requirements. You can easily change the 
size of the background, the size of the pages in the script, or both settings. 
 
You can also repeat or “tile” a smaller image across the entire background. 
This is especially useful when you want to reduce the media storage 
requirement of your production. For example, if the script is intended for 
distribution, you would only need to store or transmit a small image file in 
which to cover the entire background. Several options are also available 
to control individual repetition of the image across the page. 
 
4.7.2 Scaling the background image 
 
The Image Settings tab of the Design Background panel contains options 
related to the dimensions of the background. The Custom Image Size? 
button, although normally disabled, reveals the size of an image 
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background. Additionally, the Image Size: selector provides several 
automatic scaling options. By default, Scaling: is set to Original, allowing 
the image to cover the entire page without being distorted. If the image  
is smaller than the defined page size, it will automatically be scaled upward 
until it covers the dimensions of the page. If the image is larger than the 
page, it will be scaled down. Regardless, if the proportions of the image 
and the page do not match, some of the image will “run-off” the edge of 
the page. 
 

� The Scaling: options provide several ways of adapting an image to 
the page, such as: Original – no change to the image size. If you 
are using a higher-resolution image than your target script/screen 
size, then this choice won’t work well - unless your desired effect is 
to zoom in on the center of your background image 

 
� Fit Inside Page (Preserve Aspect Ratio) – makes the image as large as 

possible while leaving all of it visible. 
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� Fill and Trim to Page (Preserver Aspect Ratio) – makes the image large 
enough to completely cover the page; however, the sides or top 
and bottom of the image may “run-off” the edges.
 

 
 

� Fill Page Exactly – stretches the image to the exact dimensions of 
the page. Note: this can distort the selected image proportions. 
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Custom – enables Custom Image Size control to let you specify any 
arbitrary size for the image. 
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If the aspect ratio (height × width proportion) of the background image 
matches the aspect ratio of the page, you will not see any difference in the 
effect of the second, third, and fourth options. The proportions of most 
images intended for use as full-size computer backgrounds will match the 
proportions of common page sizes. 
 
To specify a particular size for the background, choose Image Size: Custom 
to enable Custom Image Size. Use the value control to set your desired 
dimensions, (width and height in pixels)  
 
Shortcut: To quickly cycle to a setting, point to the [<] or [>] arrow then 
press and hold the main (Left) mouse button until you reach the number 
of pixels you want. To accelerate the process, press both mouse buttons 
simultaneously.  
 
Changes are reflected on the screen, providing immediate feedback for 
further testing and refinement to the image.  
 
Changing the size will stretch or squeeze the entire image so it will fit 
within your newly defined dimensions. Remember, these new dimensions 
apply only to the background on the current page. To save the background, 
so that it is available from the Backgrounds folder in the File dialog, 
simply click on Edit then choose Export. 
 
After you export, you usually want to use the saved background instead of 
the original for the current page. Otherwise, Designer must resize the 
original background each time it encounters the page; that takes additional 
time, which can interrupt the flow of the script. A possible exception is if 
you made the background larger. In that case, loading a larger background 
file might take more time than scaling the original to the new size. 
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4.8 Cropping a Background Image 
 
Designer enables you to crop or trim away outer parts of picture 
backgrounds. The cropped portions of the picture will disappear from view, 
but not from the background itself, allowing them to be easily recovered. 
Normally, this will make the background smaller, but Designer can 
automatically scale a picture background so it will always remain the same 
size. 
  
The Crop? button controls cropping. Normally, the button is blank. Turning 
the Crop? button on and off enables or disables the crop position and crop 
size fields within the button. When Crop? is on, the crop position and crop 
size fields typically look like this for an un-cropped image. 
 
The crop settings you will see before cropping originate with the image 
file. The crop position setting 0,0 represents the upper left-hand corner of 
the image. The crop size setting indicates the dimensions (in pixels) of the 
original image, which should match the current size of the background 
specified on the Custom Image Size? button. When you have finished  
cropping the background, the crop size settings will reflect the amount of 
the original image still visible. 
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When using the Crop? button: 
 

• Click on Crop? to enable or disable the crop position and crop size 
value controls. 

• Click on a value to activate the cursor in one of the four text boxes. 
• Use the value control arrows to increase or decrease a value. 
• Use Tab and Shift+Tab to move to the next or previous setting. 
• The screen is updated as you click the arrows, or when you move 

to another setting after typing in a value. 
• Turning off Crop? resets the crop position and crop size to their 

original values. 
• Multi-tiles cannot be cropped, so the Crop? button is disabled for 

multi-tile backgrounds. 
 

4.8.1 Setting a crop position 
 
The first two crop position settings represent the number of pixels which 
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will be cropped from the left edge of the original background. This will 
determine the left edge of the newly cropped image.  
 
NOTE: When you load a new background, the setting will be zero because 
the original image has not been cropped. 
 
In Figure 1, the left setting is changed to 400, allowing the left edge of the 
background to be cropped accordingly. 
 

 
 

 
 
Figure 1. Cropping the left side 
 
The second position setting represents the number of pixels to be cropped 
from the top of the original background. This will determine the top edge of 
the newly, cropped background. Initially, this setting will read zero (0) 
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because the original image has not been cropped. 
 

 
 

 
 
Figure 2. Cropping the top 
 
When the top setting is changed to 140, the top of the background will be 
cropped accordingly, as shown in Fig. 2. 
 
4.8.2 Cropping and resizing 
 
When the Custom Image Size? button is disabled, cropping will reduce the 
size of the background image, and you will see a border of the Background 
color around the cropped image. This indicates the difference between 
the size of the cropped image and the size of the page. Designer can  
automatically eliminate designated areas of the background, without 
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changing the size of the image. 
 
Setting Scaling: to Custom will allow you to manually resize the 
background. At this point, Designer will resize the cropped image 
accordingly, scaling it up to the dimensions shown on the Custom Image 
Size? control. (Note: Proportions of the original image may be distorted 
to some degree. Please be careful to adjust the crop values 
proportionately.) If you set Image Size: to something other than Custom 
after cropping, that option will be applied using the aforementioned 
cropped size of the image. 
 
Keep in mind that the settings on the Crop? button are expressed in pixels 
of the original image. Once the image has been cropped and resized, 
these pixels will not correspond exactly to the physical screen pixels. 
 

 
 
Figure 3. After cropping with Custom Image Size? On 
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To discard any changes and recover your original image, turn off Crop?, or 
load the background file again. 

4.9 Creating a Tiled Image Background 
 
Turning on the Tile option in the Background panel will display additional 
controls in the Image Type tab for creating a background by “tiling” or 
duplicating an image over the entire page. 
 

 
 
With the tiling feature, you can achieve greater storage savings for your 
backgrounds, by using smaller images. 
 
The Tile? button turns tiling on and off. When Tile? is turned off, a small 
image will appear, centered on the page. The area remaining around the 
image, is the Background color. When you turn Tile? on, the page will be 
filled with multiple copies of the image, covering the entire background 
area. 
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4.9.1 Aligning tiles with the page edge 
 
When Tile? is turned on, three horizontal alignment buttons and three 
vertical alignment buttons will appear. These buttons will determine how 
the edges of the tiled images will be clipped at the edge of the page. (If the 
width and/or height of the image divides evenly into the total width/height 
of the page, these controls have no effect.) 
 
4.9.2 Changing image offset 
 
The Offset value control allows you to change the alignment of duplicate 
images, relative to each other. Duplicate images are normally laid out in a 
perfect grid, horizontally and vertically aligned. So, adjusting this strict grid 
arrangement, may add visual interest to the page. Changing Offset from 
zero moves each successive row or column of images over by the number 
of pixels specified on the control. This will create a diagonal repetition of 
the images. 
 
By default, Offset affects the horizontal alignment of each row, as shown in 
the preceding illustration. Turning on the Vertical button will switch the 
offset to affect the vertical alignment of the columns. 

4.10 Changing the Background Orientation 
 
The options on the Orientation tab allow you to easily change the overall 
orientation of a background picture.
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4.10.1 Flipping the background 
 
The two Flip options will switch the direction the background faces; either 
from side to side or top to bottom. 
 
When Flip Horizontal is applied, the button will be marked with a 
checkmark and the image will be flipped around an imaginary vertical 
axis. 
 
When Flip Vertical is applied, the button will be marked with a  
checkmark and the image will be flipped around an imaginary horizontal 
axis. 
 
When both Flip options are applied at the same time, the image will be 
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shown upside down and backwards. 
 
After applying one or both Flip options, you can save your image by clicking 
on Edit and choose Export. 
 
4.10.2 Rotating the background 
 
Using the Rotate value control, a background may be rotated in 90° 
increments around its center. This capability will make authoring portrait-
style displays much more practical, especially when used with matching 
rotation of text and clips. 
 
This option rotates the image, not the page, and does not change its 
proportions from the way it appears at 0°. Therefore, rotations of 90° or 
270° may cut off the ends of the image and leave visible bars of the 
Background color on opposite sides of the page. 
 
There is no difference between rotating a background 180° and applying 
both Flip Horizontal and Flip Vertical.  

4.11 Processing Background Image Color 
 
Any image background—can be altered in subtle or dramatic ways using 
the image processing controls on the Process tab of the Design 
Background tab. Because image processing also applies to clips as well as 
backgrounds, the Process tab is described in further detail in Chapter 13: 
Adjusting Colors.  
 

4.11.1 Exporting a Background or an Entire Page 
 
Use the Export option in the File pull-down menu to save the background 
with any new settings or changes you have made. For example, when the 
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background is adjusted to meet special size or resolution requirements, 
using this option would make it easily available for use in another script. 
 
When you click on Export, you will see this Export Options dialog: 
  

 
 
4.11.2 Exporting the Background (w/out Elements) 
 
What to Export: defaults to Background in the Background panel. 
 
Exporting either Background or Entire Page will result in an image file the 
size of the page. Background saves the background image with all of its 
styles and options (including tiling), however, without elements. Entire 
Page saves any page elements, such as text or clips, as part of the 
background. 
 
For example, you may want to use Entire Page to ensure a company logo 
appears on every page which uses the background design. When such 
“foreground” elements are saved as part of the background, they become 
part of the background design. When the saved background is opened, it 
cannot be edited or independently manipulated on the page. 
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After choosing an Export Type, click Save... to open the File dialog. Find a 
location and enter a name for the exported file. Designer automatically 
adds the file extension.PNG and saves the file in 24-bit PNG format 
regardless of the original format of the background image file. 
 

 
 
When you click OK in the File dialog, you are asked if you want to keep the 
original background, or replace the original background (and its elements, 
if you specified Entire Page) with the exported background. Choose the 
exported background only if you don’t need to work with the elements on 
the page as separate elements.. (This allows the page to appear faster.)  
Choose the original if you want to save the page as a file for future use, 
but still need to move and adjust the items on the page. 
 
In any case, when you are finished in the File dialog you will see the page 
and the Background panel as they were when you chose Export. 
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4.12 Advanced Features 
 

4.12.1 Using the Background panel in the Main view 
 
One of the columns in the Main view is Background. The panel that this 
brings up is the Background panel, which looks just like the Design 
Background tab. It opens on top of the Main view, not on top of a single-
page display. 
 
Although this is seemingly redundant, it will allow you to select multiple 
pages at the same time. It also allows background-related settings to easily 
be applied in one operation. Since background size and similar factors 
typically affect many, if not every page in a script, using the Background 
panel together with the Main view; rather than using the Design 
Background panel, allows these changes to be made much more quickly  
and effectively. 
 
To make a common background change, select any number of pages, then 
click in the Background column. You will see the Background panel at the 
bottom of the Main view. At this point, you can make your desired changes 
to the page settings. Once your edits are confirmed, you can exit the panel  
by clicking Close. If there are other pages which need editing, you can 
select them and make their changes without closing and reopening the 
panel. Different page types have different possible options. For example, if 
you select different types of pages at the same time—picture and 
animation pages—the options you will see in the panel will be the same  
options that were last selected. Additionally, these options will only be 
applied to selected pages of the same type. 
 
4.12.2  Background and Design Background panel 
 
The Background panel duplicates the Design Background panel. The 
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options are identical to those described in this chapter. 
 
4.12.3   Streaming Video in the Background 
 
Streaming Video can be used as a background page as well as any other 
video file. You just need to be sure that the Player computer has access to 
the URL where the movie file resides.  
This is very effective for live feeds and refreshed media streams. Layers of 
content - such as text, images and video clips, may also be created and 
placed on top of the streaming video. 
 
To create a Page with a streaming video background in the Main view, 
select the Add pull-down menu and choose “Add Streaming Video Page”. 
Then enter the URL for the media file and click OK. The streaming video 
page will show the Page view for further editing. 
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||||| 5 Using Design Panels in 
  Page View 
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Chapter Overview 
 
Design panels are the tabbed panels at the bottom of your Designer 
window when you are editing a page.  
 
These panels house the functions and settings you will need to compose 
individual pages in your script. There is a specific Design panel associated 
with every major type of design task. The name of a panel reflects its 
purpose or the type of element with which it is associated. You can easily 
switch from one to another. In the Page view, simply click on the View pull-
down menu. 

 
 
Although each Design panel contains options which are specific to a 
particular type of task, there are some features which are common to all 
Design panels.  
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5.1 Glossary of Terms Introduced in this Chapter 
 

Design Panel – The lower section of the Designer 5 window which 
contains the Tabs with settings, options and controls for timing, 
events, media, text and design items. 
 
Tabs – The individual tabbed panels which reside inside the  
Design Panel and contain buttons, sliders, controls, settings and 
selectors.  
 
Hide/Unhide – The ability to select the visibility of elements in the 
Page view. 
 
Context Menu – The pop-up menu which appears when the  
secondary (Right) mouse button is applied in the Main view or 
Page view windows. 

5.2 The Page view Title bar 
 
The Page view title bar includes the name of the Design panel and the 
name of the page.  
 
The Design panel title bar also includes the Page Switcher. The Page 
Switcher enables you to move to another page in the script without 
closing the current Design panel or returning to the Main view. You can click 
on (previous) to move to the previous page or (next) to move to the 
following page. If you know the page number, you may enter it between the 
arrows.  
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5.3 The Page view Toolbar 
 
The Page view Toolbar has a few buttons which are similar to  
the Main view Toolbar. Certain icons—Add, Cut, Copy, Paste,  
Undo & Redo and Preview—are also present on both Toolbars.  
However, the Page view toolbar, has other icons, that let  
you quickly access different aspects of the page in which to  
compose. 
 

• You can easily move from one Design panel to another by clicking 
its icon in the toolbar, or by pressing its F-key shortcut. 
  

• In order to see the Design panel for a particular element, first, 
select that element. Depending on the type of element selected, 
the appropriate Design panel will automatically appear. The 
Element icon in the toolbar will also be highlighted. There is a 
corresponding Design panel for every type of created screen 
element—Design Text, Design Clip, Design Animclip, Design 
Movieclip, to name a few. 
 

• To edit other aspects of the page such as Background, Palette or 
List, click on the desired icon. 
 

• After using a Design panel, simply click the Element icon to 
continue working with an element’s styles. If an element is not 
selected when you click the Element icon, or you’ve selected 
multiple elements of different types, you will see a Design Multiple 
Elements tab in which most options have been disabled. 
 
 

NOTE: Look in the View pull-down menu to see the associated F-keys for the 
different Design panels. Some keyboards may be set up with alternate global 
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commands for F-key functions. These commands may potentially be disabled 
or overridden while working in Designer. 

5.4 Adding Elements to a Page 
 
Most types of elements are added to the page through the Add icon in the 
toolbar. Select the File type at in the bottom panel and navigate to the 
location on your hard drive or server to the file you wish to add. Similar to 
Windows file dialogs, you can select more than one file at a time by either 
holding down the Shift key or using the Alt key and selecting one file at a 
time. To add elements such as Special Events, Text Crawl and Streaming 
Videos, use the Add pull-down menu. Using the Add icon in the Toolbar, 
the following elements may be utilized: 
 

• Custom: Allows you to select any type of file which is supported 
• Images: Narrows the choice of selectable items in the dialog to 

only image files 
• Animations: Shows only available animation files 
• Video: Shows only available video files 
• Sounds: Shows only available sound files 
• All Files: Allows you to select any type of file, whether or not it is 

supported 
 

Using the Add pull-down menu offers the following choices: 
 
• Add File(s): Opens the dialog which allows you to select  

any type of importable file 
• Add Special Event: Opens the Design List panel and adds a line to 

select Timing, Branch, Sound, Launch, Log, Schedule or WinScript 
• Add Text: Adds an empty text element to your page, which can be 

very useful when you can’t select an open spot on the canvas area, 
especially if you have full-screen elements on your page. Note: The 
text cursor will also appear. 
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• Add Text Crawl: Adds a Text Crawl element which can be positioned 
and edited 

• Add Box: Opens the Design List panel and creates a Box element 
that can be drawn-out with the mouse 

• Add Oval: Opens the Design List panel and creates an Oval inside a 
boundary box that can be drawn-out with the mouse 

• Add Line: Opens the Design List panel and creates a diagonal Line 
inside a boundary box that can be drawn-out with the mouse 

• Add Streaming Video clip: Opens a dialog that requests  
input of the Streaming Video URL 

5.5 Using Edit options 
 
Edit contains options for managing the contents of the page.  The 
available options depend on the tab which may differ slightly from one tab 
to another. They can be accessed primarily through the Edit pull-down 
menu. A few options are also available in the Page view Toolbar; such as 
Cut, Copy, Paste, Undo and Redo.  

5.5.1 Undo options 
 
You can Undo and Redo your actions as necessary. The Undo/Redo support 
in the Design panels is the same as described for the Main view in 
Chapter 3: Working in the Main View. The Undo command undoes the 
last action you performed. Redo, restores that action. Undo and Redo are 
multi-leveled, meaning you can repeatedly step backward through the 
sequence of your changes by continually choosing Undo. You may also step  
forward in your sequence by choosing Redo. 
 
Undo Page is basically a "whole-page" undo. Choosing this option will 
revert the current page to the state it was in when you last entered it from 
the Main view, or from another page, in any Design panel. For example, if 
you’ve just made several changes to a page and realize that it has all 
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gone wrong, Undo Page lets you start over more easily than using Undo 
repeatedly. 

5.5.2 Cut 
 
Cut deletes information from a page. The information is then placed on the 
clipboard which can be pasted into any script. Any information located on 
the clipboard is available until the next time you choose Cut or Copy. 

5.5.3 Copy 
 
Copy copies information to the clipboard which can then be pasted into any 
script. Any information located on the clipboard is available until the next 
time you choose Cut or Copy. 

5.5.4 Paste 
 
Paste inserts information from the clipboard which has been cut or copied. 
The position of the information after it has been pasted, depends on the 
current status of the page: 
 

• if you click on the screen and see the text cursor, the information 
will be inserted at the cursor position. 

• if one or more elements are selected, the information will be 
placed down and slightly to the right of the currently selected 
items’ upper left corner. 
 

• if nothing is selected and there is no cursor visible, Designer will 
remember the last position the text cursor occupied, and will 
insert the information into that position. 

 
You may continue working with any pasted information.  
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5.5.5 Paste Special 
 
Paste Special is for special options when pasting material placed on the 
clipboard from an external program. It is available only when there is 
material on the clipboard other than plain text which Designer will interpret 
as graphics. 
 
When you choose Paste Special, you will see a dialog offering two options: 
Paste as Clip and Store as a Separate File. 
 
Use Paste Special when the type of data you want to paste would not be 
useful in its “natural” form. Let's use for example, copying columns out of 
a spreadsheet program to be included in a page. If pasted normally, the 
spreadsheet data would appear on the page as a single text element, and 
the data would most likely not be arranged in columns. Using the Paste  
Special option, you can paste an image of the copied columns into the 
spreadsheet. For this option to work properly, the application from which 
you cut or copy must be able to create the bitmap image when it places the 
data on the clipboard. Not all applications can perform this action.  
 
Use Paste as Clip to embed the pasted image into your script.  
 
Use Store as a Separate File when you don't want the pasted object to be 
embedded into the Designer script file. Instead, it will remain a separately 
referenced file. This will keep the script file from becoming too large, 
especially when you are using several copies of the same item. When you 
choose this option, you will see the File dialog. Enter a location and 
filename. Designer will create a file containing the clipboard object with the 
name and location you assigned, and will display the object on the page. 
The script will reference the file exactly as Adding a file. 
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5.5.6 Delete 
 
Delete deletes any selected elements. Any deleted elements may be 
recovered by choosing Undo. 
 
5.5.7 Select All 
 
Select All automatically selects every element on the page. For example, if 
you wanted to apply the same pause setting to every element, you would 
use this option. In some situations it is faster to select all elements on the 
page and then Ctrl-click on the elements you want to exclude, rather than 
individually clicking on every element.  
 
5.5.8 Appear Later, Earlier 
 
Appear Later causes the selected element to appear on the page later than 
other elements. This will effectively move the element to the bottom of 
the Page view List mode. Appear Earlier causes the selected element to 
appear on the page earlier than other elements. This will effectively move 
the element to the top of the Page view List mode.   
 
Appear Later and Appear Earlier options also have the effect of causing the 
selected element to move in front of, or behind overlapping elements. 
Using Element Layering will control how elements cover each other, 
independent of their temporal order.  
 
5.5.9 Snap to Grid? 
 
Snap to Grid? turns on and off constraint of movement to the grid 
positions. Turning it on makes it easier to consistently align and space 
objects on the page. For additional details, please review the section, 
Using the Grid. 
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5.5.10 Spelling 
 
Choosing Spelling will check the spelling of any selected text. For 
additional information please see Chapter 6: Working with Text. 
 
5.5.11 Zoom 
 
When editing a page, zoom is now supported. The current zoom factor is shown at the right 
edge of the Design panel's title bar. The View pull-down menu contains the following new 
options:  
 

� Zoom In: Zooms into the page by increasing the zoom factor by one step. The 
hotkey is Ctrl+Plus.  

� Zoom Out: Zooms out of the page by decreasing the zoom factor by one step. 
The hotkey is Ctrl+Minus.  

� Actual Pixels: Zooms to show the actual pixels of the page, by setting the zoom 
factor to 100%. The hotkey is Ctrl+Alt+0.  

� Fit on Screen?: When on, the zoom factor is always adjusted so that the entire 
page fits on the screen. The hotkey is Ctrl+0. 
 

5.5.12 Mouse-wheel / middle-mouse-button support 
 
Wheel: Scrolls the page vertically as you turn the wheel (like before).  
 

� Shift+Wheel: Scrolls the page vertically by screenfuls, as you turn the wheel.  
� Ctrl+Wheel: Scrolls the page horizontally as you turn the wheel.  
� Shift+Ctrl+Wheel: Scrolls the page horizontally by screenfuls, as you turn the 

wheel.  
 

� Alt+Wheel: Zooms the page in or out, as you turn the wheel.  
� Middle Mouse Button: Scrolls the page as you drag with the middle mouse 

button (wheel-button) pressed. 
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5.6 Using Hide/Unhide All 
 
This feature hides an element on a page as follows:  
 

• When designing several elements which are arranged one on top 
of another 

• Temporarily disabling it from appearing in the script 
 

First select the element either by clicking it in the design canvas or from 
the List panel, then choose Hide Selected Elements from the View pull-
down menu. You can also choose Hide All Other Elements to isolate only the 
selected element on the screen. To Unhide All hidden elements, simply 
select Unhide All Elements from the View pull-down menu. This will make 
all hidden elements visible regardless if they were selected. You can also 
access the Hide/Unhide All features from the context menu, using the 
secondary (Right) mouse button on a selected element. 
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Elements will remain hidden until you complete editing and exit from the 
page. To permanently hide elements from playback, use the Enable/Disable 
feature from the Element Control panel. 
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5.7 Previewing a page 
 
Preview runs the current page, allowing you to see and hear any element 
in the page, including their transitions. 
 
However, in a Design panel Preview will not show you how the page 
transitions in, or let you hear a sound which started on an earlier page. For 
a complete overview of the interaction of the page and the rest of the 
script, you must run the script from the Main view. 

5.8 Returning to the Main view 
 
The Main icon closes the Page view and  
returns to the Main view. 
 
The page will be listed in the Main view. When you save the script, the 
page will also be permanently saved.  
 
Choosing Undo from the Edit drop-down immediately after exiting to the 
Main view, will return you to the Page view. This will also undo the last 
change you made to the page. It does not revert the page to its previous 
state, prior to any editing in Page view. To globally revert to an earlier 
version of your script, you must close it without saving changes, then 
reopen it. 

5.9 The Color bar 
 
Several Design panels include a Color bar which you can use to assign 
colors to the elements and styles on the page. You can change the color 
assigned to an element or style by dragging  
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the color from the color bar to the small colored block or “color chip” on a 
tab button. 
 
The palette is divided into color sets, each containing 16 colors. You can 
navigate from one set to another by using the Color Set Switcher arrows at 
the right-end of the color bar.  
 
Each set in the palette is also assigned a number which you can enter in the 
Switcher. 
 

 
 
The colors in a palette belong to the User palette, and are initially 
determined by Designer, however, you can change the palette and mix 
colors as desired. Details about working with palettes are discussed in 
Chapter 13: Adjusting Colors. 

5.10 Tab panels 
 
All Design panels in Designer, are comprised of several tabbed sub-panels 
called Tabs. The tab-shaped graphic near the top of each Tab panel reveals 
the names of their function. The Tabs are organized so that the Design 
panel is not cluttered with too many options. Thereby making it easier to 
see which options are related. In certain contexts, a panel’s options will 
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not apply to the current situation; in such a case the Tab will be disabled. 
 
Click a Tab to display its contents. You can also cycle through the Tabs with 
the Ctrl+Tab (left to right) and Shift+Ctrl+Tab (right to left) shortcuts. 
 
All Element Design panels share the Position, Effect, Opacity, and Misc Tabs. 
Additionally, most of the options and styles which they contain can be 
applied to every type of element. Depending on the element type, certain 
Tab options which are present for other element types (on common panels) 
are not available.  

5.11 Adding Elements using Drag and Drop 
 
When working in Page view, Designer can add elements to a page by using 
the drag and drop feature of Windows.  
 
Dragging the icon for a graphics file into the Page view canvas will add 
that file as a clip, animclip, or movieclip. You can also add sound and text 
files in the same way. They are added to the page as sound events or text 
elements after any existing elements (they will appear at the bottom of 
the Page view List panel). 
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If you drag an icon for a type of file which is unrecognized or cannot be 
added to an Designer page into the Page view canvas, you will see a 
message reading: it cannot be added. 

5.12 Using Page view Viewing Options 
 
Designer has features which allow you to adjust what is visible when you 
are working in the Page view. 
 
5.12.1 Using the scroll bars 
 
A Design panel can cover the lower portion of a Page view canvas. If any 
portion of the canvas is covered by a Design panel, or if the window is not 
large enough to display the entire page, you will see vertical and/or 
horizontal scroll bars in the Page view window. The scroll bars will disappear 
when they are not needed.  
 
Designer can automatically scroll through the page display. For example, if 
you drag an element below the top of a Design panel, Designer will scroll 
the page to reveal the entire element. 
 
5.12.2 Hiding the Design panels 
 
To see the covered portion of a page obscured by a panel without 
scrolling, press the secondary (Right) mouse button and select Hide Design 
Panel.  When the tab is hidden, press the secondary (Right) mouse button 
to make it visible. 
 
If your keyboard is not globally programmed with another feature, or you 
have reprogrammed it for accessibility in Designer, you can also use the F11 
key to Hide/Show the Design panel. 
 
If you are running in a window, and your desktop is large enough, you can 
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simply enlarge the window so that the Design panels don't obscure the 
Page view canvas. 

5.13 Selecting Elements 
 
When an element is selected, it will be highlighted with a dotted 
rectangular frame. Selected elements which can be resized, such as a clip, 
also contain graphic handles on their corners and edges. In the Page view 
List panel, selected element rows are also highlighted. There are several 
ways of selecting elements in the Design panels: 
 

• Click on the element 
• Drag the pointer across the background so that the dashed frame 

encloses, or partially encloses the element 
• Use the up and down arrow keys (arrows) to select the following 

or previous element (in the Page view List panel) 
 

Selecting more than one element at once is also possible: 
 

• Ctrl-click on the elements 
• Drag-select so that the dashed frame encloses, or partially 

encloses all the desired elements  
• Shift-click on an element to select a series of elements 
• Choose Select All from the Edit pull-down menu or press Ctrl+A to 

select all of the elements on the page 
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5.13.1 Working with several selected elements 
 
You can work with the selected elements as a unit. For example, you can 
point to one of the elements and drag it to a new position. All of the 
selected elements will move together maintaining their original positions, 
relative to one another.  
 
You can also collectively edit styles when several elements are selected. 
Changing an attribute of a style (for example, changing the color of the 
Shadow style) will change the attribute for the selected elements to which 
that style has already been applied. Turning a style on applies it to all of the 
selected elements; turning a style off will remove it. The prior style settings 
of the elements will be preserved, unless they are explicitly changed. 
 
 
When you select more than one element at a time, and they are different 
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types (for example, a text element and a clip), the Design panel that 
appears will be the Design Multiple Element stab. 
 

 
 
The available Tabs include only the settings and options which can be 
applied to all of the selected element types, globally. The controls in the tab 
can display only one setting at a time. When more than one element is 
selected, the displayed settings for the options in the tab will be those of 
the previously selected element. Changes will still be applied to all  
the selected elements. 
 
For example, suppose both text and clips are included in the selection, and 
the text elements have Outline on while the clips do not. Changing the 
outline color would affect only the text elements. Outline is not turned on 
for the clips. 
 
Every element will remain selected, even if you change from one tab to 
another. To cancel the selection, click anywhere on the page which is 
outside the area of the selected elements. 

5.14 Context Menus 
 
The Context menu will appear at the cursor when the secondary (Right) 
mouse button is pressed. Depending where you place the cursor on the 
Page view window, the Context menu options will be different.  
 
For example, if you Right-click anywhere outside the Page view canvas 
(including all of the toolbars, Design panels and the grey area), you will 
see the option to Hide Design Panel (F11).  
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If you Right-click over an element, you 
will see the Cut, Copy, Paste, Delete  
commands, as well as the Hide/Unhide  
All Other Elements, Bind [Element]  
to Data Field and the Hide Design  
Panels options. If more than one  
element is selected, you will also  
reveal the Align and Spread options. 
 
If you Right-click over the  
Background on the Page view  
canvas, you will see the Paste  
(if something is copied to the  
clipboard), Hide All Other Elements,  
Bind Background to Data Field and  
Hide Design Panel options. 
 
5.14.1 Using the grid 
 
The Snap to Grid? option allows you to easily position elements to 
consistently line up on the page. Choose Snap to > Grid? from the View 
pull-down menu to turn it on and off. The default setting is off. 
 
When turned on, this option will allow elements to be specifically 
positioned at grid points. When you drag with the grid on, the horizontal 
and vertical leading edges of the elements will show a visible yellow line 
where they can “snap” into the possible positions defined by the horizontal 
and vertical grid size values. However, if you quit dragging in-between two 
grid points, the element will not automatically “jump” to the snap position. 
The grid will also constrain elements resizing. Turning on the grid will not 
cause elements to move or change size. 
 
Turning on the Show Grid? option in the View pull-down menu, will reveal a 
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grid of points, representing the current grid settings.  

5.15 Grid options 
 
You can adjust the size and origin of the grid in the Grid Editor panel. Click 
Edit Grid from the Tools pull-down menu to open the Grid Editor panel. The 
Show Grid? option is automatically turned on. Within this dialog, you can 
adjust the grid, either graphically or numerically. 
 

 
 
5.15.1 Resizing the grid 
 
The smaller the grid size values, the more freedom you have to position 
and resize elements. Both the width and height contain a range from a 
minimum of 4 to any desired maximum size.  
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To graphically edit the size of the grid, simply drag the solid graphic handle, 
which is located below and to the right of the origin (initially the upper left 
corner of the page). To numerically edit the size of the grid, simply highlight 
the value in the Grid Size control which you want to change, (width or 
height), and use the value control to increase or decrease the number. 
As the values are edited, you will see the grid change. With coarser 
settings, the grid lines become farther apart and the “boxes” in the grid 
will become larger. 
 
5.15.2 Moving the grid on the page 
 
You can reposition the entire grid relative to the page, so that even with 
coarse grid settings you will still have considerable freedom in positioning 
items. The grid origin is represented by a hollow graphic handle crossed by 
two solid lines. By default, it is set to 0,0, which is located in the upper left 
corner of the page. You can drag this handle, or you can adjust the values in 
the Grid Origin control. Any pixel position (regardless of the grid size) can 
also be set as the origin. 
 
When you are finished in the Grid Settings dialog, simply click Done. The 
grid settings apply to every page in every open script, however, they will 
only have an effect while you are editing a page. 
 
Grid settings can be retained for future use by clicking Save Element and 
Page Defaults from the Tools pull-down menu. They are not saved with 
scripts. 
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5.16 Using the Guides 
 
Another feature provided in the Page view makes it easier to align 
objects, is the Guide Lines. Guides are horizontal and vertical lines which 
extend across the entire canvas. They are visible only in the Page view, but 
not in the Main view, and not when you preview or play a script. They can 
be created or positioned, wherever you like. The guide lines provide 
convenient references when several elements are positioned on the 
page. 
 
Layout guides are not defined by default. You can create and move Layout 
guides by selecting Edit Guide Lines from the Tools pull-down menu and 
opening the Guide Lines Editor panel. Guide lines will automatically be 
turned on when you open the panel. You can create and move lines by 
clicking and dragging directly on the page, or by using controls in the 
dialog to make more precise adjustments. You can turn guide line viewing 
on and off using the Show Guide Lines? button. 
 
5.16.1 Creating guide lines 
 
There are two ways to create a guide line: 
 

• To make a line, click anywhere on the canvas while in the Guide 
Lines Editor. The new guide line will be vertical or horizontal 
depending on whether you clicked closer to the sides of the canvas 
area or the top/bottom. 

 
• Click Add Line. The new guide line will be positioned relative to the 

side of the page specified by the Edge: pop-up. The line is 
vertical if Edge: is set to Left or Right, horizontal if it is set to Top 
or Bottom. 
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The new line will appear solid, indicating that it is the current selected line. 
Any other guide lines will be dashed. A small arrowhead in the middle of 
the current line will point to the left side, right side, the top or the bottom, 
depending upon which edge represents “0” for that line’s position value. 
 
You can create any number of guide lines.  
 

 

5.16.2 Selecting guide lines 
 
Guide lines are individually numbered. Each Edge: setting (Left, Right, Top 
or Bottom) can have a series of lines associated with it, regarding its 
numbering and position. The numbering starts with 0, and represents the 
order of the lines in terms of how far they are from the page edge: line 0 is 
closest to its edge, line 1 is the next closest, and so on. 
 
The number of the current line is shown in the Line Number value control 
arrows. You can use this value control to select a line, or alternatively, click 
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on the line. The selected line will become solid, and its Edge, Line Number, 
and Line Position settings will be displayed in those controls. 
 
5.16.3 Positioning guide lines 
 
If you used Add Line, the new line will be positioned relative to the last 
guide line which you created for the current edge. Newer lines are 
positioned farther from the edge. The Line Position value control will show 
the distance of the current guide line from its edge, in pixels. You can 
adjust the line’s position using this control. 
 
Once created, you can move guide lines by dragging them, however, you 
must click directly on the line to avoid creating a new line. In repositioning 
guide lines, it can be easier to use the Line Number control to select the 
lines, rather than making precise adjustments with the Line Position 
control. 
 
If you click and drag to move a guide line, the line will follow the mouse 
pointer, and a number will appear near the pointer, indicating its line 
position. 
 
5.16.4 Removing guide lines 
 
To remove a guide line, select it (by either clicking on it or using the Line 
Number control), then click Remove Line, or simply use the Delete key on 
your keyboard.  
 
Clicking the Remove Line button repeatedly will remove successively 
lower-numbered lines. 
 
5.16.5 Snap to Guides? 
 
Using the Snap-to Guides? Option works similarly to Snap-to Grid?. With 
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the element(s) selected, choose the Snap to > Guides? from the View pull-
down menu. When you move your elements on the canvas, the edges will 
highlight the guide lines when you get near them. Once the guide line is 
highlighted, let go of the mouse and it will snap to that guide line. 
 
5.16.6 Using the guide lines you have created 
 
When you have finished creating guide lines, click Done to close the 
Guide Lines Editor. The guide lines you defined will appear in the Page 
view canvas as solid yellow lines, whenever the Show Extras option in the 
View pull-down menu is on. The lines do not appear in playback. 
 
Guide line settings can be retained for future use by clicking Save Element 
and Page Defaults in the Tools pull-down menu. 

5.17 Using Align and Spread Tools 
 
You can apply the Align and Spread options from the Edit pull-down menu 
to multiple-selected elements on a page. Select two or more elements on 
a page and choose Edit > Align or Spread and apply the alignment or 
distribution points of the selected elements from the options. The selected 
elements will jump into alignment, or the spread distribution you’ve 
applied. The choices for the Align option are: 
 

• Top Edges 
• Middle 
• Bottom Edges 
• Left Edges 
• Center 
• Right Edges 
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The choices for the Spread option are: 
 

• Equal Vertical Gaps 
• by Top Edges 
• by Middle 
• by Bottom Edges 
• Equal Horizontal Gaps 
• by Left Edges 
• by Center 
• by Right Edges 

5.18 Advanced Features: 
 

5.18.1 Saving settings for new pages 
 
If you want any style and text layout settings which have been created in 
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the Text tab, to be applied by default to every new page; simply go to the 
Tools pull-down menu while you are still in the Page view, and click on Save 
Element and Page Defaults. The values of the saved settings will be applied 
to any new pages you create. 
 
If you want to restore the original Designer default settings, simply click on 
Restore Defaults in the Tools pull-down menu. This will not have an 
immediate effect—existing pages will not change. The default settings will 
be applied to any new pages you create. 
 
5.18.2 Export Functions 
 
You can use Export to save various items from Designer. An exported item 
will be saved as a separate file.  
 
When you choose File > Export, you will see the following options, 
depending on the element(s) you have currently selected: 
 

� Selection as Clip/Selection as Text Background 
� Entire Page 
� Palette 

 
If the page does not contain elements other than a background, then only 
Background, Entire Page and Palette will be selectable. Any type of 
selected elements can be saved as 24-bit PNG image files; text can be 
exported either as an image, or as a text file. All styles and visible options 
which have been applied to the selected elements will become part of the 
image file. 
 
When you export several elements at a time, they will be saved as a single 
image file, retaining their relative positions. The space between elements, 
and any transparent areas within exported elements, will be saved as 
black, which can easily be made transparent by turning on the Chroma 
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Key? option and loading them back into Designer. Exporting text elements 
as Text saves a standard ASCII .TXT file.  
 
5.18.3 Exporting a background or an entire page 
 
Exporting either Background or Entire Page will result in an image file the 
size of the page. Background will save the background image with its styles 
and options (including tiling), however, without elements. Entire Page will 
save the background and all of the visible elements. For more detailed 
information on backgrounds, please see Chapter 4: Working with 
Backgrounds. 
 
5.18.4 Exporting a color palette 
 
Exporting User Palette will save the current Designer User color palette, 
into a collection of user-defined 8-bit colors. It will be saved as a 
Designer- specific .PAL file. For more detailed information on the User 
palette, please see Chapter 13: Adjusting Colors. 
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||||| 6 Working with Text 
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Chapter Overview 
 
To make text editing as simple as possible, Scala Designer 5 allows you to 
work with text similar to most word processing programs. At the same 
time, Designer gives you easy access to sophisticated design tools which 
enable you to control virtually every aspect of the text. 
 
For example, you can manipulate the position, color, and weight of 
characters, even the thickness of an underline. You can also use transitions 
to move text on and off the page, in any order or speed. 
 
A comprehensive spell-check is also provided as part of the effective suite 
of tools available for text editing. As you compose and edit text in Designer 
you will work directly on the canvas area of a page, against your reselected 
background.  To begin working with text, you will use the tabs in the 
Design Text panel. 
 

 
 
When you have created a new page thumbnail by adding a background 
image from the Main view, simply navigate to the Design Text panel. 
Following are several methods which are available for viewing with the 
Design Text panel: 
 

• in the Main view Thumbnail mode, double-click on the page’s 
thumbnail. 
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• in the Main view List mode, double-click on the page name. 
• select the page thumbnail in the Main view and click on the Edit 

Page toolbar icon. 
• select the page in the Main view and press F2. In each of these 

examples, the Page view will open, allowing immediate viewing of 
any elements—text, clip art and/or drawings—which are already 
part of the page. 

 
This chapter will begin by reviewing some features and functions in the 
Design Text panel which are common to every Page view, and will 
continue with a review of the basic techniques for typing and editing text. 
 
The chapter will also introduce you to certain functions of the style panels, 
which will be used to fine-tune the appearance of text (this is discussed in 
further detail in the following chapter). 

6.1 Glossary of Terms Introduced in this Chapter 
 

Text Crawl – An element which allows you to move a segment of 
text continuously from one side of the page to the other. 
 
Variable – A named “container” for a quantity which can change 
within a script in response to user input, or the script’s 
execution. 

6.2 Typing Text 
 
Whenever you work in the Page view a text cursor is available on the 
page. If the page is empty, or if text is the first element on the page, the 
cursor will immediately appear when you open the page. 
 
If you don’t see a cursor, simply click where you want to begin working 
on the background. You do this when you are working with most other 
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types of elements, for example an image in the Design Clip panel, the 
panel will automatically change to the Design Text panel. If you have an 
element, such as a movie or image which covers the background - a 
cursor will not appear by clinking in the canvas area.  Choose Add  
Text from the Add pull-down menu instead. 
 
When the text cursor appears you can immediately begin typing, or you can 
point and click anywhere to move the cursor to a different position. As you 
type, the cursor will move forward. When it is positioned within a word or 
line of text, any new character or text will be inserted, and any existing text 
will be pushed further to the right. You have complete access to every 
standard alphanumeric keyboard character. Additionally, when you are 
working on a page, Designer will allow you create a bullet (•) symbol at the 
cursor position by pressing Ctrl + . (period). A bullet is useful at the 
beginning of a line to emphasize items in a list.  

6.3 Text Elements 
 
A text element is simply created by typing text on a page. A text element 
can be a single word, a line, or several lines. Each text element is 
independent of one another and can exhibit entirely different settings 
which govern its appearance, position, and movement on the page. 
 
The following illustration represents a page with several selected text 
elements. Four are single-word elements, one has two words spaced by a 
tab, and one is a multi-line element in which the four words have 
“wrapped” onto four lines. As you can see, text elements can be 
positioned anywhere on the page. They may also overlap one other, and 
even run off the edge of the background. 
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Designer allows tremendous freedom to individually move, manipulate and 
design each element. For example, you can move any text element simply 
by dragging it to a new position. You can also start a new element or 
break the current text element into two when the cursor is visible, by 
pressing Enter. 

6.4 Selection and Editing 
 
Depending on whether an entire text element is selected, part of it is being 
edited, or the element is unselected, your options will be different. 
Therefore, it is important to be able to tell which is the current state. The 
following illustrations will demonstrate the difference. 
 
If a dashed rectangular selection frame appears around the text when it is 
selected, it indicates that the entire text element has been selected, not 
just one line of a larger element. The top element as shown, does not 
contain a frame, therefore, it is not selected. The tabs will not directly affect 
an unselected element.  
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The bottom element contains a frame, which indicates it has been selected. 
The frame encloses the entire element. If the selected element is a multi-
line element a single frame will surround all the lines. 
 
Any chosen option will affect the selected element entirely. Any number of 
text elements (or other elements) may also be selected at the same time.  
 
 

 
 
The two examples shown above demonstrate a text element which is 
being edited. The first has a cursor in it, the second has a segment of its 
text highlighted to show which characters have been selected. In the first 
example, any changes you made to a style would not be seen until you 
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started to type.  The characters would then appear in the changed style. In 
the second example, the highlighted characters would change as soon as 
you changed the style.  
 
When a segment of text is selected, any text you type will replace the 
selected text. When a full text element is selected, the element will switch 
to editing mode and the new text will replace the existing text. 
 
6.4.1 Selected Elements vs. Selected Segments 
 
Any option which you can apply to a selected segment of a text element 
may also be applied to the full element. However, there are options which 
apply only to full elements, and cannot be applied to parts of an element. 
The following can be applied to text elements and segments of text 
elements: 
 

• Color: Front, Shadow, Outline, Underline 
• Text effects: Italic, Bold, Underline, Shadow, Outline 
• Character Spacing, Kerning 
• Font: typeface and size 
• Cut, Copy, Paste, Delete 

 
The following can only be applied to text elements: 
 

• Transitions 
• Position 
• Backdrop, Bevel, Border, Focus, Smooth 
• Opacity 
• Line Spacing 
• Alignment: Left/Center/Right, Horizontal, Vertical 
• Word Wrap 
• Page Margins 
• Tab settings 
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• Update 
• Locked 
• Snap to Grid 
• Appear Earlier/Appear Later 
• Layer 
• Timing settings 
• Branch option 

6.5 Selecting Text 
 
You can select text using the keyboard, the mouse, or a combination of 
both. The method you use will depend upon the amount of text you want 
to select, and if you want to move the text. For example, using the mouse 
is the quickest way to select and group several text elements so they can 
be moved as a unit. 
 
Depending on the selection method chosen, the text will either be 
highlighted in a different color, or enclosed in a dashed frame, as in the 
preceding illustrations. 
 
In either case, the selected text is now available to edit. You can change 
the color, apply a style, delete it, and so on. The selection frame also 
indicates the availability of options which are only available to text 
elements, such as apply a transition, specify a pause setting, change the 
alignment or drag the text to move it. 
 
The text will remain selected until you click outside the selected area, move 
off it using the arrow keys, press Esc, or move the cursor. 

6.5.1 To select an unselected text element 
 

• Click on any non-transparent part of the element. You must click 
directly on or near a character in the text to avoid  
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creating another text element which would overlap your  
selected text. The element will be selected and enclosed in  
a frame. 
 
Or 
 

• Use the keyboard up and down arrows while the List panel  
is open. 
 
Or 
 

• Drag select it with a dashed box, as described in the sub- 
section “To select several elements” later in this chapter. 
 

6.5.2 Getting a cursor 
 
In order to work with parts of a line, you must first have a text cursor. 
 
To get a text cursor in a selected text element: 
 

• Click where you want the cursor. 
 
Or 
 

• Press the Home or End keys, and then use the left/right  
arrows to move the cursor wherever you want.  

 
To get a text cursor in unselected text: 

 
• Double-click where you want the cursor. 

 
Once you have a cursor, you can easily select the entire element by: 

• Double-clicking on the element. 
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Or 
 

• Clicking away, then clicking back on the element. 
 
Or 
 

• Pressing Esc. 
 
To deselect an element in which there is a cursor, simply click away from 
the element. 

6.5.3 To select part of an element 
 
Place the cursor wherever you want, then: 
 

� Drag over the characters you want to include in the selection. 
 
Or 
 

� Use Shift + (rightarrow) or Shift + (leftarrow) to select the text. If 
the element has more than one line, you can use Shift  
+ (uparrow) and Shift + (downarrow). 

6.5.4 To select several elements as a unit 
 

� Point to a spot on the page which is close, but not directly on the 
first text element you want to include in the group. Then, simply 
drag the pointer diagonally. A dashed box will appear which will 
adjust as you move the pointer. Continue dragging until the box 
encloses part or all of each element you want to include in the 
selection, then release the mouse button. 
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A frame will appear around each element which the box touches, 
showing your selection: 

 

 
 

Or 
 

• Ctrl-click on a non-transparent part of each element which you 
want to include in the selection. Each is enclosed in a frame. 
 

Once you have created a text element, you can add text by: 
 

• Selecting the element and then typing. 
 
Or 

 
• Double-clicking in the element to bring the cursor to that position, 

then typing.  
•  
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6.5.5 Multi-line text elements 
 
Designer will allow you to create multi-line text elements—elements with 
their text on more than one line on the page. Multi-line text elements in 
Designer are similar to text columns in a word processor, or desktop  
publishing program. You can easily adjust the column’s width. When the text 
element length exceeds the column width, Designer will “wrap” the text to a 
new line underneath the first. 
 
Designer normally breaks between words. Which means it only breaks a 
word when the column’s width is shorter than that word. Unlike a word 
processor, Designer does not hyphenate broken words. However, you can 
position a multi-line text element as freely as any other element. You can 
also have any number of them on a page. 
 
By adjusting the margins for an element, and by setting certain options on 
the Alignment panel, you can control when and where Designer will wrap 
text. You can adjust the distance between lines in a multi-line text element 
using the Line Spacing attribute.  
 
For more detailed information about these controls, please see Chapter 
7: Managing Text. 

6.6 Correcting mistakes 
 
If you make a mistake while typing, you can correct it by using the 
Backspace and Delete keys. Backspace deletes the character to the left of 
the cursor. The Delete key deletes the character to the right of the cursor. 
 
If you need to correct more than a few characters, you can use one of the 
methods described earlier in the section, “Selecting text” and edit the text 
using one of the text editing options. 
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6.6.1 Joining and breaking lines 
 
If you press Backspace when the cursor is at the beginning of an element, 
the text of the element will be joined with the text of the previous element; 
that is, the element which was previously typed. Since text elements can be 
freely moved to new positions on the page, this may or may not be the text 
which is positioned immediately above it on the page. 
 

the lines.

 
 
Another way to join text elements is to press Delete when the cursor 
reaches the end of the selected text. This joins it with the text element 
which was typed immediately after it (as it is listed later in the List panel). 
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Pressing Enter will create a new text element underneath the current one, 
containing the same style settings as the original element. Any text to the 
right of the cursor will become part of the new element. 
 
The new line will be positioned directly under the previous line. Unless a 
specific alignment option is applied (left, center or right alignment), the first 
character of the original line will determine the left margin and position of 
the first character in the new line. For more detailed information, please 
see Chapter 7: Managing Text. 
 
The cursor will move down in line-space increments as determined by the 
fonts currently in the element and the Line Spacing attribute. If different 
fonts are applied to the line, the spacing may vary. 
 
Pressing Enter several times in succession will move the cursor down, 
however, it will not create any blank or empty lines in the process. Pressing 
the Backspace key, will move the cursor (and any text which accompanies 
it) back to its starting position. 
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6.6.2 Breaking up text elements 
 
Sometimes you want to use styles which can be applied only to whole 
elements with individual words or letters.   
 
Designer has a special keyboard shortcut which makes this easy to do, 
without tedious hand positioning. The Ctrl+Enter combination breaks a text 
element into two at the cursor point, without moving either element. 
Selection frames for both will flash when this is applied. For example, to 
have each letter in a word transition in separately, first type the word as a 
single element, and then place it wherever you want. Then position the 
cursor between each pair of letters in the word and press Ctrl+Enter. 
Finally, select the letters (which are now individual elements) and apply 
your transitions.  
 

 
6.6.3  Moving within text 
 
You can always use the mouse to position the cursor within your text. 
Nevertheless, as you are typing text, it is often more convenient to use the 
keyboard and navigate using special keys or key combinations. 
 
Most of the familiar keys you use in word processing applications are 
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similar in Designer. However, there are some key combinations which are 
unique to Designer. A complete list of these keyboard shortcuts may be 
found in Chapter 25: Keyboard and Mouse Shortcuts. 

6.7 Moving Selected Text 
 
Once you have a text element on a page, you can move it around by simply 
dragging it to your desired location. This can be accomplished in one click 
drag motion, regardless if the element is unselected or fully selected. 
 
If the element is being edited (has the cursor or a highlighted segment in it): 
 

• click on the text element to select the entire line 
 
Or 
 

• press Esc, then point to a non-transparent part of the text 
element, and drag 

 
To move one or more selected text elements, point to a place on or near a 
text character and drag. The selected element(s) will move to the newly 
selected position. Although every element in the selection will move 
together, they will maintain their original positions relative to one another. 
The elements will remain selected so you can refine their position as 
necessary. You can also click outside the group to deselect and 
“disconnect” them, then drag each element individually. You can constrain 
the motion of elements you are dragging so they move in a horizontal or 
vertical direction, only by holding down the Shift key as you drag. 
 
Following are examples of precisely positioning elements:  
 

• use the Element Position control on the Position panel to define 
where the upper left corner of the element should be, in XY pixel 



Designer5 
 

 
204 

 

coordinates 
 

• hold down Ctrl and press the arrow keys (arrow keys) to move the 
selected element(s) one pixel at a time, in the direction indicated 
by the arrow 

 
Note when the Snap to Grid and alignment options are on, they may restrict 
your freedom in positioning text elements.  

6.8 Editing Selected Text 
 
Text is affected by every action until it is deselected by clicking outside the 
selected area, moving the cursor, or pressing Esc. You can edit the text 
simply by beginning to type, or by pressing Backspace or Delete. 
 

• If a segment of a text element is selected, typing will delete the 
part which is selected and replace it with whatever you type. 
 

• If the full element is selected when you start typing, Designer will 
switch to editing mode, place the cursor at the end of the selected 
element, and insert your typing. 

 
There are a variety of editing options available to your selected text. For 
example, you can change the color and style. When one or more complete 
lines of text have been selected, you can change the position of the text on 
the page, the alignment, and the transition(s) applied to create movement. 
Changing the color, style, alignment and transitions are discussed further in  
Chapter 7: Managing Text 
 
6.8.1 Pasting styled text 
 
You can cut copy and paste text elements or selected segments of text 
elements.  
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If you paste when the cursor is in a text element, the pasted text will be 
inserted into the text element at the cursor position. Text elements cannot 
be inserted as part of another element. 
 
If you paste when an element is selected (that is, when one or more 
elements have the selection frame around them) the text will be added to 
the end of an element, or it will become an additional element, depending 
on whether the text on the clipboard was a segment, or an entire 
element. 
 
The characteristics of the pasted text (color, font, styles, etc.) will be 
preserved as much as possible. For example, if you cut or copy a segment 
of a text element, the pasted element will retain the characteristics of the 
original copied text, regardless of whether you paste it into another 
existing text element, or create a new element. 
 
However, a pasted segment does not retain the options, such as a 
transition, which are only available to full elements. The pasted segment 
“inherits” the transition, position, and other such settings, from the 
element to which it is pasted. It will also inherit the current or most recent 
settings, if it is not pasted into another element. 

6.9 Context Menus 
 
When you use the secondary (Right) mouse button on a text element, you 
will bring up the Context menu, which will provide several options. In 
addition to the typical Context menu options discussed in Chapter 5: 
Design Panels in Page View, (Cut, Copy, Paste, Appear, Hide, etc.) an 
additional option is available: Bind Text to Data Field. Please see “Advanced 
Features” section at the end of this chapter for further information 
regarding this option. 
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6.10 Importing and Exporting Text 
 
When working in the Page view, you can either import an unformatted 
plain text file through the Add pull-down menu or, with the Add icon on 
the toolbar. Choose Export Selection as Text from the File pull-down menu 
to export text elements. 
 
6.10.1 Importing text 
 
To import text, click the Add pull-down menu and select Add Files and 
navigate in the File dialog as necessary to locate a plain ASCII or ANSI text 
file. Designer imports approximately 1000 characters from the beginning 
of the file into a single text element. The current font and styles will be 
applied to the text. The resulting text element can be fully edited and 
manipulated. You can also click on the Add icon in the toolbar to select 
your text file from the open dialog. 
 
6.10.2 Exporting text 
 
Text can be exported either as text or as a clip which contains an image of 
the text.  
 
To export, begin by selecting the text you want to save. If you select several 
elements to save as text, Designer will save them in the order selected. 
You can also save a selected segment of a text element. Click the File pull-
down menu and choose Export Selection as Text. If you want to save the 
selected text element as a graphic clip, then select Save Selected as Clip 
from the File pull-down menu. 
 
Any selected elements other than text, will be ignored if you have chosen 
to export as Text. The result is either a plain ASCII text file containing your 
selected text with carriage return/linefeeds at the ends of text elements, 
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or a PNG image file. 

6.11 Using Text Crawls 
 
A Text Crawl is a special kind of text element; similar to an element with a 
built-in transition. It will allow you to move text across the page 
continuously in the “crawl” and “credit scroll” styles, familiar from 
television and the movies. In addition to having the attention-grabbing 
element of motion, a Text Crawl is more powerful than a simple text 
element. It will allow you to specify different types of source for the text, 
process the text for display, and define a “window” where the text can 
freely move. 
 
You can design Text Crawl elements to become “global”, thereby allowing 
them to run over every page, independent of page transitions. 
 
6.11.1 Creating a Text Crawl 
 
You cannot convert a regular text element into a Text Crawl, the crawl 
element must be specifically created:  
 
Choose Add Text Crawl from the Add pull-down menu in the Page view. 
 
A text element consisting of the word “Crawl” will appear. The element 
will inherit the current set of text styles. However, unlike a normal text 
element, the Text Crawl element contains graphic handles on its dotted 
frame, indicating it can be resized. 
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The Design Text Crawl panel is identical to the Design Text panel except it 
has an extra tab, Crawl. The controls on this panel will direct the crawl 
element how to display your text.  
 
NOTE: Text crawls support tabs, which can be useful for vertical scrolling.  
 
Text() and TextCrawl() elements support a new option, UseCharHeight(). 
When on, the font size is interpreted as the character height, rather than 
the cell height. The resulting fonts are a little bigger, but more closely 
match font sizes in certain other applications. 
 
6.11.2 Defining the Text Source 
 
The word “Crawl” is only a Page view placeholder for the text which will 
appear during playback. It exhibits the text styles which are applied to an 
element. The actual playback text can be specified in one of several ways, 
from the Crawl tab’s Text Source: selector: 
 

• File – the crawl text is contained in a text file 
• Expression – the crawl text is contained in an expression (which 

can be entered into the Text Expression field below the Text Source: 
selector) 

• Cued Expression– the crawl text is contained in an expression 
which can be updated via a cue signal 
 

6.11.3 Adjusting Crawl Speed/Duration 
 
The crawl movement can be adjusted by either Duration (time code) or a 
preset series of steps called Speed, defined in terms of how many screen 
pixels the crawl will move, in how many frames (complete screen 
refreshes). You can vary the duration of the crawl by entering the crawl 
time in the Duration time code. You can also adjust the speed at which the 
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text will move using the value control Pixels per Step. 
 
Increasing Pixels per Step will make the crawl move faster. 
 
6.11.4 Loops 
 
File and Expression text sources have the option of moving repeatedly 
through the crawl window. The number of times a given text is seen can be 
controlled with the Loops value control. 
 
Loops specifies the number of times the text is shown before the next 
event in the script will be displayed. You can specify a number between one 
(1) and nine thousand nine hundred and ninety-nine (9999) or an “infinite 
repeat” setting (infinity). The infinite repeat setting is useful when you want 
the crawl to continue indefinitely.  
 
Use the Loops value control to define the specific number of plays you 
desire. When the setting is (infinity), turning Wait? on will prevent the script 
from continuing to the next page, until there is interactive input (such as a 
mouse click), or the duration of the page time has expired. 
 
6.11.5 Gap 
 
When a crawl element loops, is cued, or contains carriage returns, there 
will be a space between the crawl texts. You can adjust the size of this space 
using the Gap value control. It specifies the number of pixels—from 1 to 
9999—between each crawl text repetition or update. 
 
To allow visual adjustments, the space you set will be reflected in the 
distance between the repetitions of the “Crawl” place-holder text which 
is displayed in the Page view. 
 
In the case of Cued Expression text crawls, in which the space between 
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successive crawl texts varies depending on when the texts are cued, the 
Gap setting will specify a minimum distance. 
 
6.11.6 Direction 
 
The content of a Text Crawl can move in any of four directions: 
 

• East to West (Left to Right - the default, traditional for horizontal 
text crawls) 

• West to East 
• South to North (Bottom to Top - traditional for credit scrolls) 
• North to South 

 
Set the direction with the Direction compass at the right-hand side of the 
Crawl panel. Click on or near the white dots so the arrow will point in the 
direction you want the text to move .Depending on whether the crawl 
direction you choose is horizontal or vertical, the “Crawl Crawl” 
placeholder text will change to indicate how the text repetitions will 
appear within the window. 
 
This illustrates how you might set up a typical text crawl: 
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How it would look in playback: 
 

 
 
6.11.7 Line breaks 
 
In vertical crawls, a carriage return in the source text will create a new line 
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underneath the current one. In horizontal crawls, carriage returns within 
the source text will break the text into separate crawl texts. The intervening 
space between crawl texts, horizontally or vertically, can be varied with the 
Gap control option. 
 
6.11.8 Sizing the crawl window 
 
Text Crawl elements can be sized so you can define the window where 
the text will appear. This will allow you to confine your moving text to your 
selected area on the page. 
 
Initially, the crawl window is blank. Text moves into the crawl window from 
one edge and will exit from the opposite edge. The crawl is considered 
complete when all the text (for all repetitions if Loops is greater than 1) 
has completely moved through the crawl window so which it is once again 
blank. 
 
To resize the crawl window, use the eight graphic handles on the corners 
and sides of the frame around the selected crawl element. You can see the 
effect the change will have by viewing the “Crawl Crawl” placeholder text. 
 
6.11.9 Word wrapping in vertical crawls 
 
For vertical text crawls, word wrapping is automatically on. The width of the 
crawl window is defined as the wrap width. 
 
6.11.10  Alignment within the crawl window 
 
Text can also be aligned within the crawl window. Alignment options can be 
enabled on the Alignment tab of the Design Text Crawl panel, depending on 
the type of crawl direction: horizontal crawls enable the Vertical Text 
Alignment: option, and vertical crawls enable the Horizontal Text 
Alignment: option.  
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Vertical text alignment will use the top and bottom of the crawl window as 
its references for Top, Middle, or Bottom alignments of the crawl text. 
Horizontal text alignment will use the sides of the crawl window for defining 
its Left, Center, and Right alignments. 
 
6.11.11 Changing styles in the crawltext 
 
Styles are assigned to the placeholder “Crawl Crawl” text element rather 
than the actual text which is crawled.  
 
However, it is possible to change various aspects of the text style within 
the text of a Text Crawl or Global Text Crawl by using special control codes. 
Inserting the appropriate control codes at the beginning of the crawltext 
will change the style in the segment of text which follows. 
 
The control codes are plain text enclosed in angle brackets. They consist 
of a keyword identifying the style to change, followed by an equals sign, 
and a value for the style. The value is within double quotes, which can 
exhibit different forms, depending on the style type. 

6.12 Spell-checking a Script 
 
Designer includes a full-featured multilingual spell-checking tool. This spell 
checker can quickly and automatically examine every text element in a 
script, and allows you to correct misspellings manually, or by choosing from 
a list of suggested alternatives. 
 
6.12.1 Configuring the Spell checker 
 
The Designer Options dialog has a panel dedicated to the spell checker. 
Click Tools and choose Options to open the Designer Options dialog, 
then click the Spelling tab to see the spell checker options panel. 
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The options on this panel are described in Chapter 17: Customizing 
Designer. 
 
6.12.2 Starting the spell checker 
 
You can access the spell checker from the Main view or the Page view. 
Starting the spell checker from the Page view will only apply to the 
current page until you advance to the next page, whereas from the Main 
view you can initiate spell check on any page.  
 
When you initiate the spell checker, it will search the full text in a script, 
and sequentially highlight any words which appear to be misspelled. 
Unrecognized words, such as proper names, can be added to a user 
dictionary so spell checker will not stop on them in the future. 
 
6.12.3 Spell-checking from the Main view 
 
To start spell-checking from the Main view, click the Tools icon and choose 
Spelling from the drop-down list. The spell checker will begin checking the 
spelling starting with the page which was highlighted when you chose 
Spelling. 
 
You can begin the spell check on any particular page by selecting it in the 
Main view before running the spell checker. 
 
6.12.4 Spell-checking from the Page views 
 
To start spell-checking from any Page view, click the Tools pull-down 
menu and choose Spelling. The spell checker will begin checking the 
spelling starting with the page currently in the Page view. 
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6.12.5 When there are no misspellings 
 
When you run the spell checker on a script without misspelled words, you 
will not see the Spelling panel. Instead, a dialog will appear which reads, 
“The spell check of this script is complete”.  
 
6.12.6 Using the Spelling panel 
 
What you will see when the spell checker runs and finds a word which is not 
in either the main or the user dictionaries for that language, is a panel that 
resembles a regular Design panel. The page currently being checked is 
displayed, with the Spelling panel at the bottom of the screen. 
 
The unrecognized word will be highlighted in the text element on the page. 
If you do not see a highlighted word, the word is hidden beneath the 
Spelling panel. (As with a Design panel, you can temporarily hide the dialog 
to see the word in context by clicking the secondary (Right) mouse button 
and select Hide Design Panel or press F11.) 
 
The highlighted word will also appear in the Not in Dictionary: text box. If 
the word is similar to a word in one of the dictionaries, the spell checker 
will offer a suggested replacement in the Change To: text box. Additional 
possibilities for the intended word may be offered in the Suggestions: 
scrolling list. 
 
You have several options: 
 

• Accept the suggested correction: 
 

1. for this occurrence. 
2. for all occurrences. 

 
• Make a different correction: 



Designer5 
 

 
216 

 

 
1. using one of the suggested alternatives. 
2. typing the correct spelling yourself. 

 
• Tell the spell checker to ignore the word: 

 
1. for this occurrence only. 
2. for all occurrences in the current session. 
3. always, by adding the word to the user dictionary. 

 
• Delete the word from the page. 
• Go to the Design Text panel to edit the page. 
• Preview the page. 
• Go on to check the following page. 
• Close the spell checker. 

 
6.12.7 Changing the highlighted word 
 
Clicking Change will replace the highlighted word on the page with the 
word in the Change To: text box. The corrected word will retain the same 
text styles as the original word. The spell checker will resume searching for 
any other unrecognized words on the page. 
 
If the suggested correction in the text box is not the intended word, but the 
intended word is in the Suggestions: list, simply select the word in the list 
to make it appear in the Change To: box. Then click Change. 
 
If the highlighted word or any suggestions are not correct, select the word 
in the Change To: box and type the intended word. Then click Change to 
make the correction. 
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6.12.8 Ignoring a word 
 
To ignore the highlighted word, and allow the spell checker to continue 
checking the page, click Ignore. 
 
To ignore the word and continue ignoring it for the remainder of your 
authoring session, click Ignore All. The word will be added to a temporary 
list in memory of words to ignore. Until you shut down and restart Designer, 
or use the Reset Ignore All option in the Options dialog from the Tools pull-
down menu, the spell checker will not stop on that particular word. 
 
6.12.9 Adding a word to the user dictionary 
 
The dictionary which Designer checks spellings is extensive, but it cannot 
possibly contain every word which might be used in a script. Proper 
names, trademarks, technical terms, foreign words, and less common 
forms of existing words are likely to be unrecognized by the spell 
checker.  
 
To prevent the need to continually use Add for such words, the spell 
checker allows you to add them to a special user dictionary. This is similar 
to the Ignore All list, but because the user dictionary is a file stored on 
your hard drive, once entered, a saved word is ignored in future Designer 
sessions as well as the current session. 
 
To add the highlighted word to the user dictionary, click Add in the Spelling 
panel. The word is then considered to be spelled correctly in this and any 
other script. Any variant forms of the word, such as plurals or those with 
different verb endings, will have to be added separately. 
 
You can see the contents of the user dictionary, and delete any words on 
the Spelling panel of the Designer Options dialog. 
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6.12.10 Multiple language dictionaries 
 
The custom user dictionary is language-specific. There can be several user 
dictionaries, each of which may contain only the words which were added 
when a particular spell check language was selected in Designer Options. 
 
6.12.11 Editing the page during spell checking 
 
At times spelling corrections may change the lengths of words, thereby 
disrupting the layout of text on the page. If this happens, simply navigate to 
the Page views to adjust the layout, (while in the middle of a spell checking 
session), then resume spell checking from where you left off. 
 
To switch to the Design panel while spell-checking, click the Design button 
at the bottom of the Spelling panel. The Design Text panel will appear, and 
the misspelled word will be highlighted. You can revise the positioning of 
text elements so everything will properly fit, and/or go to other Page views 
to rearrange other elements. 
 
When you have finished, click the Tools pull-down menu and choose 
Continue Spelling. (This choice will appear in place of Spelling in the Tools 
pull-down menu while spell checking is in progress.) The Spelling panel will 
appear again, and spell checking will restart at the point where you left the 
dialog. 
 
6.12.12   Previewing the page during spell checking 
 
You can click the Preview button to see how the current page will look 
during playback.  
 
6.12.13  Continuing the spell check 
 
As you continue to click Change, Ignore, or Ignore All, the spell checker will 
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move on to other text on the page. When all the text has been checked, the 
Next Page button will be enabled. Requiring you to explicitly move to the 
next page will give you the opportunity to review the page, and if 
necessary, adjust the layout.  
 
When you are satisfied with the page, click Next Page, allowing the spell 
checker to check the text of the following page in the script. Spell check 
will continue to check each subsequent page until it finds another 
misspelled word. 
 
When the spell checker reaches the end of the script which you did not 
start checking on the first page, it goes back to the beginning and continues 
checking. Once the text in the script has been checked, the following 
message will appear, “The spell check of this script is complete”. 
 
6.12.14  Finishing a spell check 
 
Click the Close button on the Spelling panel at any time to complete a spell 
checking session. 

6.13 Advanced Features 
 
6.13.1 Displaying variables 
 
One of Designer’s special features allows you to display the value of 
variables in ordinary text. You do this by embedding the variable in the text, 
which simply requires typing the name of the variable with an exclamation 
point (!) placed in front. The following example uses the Designer system 
variable to demonstrate this when Designer runs a script, it will 
automatically substitute the value of an embedded variable for the variable  
name in the text, giving the value the same font and styles as the variable 
name exhibited in the Page view. The variable name may contain a variety 
of styles, but you must be sure the entire variable name has exactly the 
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same styles.  
 
If there are any differences in style within the variable name (including the 
“!”), Designer will not recognize the variable, and its value will not be 
displayed. There must not be a space between the “!” and the variable 
name. The Update option, allows you to adjust how long Designer will 
continue to update the value of a variable displayed in playback.  
 

 
 
Working with variables in Designer is covered in-depth in Chapter 14: 
Branching, Variable and Scheduling. 
 
6.13.2 Using a Text File Source in a Crawl 
 
When you choose Text Source: File, the Text File: selector you can open a File 
dialog to choose the file. The file can be of any length, however, it must 
be a standard ASCII/ANSI text file. All of the text in the file is crawled before 
looping will continue. If the contents of this file change after the text crawl 
begins, it will not reflected until the next time the text crawl element is  
displayed. Updating the text file during the crawl will not cause the 
currently moving crawl text to change. 
 
Using the File source is effective when there is a large amount of text to 
be displayed. It is also appropriate when any text to be crawled is updated 
on a regular basis, provided the updates do not need to become visible 
until the next time the Text Crawl element as a whole appears in the 
script. 
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6.13.3 An expression source 
 
When you choose Text Source: Expression, a Text Expression: text box will 
appear. You can enter an expression which will determine the crawl text. 
The expression may contain any variables, operators and text functions 
which ultimately evaluate to a text string. 
 
You can simply type the crawl text between the double quotes which are 
provided by default in the Text Expression: box. By including system or 
user variables in the expression, you can use text information which may 
have been generated elsewhere in the script. If necessary, this can process 
the variable contents, as well. The following are examples of valid text 
expressions you might use: 
 
“Weather Alert - Severe thunderstorms expected!” 
“SALE TODAY: !saleitem @ ONLY !itemprice” 
“Happy New Year !(systime(year))!!!!!” 
 
The contents of variables can be updated while the crawl progresses, and if 
the crawl is set to loop, each repetition will reflect the current variable 
value at the moment which iteration begins. However, the displayed 
variable value cannot change “live” while crawling. The expression will be 
evaluated at the beginning of the event, and at the beginning of each 
repeat. 
 
6.13.4 A cued expression source 
 
When you choose Text Source: Cued Expression, you will use the Text 
Expression: box to specify the crawl text, just as you would with the 
Expression source. 
 
The advantage of the cued source type is it will respond to an external 
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“cue” signal which indicates when to start crawling a text segment. 
Typically this is used when the Text Expression: box includes a variable 
which is updated periodically with new text. The crawl element is cued to 
display a new text segment only when the variable in the expression has 
been updated. Therefore, you can have a continuous text crawl which can 
be updated at arbitrary intervals, with a series of text messages. 
 
NOTE: The expression for a cued update does not have to contain a 
variable, If the expression is a constant, the cue signal simply triggers 
another instance of the fixed text to start crawling. 
 
The actual text supplied to the text expression and the timing of the signal 
to display it can come from an external source, (such as the Windows 
Scripting Module). 
 
6.13.5 Using a cued source 
 
A cued Text Crawl element operates in tandem with another process—
usually a series of events in the Designer script, or a program in another 
scripting language accessed through the Designer Windows Scripting 
module.  
 
Two shared variables are involved: a cue variable, and a string (text) 
variable which is part of the text expression. The cued text crawl element 
and the other process, signal each other in a back-and-forth manner 
through the value of the cue variable.  
 
The other process signals (with a value of 0) when there is something in 
the text variable with which to start a crawl, and the text crawl element 
signals (with a value of 1) when it is ready to start crawling a segment of 
text. 
 
The sequence of events for a cued text crawl in playback is as follows: 
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• The Text Crawl element appears. 

 
• The Text Crawl element sets the cue variable to 1, and begins 

monitoring for a change in the value of the cue variable. 
 

• The other process updates the contents of the text variable, then 
zeroes the cue variable. 
 

• When the value of the cue variable changes to 0, the text crawl 
element “sees” this as indicating there is fresh information to 
display. 
 

• The text crawl element evaluates the expression with the new 
variable value, and starts crawling the resulting text. 

• When this text has been crawled fully into view, the sequence 
returns to step 2. 
 

Some things to remember: 
 

• The cue variable is automatically initialized to 1 by the Text Crawl 
element. It should not be explicitly initialized by the source 
process. 
 

• The Text Crawl element responds to a 0 in the cue variable only 
when it is ready. It is ready only when the element first appears, 
and in the time after it has finished generating each cued crawltext 
(including the Gap length). A cue signal which arrives while a 
crawltext has begun but hasn't fully moved into view, will not 
interrupt the crawltext. 
 

• The Text Crawl element does not “remember” a cue signal which 
arrives when it is not ready. 
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When text is not available from the source, the source process should set 
the cue variable to -1 (or any value other than 0 or 1). Any crawltext which 
is already moving in the crawl window, will continue until the crawl window 
is empty. The Text Crawl is complete. 
 
6.13.6 Cue Variable 
 
The Cue Variable: pop-up exhibits the name of the cue variable assigned 
to the Text Crawl. 
 
When you choose Cued Expression under Text Source:, Designer will look for 
user-defined integer variables. It will select the first one it finds as the 
default cue variable. However, you can choose a different variable from the  
pop-up list, which exhibits the names of every user-defined integer 
variable.  
 
You can also create your own cue variables (if, for example, your script has 
multiple independent cued text crawls). Simply choose the <Add New> 
option from the pop-up list. Only integer variables are available in the Cue 
Variable: pop-up. If there are no user-defined integer variables, a dialog 
prompting you to create one will appear. 
 
6.13.7 Wait 
 
As with other element types which can take time to complete, the Text 
Crawl element has the Wait? option. Turning this option on will prevent the 
script from continuing to the next event (after the crawl), until the crawl 
has completed or the duration of the page has expired. 
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6.13.8 Endless 
 

The Endless? option allows you to indicate when the Cued text source is 
of a continuous “stream” type which does not have a defined end (such 
as a stock price feed). This is the equivalent of a Loops=0 (infinitely 
looping) setting for the text source types which have that particular option. 
 
Endless? should be turned on for sources which are continuous. It should 
be left off for sources which have an end, such as a string or file. Its effect 
is to modify the Wait? option in view of the fact which the crawl might 
have a defined endpoint.  
 
Essentially, it controls what will happen to the page if the crawl element 
continues after every other element has completed. The four possible 
combinations of these two options and their effects are as follows. 
 

 

6.14 Specifying Control Codes 
 
Control codes are available for all the basic text styles, to turn them on and 
off and set their related attributes: 
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<typeface = “typefacename”> 
<typesize = “pointsize”> 
<facecolor = “#rrggbb”> 
<frontcolor = “#rrggbb”> 
<outlinecolor = “#rrggbb”> same as “frontcolor” 
<shadowcolor = “#rrggbb”>  same as “facecolor” 
<underlinecolor = “#rrggbb”> 
<face = “On or Off”>   same as “front” 
<front = “On or Off”>  same as “face” 
<outline = “On or Off”> 
<outlinethickness = “numpixels”> 
<opacity = “number”> 
<shadow = “On or Off”> 
<shadowoffset = “numpixels_horizontal, numpixels_vertical”> 
<under = “On or Off”> 
<underposition = “numpixels”> 
<underthickness = “numpixels”> 
<underair = “numpixels”> 
<bold = “On or Off”> 
<bolddelta = “num”> 
<italic = “On or Off”> 
<italicdelta = “num”> 
<extragap = “numpixels”> 
 
The portion shown in quotes should be replaced with the style value. Most 
values are simply a number, typically specifying the same value seen in the 
tab. Color definitions take the form of three hexadecimal numbers, 
representing the 8-bit R, G, and B values which specify a 24-bit color. 
 
For typefacename, specify the name of the typeface as seen in saved 
ScalaScript code, for example: 
 
<typeface = "Segoe Regular (Western [<Segoe>])"> 
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The <extragap> option specifies the number of extra pixels of Gap to be 
added between textcrawl segments. This option is useful for varying 
spacing when using scrolls (vertical crawls). 
 
As long as the control codes are properly formatted, they will not appear in 
the crawled text. They will, however, cause the specified change in the text 
which follows them in the crawl. Styles are not reset to their original values 
at the beginning of each crawl loop. 
 
This feature is for advanced script authors. For color changes, you must 
determine the correct values for the desired colors, and individually convert 
them to a hexadecimal format.  
 
6.14.1 Text Crawl control code example 
 
The following example demonstrates the content of a text file used as a 
Text Source for a looping crawl: 
 
This text is the original size and color only for loop 1. 
 
<frontcolor="#ff0000"> 
 
This text is red 
 
<frontcolor="#0000ff"> 
 
This is blue 
 
<typesize = "18"><italic = "On"> 
 
This is blue, with size 18 and italic. 
 



Designer5 
 

 
228 

 

<italic = "Off"> 
 
No italics. 
 
6.14.2 Activating a Text Crawl in ScalaScript 
 
An important option available to advanced Designer authors is the ability to 
change the opacity for the global text crawl using the opacity control code: 
 
<opacity=”number”> 
 
This control code controls whether the crawl is visible or invisible. Setting 
the control code to 100 causes the crawl to appear. Setting the control 
code to 0 causes the crawl to disappear. 
 

6.15 Templates – Binding Text to a Data Field 
 
Right-click on a text element to select the Bind Text to Data Field selection 
– to change this text element to a data field, enter a variable name and 
click OK. Binding a text element to a data field will allow them to be 
selected or replaced by different text through the Content Manger. This will 
also allow you to create messages from templates with placeholder text in 
Content Manager. Effectively the text you enter in Content Manager will 
replace the placeholder value and use the font, attributes, scale, transitions 
and effect.
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||||| 7 Managing Text 
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Chapter Overview 
 
All text has a style. The style may be nothing more than the design of the 
typeface or it may be a special effect which is applied to add emphasis, 
attract attention or create a mood. In Designer terms, a “text style” is any 
option which can be applied to a textual character, a word, or a phrase 
which affects the way it looks on the screen. 
 
In addition to standard options such as underlining, bold, and italic, 
Designer offers a variety of special text options, ranging from simple 
outline styles, to precise control of character and line spacing. There are a 
wide variety of styles available, many of which may be applied to clips, 
draw objects, even animations, as well as text. This chapter will cover 
styles which are exclusively used for text. 

7.1 Glossary of Terms Introduced in this Chapter 
 

Kerning – or Character spacing, is an adjustment of space 
between characters and words to create a more pleasing look 
and improve readability. 
 
Leading – (Rhymes with “wedding”) or Line spacing, is the amount 
of vertical space between lines of text.  

 

7.2 Using the Design Text panel 
 
In the Design Text panel, the Text tab includes the most commonly 
applied styles. Each style has its own button. When you switch one of these 
styles on, the button on the screen will appear to be pressed and the style 
name on the button will change color. 
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Several styles which are very useful, but generally applied or adjusted less 
frequently—Smooth, Underline, Focus, Backdrop, and Bevel—are located 
on the multistyle button. When a style on this button is applied, it is 
marked with a  . 
 
Style buttons, such as Bold or left alignment, can only be switched on or off. 
However, many style buttons allow additional attributes, such as color: 
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When you apply a style as shown in the previous image, Designer uses the 
color which is displayed on the button. You can also change the color 
without applying a style. Applied styles will stay on until you switch them 
off. 
 
The majority of styles can be applied to one or more characters, words or 
lines of text. However, Transitions can only be applied to entire text 
elements. You may also apply more than one style at a time, including styles 
located on the multistyle button. For example, you can make the text italic, 
then underline it, and then apply a special underline color and a 
backdrop: 
 
 
 
 
 
 
 
 
 
 
You can also change text styles either before or after creating your text: 
 

• Select the text for the new style settings, and then apply the 
adjustments in the Design panel. When a setting is changed, you 
will immediately see the effect in the selected text. The text will 
remain selected until you move the cursor, or click outside the 
selected area. (For a review of methods to select text, please 
review the section “Selecting text” in Chapter 6: Working with 
Text .) 
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Or 
 
• Position the cursor, then adjust the styles in the Design panel and 

simply begin typing. The text will reflect the new styles. The styles 
will remain in effect until they are changed or different styles are 
applied. 

 
When you click on a line of existing text, or move the cursor 
through the line, the settings in the Design Text panel will change 
to reflect the styles which are applied to the character preceding 
the cursor. If the cursor is at the beginning of a text line, the Text 
tab will reflect the styles of the first character in the line. 

7.3 Using the Styles Tab Panels 
 
Designer includes styles and options which can fit on a single tab panel. 
Additionally, many styles have characteristics or attributes which can be 
customized. For example, you can change the slant or direction of a 
shadow in italic text. The Design Text panel contains numerous tab panels, 
each of which allows individual control for a particular type of style. 
 

 
 
Any changes made in the styles tab panels are immediately reflected in 
the text. Simply click the tab to reveal the panel for the desired type of 
style, and then use a value control or selector in the panel to make your 
adjustment. 
 
Several of the styles tab panels in the Design Text panel, are also found in 
other Design panels, and may contain similar functions. (See Chapter 5: 
Using Design Panels in Page View.) However, there are some styles and 
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attributes which are applicable only to text. The remainder of this chapter 
will cover text-specific styles. Other styles which can be applied to text and 
other types of elements, such as clips and graphic objects, will be covered 
in Chapter 9: Applying Object Styles. 
 
7.3.1 Font 
 
All text has a specific typeface, size and style. Together, these 
characteristics define the font. 
 
A typeface is a set of characters, which include the letters of the alphabet, 
as well as other symbols, which contain the same basic design. The form of 
the curves in the characters is one difference which will immediately 
distinguish it from characters in other typefaces. 
 
“Size” refers to the height of the characters in a typeface, including the 
amount of space separating each line of text. In printing, this size is 
measured in points, the smallest unit of measure in typography. In 
Designer, size is measured in pixels, the smallest unit of a screen picture. 
 
The Font button indicates the name and size of the typeface. To change the 
font: 
 

1. In the Design Text panel, click on Font: You will see the Select 
Font panel: 
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The current typeface and size are selected in the scrolling 
lists. The Typeface list reveals the names of TrueType scalable 
font. 

 
You can filter the list to display the available typefaces 
according to “theme”, or language family. For example, 
themes may include Western (for western European 
languages), Hebrew, Greek, Cyrillic, Turkish, to name a few. 
The Theme: selector is located above the font list. If you 
choose Theme: All, the dialog will display every available 
typeface. It will also list the theme in parentheses. The default 
Theme is Western. 

 
3. Scroll through the list of typefaces and click on one. Type a 

letter to select the first name in the list beginning with that 
letter. In the font sample box you will see text displayed in 
the typeface you selected. It is displayed in the first size 
available in the font size list box. If you want to see particular 
characters, simply click on the sample text and type in your 
desired text. 

 
4. Choose a size. There are two ways to choose a size: the Size 

scrolling list and a value control. For TrueType fonts, the sizes 
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in the list represent a selection of corresponding sizes. You 
can choose one, or use the value control to specify a size 
which is not in the list.  

 
The characters in the sample box reflect the typeface and size which 
has been selected. 
 

5. After choosing your desired font, click on OK to apply the 
typeface and size settings. This will close the Select Font 
panel and return you to the Design Text panel. 

 
If you applied the changes to selected text, you will immediately see the 
effects and the Font button will reflect the new typeface and size. 
Otherwise, the typeface and size will be displayed on the Font button, 
affecting any additional text. In either case, the text will retain the styles it 
had before you clicked on the Font button. You may also change styles 
independently, according to the procedures described in the following 
sections. 
 
7.3.2 Restrictions on embedding TrueType fonts 
 
Some TrueType fonts are restricted by their creators from being 
embedded in a document. Although you can use a font in a script, if you 
want to publish or distribute the script, the font cannot be included. In 
order for such a script to play correctly on another machine, that machine 
must also have that particular font installed. 
 
The Select Font dialog provides an alert whenever you select a TrueType 
font with embedding restrictions. The Not Embeddable button will 
appear in the space beneath the Sample box when a restricted font is 
selected in the Typeface list. You can click this button for a dialog containing 
an explanation of the font’s licensing status. 
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7.3.3 Character Spacing & Kerning 
 
Each character in a font has its own natural width. For example, the 
character “w” uses more space than the character “i”. In addition to its 
natural width, extra space is added to the right of a character to ensure it is 
visually separated from the following character. The width of a character 
includes its natural width and the space between each character; it is part 
of the design and definition of the font to which it belongs, (the  
typeface, size and style of the text). This is known as character spacing. 
 

 
 
Designer provides a Character Spacing attribute, allows an increase or 
decrease in the overall amount of space between each character to 
expand or contract a word or phrase. This will not affect the automatic 
kerning features of Designer. 
 
7.3.4 Automatic Kerning 
 
Because of their shapes, some pairs of characters may appear to have too 
much space between them.  
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In addition to the AWA combination in this example, there are many other 
character combinations with similar visual problems, including P., To, Tr, Wa, 
We, we, Wo, Ya, Yo, and yo. 
 
Designer will automatically apply kerning or will adjust the space between 
character combinations which require special spacing. In essence, kerning 
overrides the normal character width in problem character pairs. With 
kerning applied, the example above will look like this: 
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Designer has three kerning options: Normal, Normal and Digits, and Off. 
With Normal kerning, kerned relationships between special character 
pairs will be maintained even when overall character spacing is adjusted. 
 
Normal kerning will not kern digits. For example, the number one (1) and 
the number zero (0) will take up the same amount of space on your page 
(assuming they are the same font). Having un-kerned digits is useful when 
creating tables, which allows columns of numbers to properly align.  
 
When you apply Normal and Digits, kerning is applied to numbers as well 
as letters. You would use this setting with any text which contains numbers, 
but does not have columns of figures.  
 
If, for any reason, kerning produces an undesirable effect, you can turn 
kerning Off. 
 
To change the automatic kern setting, or to manually adjust the overall 
character spacing, click the Alignment tab in the Design Text panel to 
reveal Character Spacing and Kerning settings, as shown in the figure on the 
previous page. 
 
You can also change one or both settings at any time. However, if you 
change both settings, it is preferable to change the kerning setting first. This 
will reveal your spacing adjustments, allowing you to adjust the character 
spacing accordingly. 
 
To change the kerning setting, select your text, then choose Kerning: 
Normal, Kerning: Normal and Digits or Kerning: Off. Normal and Digits is the 
default setting. 
 
To change the overall space between characters, select your text then 
choose Character Spacing. Initially, the setting is zero (0) because extra 
space is not added or subtracted from the normal character width. 
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Use the value control to increase or decrease space. Note: If the value is 
set too low, the characters may run together and cannot be read. If the 
value is set too high, the characters may be pushed off the edge of the 
page. 
 
7.3.5 Line Spacing (Leading) 
 
Pressing Enter to create a new line, or divide an existing text element will 
move your cursor or text down one line on the page. Typing more text in a 
text element that will fit within the word wrap width or pressing Shift-Enter, 
will also cause the cursor to move down but the lines will be kept together 
in the same element. Designer will set the spacing between new lines based 
on the size of the font. You can use the Line Spacing option in the 
Alignment tab of the Design Text panel to adjust spacing. Designer will add 
or subtract pixels between the lines accordingly. 
 
The default line spacing is zero (0). Use the value control to increase or 
decrease space. Negative values will bring the lines closer together, 
positive values will move them further apart. Large negative values can 
make new lines appear above the original line, rather than below. 
 
The Line Spacing attribute directly affects line spacing in multi-line text 
elements. It has no immediate effect on single lines. If, however, you adjust 
Line Spacing for a single line and then press Enter the position of the new 
line will reflect the spacing setting. 
 
7.3.6 Color 
 
Many style buttons in the Design Text panel allow you to specify color.  You 
can control the color of everything from text, to the color of the underline, 
or a shadow which is cast by a character. 
 
The default User palette includes a selection of colors which will stand out 
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against the background, allowing text to be easily read. These colors are 
usually displayed in the first color set and include white, black, a range 
of gray scales, and some bright, contrasting colors. 
 
A default color is automatically used when you apply a style, unless you first 
choose a different color. For example, the text Front (or text face) is white; 
an underline has the same color as the text; and a shadow is black. 
 
To change the color of a style: 
 
• Use the Color Set Switcher to move through the color sets and 

examine the available colors in the palette. 
 

• Drag the color from the color bar to the style button (a color 
square will follow the pointer). 

 

 
 
When a style is applied, the button will appear to be pressed and its label 
will be highlighted—the color will affect either the selected text, or the next 
text you type. Otherwise, the color will be used the next time you click on 
the style button.  
 
You can also drag a color directly from one style color chip to another. This 
is helpful if you need to match colors of different styles. Designer can 
customize colors for styles. You can modify the default colors in the color 
bar, as well as add additional colors. To adjust the colors, use the Design  
Palette panel, which is discussed in further detail in Chapter 13:  
Adjusting Colors 
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7.3.7 Bold 
 
Making text bold will add weight to the characters: bold text. In addition to 
applying the basic style, you can control the amount of weight which is 
added. 
 

 
 
When you apply the B (Bold) style, Designer will increase the weight of the 
characters. To change the bold weight, simply click the Style tab. Use the 
Bold Weight value control to decrease or increase the bold weight. 
 
The minimum setting is one (1), which means the text is only one step 
heavier than normal. The text becomes heavier as you increase the 
setting. 
 
7.3.8 Italic 
 
When an italic style is applied to text, the characters will slant away from 
their normal upright position: italic text. Designer can control the slanting 
of italic characters. In fact, you can actually change the direction of the slant 
and cause characters to lean toward the left rather than the right. 
 
I (Italic) style will slant the selected characters. To change the angle of the 
slant, simply click the Style tab. Use the Italic Slant value control to 
increase or decrease the angle of a character. 
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Text will not visibly slant the characters when the minimum positive 
setting, one (1) is applied. Settings of two (2) or higher are usually 
necessary before the slant is revealed. Text will slant more to the right as 
the setting increases. Note: Characters can be difficult to read at higher 
settings. If you use a negative setting, the text will slant toward the left. 
 
7.3.9 Underline 
 
Text with an Underline style, will appear with a line underneath the text: 
underlined text. 
 
Initially, an underline has the same color as the highlighted text. Although 
the thickness and position of the text have default values, Designer allows 
individual control over these characteristics. You can also control the 
amount of space or “air” between the underline and text. You can turn on 
underlining with either the multistyle button in the Design Text panel or 
the U button. To change the color of the underline, simply use the 
multistyle button. When the Underline? option is visible, drag the color 
you want to apply from the color bar to the multistyle button. 
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Other attributes of an underline can be adjusted under the Style tab. The 
Underline Position option enables you to raise or lower the underline in 
relationship to the text. When the setting is zero (0) the line is flush with 
the baseline of the text. As you increase the underline position setting, the 
line will move down in pixels. As you decrease the setting, the line will move 
up. Negative settings can make the underline run behind the body of the 
characters. For many fonts, the lowest setting may place the underline 
completely above the text.  
 

 
 
The default underline position is a few pixels below the baseline of the text. 
 
The option Underline Thickness in the Style panel adjusts the thickness of 
the underline, in pixels, with a minimum setting of one (1). Generally, an 
underline will become too thick to be useful long before you reach the 
largest setting. 
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The option Underline Air in the Style panel adds space around text 
characters where the underline crosses, so that the characters remain 
distinct. 
 
For example, when the setting is zero (0), the lower part of the characters 
will touch the underline. Increasing the setting will make the text more 
readable. This may be preferable if the underline is thick and close to the 
baseline, or if you want to create a different colored underline as a base 
graphic accent. 
 

 
 
The amount of air is measured in pixels. The default air setting is one (1). 
Regardless of the font, the maximum setting is three (3). 
 
7.3.10 Laying out text on the page 
 
In order to give you the greatest possible freedom to compose and arrange 
elements on a screen page, an element—a line of text or a clip —can be 
placed anywhere. You can point and click anywhere on the screen page and 
establish the position for the cursor and the left margin of a new line of 
text. Additionally, you can quickly and easily move an existing text element 
by dragging it to a different position. The position of the first character in 
this line, will determine the left margin of any lines which may be created 
when you press Enter, or any lines of a multi-line text element. 
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Although this flexibility is one of Designer’s most useful features, there 
may be occasions when you need to impose more structure. When this is 
necessary, you can align the text in various ways, specify per-element 
margin settings to create multi-line text “columns”, and define tab stops. 
 
7.3.11 Tab stops 
 
Tab stops arrange text (and other elements) in columns and, when 
necessary, ensure the same amount of space is consistently used between 
them. 
 
Tab stops in Designer function similar to a typewriter or word processor. 
Rather than creating a series of blank spaces by repeatedly pressing the 
spacebar, you can set tab stops to automatically line up your text. Tab stops 
will be applied to the entire page, unlike word wrap settings, which can  
be different for each element. In Designer, pressing Tab will insert an 
invisible tab character, which will move the cursor and any text to its right, 
to the next tab stop. You can set the positions of tab stops in the tab/margin 
bar in the Text tab. 
 

 
 
Designer predefines and positions a series of tab stops (represented by 
white triangles) at intervals along the tab/margin bar. With each press of 
the cursor (and any text to its right) will move to the right, to the nearest 
tab stop, then to the next, and so forth. 
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When text elements containing tab characters are repositioned, the spaces 
in the element created by the tabs will change as the element’s relation to 
the fixed stops changes. After moving you may need to modify the tab 
stops, or the number of tab characters in the text, to keep it aligned. 
 
You can press at any time to insert a tab character in the element.  
 
7.3.12 Adjusting tab stops 
 

 
 
To adjust tab settings, drag the tab stop to a new position on the 
tab/margin bar in the Text tab.  
 

 
 
After adjusting the tab stops, select the text that you want to apply the 
changes to and they will automatically update. You cannot add or remove 
tab stops. If necessary, you can move any unneeded stops to the left or 
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right end of the bar. By doing so, it will ensure they will not have an effect 
when you move text (or another element) which includes a tab character. 
 
7.3.13 Margins and word wrap settings 
 
Every text element in Designer contains independent left and right margins. 
The margin positions are shown by the two black triangle markers on the 
tab/margin bar in the Text tab. As you click on text elements in different 
parts of the page, the positions of these markers will change. 
 
The left margin of a text element is determined by the position of the first 
character of the element. The right margin assumes a default setting near 
the right edge of the page; it determines the point at which the text wraps 
to the next line. The difference between the two settings is the word wrap 
width. The margin settings will follow the text element as it is moved 
around the page, maintaining the same word wrap width. 
 
To adjust a margin, point to the margin marker and drag it to your desired 
position. As you move the arrow, you will see a vertical line on the screen 
page. The line will follow the movement to help you visualize the position of 
the margin on the page. When you release the mouse button, the line will 
disappear. You will see the text in the element wrap to additional lines if 
necessary to fit within the margins. 
 
NOTE: If you move a text element so a margin appears off the screen, the 
margin markers will change from the solid to hollow and will be placed at 
the edge of the tab/margin bar. Click on the hollow marker to set the 
margin to the page edge. 
 
By dragging elements and adjusting the margin positions, you can create 
text columns of any width anywhere on the page. To precisely control the 
column width, you can use the Word Wrap Width attribute on the 
Alignment panel of the Text tab. 
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7.3.14 Word Wrap 
 
Word wrapping is controlled by the Word Wrap? option on the Alignment 
panel of the Text tab. 
 
If you do not want an element to wrap, regardless of its width, simply turn 
Word Wrap? off. This will allow a long text element to extend off the 
screen, as one long line. This is required with the “Crawl” transition, to 
create a scrolling banner across the screen, similar to a TV news bulletin. It 
also may be necessary if a wrapped line would disrupt the page layout, for 
example, if the line contained an embedded variable whose value was 
unexpectedly long. With word wrap off, you can still wrap lines manually by 
inserting linefeeds with Shift-Enter. 
 
Generally, you can leave Word Wrap? on. Doing so will ensure the line will 
wrap whenever it becomes longer than the word wrap margin. A specific 
example would be if the displayed value of an embedded variable (for 
example, ”Scala: Multimedia the easy way.”) turns out to be much longer 
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than the embedded variable reference itself (for example, !slogan).  
See Chapter 15: Branching, Variables and Scheduling for more information 
on embedded variables. 
 
7.3.15 Page Margins 
 

 
 
Designer predefines left and right page margins which are slightly indented 
from the edges of the screen with the Page Margins attribute, located on 
the Misc panel of the Design Text panel. Its settings are used to determine 
the position of the text when an alignment option is applied. However, 
they also provide the default position of the left and right margins for new 
elements. This will be discussed further in the following section. 
 
7.3.16 Horizontal Text Alignment 
 
The Design Text panel includes four alignment options: Left, Center and 
Right.  
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To apply one of an alignment option, simply click on the corresponding 
button. (The button will appear pushed in and highlighted when the option 
is applied.) Click again to undo. You can apply only one alignment option at 
a time to an element. All three options are normally left off allowing 
complete positioning freedom. 
 
If the cursor is positioned in a text element, or if several elements are 
selected, the text is immediately aligned. Otherwise, the cursor will move 
horizontally to the appropriate position on the page and any new text will 
automatically be aligned when you begin typing. The position of the text is 
determined by the Page Margins settings specified in the Misc panel of 
the Text tab. (Alignment can also be applied to a clip—see Chapter 8: 
Working with Clips and Draw Objects.) 
 
When you try to move text which is affected by an alignment setting, the 
movement will be restricted to only vertical movement. For example, if 
center alignment is applied, you can move the text up or down in the 
middle of the page, but you cannot move it toward the left or right edge.  
 
NOTE: If you create a new element and it is locked in one of the alignment 
settings, this is because new elements inherit the settings of the previously 
selected element. You can turn off the alignment setting after creating it, 
or select a different element with more preferable settings before adding a 
new one. 
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You can also use the Horizontal Text Alignment selector in the Alignment tab 
of the Design Text panel applied to the selected text element. 
 
7.3.17 Multi-line Text Settings 
 
Multi-line text elements can have their text aligned independently from the 
alignment applied to other text elements on the page. For example, a multi-
line text element can have text which is right-aligned, while the text   
element is aligned along the left page margin. 
 
Settings for multi-line text alignment are made in the Alignment panel of 
the Text tab with the Horizontal Text Alignment selector. Simply use the 
selector to choose from the following four options: Auto, Left, Center, and 
Right. The default setting is Auto. 
 
To affect multi-line text, use the settings on the Horizontal Text Alignment 
selector in the Alignment panel, together with the alignment options in the 
Text panel, as follows:  
 
Auto: The alignment of a multi-line text element within its frame will match 
the left, center or right alignment of the element within the page margins, 
as selected in the Design Text panel. For example, if the element is centered 
between the margins, the text within the element will also be centered 
within its frame. If you do not select any of the three alignment options in 
the Text tab, the text in a multi-line text element will be left-aligned. 
 
Left: Multi-line text is left-aligned within its frame, independent of the 
alignment buttons in the Text tab. 
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Center: Multi-line text is centered within its frame, independent of the 
alignment buttons in the Text tab. 
 
Right: Multi-line text is right-aligned within its frame, independent of the 
alignment buttons in the Text tab. 

7.4 Update Text 
 
The Update selector in the Misc panel of the Design panel allows 
individual control of embedded variables displayed on the screen. As 
described in the “Displaying variables” section at the end of Chapter 6: 
Working with Text, Designer can embed variables in text elements. The 
variable display will update automatically as variable values change. 
However, updating can be affected by subsequent events. The Update 
option allows you to choose your desired update behavior. 
 

 
 
When Update is set to None for an embedded variable, the value will not 
update. When Update is set to Normal, the variable will update as its 
value changes, however, updating will only continue to the end of the 
current page. This applies whether or not the next page is a special event. 
Note: This will prevent a variable from prematurely updating before the 
next page appears. For example, if a page containing an embedded 
variable is followed by a special event page which plays a sound, the 
variable updating will stop when the sound page begins. 
 
To make it possible for variable updating to continue through the extent of 
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a complete screen page, regardless of intervening special event pages such 
as a music selection, Update provides the Extended setting. When an 
element with an embedded variable is set to Extended, it will continue to 
update its value until the beginning of the next page. 

7.5 Advanced Features 
 
7.5.1 Export Text to Clip Image 
 
You can export text created in Designer as a rasterized image or Clip. The 
image file will be saved as a PNG file which will retain any text Styles which 
were applied in your Page view design session. The PNG file type will also 
retain any transparency information around the text. 
 

 
 
Select the text in your page and from the File pull-down menu, choose  
Edit > Selection as Clip. This will bring up the save dialog, select the 
location from the Save as type: selector. Determine a name and location, 
and click Save. A dialog will pop-up and you will be prompted to replace 
the existing selected text in your page with the saved Clip file. This will 
ensure any fonts which cannot be embedded into your script, will be 
saved as a graphic image.  
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7.5.2 Copy and Paste Format 
 
To apply a format and style of a line of text to another text element, simply 
use the Copy and the Paste Format option. 
 
Select the text with the style format which you wish to copy and select 
Copy from the Edit pull-down menu or from the Page view toolbar. Next, 
select the text element from which you want to apply the copied style 
formatting, and choose Paste Format from the Edit pull-down menu. This 
will apply only the style formatting to the selected text. It will not overwrite 
the text itself. You can also use this option on subsequent pages in your 
script.  
 
7.5.3 Text Engine 
 
Lets you choose which engine will be used to draw text. The Standard text 
engine supports a full range of text effects and styles. The Complex Writing 
Systems engine supports Arabic, Thai , Hebrew, Hindi, and other complex 
writing systems, but does not support certain text styles. 
 
Automatic - Uses the Standard text engine when possible, but uses the 
Complex Writing Systems engine when the text element requires its 
features. 
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Complex Writing Systems - Always uses the Complex Writing Systems text 
engine.
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||||| 8 Working with Clips  
  and Draw Objects 
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Chapter Overview 
 
Graphics can add style and meaning to multimedia production, and Scala 
Designer includes a diverse collection of high-quality clip-art graphics 
which will serve as a catalyst for your next production. These images can be 
used to illustrate a point, enhance a page and augment your creativity as 
you design your scripts. 
 
Designer can import and separately position virtually any image which is 
available as a graphic file, even animations. In Designer, any graphic image 
which is placed on a page is referred to as a clip—or, in the case of  
animations, an animclip, movieclip or Flashclip. A clip is an independent 
element which can be moved, resized, and styled on top of the current page 
background. 
 
In addition to the hundreds of clips which come with Designer, any file 
created using the techniques described in Chapter 5: Working with 
Backgrounds, can be used as a graphic element on a page. For example: 
image files from a scanner, paint or drawing programs, and animations 
in supported formats such as AVI, MPEG, AnimGif, and the SWF (Abobe® 
Flash™) multimedia format. Even streaming media such as Flash or Video 
animations and movies can be used as backgrounds, as long as the Player 
has online access to the hosted media. 
 

8.1 Glossary of Terms in this Chapter 
 

Clip – A predefined graphic image, such as a picture, drawing, 
symbol, etc., which can be imported and positioned on an 
Designer Page. 
 
Animclip – An animated clip in the GIF or SWF formats which have 
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been loaded as a clip in a Designer page. Similar to other clips, 
Animclips can moved, scaled, as well as have their speed and 
other parameters modified. 
 
Movieclip – A digital video imported into a Designer Page, in MPG, 
AVI and WMV formats. Similar to Animclips, Movieclips can be 
modified in scale and placement. They may also include audio 
channels. 

8.2 Adding a Clip 
 
Use the Design Clip panel when working with clips in the Page  
view.  
 

 
 
The Design Clip panel features style tabs which contain numerous options 
when working with clips. This chapter will address basic options, and only 
those applying to clips. Additional options which can be applied to 
Movieclips, text, and drawings will be discussed in Chapter 9: Applying 
Object Styles. 
 
There are several ways you can access the panel:  

 
• In the toolbar, click on the Add icon, which reveals the File dialog. 

When you select a graphic from any folder, the clip will be 
imported and the Design Clip panel at the bottom of the Page view 
window will appear. 

• Use the Add pull-down menu and select the Add File(s) option to 
select a clip.  



Designer5 
 

 
261 

 

 
• In the Page view, select a clip on the page. 

 
If the panel appears as a result of selecting a clip, then it will change to 
reflect the type of clip (static or animation), and the Clip: button will 
indicate the name of the file. (Note: This is not necessarily the name 
assigned by you or by Designer in the Design List panel.) The Clip: button 
displays the name of the clip, animclip, movieclip, or Flashclip file. If a clip 
was added by pasting, the Clip: the button will read <embedded>, 
indicating there is no underlying file. 
 
Regardless of the status of the Clip: button or the number of clips on a 
page, when you click on Clip: you will see the File dialog. You can navigate 
in the dialog and choose a graphic file to add as a clip. The clip will be 
added to the page as a new element. If a clip was already selected and 
you entered the File dialog from the Clip: button, the new clip will replace 
the previous clip. 
 
Designer handles a new clip the same way it handles an element which 
has been pasted from the clipboard: 
 

• If you click on the page to position the text cursor in an 
unoccupied area before you add a clip, the clip will be positioned 
at the cursor. 
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• If you do not make a selection, and the text cursor is not visible, 

Designer will remember the previous location of the cursor, and 
will position the clip accordingly. 
 

• If part or all of one or more elements is selected, or if the text 
cursor is in a line of text, the clip will be positioned downward and 
slightly to the right of the top left corner of the element(s). 

 
When the clip is displayed on the page, you will see a dashed frame with 
eight graphic handles positioned around the edge. The handles are an 
indication that a clip has been selected. You can continue to work with the 
clip, or click anywhere on the page outside of the clip image to deselect it. If 
the clip is too large (for example, if you have imported a background as a 
clip), you can use the single-key hotkey H to make the clip half its normal 
width and height. The reverse of this operation is the D hotkey, which will 
double the size. 
 
NOTE: Several single-key hotkeys which are specific to clips are also 
available. You can quickly perform common operations on a clip from 
most Design panels and pull-down menus. Refer to Appendix A: Keyboard 
and Mouse Shortcuts for specific hotkeys. 
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Designer may hide the Design Clip panel at first to ensure that the lower 
portion of the clip is visible. If the panel is hidden, click the secondary (right) 
mouse button and select the Show Design Panel context menu to see it 
again. 
 
You can work with a clip by clicking on it. If the clip has transparent areas, 
you will need to click on a non-transparent part in order to select the clip. 
Following are a few options in regard to selected clips: 
 

• To move the clip, point to a non-transparent part anywhere inside 
the dashed frame and drag the clip to the new position. To 
constrain the clip to horizontal or vertical movement, simply hold 
down Shift while dragging.  

 
• To change the size, point to a graphic handle on the side or corner 

of the clip and drag the handle to a new position. 
 
Dragging a handle at a corner will allow you to simultaneously adjust 
the width and the height. Dragging a handle on a side will allow you to 
adjust only that side. To maintain the original proportions of the image, 
Shift-drag a corner handle. 
 
NOTE: You can cancel a dragging operation by pressing the secondary 
(Right) mouse button while holding down the main (Left) mouse 
button. 
 
• To crop away parts of the clip, point to a graphic handle on the side 

or corner of the clip, then Alt- drag the handle until the edge or 
edges enclose only the portion of the clip you want to keep. 

 
Alt-dragging a corner will allow you to simultaneously crop the width and 
height of a clip. Alt-dragging a handle on a side will only crop that side. 
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8.2.1 Selecting clips and other elements 
 
When you click on a clip, you will see graphic handles placed around its 
edges.  
 
Remember you have to click on a non-transparent part of a clip which has 
the Chroma Key? option on in order to select it. If several clips overlap, 
you can click through the transparent part of one to select another 
underneath. 
 
You can also select several clips at one time, or a combination of clips and 
text elements by Ctrl-clicking on them. 
 
You can also drag-select clips. When the dotted frame encloses all or part 
of each element, release the mouse button. Each element will be selected: 
each text element will be enclosed in its own frame, and each clip will have 
graphic handles. Unlike text, you cannot select part of a clip. 
 
Regardless of your selection method, the Design panel will appear for the 
last type of element you have selected. If it is a clip, you will see the Clip 
panel; if it is text, you will see the Design Text panel, if it is an oval, you will 
see the Design Ovalpanel, and so on. 
 
8.2.2 Working with several selected elements 
 
You can work with the selected elements as a unit. For example, you can 
point to one of the elements and drag it to a new position. All of the 
elements in the group will move together, maintaining their original 
positions relative to one another. You can also apply styles collectively. 
Whatever styles you apply or edit will affect all of the selected elements. If 
you have selected different types of elements at the same time—for 
example, both text and clips—you the Design Multiple Elements panel will 
appear. This panel will reveal only those options, such as Shadow and Bevel, 
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which can be applied to every selected element type. Elements will remain 
selected even if you change from one Design panel to another. To cancel 
the selection, simply click anywhere on the page which is outside the area 
of the selected elements. 
 
8.2.3 Adjusting Settings for Animclips and Movieclips 
 
Animclips and movieclips are not fundamentally different from full-screen 
animations which you might use as page backgrounds aside from the way 
you would change their size. In Chapter 15: Using Animation, Digital 
Video &Sound, you will find additional general information about 
animations and animation options.  
 
Almost all options which can be applied to a plain clip may also be applied 
to an animclip or movieclip: they can also be sized, rotated, cropped, 
have a beveled edge, shadow, or outline, etc. The Focus? option does not 
affect animclips or movieclips. 
 

 
 
When an animclip (an animation loaded as a clip) or a movieclip (a digital 
video segment loaded as a clip) is selected, the panel changes to a Design 
Animclip or Design Movieclip. Each will add a Video tab, which contains 
settings which are animation specific. 
 
Settings which apply only to animations are described below. 
 
8.2.4 Options common to animclips and movieclips 
 
The following options apply to both animclips and movieclips. 
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Wait? 
 
You can initiate other events while an animation plays, or you can suspend 
other events until an animation has completed. When the Wait? option is 
off, subsequent script events can begin while the animation is playing. 
With Wait? on, the animclip or movieclip must finish playing (including the 
set number of loops, if any) before the next event in the script can begin. 
You can see the duration of the clip in the End Time button. 
 
Loops 
 
Loops specify the number of times an animation repeats before the next 
event in the script is displayed, or the animation stops.  
 
You can specify a number between one (1) and nine thousand nine hundred 
and ninety-nine (9999), or “infinite repeat” setting. This last setting will 
repeat indefinitely, which is useful when you don’t know when the 
animation should stop. The default for animclips is infinite repeat, as 
these animations are frequently designed to loop. Movieclips, however, 
default to a Loops value of 1, because they are usually made to be played 
just once. For more detail on this option, please see the Repeating the 
animation section in Chapter 11: Timing. 
 
NOTE: When Loops are infinite, the Wait option is applied as follows: if 
Wait? is on, the animation will continue until the page advances. If Wait? 
is off, the page will advance when all remaining elements on the page 
have completed, or the duration of the page is set to a defined time. 
 
8.2.5 Options for animclips only 
 
Because an animation takes time to play, certain special options are 
required. 
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Speed 
 
The Speed value control governs the speed of the animclip in frames per 
second. For more information on animation speed, please see the 
section on the Frames per Second option in the Background panel in 
Chapter 11: Timing. 
 
Stop on First? 
 
The Stop on First? option allows you to control whether the frame which is 
revealed when an animclip has completed, will be the first frame, or the 
last. In some cases, one of the clips will simply look better than the other. 
Turn this option on to leave the first frame visible. For more detail on this 
option, please see the Chapter 10: Timing for more information. 
 
8.2.6 Options for movieclips only 
 
Most movieclip options will match animclips, however, some are unique. 
 
Playing a specific part of a movieclip 
 
The Start Time in HH:MM:SS.hh? and End Time in HH:MM:SS.hh? controls 
allow you to play a subsection of a complete movieclip.  
 
The default will play the entire movieclip. To exclude some part of the 
beginning and/or end of the movieclip, turn on the Start Time and/or End 
Time buttons in the Video tab. This will activate their associated value 
controls, which allow you to specify an offset time from the beginning or 
end of the movieclip. 
 
To have the movieclip start playing at some point after the beginning, use 
the Start Time control to set the delay time (in hours, minutes, seconds, and 
hundredths). To have the movieclip stop playing at some point before the 
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end, use the End Time control to set the length of time from the beginning 
to the desired stop point. 
 
Movieclips also have the Wait? and Loops options, which function the 
same as described in the preceding section. However, the frame rate and 
stopping frame in a movieclip are fixed, so the Speed and Stop on First? 
options are not available. 
 
Volume 
 
Because a movieclip can have sound, Designer will allow you to control the 
sound level. When a movieclip is selected, use the Video tab’s Volume slider 
to preset the volume. 
 
8.2.7 Options for Flashclips only 
 
Quality: controls the visual quality setting of the Flash display engine. (The 
default value is High, which is better than in earlier releases.)  
 
Interactive: Select to allow this Flash to receive keyboard/mouse input.  
 
Mode: Controls the "Window Mode" property of the Flash clip. Opaque 
mode hides everything underneath the Flash clip. Transparent mode allows 
elements underneath to show through any transparent portions of the 
Flash clip, including any alpha-channel transparency. This may slow 
animation performance.  
 
Flash Variables: Lets you specify text that will passed to the Flash file 
through the FlashVars method. Useful for certain advanced Flash files that 
can take parameters. 
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8.3 Cropping a Clip 
 
You can use the aforementioned graphic handles to crop a clip, or simply by 
turning on the Crop? button, you can use the Crop Position and Crop Size 
buttons in the Misc tab. 
 

 
 
Before you crop or trim a clip, please note that the Width and Height 
settings on the Crop Size button will reflect the dimensions of the original 
clip. If you adjust the size of the clip the crop settings will not change You 
will notice that they can become quite different from the current size of the 
clip specified on the Element Size control. 
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When you use the graphic handles to crop a clip (press and hold Alt as you 
drag a handle) the settings on the Crop buttons will change accordingly, as 
demonstrated in the following illustration: 
 
Left – Represents the number of pixels you can trim from the left edge of 
the original image. 
 
Top – Represents the number of pixels you can trim from the top edge of 
the original image. 
 
Width – Represents the number of pixels in the width of a newly cropped 
image. Width is measured from the left edge of the clip as determined by 
the Left setting. 
 
Height – Represents the number of pixels in the height of the cropped 
image. It is measured from the top edge of the clip as determined by the 
Top setting. 



Designer5 
 

 
271 

 

Using the graphic handles to crop a clip will also change the size of the clip. 
The Element Size dimensions will also updated. When you have finished 
cropping an image (and released the Alt key) you can use the handles to 
adjust the size or change the settings on the Element Size control. 
 

 
 
8.3.1 Cropping without changing the size 
 
If you want to trim the image, but do not want to change its size, make sure 
the Size? button is on; you may then change the settings on the Crop 
buttons instead of using the handles. The Element Size dimensions will 
not be affected. Designer will automatically enlarge or reduce the cropped 
image so the width and height will be the same as specified by the 
Element Size dimensions. 
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To change a Crop setting, use the corresponding value control. The screen 
will immediately update allowing you to see the results of one adjustment 
before you make another. You can change the Crop settings in any 
combination. 
 
Cropping an image by changing the settings on the Crop buttons is very 
accurate, however, using the graphic handles is generally faster. You may 
also apply a combination of the two techniques, which is often useful. 
 
8.3.2 Cropping, sizing, and the original image 
 
Cropping and sizing, does not affect the original image file unless you 
export the edited clip using the original file name. To recover the original 
image, load the clip or turn off the Crop? and Size? buttons. The maximum 
crop width and height settings will be the original dimensions; when an 
image is not cropped, the Crop Position settings will be 0. 
 
For additional examples of cropping and a more detailed description of 
the settings on the Crop buttons, please see Chapter 4: Working with 
backgrounds. The crop function is essentially the same for both clips and 
backgrounds, with the exception that backgrounds cannot be cropped using 
a graphic handle. 
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8.4 Clip Transparency & Keying 
 
A style which is available only for clips, Chroma Key?, is located on the 
multistyle button in the Clip panel. When Chroma Key? is on, certain areas 
of the clip will not be visible, allowing the page background or other 
elements to show through. When Chroma Key? is off, you will see all of the 
colors in the clip. Regardless of the design of its image, a clip is always 
rectangular. When selected, it will be bounded by a rectangular frame with  
graphic handles. However, in many clips, such as the one shown below, 
the background area between the frame and the image can be made 
transparent. Additionally, areas surrounded by opaque colors can also be 
transparent. 
 
Transparency will allow clips to fit cleanly into any background, appearing 
as any shape. Transparent areas will also allow you to click through them in 
order to select any underlying clips. This is very effective when there are 
several clips which overlap. Some clips have a pre-set alpha channel, such 
as PNG or GIF images. For clip formats that do not support alpha channel, 
the transparent area can be associated with a selected color. 
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Any particular color in the clip’s palette which has been defined as 
transparent, will determine which areas of the clip will disappear when 
Chroma Key? is turned on. You can see this color by turning the Chroma 
Key? option off. You can also specify which color in a clip is transparent 
using the Transparency tab in the Clip panel. 
 
8.4.1 Selecting a transparent color 
 
You may want to make a clip background transparent so the content will 
integrate into a page without a rectangular background. You may also want 
to make other areas of a clip transparent, for special effects. Regardless 
of your reason, you may need to change a transparent area.   
 
Designer will allow you to turn transparency on and off with the multistyle 
button on the Clip panel, and, for most clips, pick the transparent color(s) 
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on the panel’s Transparency tab. 
 
The Transparency tab features a set of sliders and associated value displays 
which reveal the chosen transparency or “chroma key” color. The color 
block will display the clip color which you has been chosen to be 
transparent. The Transparency Range control will allow you to specify a 
color “tolerance”, so similar colors may also become transparent. The 
Chroma Key Feathering control allows you to adjust smoothness of the 
transition between transparent and non-transparent areas. 
 
To designate a color to become transparent, simply click Pick, then with 
the Pick pointer click on your desired color in the clip. The large color block 
will display your chosen color. If the Chroma Key? button in the Clip panel is 
on, your chosen color will become transparent in the clip. 
 
If your color selection was incorrect, you can choose Pick again. Or, for 
greater precision, you can refine your color selection by using the three 
color sliders. The slider values are reflected by the color in the color block 
and are numerically displayed in the RGB/HSV display box. If the Chroma 
Key? option is on, you can immediately see how your changes will affect 
the clip as you adjust their values. Similar to the Design Palette panel, you 
can switch between the RGB and HSV color models by clicking in the 
RGB/HSV display box. (See Chapter 13: Adjusting Colors for more 
information on using RGB and HSV sliders to specify a color.) 
 
To make similar colors transparent—for example the blues in a sky—pick a 
conventional color, then move the Chroma Key Range slider to the right 
until the desired amount of the clip is transparent. 
 
NOTE: For clips with a preset alpha channel – such as some PNG images, 
including clips distributed with Designer – the Transparency tab will be 
disabled. 
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You may need to experiment with the range value and the exact color to 
achieve your desired effect. When the range slider is all the way to the 
left, only the exact color on the color block will be affected. 
 

 
 
Chroma Key? is on by default if, as the illustrations demonstrate, the clip 
was designed with transparent parts. Generally, in more detailed images or 
digitized photographs, every color should be displayed. If an image is not 
acceptable with transparency on, switch it off. The Chroma Key? setting 
for each clip will be saved with the script. 
 
8.4.2 Adjusting the degree of transparency 
 
The Chroma Key Feathering control will give you the option of adjusting 
the gradation of transparency between the transparent colors and non-
transparent colors. This is valuable when softening the sharp edge between 
transparent and non-transparent areas of a clip, in addition to special 
effects. 
 
By default, the Chroma Key Feathering slider is set to 0. This will make the 
transparent colors(s) entirely transparent, and the remaining colors entirely 
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opaque. As you move the slider to the right, the transition between 
transparent and opaque color(s) will be increasingly graduated, until it 
reaches the maximum value of 128. Much of the previously opaque area of 
the image will have some degree of transparency. 
 
The Chroma Key Feathering control will interact with the Chroma Key 
Range control to produce this effect. When the range control is 0, a 
single color will be defined as transparent, and varying feathering 
settings will adjust the opacity of this color.  
 

 
 
When the range value is increased, additional colors will be defined as 
transparent, however, with feathering, those which are less similar to the 
chosen transparency color, will be less transparent. This allows 
transparent and non-transparent areas to smoothly merge into one 
another. When Range is non-zero, you can use the Feathering setting to 
control the smoothness of the transition between transparent and non-
transparent areas of the clip. This can be especially helpful when high 
range values affect areas of the clip which were not intended to be 
transparent. The correct feathering setting will make those areas opaque.  
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8.4.3 Using transparency with other styles 
 
Using the Chroma Key? option, will change how other styles appear when 
applied to a clip. Without a transparency, the Outline and Shadow styles will 
follow the rectangular shape of the clip. However, when transparency is on, 
both Outline and Shadow will follow the edges of the image, where 
transparent and non-transparent areas intersect. This is a very effective 
method to make monochrome clips stand out. 
 

 

8.5 Image Processing 
 
8.5.1 Clip attributes 
 
Many attributes, such as Position and Outline Thickness, will affect clips 
the same as text elements. However, there are also several attributes 
which do not apply to text: 
 

•  Size? 
•  Chroma Key Color, Range, Feathering 
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•  Crop?, Crop Position, Crop Size 
 
These attributes are available when one clip is selected or included in the 
selection of several elements. The attributes which are common to both 
text and clips will work the same with clips as they do with text, as 
described in Chapter 7: Managing Text. 
 
8.5.2 Changing clip size 
 
The Element Size setting in the Position tab indicates the width and height 
of a clip in pixels. Initially, the size will be determined when the clip is 
created. However, you can change the clip size. Turn the Size? button on  
to enable the Element Size value control to the right. Turning Size? off will 
cause the clip to revert to its original dimensions. 
 
The settings on this button will be immediately updated when the graphic 
handles are used to adjust the size of a clip. Similarly, if you change the 
dimensions on the Element Size control, the selected clip will change size 
accordingly. 
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To change the width or height of a clip, drag its handles, or use the 
corresponding Element Size value control until you reach your desired size. 
Shift-drag a corner handle to resize while retaining the clip’s original 
proportions. 
 
There are two single-key hotkeys for clip size: H halves the size of the 
selected clip, and D doubles the size. Repeating either key will continue to 
reduce or double the current size of the clip. 
 
8.5.3 Flipping a clip horizontally or vertically 
 
The two Flip options in the Position tab allow four different options to 
control the direction of the clip.  
 
When Flip X? (Horizontal) is applied, the button will be marked with a 
check and the image will face in the opposite direction, horizontally. 
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When Flip Y? (Vertical) is applied, the button will be marked with a check 
and the image will face in the opposite direction, vertically. 
 

 
 
When both Flip options are applied, the image will appear upside down 
and backwards. 
 
The single-key hotkey for Flip Horizontal? is X. The single-key hotkey for 
Flip Vertical? is Y. 
 
You can click on Edit and choose Export to save the customized clip as a 
file, after applying one or both Flip options to generate an image you want 
to save.  
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8.6 Changing the Colors in a Clip 
 
There are two possible ways of adjusting clip colors in Designer: you can 
adjust individual colors in the clip’s palette, or you can alter the color 
values in a clip as a whole. Adjusting individual colors in a clip palette only 
possible with 256-color clips. Processing the entire palette can be  
accomplished for any clip. 
 
8.6.1 Changing colors in a 256-color clip 
 
For 256-color clips such as GIF images, Designer allows you to make 
changes in the image palette while mixing the colors using the Design 
Palette panel. High Color and True Color clips contain fixed palettes in 
which colors cannot be individually adjusted.  
 
The Palette tab allows you to individually adjust colors in a 256-color clip. 
The Clip palette in the Palette tab contains every color used to create a 
clip. As the colors in the palette are modified, the changes will be 
reflected in the clip. Ultimately this will give you the ability to change the 
entire tone or impression of the image; for example, from bright and bold 
to subtle and subdued. 
 
Changing individual colors in a clip which is a digitized image, may lead to 
unnatural-looking effects. The large number of subtly varying colors in 
digitized images will make it very difficult to make large adjustments in the 
Palette tab without interfering with the natural color balance. Simpler, non-
digitized images with relatively few colors, as shown above, can be easily  
changed. 
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8.6.2 Processing a clip palette 
 
Designer allows you to make changes in the overall color balance and 
tonal qualities of a clip. Use the image processing capabilities available in 
the Process tab of the Clip panel. 
 
Because image processing also applies in a similar way to backgrounds, 
the Process tab is discussed in detail in Chapter 13: Adjusting Colors. 
 
8.6.3 Styling a monochrome clip 
 
If a clip is monochrome (only one color), you can change its foreground 
color with the Front button. 
 
You can also turn the Front color off, making the colored areas of the clip 
transparent. 
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This is very effective with the Outline and Shadow styles. As noted in the 
preceding section on the Chroma Key? option, when a clip has Chroma 
Key? on, using Outline or Shadow will outline or shadow only the non-
transparent parts of the clip, rather than its rectangular border. It is not 
possible to turn off Front, Shadow, and Outline simultaneously to prevent a 
clip from becoming invisible. If this is attempted, the last of these three 
options will not be turned off. 

8.7 Adding Draw Objects 
 
When designing a page alongside constantly changing text, certain graphic 
elements have to change as well. Since it can be cumbersome to externally 
create elements, and move back and forth between Designer and an 
external drawing program; Designer contains built-in drawing capabilities to 
make many such external modifications unnecessary. You can add simple, 
structured graphic elements or draw objects to your pages, and edit them 
freely, without the need for outside programs. You can also add lines, 
arrows, boxes, circles, and ovals, and as with clips, easily adjust their size, 
position, color and other attributes. 
 
To create a draw object, open the Add drop-down and choose either Add 
Box, Add Oval, or Add Line, which will open the appropriate Design panel. 

8.8 Drawing an Object 
 
When you add one of the three draw object types, the mouse pointer will 
become a cross +. Click with the cross pointer to place the corners or 
endpoints for the object. You can also click other buttons on the panel, 
such as the Fill button.  
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8.8.1 Drawing boxes 
 
With Add Box you can create rectangles or perfect squares—referred to as 
“boxes” .To draw a filled box, either make sure the Fill button is on before 
you draw, or turn it on after drawing. Place the cross cursor where you 
want one corner of the box, then press the main 
  

 
 
mouse button, then move the pointer to the position of the diagonally 
opposite corner. Release the mouse button to complete the drawing. 
 
While drawing, you can hold down the Shift key to draw a perfect square, 
or the Ctrl key to draw from the center of the box. Graphic handles will 
appear around the resulting box, indicating it is selected, allowing you to 
change its shape. 
 
8.8.2 Drawing ovals 
 
With Add Oval you can create ellipses or perfect circles—referred to as 
“ovals”. 
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For a filled oval, either make sure the Fill button is on before you draw, or 
turn it on after drawing. Place the cross cursor where you want one corner 
of an imaginary box which in essence would surround the oval, press the 
main mouse button, then move the pointer to the position of the 
diagonally opposite corner. Release the mouse button to complete the 
drawing. While drawing, you can hold down the Shift key to draw a perfect 
circle, or the Ctrl key to draw from the center of the oval outward. Hold 
down both keys to draw a circle from the center. 
 
Graphic handles will appear around the resulting oval, indicating it is 
selected, allowing you to change its shape. 
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8.8.3 Lines and arrows 
 
With Add Line you can create lines or arrows.  
 

 
 
Place the cross cursor where you want to start the line, and press the main 
mouse button, then move the pointer to the end position. Release the 
mouse button and the line is drawn. 
 
If you want an arrow, after drawing a line, go to the Misc tab and turn on 
the Arrowhead at Start? or Arrowhead at End? options. The arrowhead size 
will automatically adjust according to the line weight set by Line Thickness. 
 
While drawing, you can hold down the Shift key to constrain the angle of 
the finished line to fifteen degree increments (15°, 30°, 45°, and so on). This 
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facilitates drawing perfectly horizontal, vertical, or diagonal lines. 
 
Graphic handles will appear at the two ends of the resulting line, indicating 
it is selected, allowing you to reposition the ends. 
 

8.8.4 Using different line ends 
 
The only difference between line and arrow objects is the way the lines end. 
Normal ends produce an ordinary line, and arrowhead ends produce an 
arrow. 
 
You can change the ends of lines and arrows before or after drawing 
using attributes in the Misc tab. The Arrowhead at Start? and Arrowhead 
at End? options allow you to change one or both ends of a line to 
arrowheads. When these options are off, the ends are normal. 
 
These options are only enabled when a line object or the Line button is 
selected. Whichever settings are made for the start and end of a line will 
remain active until you explicitly change the settings. 
 

 
 

8.8.5 Drawing options 
 
Most options which apply to clips also apply to draw objects: you can add In 
and Out transitions, and turn on Shadow, Outline, Smooth?, Backdrop?, or 
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Bevel?. The Left, Center, and Right alignment buttons can be used to 
constrain the position of the object on the page. 
 
The Fill, Line, and Line Thickness options are unique to draw objects. 
 
Filled objects and object color 
 
There are two color chips which control most draw objects, one on the Fill 
button and one on the Line button. You can assign colors with these color 
chips by dragging colors from the color bar.  
 
The Fill color chip specifies the color used in the body of filled boxes and 
ovals. 
 
When a box or oval is selected, you can click the Fill button to turn the fill 
color off and on. You can also turn Fill on or off whenever the Box or Oval 
buttons are selected, in order to control whether the object you are about 
to draw is filled or not. 
 
When Fill is off, the area which would be occupied by the fill color will be 
transparent. In other words, the object is basically an unfilled object. You 
cannot turn Fill off unless the selected object has Line turned on—this will 
prevent creating an invisible object. 
 
Fill is not available for lines and arrows, therefore, this button is not 
available when they are selected. However, if you want the effect of a line 
or arrow with a colored edge, you can use the Outline option. 
 
The Line color chip will specify the color of the edges of boxes and ovals, 
and the color of lines and arrows. The width of this colored area is 
controlled by Line Thickness. 
 
You cannot turn Line off unless the selected object has Fill turned on—this 
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will prevent creating an invisible object. When you turn Line off, the color 
of the Line Thickness area will change to match the Fill color. The object will 
retain the additional size created by the specified thickness.  
 
Line Thickness 
 
The Line Thickness value control specifies the thickness of the line used to 
draw edges of boxes and ovals, as well as the thickness of lines and arrows. 
For boxes and ovals, it is similar to a second, independent Outline option. 
You can control its thickness without using the Effect tab. 
 

 
 
8.8.6 Manipulating objects 
 
To alter an object’s appearance, position, or orientation, you can use the 
Fill, Line, and Line Thickness controls, as well as any available options on the 
style panels of the Draw panel. The available options are similar to those 
which are available for clips. The only clip options which are not available 
are Focus? and Chroma Key?. 
 
As you size, rotate, and change the shape of objects, their edges will not 
become excessively rough because they are structured objects, rather 
than images. In essence, they are always rendered at the same resolution 
as the page, thereby minimizing pixilation. Therefore, if objects must be 
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manipulated, especially within rotation or enlargement, using draw objects 
is preferred to using clips. Draw objects are easily edited and will not add 
excessive size to the script. The Smooth? option, is on by default. This will 
further enhance the look and feel of draw objects. 

8.9 Advanced Features 
 

8.9.1 Options available for Flashclips 
 
The options available for Flashclips match those for movieclips, with the 
exception of certain features.  
 

 
 
The following options which are available in the Design Movieclip panel are 
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not available on the Design Flashclip panel: 
 

•  Cropping 
•  Rotation, Flip controls on the Position tab 
•  Most other options on the Video tab 

 
All other options work in a similar manner with Flashclips and Movieclips. 
 
8.9.2 Exporting Clips 
 
You can save clips with your size, crop and style changes simply by 
choosing Export from the Edit drop-down. 
 
In the File dialog, choose a location and enter a name for the processed 
clip. If several clips are selected, they will be exported as one, with any 
additional transparent areas saved as black. 
  
Note: The black fill can be made transparent when the exported file is 
loaded back into Designer, by turning on Chroma Key. 
 
Subsequently, you will be prompted whether you want to use this new clip 
file in place of the original file. If you answer Yes, every style which was 
applied when you exported the file, will become a part of the image, and no 
longer editable. For example, you cannot change the shadow depth of a clip 
which was exported with the Shadow option turned on.  
 
For a detailed description of styles and how to apply them, please see 
Chapter 9: Applying Object Styles. 
 
8.9.3 Applying Clip Styles 
 
The Design Clip panel has the same basic features as other Design panels. 
You can easily move between the panel and the page as you experiment 
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with different styles.  
 
As with text, use the settings in the tabs of a Design panel to fine-tune any 
styles containing attributes. From the multistyle button choose Backdrop 
or Bevel, then, simply adjust the related attributes on the Effect tab. For 
more detailed information, please see Chapter 9: Applying Object Styles. 
 
8.9.4 Templates – Binding Clip Filename to a Data Field 
 
Right-click on a clip to select the Bind Clip Filename to Data Field element 
as a template. Binding a clip to a data field allows clips to be selected or 
replaced by other elements through Content Manger. This allows you to 
create templates with placeholder clips that can be replaced with other 
clips in your Content Manager media folder, that will adapt to the 
attributes, scale, transitions and effects that are applied to the template 
clip. 
 
NOTE: You cannot use a still image clip as a template placeholder and 
select a video clip or anim clip to replace it in Content Manager. You must 
keep the same type of clip used in your template as you will use from your 
media folder items. 
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||||| 9 Applying Object Styles 
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Chapter Overview 
 
Of the three basic types of graphical elements in Designer — text, clips, and 
draw objects— each contain specific, definable styles. For example, italic 
style, is only relevant to text. However, there are many styles in Designer 
which apply to more than one type of element. This chapter will discuss 
styles which apply to more than one type of element; primarily for clips or 
draw objects. Text styles are covered in more detail in Chapter 7: Text 
Styles and Formatting.  

9.1 Glossary of Terms in this Chapter 
 

Effect – The way an element’s style or appearance, such as  
borders, outline thickness and shadow amount and position, can 
be modified. 
 
Style– A special feature which can be applied to an element  
in order to enhance its appearance; for example, shadow,  
underline, outline, color, bold, italic, etc. 

9.2 Front (face) 
 
Front is available for text elements and clips. 
 
When Front is applied, you will see the text in the color indicated by the 
color chip. 
 
When Front is off, the text will be transparent, unless no other style such as 
Outline or Shadow is applied. If the Outline or Shadow styles are applied, 
the Front may be turned off, leaving just the border around the text – or 
just the shadows applied to the text and the rest transparent.
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To switch Front on or off, simply click on the button (it can only be turned 
off if Shadow or Outline is turned on). By default, the text color is white, 
however, you can drag a different color to the Front button and save it as 
the standard text color by clicking on Save as Defaults in the Misc tab of the 
Design Text menu. 
 
The Front button will differ slightly depending on the type of clip that is 
used. Monochrome clips are treated the same as text elements: the color 
in the color chip will determine the image color. Front can be turned off if 
the Outline or Shadow style is on. With multicolor clips, the color chip on 
the Front button is not available. Turning the button off will make the fill 
color in the clip, or the image, become transparent, leaving only the outline  
or shadow. The outline and shadow opacity can be adjusted for a variety of 
design effects. 
 
You can also adjust text opacity which will leave the shadow more opaque, 
and some of the text fill color visible. Different levels may be adjusted from 
the Opacity tab. For more information regarding text effects please see 
Chapter 7: Managing Text. 
 



Designer5 
 

 
299 

 

9.2.1 Shadow 
 
When you apply the Shadow style, a selected text, clip, or draw object will 
cast a shadow—a duplicate image of the element will appear underneath.  
 

 
 
The default shadow color is black. To change the color, simply drag your 
desired color from the color bar to the Shadow button. 
 
Designer will allow you to adjust the length and position of a shadow 
relative to the light source. The default is a shadow which falls slightly 
downward and to the right. To change these attributes, simply use the 
Effect tab in the Design menu. 
 
In the Effect tab, point to the control in the Shadow box and drag the 
control to a new position. As the control is dragged, you are actually 
changing the position of an imaginary light source, thereby changing the 
direction and length of the shadow. 
 
For more precise adjustment, you can select the numerical values above the 
Shadow box and type in horizontal and vertical shadow offsets.  
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When a shadow does not exist, the light source will be directly in front of 
the element and the control will be in the center of the Shadow box. Move 
the control to indicate the direction in which you want the shadow to fall. 
As you move the control, the values will be shown above the Shadow box, 
and change accordingly. 
 
The first number represents horizontal shadow movement; as the shadow 
moves to the right of the object, you will see positive values, as it moves to 
the left you will see negative values. The second number represents 
vertical shadow movement; positive values result in a shadow which is 
lower than the object, negative values produce a shadow which is higher 
than the object. 
 
Regardless of where you envision the light source, the direction of the 
shadow should be the same for every elements on the same page which 
contain shadows. You can also change the length of a shadow. 
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9.2.3 Adjusting the Shadow Opacity 
 
Another control related to element shadows is the Shadow slider on the 
Opacity tab. This control will allow you to adjust the degree of transparency 
from fully opaque to fully transparent. Partially opaque shadows will 
provide a more natural shadow effect resulting in subtle page designs. By 
default, shadows are fully opaque, represented by a setting of 100. A 
setting of 0 will make the shadow invisible. At intermediate settings, the 
background, or other elements beneath the shadow, will show through the 
shadow, thereby softening the effect. 
 
The maximum shadow opacity is affected by the setting of the Whole 
Element control for the entire element. Reducing the Whole Element 
opacity to 0 will make the element’s shadow invisible, even if the Shadow 
opacity is set to 100.         
 

 
 
9.2.4 Outline 
 
The Outline option will produce an outline of a different color along the 
inner and outer edges of selected text, clips, or draw objects. 
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An outline may be especially useful to help light text stand out against a 
light or busy background. Designer will apply a thin black outline by default. 
In addition to letting you change the color of the outline, Designer will let 
you adjust the thickness of the outline. To experiment with different outline 
colors, simply drag colors from the color bar to the Outline button. 
 
To experiment with bolder outlines, use the Outline Thickness value control 
in the Effect tab of the Design menu.  
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Use the control to increase the outline on selected elements from a 
minimum of 1 pixel to a maximum of 19. 
 
Adjusting the opacity of the outline will give the clip a smoother effect. It 
may also cut-out the overlapping area of the shadow applied beneath if 
the opacity is set to 0. 
 

 
 
9.2.5 Backdrop 
 
This option will fill the area behind the selected text, clips, or draw objects 
with your selected color. The area will expand as you type more text or 
otherwise change the size of the element; or as you apply other styles 
which take up space, such as Shadow. The Backdrop? option is especially 
useful to ensure text is always readable against a busy or constantly 
changing background, such as live video. It is also an effective way to 
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make text and other clip objects stand out from background graphics and 
video. 
 
To access the option and switch it on or off, simply click the arrows on the 
multistyle button in the Design menu until you see Backdrop?. The button is 
marked with a when the style is applied. 
 
The backdrop box may extend slightly above and below the top and bottom 
of the characters of a text element. When the Backdrop? option is off, you 
will see the background color, or an image surrounding the characters.  
 

 
 
When Backdrop? is used with clips or draw objects, the backdrop is only 
visible when the elements have transparent areas, and/or when the Border 
attributes (described next) cause the backdrop area to become larger than 
the size of the element itself. 
 
The default color is a medium gray. To change the color, simply drag your 
desired from the color bar to the Backdrop? button. Note the backdrop 
color is related to the bevel color. You can increase the dimensions of the 
backdrop box by using the four Border attributes. Opacity and other Effects 
can be applied for various effects and scaling. 
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9.2.6 Border 
 
The Left Border, Right Border, Top Border, and Bottom Border options in the 
Effect tab of the Design menu allow you to increase the width and height of 
the backdrop area by adding additional pixels to the edges. Moving the 
edges of the backdrop area away from text elements will make the text 
more readable and aesthetically balanced.  
 
The additional pixels will be the same color as the backdrop area. If 
Backdrop? is not on, the border of additional pixels will be transparent 
and the difference in size will not be apparent, unless the Bevel? style is 
also applied. 
 

 
 
The default settings will not produce an additional border. The four controls 
allow you to adjust the border, independently on all four sides. 
 
9.2.7 Bevel 
 
Every button used in the Designer menus are beveled. Each edge is also 
highlighted and shadowed, adding increased depth to a two-dimensional 
rectangle. Clicking on a button will reverse the highlighting effect, 
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producing an indented appearance. 
 
You can easily produce the same effect with the Bevel? style. As you can 
see in the following illustration, the beveled edges have been added around 
the backdrop area surrounding text elements, draw objects and clips. To 
switch the option on or off, simply click the arrows on the multistyle button  
in the Design menu until you see Bevel?. 
 
The button will be marked with a check   
when the style is applied. You can also  
apply a beveled edge to your text 
regardless of the current combination 
of styles, such as a backdrop or border. 
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9.2.8 Bevel colors 
 
Designer uses at least two colors to create the beveled effect and may use 
up to four, one for each edge; if the current color palette includes the 
necessary shades. As a result, each edge has a corresponding color chip on 
the Bevel? button. 
 

 
 
The main color is used as the basis for the selection of edge colors. It is 
not used for edges. A backdrop is primarily used with a bevel, with the 
backdrop color matching the main bevel color.
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You can change any of these colors by dragging a color from the color bar to 
the appropriate color chip on the Bevel? button. If you change the main 
color, Designer will automatically suggest colors from the palette which are 
compatible with your chosen color, yet provide additional contrast. 
Designer will always attempt to suggest four colors. Note: The suggested 
color options may be limited by the available colors on the palette. You 
may need to change the palette by adding new colors. Please see Chapter 
13: Adjusting Colors for further details regarding adding new colors. 
 
When a complete range of colors is available for use as edge colors, 
Designer will use the lightest one for the top edge, the darkest for the 
bottom edge, and in-between tones for the left and right sides. It will 
essentially position an imaginary light source above and slightly to the left 
of the text box. This will produce a three-dimensional effect, making it  
appear as though the top edge of the box is fully illuminated, while the 
bottom is shadowed. Reversing the normal order of these color 
assignments in the Bevel? button color chips will create the inverse effect, 
causing the box to appear indented.  

9.2.9 Backdrop and the Bevel colors 
 
The default for the main bevel color is the same medium gray as the default 
backdrop color. The main bevel color and the four bevel edge colors may be 
independently adjusted. However, under certain circumstances, the 
backdrop and main bevel colors are linked. When: 
 

• the backdrop and main bevel colors already match  
• Backdrop? is on  

 
Changing the backdrop color will also change the bevel colors, allowing 
bevel and backdrop to retain their matching color scheme. (Changing the 
main bevel color will not affect the backdrop color, however, you can  
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directly adjust the bevel colors. This is effective if you want increased 
contrast with the backdrop.) 
 
9.2.10 Bevel styles 
 
Beveled edges are two pixels wide by default. You can adjust the width in 
the Effect tab of the Design menu. Look for the Bevel Thickness attribute. 
Use the value control to adjust the width of the beveled edges. The width 
can vary from 1 to 19 pixels. 
 
If the text appears to be too close to the beveled edges, you can use the 
Border attributes to increase the distance between text and bevel.  
 

 

9.2.11 Focus 
 
The Focus? style, on the multistyle button, will allow you to use a special 
color to temporarily highlight a new element. It will automatically change 
the color to its Front color when the next element is displayed. This is 
mainly used for text. Focus? is available for monochrome clips and draw 
objects, however, it will not affect multicolor clips. 
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Using a Focus color is especially useful when you are gradually building a 
list or making a series of connected points. The most recent element will 
receive the emphasis until another element is brought into view. 
 
You can apply Focus? to elements which have an In transition and a defined 
duration setting. The transition specifies how an element moves onto a 
page. The duration setting ensures it is displayed long enough for the 
highlight color to be visible. Unless a duration setting is defined, the next 
element will be displayed as soon as the current element has transitioned in 
(or out). The duration setting may be applied as a mouse click, or a 
predefined length of time. 
 
To apply the style, simply select a text element, draw object or 
monochrome clip and turn on Focus? Drag a color from the color bar to 
the Focus? button. Ideally, the color should be brighter than the element’s 
normal color. The Focus opacity can also be changed in the Opacity tab.  
 
The last element on a page containing a Focus style will determine the focus 
color, until the page transitions out. To revert an element to its normal 
color, before the end of the page, an invisible final element must be created 
and given an In transition. 
 
9.2.12 Opacity 
 
Graphic elements and styles are normally opaque. They do not have 
transparency. They do, however, completely cover the background, along 
with any other element located underneath. Using the controls in the 
Opacity tab of the Design menus, Designer makes it possible to give 
elements and styles a variable level of transparency.  
 
Opacity is not turned on and off. It is governed by sliders which vary the 
level of opacity in percent. Sliders can be adjusted from 100 (the default, 
completely opaque) to 0 (completely transparent). At intermediate values, 
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the colors of whatever is beneath a partially opaque element will be 
effectively blended with the element, allowing both to be seen. This can 
give the illusion that an element is translucent or make an Outline 
disappear. 

 
 

 
 
The ten sliders on the Opacity tab allows control over a variety of graphic 
styles. The sliders in this tab correspond to the styles with the same name: 
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Sliders are disabled for styles which are not applicable to the selected 
element. 
 
The Whole Element control is primarily a master control for the opacity 
of every aspect of a selected element. Although each opacity control can 
be independently adjusted, Whole Element actually controls the overall 
degree of transparency. Reducing Whole Element to 0 will cause everything 
in a heavily styled element to be invisible, regardless of the slider 
settings for Shadow, Outline, Backdrop etc. 
 
9.2.13 Element Position 
 
The position of any element on a page is defined by the distance from the 
left and top edges of the page to the element. The distance is measured in 
pixels and specifies the coordinates of the upper left corner of the 
element. The Element Position attribute in the Position tab of the Design  
menu will reflect these distances as the element is moved. In most 
situations, it will be faster, easier and accurate enough to drag an object 
to a new location on the page. However, if exact placement is required, 
the Element Position attribute allows you to place an element with single-
pixel accuracy. 
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To change the position of a selected element with the Element Position 
attribute, go to the Position tab. 
 
Use the first value to set the distance from the left edge, and the second to 
set the distance from the top edge. Negative values indicate the upper 
left corner of the element is off the page, above, or to the left. 
 
TIP: Holding down the Shift key while dragging an element will constrain 
the movement to either horizontal or vertical directions. Pressing an 
Arrow key while holding down the Ctrl key will move the selected 
element(s) one pixel in the direction of the arrow used. 
 
9.2.14 Element Size 
 
You can click and drag the handles of a clip’s bounding box and quickly  
adjust the size. However, to numerically change the dimensions of a clip, 
click on the Size? button and enter the dimensions in the Element Size 
location. You can also click the arrows to adjust the size incrementally.  
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9.2.15 Rotate Angle 
 
Designer also allows you to rotate an element using the Rotate Angle 
option in the Position tab. You can rotate clips from 0 to 359 degrees in 
one-degree increments, and text elements in 90-degree increments. 
 

 
 
Use the value control to adjust the angle. Rotate Angle will rotate elements 
clockwise. Note: You cannot enter negative values. To obtain rotations 
which appear to be counter-clockwise, use values from 180 to 359. 
 
Using a matching rotation for all text and clipson a page with a rotated 
background can make authoring portrait-style displays more practical. 
(Please see Chapter 4: Working with Backgrounds for additional 
information on background rotation.) 
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9.2.16 Clip rotation 
 
Clips rotate around the center of the clip. When a clip’s rotation is 
something other than 0, 90, 180, or 270, only the four corner handles are 
available for sizing and cropping. 
 
The single-key hotkey R will rotate the selected clip 15 degrees clockwise. 
Shift+R rotates 15 degrees counter-clockwise. 
 
9.2.17 Text rotation 
 
Text elements rotate clockwise around their upper left corner. The possible 
values are 0, 90, 180, and 270 degrees. 
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When you rotate a text element, the text cursor’s orientation will also 
change: the cursor will become horizontal when the text is vertical (a 
rotation angle of 90 or 270 degrees). However, you will still use the same 
keyboard keys to move the cursor within the element—the right arrow key 
(r-arrow) will always move the cursor toward the end of the element. 

9.3 Element Levels 
 
To change the Element Level of the clip without switching to the List panel, 
select the Position tab and adjust the Element Level with the arrows.  
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Higher numbers will bring the clip forward. Lower numbers will push it 
backwards. 
 
Levels allow elements to be layered differently than their order in time, as 
controlled by dragging elements in the List panel. For example, you can 
have an element that transitions in after other elements, but moves behind 
them on the screen. 
 
9.3.1 Global 
 
You will find the Global? button under the Misc tab in the Design Clip 
panel. 
 
When this option is turned on, it will allow an element to become visible on 
every page of the script, without being affected by any page transitions. 
When Global is turned off, the element will appear only on the selected 
page. 
 
A Global element cannot have an In or Out transition. Additionally, it cannot 
be aligned relative to the page. 
 
If transitions are used for the element, they will be removed when Global is 
turned on.  
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9.4 Advanced Features: 
 
9.4.1 Locked? 
 
Designer will allow you to prevent any editing changes to a given element. 
For example, if you need to keep a particular clip in the exact size and 
position on a number of pages, the Locked? option in the Position tab of 
the Design menu will make this possible for any element. To lock an 
element, simply select one or more elements, then turn this option on.    
A locked element cannot be moved, sized, or otherwise edited. When a 
locked element is selected, small lock icons will appear near the corners 
of its selection frame, indicating its status. 
 

 
 
Turn off the Locked? option while an element is selected to unlock it. 
 
9.4.2 Features for non-Western languages 
 
Designer offers a few options to consider when working with non-
Western language text. Particularly Asian language fonts, such as Kanji, 
require special alignment and character wrapping tools. 
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Asian Vertical Text? – located on  
the Design Text panel, in the Text  
tab, select the multistyle button  
with the selector arrows. This also  
is available in the Text Crawl panel.  
CAUTION: Only works with Asian character fonts! 
 
Keep Ideographs Together?– when this option is turned on (checkmark), 
word wrapping will try to keep ideographic phrases together. When it is off, 
text is allowed to wrap in the middle of an ideographic phrase. 
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||||| 10  Working in the Page 
  View List Panel 

  



Designer5 
 

 
321 

 

Chapter Overview 
 
The Page view List panel will give you an overview of the relationships 
between elements and events which take place on a page. This is similar to 
the way the Main view presents an overview of how every page fits into 
the complete architecture of your script. 
 
The List panel arranges the events on a page in their specific order, 
allowing you to change their sequence without affecting the position of the 
elements on the page. It primarily allows you to apply and remove 
transitions, as well as individually control the timing of events. 
 
From the List panel you can access the Sound panel to create a sound 
event which is specifically associated with an element. You can also access 
the Timing panel which will allow you to define the pause setting of an 
element. The Element Transition panel determines how elements enter 
and leave the page. 
 

10.1 Glossary of Terms in this Chapter 
 

Element – Any type of text, draw object, crawl, clip or movieclip 
which can appear on a page.  
 
Level– Refers to the order in which the elements are placed on 
the page – either in front of, or behind clips or objects, as shown in 
the List panel. 

10.2 Using the List Panel 
 
The List panel can adjust the order of existing events on a Page. It can also 
create a special event which may not be associated with a visual element. If 
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you are currently working in a Design panel, click on the List icon on the 
toolbar. If you are in the Main view, select the page you want to edit before 
you choose List from the toolbar. 
 
You will see the Page view List panel, complete with text and clip elements. 
 

 
 
If the page has more than a few elements, you can use the scroll bars to 
access different parts of the list, or you can click on the Normal/Full Size 
button in the panel title bar to enlarge the panel to full screen size. 
 
This allows you to see multiple events in the list thereby realizing their 
relationships to one another. 
 
Clicking the Normal/Full Size button a second time will reduce the List 
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panel to its standard size. You will also be able to view both the Page view 
canvas and the panel simultaneously. When the panel is normal size, you 
can press the secondary mouse button to temporarily hide the List panel. If 
the panel is hidden, simply press the button again and it will appear.  
 

 
 
You can easily move between the List panel and the current page while 
you are working.  Any selections or changes which are applied in one 
area, will immediately be reflected in the other. 
 
Unlike settings defined in most Design panels, you will not be able to see or 
hear the results until you preview the page or run the script. Any changes 
made in the List panel are timing-related, therefore, they are not 
apparent on a static page. 
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You can move from one page to another using the Page Switcher arrows 
in the panel title bar. You can also access a different Design panel by using 
the toolbar icons, or a shortcut key. 

10.3 The List Panel and the Main View List Mode 
 
The List panel offers the same facilities as the Main view when accessing 
a variety of other panels It will also define attributes for one or more 
elements from a central place. For details on how to use the List panel 
functions which correspond to those in the Main view, please see Chapter 
3: Working in the Main View. 
 
10.3.1 Similarities 
 
The List and Main views share several basic similarities: 
 

• An event in the List panel is analogous to a page in the Main view: 
it can be a single line of text, a clip, or it may be a special event 
which defines a sound event, a pause, or a variable. Essentially, 
an event is anything which can be introduced on a page and 
controlled from the List panel. Events representing something 
which is seen on a page, such as text and clips, are more 
frequently referred to as elements, however, they may also be 
known as events. 
 

• The No. (number) column indicates the position of an event  
in the sequence of events as they occur on the page. 
 
The No. button also indicates whether or not the event is “on”, or 
enabled on the page. To change the status of an element, click on 
the No. button and use the Element Control panel, which is the 
same as the Page Control panel on the Main view. When an event 
is disabled, the No. button will read Off. Additionally, its row in the 
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List panel will change color. If the event is an element, the element 
will disappear from the screen. 
 

• In the Element column, the name of an element is based on the 
element itself. For example, if the element is a line of text, the 
name will be the same as the contents of the line; that is, the 
actual text. A clip is identified by its file name. 
 
If the same text or the same type of element is used more than 
once on a page, Designer automatically adjusts the name by 
adding a numerical suffix such as “.1”. 
 
You can change the name which identifies an element without 
affecting the element itself. To edit the on-screen text in a text 
element, you must work directly in the Page view. Do not edit the 
text by editing the name of the element in the List panel. 
 

• You can change the order in which events take place by dragging 
the Element button to a different position. 
 

• You can adjust the width of the columns, as well as change their 
order. 
 

• To work with several elements simultaneously, you can select the 
elements on the page by using the Shift-click and Ctrl-click 
commands.  
 

• All the standard functions of the Edit pull-down menu and the 
context menu (Cut, Copy, Delete, etc.) are available. 

 
10.3.2 Differences 
 
There are a number of ways in which the Page view List panel differs from 
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the Main view List mode: 
 

• You can choose between full-screen and partial-screen views of 
the panel by using the Normal/Full Size button in Page view. 
 

 
 

• Since the page and elements in the List panel are visible, there is 
no Thumbnail view available. 
 

• There are two transition columns in the List panel, Transition In 
and Transition Out. Unlike a page, an element can either enter or 
exit the screen. 
 

• The List panel contains a Level column, which opens another panel 
allowing independent control of element depth arrangement. 
 

• The List panel is the only way you can apply and control events, 
such as sound effects, pauses, and branches within a page. 
Defining these events is discussed further in Chapter 15: 
Branching, Variables and Scheduling. 

 
The freedom of movement within the list depends on the type of element 
you are moving, either passive or independent. 
 
10.3.3 Adding Elements on the List Panel 
 
Designer allows you to add elements to the current page directly from the 
List panel. Similar to the Design Text panel, simply click on the page and 
type to add text. You can add an element which exists as a file in your 
system, such as a clip, or script, or you can add a special event which will 
insert a blank element into the List panel. For example, you can define a 
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pause setting to ensure there is a brief delay before the first element 
transitions onto the page. 
 
To add an element to the page from the Page view List panel, click on 
Add. The File dialog will appear. Similar to clicking Add in the Main view, 
you have access to the same folders and files. To add a special event 
choose Add Special Event from the Add icon pull-down menu list. An event 
named “<untitled>” will appear in the List panel. 
 
When you double-click on a file name, click OK, or choose Add Special 
Event, you will see the List panel again. The new event will be inserted 
below the previously selected event in the list or at the end of the list if a 
selection was not made. Added elements are automatically selected on the 
page (if the element is visible) and in the List panel. Note: If the new 
element overlaps any existing elements on the Page view canvas, you  
may need to adjust its position. 

10.4 Working with Elements 
 
In the Page view List panel, page  
elements and events are listed 
in order according to time.  
Later events are further down 
in the list. Depending on how 
you arrange them, this sequence  
can be quite different from  
the top-to-bottom arrangement 
of the elements as they are  
positioned on the page itself. 
 
10.4.1 Passive elements 
 
When the script is running, 
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elements which do not contain an In transition will simultaneously come 
into view with the background. They are also collectively affected by any 
settings which apply to the entire page. If they are global elements, they 
will be displayed over every background. 
 
These are called passive elements; meaning they are not separate events 
in time. Additionally, they cannot have special module column events, 
such as a sound or pause. They are always listed first in the List panel. When 
you assign an In transition to an element, it is no longer passive—it 
becomes an independent element. 
 
10.4.2 Independent elements 
 
Elements with transitions and events created as special events will 
produce effects which occur independently of the page transition. These 
are known as independent elements. They will appear in the List panel 
following the passive elements. In playback, they will either appear during, 
or after the page transition, depending upon the status of the Wait option 
of the page transition. 
 
Independent elements and events are listed in the order in which they take 
place. Initially, this is the order in which they were created, or placed on 
the page. To make an independent element passive, remove the In 
transition. 
 
10.4.3 Changing the order of events 
 
You can change the position of an element in the List panel by pointing to 
its Element button and dragging the row to a new position. 
 
NOTE: Changing the position of an element in the List panel does not 
affect the position of the element on the page. 
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You cannot move a passive element into the section of the panel which lists 
the independent elements. Similarly, you cannot move an independent 
element into the area of passive elements.  
 
Changing the order of passive elements will not affect the order in which 
they are displayed. However, you may want to change their order in the List 
panel, especially if they overlap. You may also change their order to place a 
particular element on top, or simply to make the panel more closely 
resemble the Page view. 
 
Changing the order of independent elements will also affect the sequence 
of events. Additionally, it will determine which element will be displayed 
first, next or last. 
 
If in the following example, the National Logo clip is not moved from its 
place at the bottom of the list of events, it will be the last element 
displayed. If it is dragged to the top of the list such as “Not a Good Time..” 
text clip in the example, it will end up as event 1, the first independent 
element.
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10.4.4 Listing order and stacking order 
 
Most Design panels have options such as, Appear Earlier and Appear Later 
in the Edit pull-down menu. These exist primarily to arrange the sequence 
in which an event will appear on the page, as reflected in the List panel. 
However, within a given level the ordering options also directly affect the 
stacking or visual depth arrangement of screen elements. 
 
Appear Later will move the selected event downward in the List panel; 
Appear Earlier will move the selected event upward. If the event is an 
independent element, it therefore happens earlier or later than it did 
previously. Within a given level, later elements will appear to be on top of 
earlier elements. 
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10.5 Element Levels 
 
The List panel contains the Level column. The column button contains the 
current level number of each element. Clicking in the Level column will 
open the Level panel, which contains the Element Level control. 
 

 
 
Use the Level panel to create visual levels of elements which are 
independent of their time ordering. Click Preview to reveal element 
transitions in playback. 
 
Depth arrangement is not effected by changing the listing order with 
Appear Earlier or Appear Later or dragging events up and down in the List 
panel.  
 
10.5.1 Applying transitions from the List panel 
 
In and Out transitions may be applied to any element which is not a sub-
script or non-graphic special event (such as a sound or a pause). When a 
page element is added, it does not contain an In or Out transition.  

If you click on a transition button the Element Transition panel will appear. 
Additionally, depending upon the size of the List panel, either the Page 
view canvas and the Transition panel, or the full-screen List panel and the 
Transition panel will appear. 
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Applying transitions using the List panel allows an effective overview of the 
sequence of page elements, as well as events. It also reveals transition 
settings. As a result, it is often more practical to work with the full-screen 
List panel and the Transition panel. Note: Click Preview to test the on-
screen effects of your adjustments.  
 
You can select a transition, adjust its duration and preview the results. You 
can also work in the panel and apply In and Out transitions to multiple 
elements in the List panel before closing the Transition panel. 
 
NOTE: On the Transitions panel, you can control the acceleration at the 
start and end of the effect. You can choose between Slower, Slow, 
Normal, Fast, and Faster choices, for various ease-in / ease-out type 
effects. 
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10.5.2 Transitions and passive elements 
 
If you apply an In transition to a passive element, Designer will 
automatically move the element to the bottom of the list in the List panel. 
Similarly, if you remove an In transition from an independent element—the 
element will automatically be repositioned and listed last in the series of 
passive elements. (Elements which are special events are interpreted by  
Designer as independent elements.) If there is a long list of elements, 
Designer will scroll to the element in its new position, selecting it so you can 
continue working. 
  
Passive elements may contain an Out transition. When an Out  
transition is applied, Designer will create a new event in the list of 
independent elements. The name will be the same as the original element, 
however, it will include the prefix “Out:”. This will allow you to easily 
distinguish between every type of transition, and related event. If you 
change the name of one of the related events, Designer will automatically 
update the other. If you do not apply an Out transition to an element, it will 
remain on the page until the next page transitions in. 
 
10.5.3 Using levels 
 
Designer will allow you to specify a “stacking” of elements which are 
independent of timing with the element levels feature. For example, if you 
wanted your clip “Bird.bmp” to wipe onto the page behind the 
“Trees.bmp” clip. In Designer, you can specify elements as if they existed 
on independent levels, allowing them to be freely depth-arranged in 
relation to one another. Depth-arranging elements will not affect their time 
ordering in the List mode. There is no limit to the number of element levels, 
or number of elements which can be at a given level. Levels are adjusted by 
changing a selected element’s level number. This can be done in either of 
two ways: 



Designer5 
 

 
334 

 

 
• Changing the value in the Element Level control on the Position 

panel of the Element Design panels. 
 

• Changing the level number in the List panel’s Level column.  
 

 
 
By default, elements are created in Level 
0. Changing an element’s level number 
from 0 to a higher number will ensure it 
will appear on top of any elements with a 
lower level number. Levels are only a 
designation of the depth relationship of 
overlapping elements. Levels do not exist 
as entities which you work with directly. 

You can directly select and manipulate any element on any level. For any 
elements with level numbers other than 0, a legend will appear in the upper 
left corner of their selection frame, indicating the element’s level number. 
 
You can change an element’s level at any time. First, select it. Then, in the 
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Element Level control on the Position panel, use the arrows to adjust the 
level number. 
 
Or, in the List mode, click in the element’s Level column to open the Level 
tab, where you will notice the Element Level control. Watch the page to 
see how the element moves in front of or behind other elements, and make 
your choice accordingly. 
 
As with other element attributes, newly created elements will take on 
whatever value is specified in the Element Level. New elements are 
created in the level with the last level specified, or the level of the last 
element which was selected, or until you change the level number. 
 
10.5.4 Adjusting the sequence of In and Out Transitions 
 
When you apply both an In and an Out transitions to an element, Designer 
will schedule the element to transition out immediately after it transitions 
in. In the list of independent elements, the Out transition event is placed 
directly below the event with the related In transition. 
 
You can change the timing by moving one or both of the elements in the 
list, or by changing the Timing setting for the element with the In transition. 
 
Since an element cannot transition out of view before it is displayed, you 
cannot move an Out transition event to a position which precedes its 
related “In” event.  
 
10.5.5 Adding pauses 
 
The setting on the Timing button of an element indicates how long Designer 
waits before it proceeds to the next event in the sequence. Initially, this 
setting is one(1) second after which the next event will occur immediately.  
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This aforementioned duration is independent of the transition duration. If it 
is less than the duration of the transition then the next event will start 
before the current transition has been completed. If it is longer, playback 
will appear to wait for the difference between the two durations. 
 
To vary the timing, simply click on the Timing button of an element which 
will open the Timing panel. This panel will also appear when you click on a 
Timing button in the Main view. The timing options for elements are the 
same as for pages. 
 
10.5.6 Special event pauses 
 
It is often useful to create a special event which is used to define a pause. 
For example, to create a brief delay between the information presented 
by the passive elements which come into view with the page, and the 
appearance of the first independent event, which may be additional text. 
You cannot apply a pause directly to a passive element. These and other 
uses of the Timing panel are discussed in detail in Chapter 10: Timing 

10.6 Context Menus 
 
The Context menus are available when you Right-click the mouse over an 
element or area in the Page view window. There are several similarities of 
Page view context menus and menus located in the Main view (see 
Chapter 3: Working in the Main View). You will also find more detailed 
information about context menus in Chapter 4: Using Design Panels in 
Page View. 
 
Most of the context  
menu items parallel the  
Edit pull-down menu.  
If you Right-click over a  
clip object in the Page view 
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canvas, then the standard 
selections will be available.; such as Cut, Copy, Paste, Delete and Hide/Hide 
All Other Elements. You can also select Hide Design Panel from anywhere 
inside the Designer window.  
 
The other selections which are available to a variety of clips and text 
objects are; Appear Later/Appear Earlier and Bind Text to Data Field… (or 
Bind Clip Filename…, Bind Movie Clip Filename…, etc.). If more than one 
element on a page is selected, then the option to Align or Spread will also 
be available. 

10.7 Enabling/Disabling and Renaming Elements 
 
In addition to “Hiding” an element, you can disable it entirely in the Page 
view List panel. By clicking on the element’s number in the No. column of 
the List panel, the Element Control panel will appear at the bottom. You can 
select or deselect the Enabled? Button. This is very effective if you are 
building a page with several element levels and don’t want to disturb 
completed portions of the project. It also allows you to distinguish which 
elements look best in preview. 
 
You can also rename any element or clip in the Element Control panel 
Name bar. 
 

 

10.8 Advanced Features 
 
10.8.1 Working with Sound and Other Events 
 
Using the List panel is the only way you can apply a timing setting to specific 
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events within a page. Similarly, it is the only way you can access: 
 

• the Sound panel in order to:  
 

• apply sound to an existing element (click on its Sound 
button). 
 

• create an element which is itself a sound (click on Add 
and from the Sounds folder choose a sound file). 
 

• the Branch panel to set variables or comparisons, then control the 
sequence of events on the page based on variables or expressions 
(click on an element’s Branch button). 
 

• other panels specific to Scala Modules which can be installed as 
special Designer utilities. These Modules are also represented by 
columns in the Main view. (Click on a button in the Modules 
column to open its panel.) 
 

The Sound panel is further discussed in Chapter 14: Using Animation, 
Digital Video & Sound. The Branch panel is further discussed in Chapter 
15: Branching, Variables and Scheduling. 
 
10.8.2 Module Events 
 
Depending upon the Scala Modules you have installed and activated, you 
will have access to a variety of panels in the List panel. For additional 
information about working in these panels, please see Chapter 17: 
Customizing Designer. 
 
Module options are available and special settings may be applied to most 
independent elements in the List panel. If you are working with a series of 
selected elements, some of which are passive, your results are applied to 
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only independent elements which have the options available. A new, 
independent element or event will not inherit any of the settings of the 
previous element in the list.
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||||| 11 Timing 
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Chapter Overview 
 
The timing options available in Scala Designer are designed with your 
audience in mind. You can synchronize pages with music, narration, or live 
events so that your script will run smoothly and effectively. 
 
This chapter will focus on using the Timing panel to control how your script 
advances. You will primarily use the Timing panel to adjust the timing of 
elements on the page, however it can also be used to adjust the timing of 
the page itself. 

11.1 Glossary of Terms Introduced in this Chapter 
 

Event – An action in a script; virtually everything which happens in 
a script is an event, including pages, text, sounds, transitions, 
animations, etc.. 
 
Duration – The amount of time which is individually specified, 
using standard time code settings at the frame rate of 30fps 
(frames per second). 
 
Speed – A predetermined amount of time which will move 
elements at an equal rate of speed, regardless of their distance of 
motion on the page.  
 
Wait for Element(s) – The page or element will not advance until  
the page or element is complete. 

11.2 Advancing from Event to Event 
 
A script in Designer can be regarded as a chain of events, a linear series. A 
script will proceed by advancing from event to event—from page to page, 
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on the Main view level, and from element to element within an individual 
page.  
 
NOTE: Advancing is essentially the same for both pages and elements. This 
manual will use the term Events for both. 

11.3 Automatic Script Advance 
 
An automatic script advance designates predetermined time values for 
the durations of events, or for the intervals between each event. When the 
time value, or timeout, is reached, the following event will be triggered. As 
a result, the pages and elements in your production will advance at a pre-
set pace. 
 
In Designer, automatic timing of events relative,, meaning as you lengthen 
one event, the following events are pushed back further in overall time. 
Fig. 1 illustrates this process.  
 

 
Figure 1. Illustration of relative timing of events. 
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An exception to this is the relationship between the timing of a page and 
the elements inside it. In this case the page’s duration can be set to a fixed 
value that will override the total time of the elements. 
 
11.3.1 Working in the Timing panel 
 
To open the Timing panel, simply click on the Timing button for a page in 
the Main view, or an event in the List panel column.  
 

 
 
This panel will allow you to specify how the script will advance to the next 
event— that is, to the next page or element on a page. 
 
11.3.2 Types of Advance 
 
The Timing: selector in this panel will determine the type of advance. There 
are four possibilities from the pop-up menu: 
 

� Timing: Wait for Elements 
� Timing: Duration 
� Timing: Wait Forever 
� Timing: Record Time With Mouse 

 
Wait for Elements and Duration specify different types of automatic 
advance. Wait Forever, will disable automatic advance, and should be 
used primarily when the advance is strictly interactive, with a mouse 
click. Record Time With Mouse, allows you to choose the timing with the 
click of the mouse, during preview playback from the Main view. 
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11.3.3 Setting the advance for several events 
 
You can set timing for several events without closing the Timing panel after 
each event. Clicking on a new event will confirm any previous changes you 
have made to an event. If you want to set identical timing for every page in 
your production, simply click Edit and choose Select All. Then, open the 
Timing panel and enter a setting. Timing for the selected pages will 
automatically be duplicated. You can also select more than one item at a 
time by Shift-clicking or Ctrl-clicking on the desired pages. 
 
11.3.4 Settings in the Timing panel 
 
Use the Timing: selector to choose one of the following timing settings. 
 
Wait For Elements 
 
The Wait For Elements setting will automatically advance after elements 
inside a page have finished playing. The page will not advance as long as 
there are elements in motion through transitions, and timed events, or if 
there are animations or movies playing. This is the default setting for all 
new pages and subscripts. 
 
Duration 
 
Once you have chosen Duration, use the value control to change the time 
value. The new value will be reflected in the Timing column. If the Timing 
column is narrow, it will be abbreviated. The next event will begin after your 
newly set time value has completed, regardless of the length of the event. 
New elements in the Page view will default to a Duration of one (1) second. 
 
Designer records your chosen timings, which will display as HH:MM:SS.hh 
values in the Timing column. These are specified as 
hours:minutes:seconds:frames. 
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Establishing a Useful Duration time 
 
If the time of an event is already established, simply set that time as the 
Duration value. You may need to adjust the event, (transition speed or the 
music clip’s tempo) so its length does not exceed the Duration time. 
 
Duration always overrides event completion time. For example, if you set 
8 seconds as your Duration, and a page takes 11 seconds to run, the page 
events will be cut off. They will not be accelerated.  
 
When using a Duration setting, the selected time should exceed the time it 
takes to actually run the event, otherwise, some elements will not appear 
on the page. By using a Wait for elements setting, the script will not 
advance until the elements have completed. 
 

 
 
Figure 2. Page Duration 
 
Wait Forever 
The Wait Forever setting is indicated by a dash in the Timing column. Upon 
applying this setting, the script will not automatically proceed to the next 
event.  
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The viewer can manually control the advance of the script, The viewer can 
manually control the advance of the script, simply by: 
 

� Clicking a mouse button 
� Pressing a key on the keyboard 
� Other external trigger device 

 
Setting up an advance usually depends upon additional settings in the Input 
panel. However, the default Input panel settings in Designer will allow an 
advance to the previous or following event based on a mouse button 
click. See Chapter 15: Branching, Variables and Scheduling for detailed 
information on this panel. 
 
Controlling advance interactively 
Wait Forever is very effective with slideshows. For example, if you wanted 
a page to Wait in order to discuss it with your audience, simply set Wait 
Forever to interactively control the pace of your production.  
 
Wait Forever is different from other advance settings because it allows 
“live” timing: Timing is determined as the production is being displayed, 
not before. Using the mouse to advance events, you can conveniently 
interrupt a page at any time—even during a transition—to begin the next 
event. 
 
11.3.5 Record Time with Mouse 
 
The Record Time with Mouse option is an interactive way to make a series 
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of Duration settings. By clicking the mouse, you can indicate when to 
advance. Designer records the click-timings and will apply them as 
Durations to their appropriate events. 
 
Select your desired series of events, before clicking in the Timing 
column. On the Timing panel pop-up, choose Record Time with Mouse. 
The Timing column will display a mouse icon for every selected event. 
 

 
 
Now preview the script. 
 
Click the main (left) mouse button whenever you want to advance from one 
of your selected events. 
 
After recording, the mouse icons will be replaced by the time values which  
Designer measured from the beginning of each event, to the moment you 
clicked. 
 
If you are not satisfied with the timing, you can easily replace it by selecting 
the event and applying Record Time with Mouse again. Simply follow the 
identical procedure as previously outlined. You can also change the 
Duration setting using the Timing panel value control. This is especially 
effective when fine adjustments in a recorded timing are required. 
 
Record Time with Mouse is particularly useful when synchronizing your 
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script with music. You can quickly and precisely set a large number of 
advance timeouts, without having to manually specify a series of 
HH:MM:SS.hh settings. 
 
11.3.6 Overriding timeout settings 
 
Because flexibility is vital to a successful production, Designer allows you 
to override automatic timeouts. 
 
Overriding automatic timeout settings 
By default, any automatic timeout setting can be overridden by clicking the 
main mouse button, or by pressing the Page Down key. Doing so will 
interrupt a Wait, a Duration, or even a transition, before proceeding to the 
next event. Clicking the secondary mouse button, or pressing the Page Up 
key, will move to the previous event. This is very effective during script  
creation, when you may need to check the sequence of events. It is also 
convenient if you want to quickly view another portion of the script.  
 
Timing settings can be overridden by the mouse or keyboard, when you 
switch on the Reset on Input? option. This will cause the Duration to be 
longer, rather than shorter. The Input panel’s Slideshow Controls options 
will allow you to disable the mouse and/or the keyboard so preset timings 
will not be interrupted. This will ensure automatic timing settings cannot be 
overridden. 
 
11.3.7 Timing with Long Events 
 
Adjusting the timing for simple events is basically the same regardless of its 
type, however, an additional factor special to timeouts for events which 
take time to complete: the Wait option. 
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The Wait option 
 
Some events are essentially instantaneous: Cut transitions, setting 
variables, branches, etc.. Other events, such as sound, animation, and 
elements with transitions, (other than Cut), take additional time to 
complete. Events which take time, are provided with the Wait button on 
their panels. 
 
When this option is on, the event being defined—including its Wait, if any—
must complete before the next event begins (Fig. 3 uses a sound event as 
an example).
 

 
Figure 3. The effect of leaving the Wait option on. 
 
If Wait is off, any events which follow in the script, can begin to run, after 
the current event has initiated. Essentially, more than one event can run 
simultaneously (shown in Fig. 4). 
 

 
 
Figure 4. The effect of turning the Wait option off. 
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11.4 Advanced Features 
 

11.4.1 Choosing the Right Setting 
 
In order to choose the timing options which work most effectively for your  
Designer production, it may be helpful to identify the goals of your 
production. Is precise timing critical—as in synchronizing music to images—
or is it more important that your audience spend as much time as  
necessary on an individual page, before the following page begins. Your 
production may require both situations. In order to choose the most 
efficient way to time your script, Designer provides a creative collection of 
settings, specifically designed to enhance your original production. 
 
Following are a few suggestions: 
 
11.4.2 Slideshows 
 
A “slideshow” is a simple production which consists of full-page images 
being shown in sequence, without individual elements wiping on or off. 
Slideshows can be interactive, automatically timed, or a mixture of both, 
depending upon the specific requirements of your production. If a 
slideshow accompanies a spoken presentation, use the Wait Forever 
option. This will allow individual control over each page. 
 
Simply by clicking, you can navigate through your production. Explicit timing 
settings are not required. 
 
11.4.3 Music video  
 
Duration settings will effectively allow precise synchronization, to any type 
of “music video” style production, in which there is a music track 
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accompanied by related images or text. Begin by starting the music track 
with the Wait option turned off. Then, add a special event page for an 
initial delay, and additional pages for any events you want to 
synchronize. Apply a Record Time with Mouse timing, and run the script, 
clicking when you want a new event to appear. Each event will receive a 
Duration sufficient to reach the following synchronized event in the music 
track. If the recorded timing was not exact, simply edit the Duration times 
directly, or re-do the Record Time with Mouse procedure.  

11.5 Factors Which Affect Timing 
 
Some events in Designer, such as transitions and fades, are dependent 
upon a number of internal and external factors, such as: 
 

� In transitions and Out transitions 
 
When you set In and Out transitions, you may also choose a 
Duration or Speed setting for each transition, (except the Cut 
transition, which is instantaneous). Using duration rate control, 
you can set a specific length of time for individual transitions. The 
speed rate control directs the speed of the transition, however, it 
does not specify a length of time. 
 
A Speed setting is designed to produce a transition time which is 
proportional to other settings. The same transition setting can vary 
considerably, in actual speed of execution, on different machines. 
Timing in Designer is relative, the overall time of a page or script is 
primarily the sum of the time utilized by various transitions and 
media element run times. 
 

� Passive vs. independent element 
 
A passive element does not contain an In transition. It is present 
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when the page transitions in. An independent element, contains 
an In transition, however, it doesn’t appear on the page until the 
page’s In transition (if any) has completed. If you apply an In 
transition to a passive element, the element will be moved to the 
beginning of the list of independent elements. This will in effect 
add the transition’s time to the total time of the page. It will also  
change the order in which events appear on the page. 
 

External factors, such as computer speed, length of sound/music tracks, 
and length of video clips can also affect timing. 

 
� The refresh rate of the graphics mode used for playback, acts as an 

overall speed control for transitions and animations. 
 
Additionally, the speed of the display adapter can critically affect 
the smoothness of your transitions, as well as other graphic 
effects in your script. With a fast display adapter, you can run 
transitions— especially fly-ons—more smoothly. For example, a 
slow hard disk, will take longer to load an image or sound files. 
Processor speed will also affect how quickly operations such as 
scaling and 3D effects, may be completed. 
 

� Some animations will allow you to set the number of frames 
shown per second. This will directly affect how long it takes an 
animation to complete. The higher the number of frames per 
second, the faster the animation. Sound events also have timing-
related settings. Additionally, both sound and animation events 
contain loop settings, which control how frequently an animation 
or sound repeats. You may need to use settings on the Timing 
panel, as well as other panels, to achieve your desired effect. 
 

� Looping sounds which have been set on “infinite repeat” can be 
interrupted by timing events. For example, a sound can be set to 
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repeat indefinitely or until you click the mouse to initiate the next 
event.  
 

11.5.1 Differences between Duration and Wait For Elements 
 
As described in the preceding sections, there is a difference between 
these methods of automatic advance: 
 

� A Wait For Elements will advance when the event is finished 
 

� A Duration will start to measure its timeout when the event begins 
and finishes at a set time 

 
Using Wait For Elements 
 
Wait For Elements will allow you to quickly set up a script, without the need 
to determine the length of the event. You can add or adjust a timing setting 
without having to consider other timing-related factors. 
 
Wait For Elements does not necessarily produce consistent results after 
editing other aspects of the script. If you adjust the speed of a single 
transition, the script’s overall timing will change.  
 
Using Duration 
 
The main advantage of using Duration instead of Wait For Element is that 
it will allow you to achieve consistent, accurate automatic advance intervals 
within your script, regardless of varying conditions. Duration will also 
maintain timing when transition speeds and other editing operations are 
adjusted on elements.  
 
Duration settings are effectively applied to continuous, non-editable 
events, such as video or music tracks, which are highly dependent upon 
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synchronized script events.  
 
For example, if you want to display text on the screen with corresponding 
lyrics in a music track, so people can sing along, the text and music must 
be consistent. Using Duration settings will allow you to maintain 
consistency, that is a 13.5- second Duration will always take 13.5 seconds. 
This will allow words and music to stay in synchronization.  
 
The disadvantage of using Duration for an event is you will need to 
determine how long an event requires to playback. If an event takes more 
time to complete than the set Duration time, some elements will be cut 
off. This occurs because the script will immediately to proceed to the next 
event.  
 
NOTE: Even when using Duration timing, the length of time it takes for an 
event to run – especially transitions – can vary from machine to machine. 
 
Remember these factors to consider when establishing a Duration time:  
 

� Hardware speed (Can affect transition speeds. It can also  
animations) 
 

� Speed settings (transitions) 
 

� Wait settings (transitions, sounds, animations) 
 

� Loops settings (sounds, animations) 
 

� Frames per second settings (animation)
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||||| 12 Using Transitions 
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Chapter Overview 
 
One of the most dynamic features offered in Designer, is an extensive 
library of built-in graphic transitions. Being able to move foreground 
elements such as text and graphics, as well as backgrounds, means you can 
easily use the animated transition effects not only between pages, but 
within them as well. Additionally, since these transitions are created  
inside Designer, you don’t have to rely entirely on external animation 
programs to add movement to your scripts. Transitions are used to pace 
your production, creatively capturing the viewers’ attention. This chapter 
will address both the process of applying transitions, and how to effectively 
use them in your scripts to achieve the exact timing and visual interest 
required, for an imaginative professional production.  
 

12.1 Glossary of Terms in this Chapter 
 

Transition – A graphic effect for moving from one page to the  
next, or when animating page elements on and off the  
screen. 
 
Fade – A gradual change in a setting of opacity from a  
background color, or previous page element, to the present  
– facilitated by a Fade transition. 
 
Fly-on – A type of transition in which an image, clip or text  
moves onto or off the screen from a position outside its  
borders.  

 
Wait? – Allows you to specify whether elements on a page  
should wait for the page transition to complete, before  
beginning their element transitions. 
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12.2 Categories 
 
Both the Page Transition and Element Transition panels have an 
assortment of buttons with icons which represent transitions. Related 
transitions are grouped together into categories such as Fades, Alphas 
and Zooms. The set of transition buttons or icons which will appear in the 
panel, depends upon which category tab panel you select. You may need to 
use the scroll bars to see every transition in a category. 
 
Not all transitions are available in both the Page and Element Transition 
panels. For example, Fly-ons apply only to text or graphic elements and 
therefore are not available in the Page Transition panel. 

12.2.1 Page Transitions 
 
A page transition is used to animate a page. Page transitions create moving 
transitions from one page background to the next. The Page Transition 
panel is accessed from the Main view. Page transitions include spin, 
zoom, push and reveal transitions,  
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not to mention a wide variety of special effects. Page transitions control 
how a page first appears in a script. If you don’t apply a transition to a 
page, it will immediately appear as soon as any preceding pages or events 
have completed. You cannot apply a transition to a special event page, 
group, or sub-script. Only single In transitions are applied to pages, so 
you can’t select both an In and Out transition. The transition applied to a 
page will automatically animate from the preceding page during the 
transition. 
 
12.2.2 Element Transitions 
 
Element transitions are available for any text, clips or draw objects which 
have been created or imported. Element transitions control how an 
element moves onto and off the page. The Element Transition panel is 
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accessed from the Design List panel, or any of the Element Design panels. 
 
Each of the Design panels contains In and Out buttons. These buttons 
provide individual control over the element transitions – or the appearance 
and disappearance of an element on a page. 
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12.2.3 Applying Page Transitions 
 
Until you specifically select a transition, a page’s transition button will 
display the Cut icon. The Cut icon represents a “non-transition”: the page 
will simply appear, without a transition. Click on the Transition column 
button in the Main view to access the page you want to transition. If you 
want to apply the same transition to additional pages, simply select them 
by choosing Select All from the Edit drop-down and/or using Ctrl-click 
and Shift-click, then click a Transition column button. This will open  
the Page Transition panel. 
 
To select a transition, begin  
by clicking one of the tabs  
to choose a category, then  
scroll through the individual  
transition icons and select  
one. By moving the pointer  
over a transition icon, the  
transition’s name will appear 
in a Tool Tip. 
 
Additionally, when you click on the transition icon, the name of the 
transition will be displayed in the Transition panel title bar. The icon will 
appear on the page’s button in the Transition column. To see the 
transition’s effect, click on Preview. The preview starts with the page just 
prior to your chosen page in the script—or from black if this is the first page 
in the script—and shows the transition to the new page using the selected  
transition. When the transition finishes, you will return to the Transition 
panel. 
 
The rate of transition motion can be adjusted by using either the Speed or 
the Duration value controls. 
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You can also edit page transitions on other pages in the script, without 
leaving the Page Transition panel. Simply click on a Transition or Name 
button in the Main view to select a new page. The Transition panel will 
change to reflect the transition choices which were previously selected for 
the new page.  
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When you are satisfied with your page transition effect(s), click on Close 
to accept the current transition, or Cancel to discard your choice. In 
either case, the Page Transition panel will close, and the Main view will 
appear. 
 
12.2.4 Applying Element Transitions 
 
Open a page from the Main view, then choose the Element button on the 
toolbar. Working with transitions for more than one element from the List 
panel allows you to see every element listed on the screen, including Out 
transitions and non-graphic elements. 
 
If you want to apply the same transition to several elements, select them 
by using Ctrl-click, drag selection, or choosing Select All from the Edit 
drop-down. Clicking the In or Out button in the Element Design panels, will 
open the Element Transition panel. If a transition has been applied to the 
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element, the panel containing that transition will already be open. 
 

 
 
The title bar of the panel will indicate None, until a transition is selected. 
With no In transition specified, the element will be in a fixed position on 
the page as the page transitions in. An element with no Out transition 
remains on the screen as long as the page is displayed. To apply a 
transition to an element, simply click one of the tabs to choose a transition 
category in the Element Transition panel, then click on a transition icon. If  
the element already has a transition applied, you can edit the speed or 
other parameters, or click on a different icon to select a new transition. 
To view the transition’s effect, click Preview, then press Esc to continue 
working in the Transition panel. 
 
Out transitions 
 
The same transitions which are available to move elements onto the page 
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are also available to move them off. The pattern or motion is the same as 
the In transition. 
 
When you click on the Out button and select a transition, you will create a 
new event in the list of independent elements in the List panel. The name 
will be the same as the original element, however, it will include the prefix 
Out This will allow you to easily distinguish between each type of transition. 
If you change the name of one related event, it automatically update the 
name of the other. 
 
The Out: event initially appears immediately after the related In event in 
the List panel. The element will begin to transition out, as soon as it 
completes wiping in. You can also add a delay to the In-transition event by 
changing the Duration in the Timing EX panel. Or you can drag the Out: 
event to a later location in the event list, or insert other events between the 
In: and Out: events. 
 
Overlapping Transitions 
 
Designer will allow you to start an element transition before a preceding 
transition has finished, by changing the preceding element’s Duration to 
shorter than the duration of the element’s transition. If you set the 
Duration to zero, this will cause the following event’s In transition to begin 
immediately after the first transition. In essence, several element 
transitions can occur simultaneously. 
 
12.2.5 Transition Direction 
 
Each transition button has an individual icon representing the transition’s 
pattern of movement. Some transitions, or types of transitions, are 
symmetrical, that is, they do not have motion or predominant direction, 
such as fades and Alpha transitions. Transitions which have a direction, 
may have corresponding arrows on the icon, indicating their movement. 



Designer5 
 

 
366 

 

 
Transitions which have a predominant direction of movement commonly 
allow you to specify their direction. Ideally, this is accomplished graphically, 
with the transition direction compass, or simply by using the keyboard.  
 
Using the Transition Compass 
 
The Transition Direction compass is located to the right of the transition 
icons. If the selected transition does not allow a direction adjustment, the 
compass will be empty. Otherwise, it will contain a pointer which will 
indicate the motion direction for the transition. 
 
Directions for the transition are indicated by white dots around the edge of 
the compass. Most adjustable transitions have either four or eight 
directions. A four-direction transition will offer either North, South, East, 
and West, or Northeast, Southeast, Northwest, and Southwest. 
 

  
 

To set a transition to a specific direction, simply click on or around any of 
the aforementioned dots. You may also drag the compass pointer to your 
desired direction. 
 
Using Transition Direction Hotkeys 
 
Holding down Alt allows the arrow keys to change the direction of the 
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transition to south, west, east, and north. Certain transitions can also 
move diagonally. They can be selected using Alt with the End, Page Down, 
Home, and Page Up keys. 
 
The title bar will display the transition direction after the name of the 
transition, as “North”, “Southwest” and so on. The direction will change as 
you use the hotkeys or the compass. In some cases, the transition icon will 
also change to indicate the selected direction. 
 
12.2.6 Setting Transition Orientation 
 
Many transitions also allow you to choose a transition orientation. The Flip 
Horizontal? and Flip Vertical? options operate similar to their counterparts 
in the Orientation panels of various Design panels: they can flip the overall 
pattern of the transition around an imaginary vertical or horizontal axis. 
 
Frequently the transition Flip options will produce an effect similar or 
identical to the effect of a particular change in the Direction setting.  
 
12.2.7 Reversing Transition Motion 
 
Some transitions will allow you to select their pattern of motion as it 
progresses from the end to the beginning, rather than the beginning to the 
end. For example, an Alpha transition which reveals a new image from the 
center outward, can be directed to reveal the same image from the outer 
edges to the center. Turning on the Run Backwards? button directs the 
selected transitions to reverse their pattern of motion. 

12.3 Transition Timing 
 
Each transition also contains a speed setting which allows you to control 
its rate of progress. The Speed value control not only displays the setting, it 
will also allow it to be modified. Most transitions have a Speed range from 
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1 (slow) to 10 (fast), however, higher maximum speeds are available. 
 
The default for each transition is a medium speed. The total length of a 
transition’s action depends on a variety of factors. The transition speed is 
primarily affected by the number of pixels being moved or processed at a 
given time—the size of the element. With smaller elements, you may need 
to reduce the Speed setting. 
 
You can view the current speed of a transition using the Preview button. 
Once the preview is complete, the Transition panel will appear. 
 

 
 
To change from Speed to Duration, select Duration from the Rate 
Control selector and enter the exact amount of time you want your selected 
element to move. For additional information about timing, please see 
Chapter 11: Timing. 

12.4 Accepting Your Transition Choices 
 
You can select, edit, and preview transitions for every elements on the 
page, without leaving the Element Transition panel. Once you have applied 
your transitions, click on Close to close the Transition panel. If you entered 
the Transition panel from the Design List panel, you will remain in the List 
panel. Otherwise, the Element Design panel (for the last element with 
which you worked) will appear. The In or Out buttons in the Design panel  
will display the applied transitions. 
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12.5 Applying Special Transitions 
 
The transitions in the Special category do not readily fit into other 
categories. Actually, some of these transitions function more as utilities, 
designed to help you apply other transitions. The Direction and Flip 
options are not available to most Special transitions. 
 

  Cut 
The Cut transition is a “non-transition” which simply causes the next 
page or element to display. Cut is the default transition for pages. Because 
Cut is by definition, the fastest possible transition, the Speed value 
control is disabled. Applying Cut as an Out transition will make an element 
disappear. 
 
 

  Next 
Every time the script encounters this transition, a new transition will be 
chosen. Basically, it will step through the transitions, in each category. This 
can be useful, for example, if you want to ensure that a different transition 
is applied to each line in a series of text lines. The speed you set will be 
used for every transition. 
 

  Random Once 
Choosing RandomOnce will direct Designer to randomly select a 
transition. When you leave the Transition panel, the icon for the selected 
transition, will be displayed in the transition button. The script will use this 
transition until it is changed. Clicking the transition icon allows you to edit 
the speed, Flip options, and direction for the particular selected 
transition.  
 



Designer5 
 

 
370 

 

  Random Always 
Designer will randomly select a different transition each time the page or 
element to which you have applied this transition, is displayed. The speed 
you set will also be used for every transition. The Flip options are not 
available. The selected transition direction will always be used as the 
default setting.  
 

  Dissolve 
The Dissolve transition will utilize Designer’s variable transparency 
capabilities to smoothly cause a page or element to appear. This is a 
particularly compelling, cinematic effect. 
 

  C-C-C-Cut 
Similar to a Flash transition, the C-C-C-Cut transition blinks the element 
while giving a zooming effect as if is coming at you, then flying away in a 
perspective tunnel. By slowing down the transition using speed or duration, 
you can effectively enhance the zooming effect.  
 

  Flash 
Flashes the element on and off repeatedly until the transition is complete. 
This can also be controlled by speed or duration.  
 

  Quake 
The element will jump out at you in a shaking motion, which will radically 
zoom, as if popping off from a flat surface. 
 

  Rub 
The Rub transition applies a smooth “bounce” in from whichever 
direction was chosen on the direction compass. This transition is more 
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effective at higher speeds, or a duration of 1 second or less. 
 
12.5.1 Timing considerations 
 
Adding a transition is more than just a style; it is an event which takes a 
certain amount of time. A transition, (including its speed or duration) 
shapes the pace and feeling of an element’s appearance. Adding 
different Wait events, using the Timing panel, will allow you to define the 
time between the transitions.  
 
See Chapter 15: Branching, Variables and Scheduling for complete details 
on this aspect of script timing. 
 
12.5.2 Passive Elements 
 
Usually applying a transition does not necessarily change the order of 
elements as shown on the List panel. Each element is approached 
individually, and will remain in the sequence in which it was placed. An 
exception to this rule occurs if you apply an In transition to a passive 
element.  
 
A passive element is one which has no transition applied and 
immediately appears on the page as the page transitions in. The passive 
elements on a page are always listed first in the List panel. An 
independent element, on the other hand, has an In transition. If you apply 
an In transition to a passive element, it moves the element to the top of the 
list of the independent elements. 
 
12.5.3 Deleting a Transition 
 
If you delete an In transition from an element it will become passive and 
will automatically be placed last in the series of passive elements. You can 
delete an Out transition simply by deleting the Out: event using the Delete 
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button in the Element Transition panel. Removing a transition may have an 
effect on other events, such as Sound or Timing column events, or  
other elements. If you make an element passive by deleting the transition, 
any associated sound, timing and/or EX events which were previously 
defined, will disappear. Similarly, if you remove an Out transition event, any 
associated events will disappear.  
 
Applying Out Transitions to Passive Elements 
 
You can apply an Out transition to a passive element. It is no different from 
an independent element, The Out: event will appear in the list of elements. 
 
12.5.4 Pacing 
 
Pacing your production will have a tremendous effect on your audience.  
 
The concept of pacing your production is simple: if your production moves 
too slowly, people may be bored, impatient, or lose interest. If your 
production moves too quickly, people may not be able to read or absorb 
your information. Since it is often difficult for the script author to judge 
the pacing of the script from “inside”, you should frequently run the script, 
paying particular attention to the length of each segment. Note: It is 
important to enlist feedback from your peers regarding script pacing For 
example, if you are a fast reader, you might misjudge how much time 
your audience will need to read your text. A good rule of thumb is to allow 
enough time for you to read the page’s message to yourself twice in a row. 
 
12.5.5 Duration and Speed 
 
The pacing in a script is synergistically derived from combinations of the 
Duration and Speed settings. These settings are significant to the 
effectiveness of the script. They govern how much time the audience has to 
look at the most recent image or text before the next one appears. For a 
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more detailed discussion of these settings and the ordering of elements in 
the List panel, please see Chapter 11: Timing. 
 
Transition Speed is open to variation. Although fast transition speeds would 
be appropriate for a fast-paced high-energy script, fast transition speeds 
can also work well with a script that is relatively slow, or is paced 
interactively. Again, remember that the audience doesn’t really care how 
beautiful the transition is. They just want the next piece of information. So 
don’t be afraid to let the transition go by quickly. 
 
12.5.6 Making the best use of transitions 
 
This section will cover some general factors to enhance your productions.  
 
NOTE: The performance of the system running the script, not the system on 
which the script is created which governs the transition playback 
performance.  

12.5.7 Choosing a Transition 
 
A transition should add a dash of visual interest, but is primarily a tool for 
helping the audience grasp the information more easily.  
 
More often than not, the best choice for a transition is to keep it simple 
and familiar. This will ensure your audience’s attention will be drawn to 
the content in your production, not the transition.  
 
12.5.8 Transition style 
 
Transitions serve a similar purpose as punctuation in written 
communication. In the long history of film and video production, many 
standard transitions have been developed. Some transitions may suggest a 
continuity, or the simple passage of time, to whatever comes before or 
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after an image, text or event. Others have a separating function, or effect, 
and are best utilized to begin or end a sequence. Some are suited to a 
fast-paced production, while others are best reserved for situations 
requiring a graceful shift. Using the wrong transition for a given context 
can be as confusing to the viewer as using a comma at the end of a 
sentence. 
 
If you are having trouble choosing transitions, try getting a “rough cut” of 
the script’s timing, by using only Cut transitions. Run it a few times. You’ll 
probably notice that some transitions work well as straight cuts. Try 
imagining your production is complete, and you are watching it on 
television—what would it look like? From years of familiarity with this 
form of “classic multimedia,” your mind’s eye should suggest some 
transitions, especially where you may need something more than a straight 
cut. 
 
Next try using Dissolve transitions to add dramatic pauses to titles or key 
messages. Dissolve is a dramatic yet elegant effect, and because it doesn’t 
have motion or zooming, text can still be readable during the transition. 
 
As a general rule, you should minimize the use of different kinds of 
transitions in a given script, especially if they make the page too busy. 
Don’t hesitate to use a simple transition more than once. In fact, this will 
help bring a continuity to your production.  
 
12.5.9 Transition families 
 
� Special - The Special transitions listed earlier in this chapter, are Cut, 

Random Once, Random Always, Dissolve, C-C-C-Cut, Flash, Quake and Rub. 
 

� Through - Through transitions are a special kind of element transition 
which will move an element onto and off the page in a smooth motion. 
It is essentially a fly-on In transition, seamlessly coupled with an 
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immediate fly- on Out transition. Through transitions are available only 
to elements, and only from the In transition button.  

 
� Fly-on - Fly-ons move an object onto the page or into view along a 

particular path of motion. This is ideal when you want to focus 
attention on an object. You can also use fly-ons and fly-offs with clips, 
or to add simple kinds of animation to a script without creating an 
actual animation. Most Fly-on transitions will allow you to set their 
direction of motion. Fly-ons are available only to elements. 

 
� Alpha - A unique and especially stunning type of reveal is Designer’s set 

of Alpha transitions, which contain reveal patterns based on the 
grayscale image files depicted on their transition buttons. Many Alpha 
transitions resemble dissolves. They demonstrate a unique, organic 
appearance which is completely different from the usual geometric 
transition forms. 

 
� Fade - Fades are graceful transitions which smoothly blend from the 

page image to a solid color. They are commonly used at the end of a 
production, and tend to suggest the continuation of whatever was 
previously viewed on the screen. A fade-out followed by a fade-in 
usually suggests the passage of time.  

 
� Zoom - Zoom transitions simulate zooming in or out of an image in a 

variety of ways, demonstrating a very dramatic effect. 
 

� 3D - An eye-catching option for element transitions is to use 3D 
transitions. These are special fly-on transitions which can spin, flip, 
and warp any element, while moving it onto the page. These 
transitions use real three-dimensional geometry for very convincing 
cinematic effects. Designer also features many exotic transitions 
which are unique to the program, and don’t fit easily into any category 
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or family. These can be just right for productions which require 
something “spectacular”. 

12.6 Advanced Features 
 
12.6.1 Applying the “Wait” button to a Page Transition 
 
When you’re applying a transition to a Page in the Main view, you can 
choose whether independent elements will transition in during or after 
the page’s transition. The default is Wait on, which makes the elements 
with In transitions wait for the page transition to finish. If you click Wait? 
off, the elements will start to animate as soon as the page transition 
begins.  
 
12.6.2 Some Transition Applications 
 
Following are some helpful ideas for imaginatively using transitions. 
 
Building a page 
 
One of the most basic transition strategies is to build your page, point by 
point. First, open with a background, next, transition in a headline. Place a 
pattern or shaded block over part of the image, and ultimately, begin 
transitioning bullet points onto the shaded block. 
 
This will give your audience time to absorb your content. It will also keep 
your production moving. Although finding just the right transitions and 
pause settings to design an effective page takes time, it is definitely 
worthwhile. You can view many examples of this technique in the demo 
scripts provided with Designer. 
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Relevant transitions 
 
When trying to decide on element transitions for your production, try to 
imagine how different transitions might relate to your subject matter. A 
simple effect in a certain direction can often work well. For example, a plain 
bar-graph or chart presentation can be put into motion by revealing rising 
sales figures from left to right, or from bottom to top. An information  
display on transportation arrangements could be animated by airplane clips 
which fly in from one side and fly off from the other. A photography tutorial 
could easily be enhanced utilizing zoom transitions, or the Nuclear fade 
transition. 
 
Sound 
 
Many transitions clearly suggest sound effects, such as swishing, 
creaking, or slamming noises. Additionally, transitions which progress as a 
series of events, such as those which break the screen into smaller blocks, 
could be synchronized into bits of music. Since sound will draw particular 
attention to an event, the aforementioned technique should only be used if 
the transition relates to the subject matter.  
 
Combining transitions 
 
With some preparation, you can create complex effects which are not 
available as simple transitions in Designer. For example, suppose you want 
to display an image, then tint it dark blue before wiping some text over it. 
You can alter the image using the options in the Process panel of the 
Design Background, or Design Clip panel, in order to tint it.  
 
Next, follow the normal image with the tinted one. To prevent the 
impression that you have two separate images, and are simply putting the 
plain image on top of the processed image, simply use a reveal transition. 
Your resulting effect will be a Blue Tint transition—which doesn’t exist in 
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the library! 
 
Another effect would be to start with one photo, then transition to an 
image of a door or curtain, then transition to another photo. The result 
looks like the photos were swapped “behind” the door or curtain. 
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||||| 13 Adjusting Colors  
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Chapter Overview 
 
Designer has many automatic functions which help to make your images 
look their best on any graphics display hardware, but it also has several 
controls that let you create, manipulate, and manually control colors. 
 
To collectively work with the colors in a background or clip image, Designer 
provides the Process tab in the Design Background, Design Clip, Design 
Movieclip and Design Animclip panels. These panels contain image-
processing functions which allow you to change colors to an image in  
subtle and dramatic ways. 
 
Several Design panels will also allow you to assign colors to elements 
from the color bar. These colors are controlled from the Design Palette 
panel, where you can individually apply color options to images and edit 
individual colors. 

13.1 Glossary of Terms in this Chapter 
 

Palette – A set of colors which can be selected and applied to 
elements on a page. Also refers to the selection of colors which 
make up an image or animation. 
 
RGB – The Red, Green and Blue channels which are combined in 
the color light spectrum to produce the color block. Pure white 
light is a full combination of RGB at 100%, whereas black, is the 
absence of all RGB or 0%. 
 
HSV – The Hue (basic color), Saturation (intensity of the hue) and 
Value (overall brightness) of an image, or digitized video clip. 
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13.2 The Design Palette Panel 
 
Designer actually uses three kinds of palettes: the Background palette, 
the Clip palette, and the User palette. Most of your time working with 
individual colors in Designer will involve the User palette. 
 

 
 
 
The User palette contains a selection of default colors, which are fully 
customizable. The Background palette contains the colors in the 
background image if the image is 256-color format such as GIF, and the Clip 
palette contains the colors for the currently selected clip, also only if it is a 
256-color format. 
 

� The Palette icon button on the toolbar, will allow you to access the 
User, Background, and Clip palettes. 
 

� A Background palette option will not be available if the 
background is Plain, a High Color or True Color image, or a movie. 
 

� The Clip palette option will not be available if a clip has not been 
selected, or if the clip is a High Color, or True Color image, or a 
movieclip. 
 

� the clip is a High Color, or True Color image, or a movieclip. 
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� no clip is currently selected 
 

The contents of the current palette are displayed in the color bar at the top 
of the panel, in color sets of 16 colors at a time.  
 
Use the Color Set Switcher at the end of the color bar to cycle through the 
color sets in the palette. 
 
The color bar for the User palette contains the system default of 19 colors. 
One of these colors is always selected, as indicated by a box within one of 
the colors on the color bar. The selected color will also be displayed in a 
larger color block to the right of the sliders. 
 
13.2.1 The User palette 
 
When you open the Palette panel, the User palette is revealed. This 
palette is also shown in other Design panels which have a color bar. 
 
The User palette is similar in many respects to a traditional artist’s paint 
palette. It will allow you to select mix and apply a variety of colors to text, 
boxes and other elements in the other Design panels.  
 
You can edit, delete or add colors to the User palette, as well as copy 
colors from Background or Clip palettes. The size of the User palette is 
unlimited. 
 
13.2.2 Adding colors to the User palette 
 
You can transfer some of the clip, or background colors to the User palette 
to color text blocks, allowing them to match the background. You do this by: 
 

� Switching to the Background or Clip palette by using the Palette: 
pop-up. 
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� Selecting the color on the Background or Clip palette color bar. 
 

� Clicking the Add to User Palette button. (When you switch from 
the User palette to the Background or Clip palettes, button will 
replace the Add and Delete buttons.) 

 
Every time you click on the Add to User Palette button, the selected color 
will be copied to the User palette. The color will immediately be selected in 
the User palette display.  
 
13.2.3 Deleting colors 
 
Deleting unneeded User colors will facilitate locating the colors you want to 
use in your production. To do so, select the color in the User palette and 
simply click the Delete button. You cannot delete colors from the 
Background or Clip palettes. If you delete a color which is already in use, 
(applied to some element), the element’s color will be remapped to the 
closest matching color in the User palette. 

13.3 Creating and Editing Colors in the Design 
Palette Panel 
 

13.3.1 Creating a color 
 
You can create and add any color you choose to the User palette. Click the 
Add button beneath the Palette: pop-up (not the Add icon) to create a new 
chip. The newly created chip is located to the left of the currently selected 
color chip. Subsequently, it will be the selected color. (Colors which are 
located to the right on the color bar, and those which are located in higher 
numbered color sets, will be moved over one space.) 
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Initially, the new chip is the same color as the previously selected color 
chip, however, it can be edited to reflect your choice of colors.  
 
13.3.2 Editing a color 
 
You can adjust the color of the selected chip to any desired shade, simply 
by using the three color sliders. The sliders are available for two color 
modes, RGB or HSV. For both modes, the large color block in the middle of 
the panel will display the color, and the corresponding numerical display. 
You can also click the value and enter a number. Clicking on the RGB/HSV 
display will switch between modes. 
 
Using RGB sliders 
 
The RGB color mode is simple. The sliders control the Red, Green and Blue 
amounts which combine to form a color. The R, G, and B values range 
from 0 to 255. 
 
13.3.3 Using HSV sliders 
 
The HSV color mode is slightly more complicated, however, once you 
understand it, you can frequently make color adjustments more easily than 
with RGB. The three sliders in HSV control are Hue, Saturation, and Value. 
Hue is the basic color, accessible on the slider in a spectral order: red-
orange–yellow–green–blue–violet–red. Because of this circular order, the 
value ranges from 0 to 359. Saturation is the intensity or purity of the  
hue. Value is the overall brightness. Both can have values from 0 to 255. 
 
You can switch back and forth between RGB and HSV at any time to 
compare settings. 
 
You can also edit the colors in the Background or Clip palettes which is 
the same as editing a User color. Select the color on the color bar, then 
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simply adjust the corresponding color controls.  
 
NOTE: If the V slider is at 0 before starting, the color will remain black. To 
achieve gray tones, set S to 0 and adjust V. H will not have an effect. For 
bright, pure colors, set S and V to their maximum setting, and adjust H. 
 
13.3.4 Picking a color from the screen 
 
The Palette panel allows you to individually choose a color from an image. 
To create a new color chip, simply select a color in the User palette which 
is not required, or click the Add button. Click the Pick button. The pointer 
will change to the Pick pointer. 
 
Place the Pick pointer so it encloses your desired color, and click. In the 
User palette, the predominant color will immediately be transferred to the 
selected color chip, which can then be edited.  
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Clip works the same way as using Pick, when you have selected either 
Palette: Background or Palette. The color on the selected color chip will 
change to the color you pick, and all pixels in the clip or background which 
contained the color that was on the color chip, will be re-colored with the 
new color. 

13.4 Exporting and Importing the Design Palette 
 
13.4.1 Loading and Saving a Palette 
 
User palettes can be saved as files. You can also load and save a palette at 
any time. Assigning colors to different production projects is more 
convenient with several User palettes. To save the current palette, click 
on File and choose Export>Palette... This will open the Windows File 
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dialog. A file type extension of . PA L  will automatically be added to the 
name. Finally, simply name the palette and save it. To load a palette  
which has previously been saved, simply click the Add toolbar icon to 
open the File dialog, then choose a .PAL file to load. 
 
13.4.2 Changing the Default User Palette 
 
You can save a set of colors as the default palette. Designer will save the 
current User palette as the default when you choose Save as Defaults in the 
Misc panel of the Element Design panels. 

13.5 The Design Background Palette 
 
Every time you initiate a new screen page and load a new 8-bit (256 color) 
background image, (picture or animation) its constituent colors will be 
placed into the Background palette. Following are some guidelines when 
using this palette with different backgrounds. 
 
8-bit (256 color) background: The palette is editable within Designer.  
 
Plain background: Only one color is used with this background and it 
originates from the User palette. The Background palette is not accessible 
on the Palette toolbar icon. 
 
High Color and True Color backgrounds: Individual colors in the image are not 
editable within Designer, therefore, there is not a Background palette 
accessible on the Palette toolbar icon. However, you can work on the colors 
of the background as a whole By using the controls in the Process panel of 
the Design Background panel, you can edit the colors of the entire 
background. The Process panel will be discussed later in this chapter. 
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13.5.1 Working with an 8-bit background palette 
 
A Background palette has a given number of color slots, or locations for 
colors. Each separate color in the background uses one slot. An 8-bit 
background has 256 color slots. If there are fewer colors in the image than 
the number of slots, there will be empty slots at the end of the palette. 
 
The backgrounds supplied with Designer generally don’t use every color 
slot, therefore, there are still color slots available for clip and user colors. 
 
NOTE: Colors are positioned in the Background and Clip palettes according 
to their frequency of use in the image. The more pixels in the image which 
use a particular color, the earlier in the palette it will appear. The leftmost 
color chips in color set 1 are the colors used by the most pixels in the selected 
image. 
 
The Background palette typically changes for each page, because Every 
image background requires a different assortment of colors, 
subsequently, the Background palette will adjust for each page. 
 
In general, although you can edit colors directly on the Background palette, 
Image backgrounds usually look better with their original colors. 
 
Use the color parameters in the Process panel of the Background panel to 
make overall adjustments in the background. For the ultimate in color 
control and flexibility, you can manipulate the image in an external image-
processing program. Within Designer’s Palette panel, however, minor 
fine-tuning and special color effects are easily accomplished.  
 
13.5.2 The Clip palette 
 
The Clip palette is accessible on the Palette: pop-up only when a clip is 
loaded and selected. Additionally, the clip cannot be a High or True Color. 
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The color bar in the Clip palette displays the colors in the selected clip. 
There are as many Clip palettes as there are clips; each one is independent 
of one another .Although you cannot control individual colors in the 
palettes of High Color or True Color clips, as with backgrounds, you can 
adjust the colors in the clip itself, on the Process panel of the Design Clip 
panel. 
 
13.5.3 Using the Process panel 
 
When using images in Designer, especially photographic images, it is not 
uncommon that an image may need some “touching up”. Some examples 
may include tinting an image a particular color for an artistic effect, or 
reducing its contrast to make it work better by allow it to blend more 
effectively into a background. You can address any of these examples, and 
more, within Designer, using the Process style panel located in the Design 
Clip, Design Animclip, Design Movieclip, and Design Background panels. 
 



Designer5 
 

 
391 

 

 
 
The controls in the Process panel allow you to make fine or drastic 
adjustments to the color, brightness, and other visual qualities of an 
image. You can adjust any still image in Designer: individual clips, or 
entire backgrounds.  
 
Adjustments made in the Process panel will not alter the source image. You 
can always return to the original, unprocessed image with a single click. 
 
13.5.4 Types of image processing 
 
The image processing tasks which you can accomplish in the Process panel 
can be distinguished within two general types: color processing and 
luminance processing. 
 
Color processing deals with adjusting hues which make up an image. Using 
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color processing, you can apply minor alterations in the strength of a 
particular color component in order to correct a picture’s color balance. You 
can also make a radical adjustment which will completely alter the natural 
colors in the image. Luminance processing affects the relative and overall  
brightness levels of the pixels in the image, apart from their color. 
 
However, as you will see when you begin to work in this panel, the effects 
of the controls are not independent. There are many ways to achieve 
similar effects. Not only will every control affect the entire image, they will 
also interact with one another. 
 
13.5.5 Choosing what to process 
 
To process backgrounds, go to the Design Background panel and select 
the Process panel. To process a clip or animclip, you will use the Design 
Clip panel’s Process panel. In the Design Clip panel, only one image can be 
processed at a time; if you select more than one clip, the clip which was 
selected last, will be processed first. 
 
13.5.6 Process controls 
 
The Process panel includes the following controls: 
 

• Hue – shifts the hue of all colors by a constant amount, retaining 
color relationships 

• Saturation – adjusts the intensity or purity of the colors in  
the image 

• Red – controls the amount of red in the image 
• Green – controls the amount of green in the image 
• Blue – controls the amount of blue in the image 

 
Luminance controls include the following: 
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• Brightness – adjusts the brightness of the image 
• Contrast – adjusts the relationship of light and dark areas,  

increasing or decreasing contrast 
• Gamma Correction – similar to Brightness, adjusts the overall  

luminance of the image, but does not alter the lightest and  
darkest tones from their original values 

• Reset – returns the image to its original, unprocessed state, 
resetting all controls to zero 
 

Most controls are sliders, which can vary one parameter, continuously. 
The value represented by the slider’s position is revealed above the upper 
right corner of the slider. You can also select this value and directly enter a 
number. The initial value for all sliders is 0. When every slider is at 0, the 
result is an original, unaltered image. Every slider contains either positive 
or negative values, either by increasing or decreasing their associated 
parameter. Most will contain a range of -100 to +100. Because of the 
different function of the Hue parameter, its value will range from -179 to 
180. 
 
13.5.7 Using the color controls 
 
The color controls will often interact unpredictably. Keep in mind that by 
increasing one or more parameters, you may have to decrease others in 
order to retain an overall brightness or color balance in the image. 
 
Hue 
 
Hue is the basic color of a object, such as green, yellow, or red. Using the 
Hue slider will shift the colors in your selected image, producing an effect 
of re-coloring the image. Since hues are typically thought of as existing 
on a “color wheel”, the Hue slider’s value is in the form of 360 degrees of 
rotation, -179 to 180. 
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You can achieve somewhat similar tinting effects by manipulating the 
individual Red, Green, and Blue sliders. Doing so, however, will require 
coordinating the three color values. It may also involve adjusting 
Saturation or Brightness to compensate for the changes. Using Hue will 
automatically maintain the identical color saturation and brightness as in 
the original image.  
 
Saturation 
 
The Saturation control adjusts the intensity of the colors in the image. At 
the minimum value, all color is removed and the result will be a grayscale 
image. At the maximum value, the colors are greatly exaggerated, for a 
bright, cartoon-like effect. By increasing Saturation you cannot add color 
to an image which was originally grayscale. Additionally, it will not affect 
colors which were already fully saturated in the source image. 
 
Red 
 
The Red control allows you to increase or decrease any red in the image. 
Adding red makes the image “warmer”, and at high values it will tint the 
image red. Subtracting red will make the image “cooler”, generally 
resulting in a blue-green tint. Adjusting this slider will not have effect on 
any areas of an image which initially did not contain red. 
 
Green 
 
The Green control will allow you to increase or decrease any green in the 
image. Higher values will tint the image green, and lower values will give it a 
purple cast. Adjusting this slider will not have an effect on any areas of an 
image which initially did not contain green. 
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Blue 
 
The Blue control will allow you to increase or decrease any blue in the 
image. Adding blue will make the image “cooler”, and at high values it 
will tint the image blue. Subtracting blue will make the image “warmer”, 
generally resulting in a yellow tint. Adjusting this slider will not have effect 
on any areas of an image which initially did not contain blue.  
 
13.5.8 Using the luminance controls 
 
The luminance controls do not alter the color balance of the image, 
however, they will affect the overall brightness of pixels in the image. This 
will allow you to improve the appearance of an image which is too light or 
too dark. 
 
Brightness 
 
The overall brightness of the image is adjusted by using the Brightness 
control. At the minimum setting, an image can turn completely black. At the 
maximum setting, every area of the image will be extremely light. Small to 
medium adjustments of the Brightness control can correct overexposure 
or underexposure of your photographic images. Often, adjusting the 
Contrast control is effective after modifying an image’s brightness. 
 
Contrast 
 
“Contrast” describes the sharply defined differences between the 
lightest and darkest areas of an image. If the dark areas in an image are 
black or almost black, and the light areas are white or almost white, the 
image would be defined as a high contrast image. In a low contrast image, 
the tones throughout the image would exist within a relatively narrow 
range of brightness. The features in the image would blend into one 
another for a “washed out” look. 
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Increasing Contrast for photographic images, will frequently increase 
sharpness and definition to the image. Reducing Contrast on a 
photograph, or another type of image which may be used as a background, 
can tone down the details and keep the background from being visually 
distractive to any elements. Varying the contrast of an image can have a 
corresponding effect on the saturation and brightness of the image. You 
may need to adjust one or both of those parameters to compensate. 
 
Gamma 
 
The effect of the Gamma control is similar to Brightness. Gamma 
correction operates on the midtones of the image, and does not affect the 
very light and very dark areas in the image. Using Gamma Correction allows 
you to adjust the image brightness, without disrupting the image 
definition. This way, you can frequently avoid having to make compensatory 
adjustments in Contrast, after modifying the brightness. 
 
13.5.9 Tips on using the image processing functions 
 
There are three primary reasons to alter an image using the Process 
panel: 
 

• to correct a flawed image 
• to adapt an image for a particular use 
• to create special artistic effects 

 
13.5.10  Correcting flawed images 
 
The correction of flawed images is almost exclusively regulated to 
photographic images. Professional photographs, such as those found in 
the clip art and photographic image collection CD-ROMs, seldom need any 
additional retouching. However, amateur photographs are frequently 
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taken without regard to proper lighting, exposure, film stock and so on, and 
therefore are likely to benefit from additional processing. 
 
Exposure 
 
To correct moderate over or under-exposure (a picture which is too light or 
too dark), try applying the Gamma control. This will lighten or darken most 
of the image, but it will also leave the highlights and shadows unaffected. 
You can also try adjusting the Brightness control. However, be sure to watch 
the light and dark areas of the picture, to see if you are beginning to lose 
detail as the control moves farther from zero. 
 
After making a picture lighter or darker, frequently, adjusting the Contrast 
control will improve the picture’s definition. 
 
Contrast 
 
If the image seems to be flat or lifeless, with a slight haze surrounding the 
subject, the contrast is most likely low. Increase the Contrast control 
gradually until the image becomes more well-defined. As with adjusting 
exposure, look at the lightest and darkest areas of the image, and slightly 
pull back the control when you notice details becoming lost. You may also 
need to make a slight adjustment to the Gamma or Brightness controls 
after adjusting Contrast, in order to restore the image’s overall level of 
exposure. 
 
Color 
 
Sometimes a photograph’s color balance is poor, so much so that it may 
take on a slight overall tint of one hue or another. Careful adjustment of 
the color controls in the Process panel can all but eliminate this imbalance, 
restoring the appearance of a natural color. 
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Using the Hue control will not be useful to address color balance problems, 
because its effect is fairly radical and difficult to precisely control. 
Instead, use the Red, Green, and Blue controls. Make small adjustments, and 
carefully watch the effects on the image. If the problem is an excess of one 
of these three colors, you can simply raise or lower its slider. To fix a 
yellow cast, lower the Red and Green sliders an equal amount, or raise the 
Blue. 
 
Remember since you are in effect adjusting the brightness of the colors, you 
may need to compensate for your adjustments with the Saturation and/or 
Brightness controls, in order to maintain the original image’s tonal values. 
 
13.5.11  Adapting an image 
 
In many multimedia situations, a source image—whether photographic or 
drawn—may be technically perfect, but still unsuited for use in your 
production.  
 
Lowering background contrast 
 
Lowering the contrast in a background image will allow you to read small to 
medium sized text more easily. If you are presented with a normal, full-
contrast image, you can alter it appropriately in the Process panel. Bring 
the Contrast control down to 50 or more. This will considerably de-
emphasize the features of the background. Depending on whether your 
overlying text is light or dark, you may also want to raise or lower the 
Brightness for the background. In the final result, any overlying text or clips 
will stand out more effectively against the processed background. 
 
Changing brightness for emphasis 
 
Changing brightness is another type of adaptation which is frequently 
useful to make clips lighter and darker. For example, in a script which 



Designer5 
 

 
399 

 

refers in sequence to several different clips on a page. You could have 
each clip highlight at the appropriate time by transitioning in the 
highlighted version. To do this, create a highlighted clip version by adjusting 
its brightness and contrast as necessary. Then, choose File > Export to save 
the processed clip. Finally, position the processed clip directly over its 
unprocessed counterpart on the page. You can have the processed clip 
appear at the right time by using a Cut, Reveal, or Alpha transition. 
 
Adjusting palettes for video use 
 
Bright colors, especially when shown on NTSC displays, tend to bleed, or 
blend into one another, producing a blurred image. This can be avoided by 
slightly reducing the saturation of the colors in the display.  

13.6 Advanced Features: 
 
13.6.1 Creating Special Effects 
 
In many situations, your original source images will not be aesthetically 
pleasing or complementary to your page design. The Process panel allows 
you to easily apply fairly radical processing to images, thereby achieving 
eye-catching special effects.  
 
Color effects 
 
Making bold manipulations of the colors in an image is the most obvious 
way to create visual interest with the Process panel. It will also allow your 
chosen image to fit very well in an existing color scheme. Adjusting the Hue 
control will bring a dramatic change to the colors in your images. Using 
the Red, Green, and Blue controls can also produce dramatic color changes, 
however, they will also allow you to make subtle and precise adjustments 
as well. 
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Some tips on techniques and color relationships: 
 

� To produce a grayscale image from a color original, reduce 
Saturation to -100 
 

� To produce sepia-tone or other subtly tinted, near-monochrome 
images from color originals, reduce Saturation to -85, then adjust 
Hue for the basic tint, and fine-tune the tint with Red, Green and 
Blue 
 

� To add a tint to monochrome originals, use Red, Green, and  
Blue; you can then apply Hue and Saturation to further alter  
the color scheme 
 

� When working with the Red, Green, and Blue controls,  
remember which hues are complementary, thereby causing  
an effect similar to increasing one slider by decreasing the  
other two 
 

� The effect of increasing or decreasing the Red, Green, and  
Blue controls simultaneously and equally is to raise or lower  
the overall brightness of the image 
 

� Adjusting Contrast in a color image will affect the color intensity. 
You may also want to adjust Saturation to compensate 
 

� If the maximum range of adjustment of a control is not sufficient 
for your purposes, you can export the processed image, then 
reload it for further processing 
 

� Yellow is an equal combination of red and green 
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13.6.2 Creating a Color Spread 
 
One special feature of the Palette panel is automatic color spreads. This 
will allow you to easily create a series of any number of colors which will 
smoothly shade between two given colors. To create a spread in the User 
palette: 
 

1. Select a color chip on the User palette color bar. 
 

2. Click the Add button as many times as the number of steps you 
want in the spread. 
 

3. Use the color controls to adjust the last color which was added, or 
Pick a color from the page. This color will be represent end of 
the spread. 
 

4. Select the first color which was added, and simply adjust it (or 
Pick a color) which will represent the other end of the spread. 
 

5. Click on Spread. 
 

6. Click on the last color in the spread. 
 

The color chips between the first and last colors which were created will 
smoothly shade between the two colors. 
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One use for a spread is to create four colors which can be used with the 
Bevel style. Longer spreads will allow you to create interesting graphic 
effects with a series of elements. 
 
You can also create spreads in the Background and Clip palettes by 
selecting the two end colors in their respective color bars, however, the 
effect will be unpredictable. It is primarily used for special effects. 
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||||| 14  Using Animation,  
  Digital Video & Sound  
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Chapter Overview 
 
The element transitions and page transitions available in Designer add an 
amazing array of creative movement and activity to a script. In essence, it 
allows you to intuitively design smoothly flowing professional, made-for-TV-
style productions. Designer also includes an amazing library of intriguing 
animation files, or if you prefer, you can design your own, using separate, 
animation-specific software. 
 
Designer was designed to utilize nearly any type of animation, including 
AnimGIF, AVI, WMV and MPEG-1/MPEG-2. You can also use Adobe Flash 
animations as “Flashclips”. There are a few limitations, in which you cannot 
control or make changes to the contents of an animation from within 
Designer, however, you can easily adjust settings such as the speed and 
number of repetitions or loops. 
 

14.1 Glossary of Terms in this Chapter 
 

Animclip – An animated sequence of individual frames, like an 
animated GIF. 
 
Flashclip – Created in Adobe® Flash, either SWF or FLA movies. 
 
Video Clip – Any digital video movie that can be imported into 
Designer. 
 
Sound Event – An event in the Main view that controls an 
independent sound or the sound in the previous page. 
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14.2 Types of Animation 
 
Traditionally, the characters and objects in an animation were hand-drawn, 
frame-by-frame. Today, computer drawing and animation tools have 
revolutionized the way animations are created. The methods used depend 
upon a combination of hardware, software, artistic skill and imagination. 
There are three basic types of computer-generated animation: 
 

• Two-dimensional animation which is drawn, composed and 
manipulated by using a paint or animation program, or Flash. 
Animation of this type generally resembles familiar cartoon-style 
films:  

 

 
 

• Three-dimensional rendered animation. This type of animation is 
created using applications which mathematically define the shape, 
movement and appearance of objects and titling. This involves 
constructing a computer model of the image and then “rendering” 
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the model. The rendering process adds color, detailed reflections 
and texture, highlights and shadows to closely simulate objects in 
the real world: 

 

 
 
This type of animation is used for everything from automobile and 
architectural design, to television titling and special effects in feature films. 
 

• Digital video, in which a video or film sequence has been changed 
into a digital format and saved as a file. The digitized file can be 
controlled and played from a PC, eliminating the need for a VCR or 
laserdisc: 
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14.2.1 Types of Animation in Designer 
 
Designer recognizes two basic types of animation, based on file format: 
animations, which are in AnimGIF formats, and movies, which are in the 
AVI and MPG digital video formats plus SWF (Flash). Animations are 
limited to 256 colors, and are silent. Movies are inherently High Color or 
True Color, and may contain sound. Generically, both types will be referred 
to as “animations” in this manual. Typically, animation formats are used 
for cartoon-style animations, and movie formats are used for 3D 
rendered and digital video. 

14.3 Adding an Animation to a Script 
 
Any type of animation supported in Designer can be added as a clip—an 
animclip, a movieclip, or a Flashclip—in the Design panels.  
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14.3.1 Animations as Page Backgrounds 
 
When you add an animation as a background for the screen page, you 
can work with it from the Main view, just as you would any other page, 
applying sound effects or transitions and defining timing settings. Or you 
can use the Design panels to add text, clips, and other elements using the 
animation as a background. 
 
To include an animation in a script as a page: 
 
• Click on Add in the Main view. The File dialog will appear. 
• Navigate to the folder you want. 
• Look through the folder until you find your desired animation. 
• Double-click on the animation file or select it and click OK. 

 
The Design Background panel will appear. 
 
14.3.2 Animations in the Background panel 
 
You can access the Design Background panel from the Main view, when 
you double-click the page. When an animation is the selected page, the 
Image Type panel of the Design Background panel will look like this: 
 

 
 
When a movie is the selected page, the Image Type tab of the Design 
Background panel will look like this: 
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14.3.3 Replacing an animation 
 
Click the File: button to replace an animation background with another 
image background. You the File dialog will appear. At this point, you can 
choose another animation, or navigate to another folder and choose a 
different type of image background. The File dialog will also appear if you 
change the image type using the Type: selector. To replace an animation 
background with a Plain background, use the Type: selector and choose 
Plain. 
 
14.3.4 Changing animation speed 
 
The Frames per Second setting controls the speed of an animation. To 
create the illusion of continuous movement, this speed must be fast 
enough to fool the viewer’s eye. The practical minimum is approximately 
12 frames per second (fps), however, essentially all animations run at 
higher speeds to ensure their movement looks smooth. The higher or lower  
the fps setting, the faster or slower objects in the animation will appear to 
move. For example, film animations run at 24 fps, while video displays 
are 25 fps for PAL and SECAM systems, and 30 fps for NTSC systems. 
 
Although these are good guidelines to keep in mind as you consider the rate 
at which you want the animation to be displayed, there are several other 
factors which should be considered: 
 

• An animation is generally created to run at a certain speed. For 
movement to look natural, so events do not appear to happen too 
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quickly, or too slowly; a certain frame rate may be required. 
 

• If you vary the animation’s speed, and the time it takes to 
complete changes, the timing of other script events might need to 
be adjusted as well. 

 
• The animation may have been optimized to run successfully at 

slower speeds. For example, they may have been done to save 
storage space and computer resources. 

 
• The PC controlling the animation may not be powerful enough to 

handle higher speeds. Past a certain speed, for instance, the 
animation may appear to be jerky or there may not be a noticeable 
difference between one setting or another. Designer is fast and 
works with the animation as efficiently as possible, but there are 
limitations which are not within Designer’s control. 

 
At any time as you work in the Background panel, you can click on the 
Preview button to see the animation at the currently set speed. Even if you 
are familiar with the animation, you may want to experiment with different 
speed settings to test the visual effect at different rates. To change and 
test the animation speed setting: 
 

1. Use the Frames per Second value control to change the setting. 
The range of speed depends upon the animation. The lowest 
setting, one (1) fps, is slow enough so you can see each frame of 
the animation as a separate image. The upper limit is 50 fps. 
 

2. Click on Preview to see the animation and, when it is finished, 
press Esc or either mouse button to return to the Design 
Background panel. 
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14.3.5 Repeating an animation 
 
Loops allows you to specify the number of times an animation or movie 
plays before the next page of the script is displayed, or the animation 
stops. You can specify a number between one (1) and ninety-nine (99), or 
an “infinite repeat” setting. This last setting will repeat infinitely. This is very 
useful when you don’t know exactly when the animation should stop. 
 

 
 
In addition to the setting defined for Loops, the animation is also influenced 
by the duration setting defined in the Timing panel for the animation as a 
page in the script. 
 
When Loops is infinite, a Duration setting will stop the repetition. If you 
need an animation to loop for an indefinite length of time, you need to 
provide a means to allow the script to advance, such as directing the 
viewer to click the mouse. Otherwise, the animation will continue to run. 
 
When Loops is set between 1 and 99, the animation may not play the 
specified number of times, because the duration time will override the loop 
setting. For example, if three repetitions of the animation take more than 
the 10 seconds as defined in the Duration setting, the animation will be 
cut short after 10 seconds has elapsed and the script will proceed to the 
next page. 
 
Regardless of the setting defined for Loops, the animation will stop 
when a mouse button is pressed. Pressing the main mouse button will 
reveal the next page in the script, while pressing the secondary mouse 
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button will display the previous page. 
 
14.3.6 Stopping on the first frame 
 
Some looping animations are designed so the final frame shown when 
the animation ends, is either the first or the last frame of the animation. 
Because the final frame is often used as a freeze-frame background for 
subsequent material, this can be very important. 
 
The Stop on First? button will allow you to specify which frame of an 
animation should remain visible after the animation ends. This option is off 
by default. When an animation completes its given number of loops, the 
screen will show the last frame of the animation. When Stop on First? is on  
the animation will advance one more frame to the beginning of the loop, 
so the first frame of the animation will remain on the screen. 
 
14.3.7 Playing a specific part of a movie 
 
The Start Time in HH:MM:SS.hh? and End Time in HH:MM:SS.hh? controls 
allow you to play a subsection of a complete movie. The default is to play 
the entire movie. To exclude some part of the beginning and/or end of the 
movie, turn on the Start Time and/or End Time buttons as necessary. 
Turning these buttons on will activate their associated value controls. These  
will allow you to specify an offset time from the beginning or end of the 
movie. 
 
To have the movie start playing at some point later than the actual 
beginning, use the Start Time control to set the delay time (in hours, 
minutes, seconds, and hundredths). To have the movie finish playing at 
some point before the actual end, use the End Time control to set the 
length of time from the actual beginning, to the desired stop point. 
 
Movies also contain the Loops option, which function the same as 



Designer5 
 

 
414 

 

described in the preceding section. However, the frame rate and 
stopping frame in a movie are fixed, so the Frames Per Second and Stop on 
First? options are not available. 
 
14.3.8 Adjusting the volume of a movie 
 
If the animation is an AVI, MPEG or other supported digital video 
segment, it may also contain sound. You can adjust the volume of the sound 
with the Volume slider in the Image Type tab on the Design Background 
panel; which will appear only when there is a movie background. 
 
14.3.9 Putting elements on top of a movie 
 
Any kind of element can be placed on top of a page background containing 
a movie or animation. This wasn’t true for previous versions of Designer. 
 
14.3.10  Transitions with Animations and Movies as Backgrounds 
 
You can give an animation a transition in the Main view, just like any other 
page. When the page plays, Designer keeps the animation or movie 
background running as the transition changes from one page to another. 
For example, if you have a 20 second movie as a background, and a 5 
second fade or dissolve transition applied to the page, then the preceding 
page will fade out as the movie in the background in the following page will 
start at the same time as the transition, and continue to play the movie 
until the transition to the next page begins. 
 
14.3.11  Using Sound 

 
Any type of sound – music, voice-overs, sound effects – can be used to 
enhance an Designer script. 
 
The right sound applied at the right time, will not only attract attention, but 
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it will also create a more vibrant viewing experience. When synchronized 
with on-screen activity such as text or page transitions, sound will add life 
to your message. A simple voice-over recording can often replace pages 
of less dynamic text. Adding sound will also attract and maintain the  
interest of your audience. Sound is yet another element which will enable 
you to create and present your production with broadcast television quality. 
 
When the Sound button in the List panel or Main view is blank, it indicates 
sound is not being applied to the element or page. When you click on a 
blank Sound button for the first time during an Designer working session, 
the Sound panel shown in the preceding illustration will appear. Otherwise, 
the panel for the type of sound you worked with most recently for that 
specific event will be shown. 
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When the Sound button is not blank, it means a sound event is already 
being applied to the element in the List panel, or page in the Main view. The 
text on the button specifies each sound event which is currently being 
applied; that is, the type of sound and the command defined. 
 
For example, in the page row shown above, the Sound button indicates 
that when the script reaches page 2, a sound sample is scheduled to play.  
 
When you click on a Sound button containing text, the Sound panel and the 
panel for that particular type of sound event will appear. 
 
14.3.12  Supported Sound File Types 
 

The only sound files which work directly with Designer are MP3, WMA and 
WAV. 

14.4 The Sound panel 
 
The Sound panel will appear when you click on a button in the Sound 
column corresponding to an element in the List panel, or a page in the 
Main view.  
 

 
 
In the Sound panel, there are a few options from which to choose. 
 

� The Command: selector in the upper left corner of each panel, 
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determines which options will be seen. Clicking on the Command: 
selector will show you the list of possible commands associated 
with that particular type of sound. When you choose a command, 
the selector will reveal the name of the command. Additionally, 
the set of applicable controls for that command, if any, will appear 
in the panel. 

 
� The File: selector brings up a File dialog when clicked, allowing 

you to select the file you wish to use – or change to another 
file/file type. The selectable file types are MP3, WAV and WMA 
files. 

 
� The Wait? button will instruct the selected sound file to wait for 

the page or event to complete, before proceeding. 
 

� The Loops selector will allow you to select how many times you 
want your sound to repeat from 1 to infinity. 

 
� The Fade In Time selector will allow you to fade in the selected 

sound over a period of time, using the numerical Speed settings. 
 

� The Volume slider adjusts the sound file’s playback volume. 
 

� The Pan slider allows you to adjust the left to right panning of the 
sound file playback. 

 
14.4.1 Sample Play command 
 
This command enables you to select a sample file and access the 
command panel for sampled sounds. The default command, Play is selected 
and the following options are listed on the panel. 
 
Loops defines the number of times the sample is played before the next 
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page in the script is displayed, or the sample is stopped. You can specify a 
number between one (1) and ninety-nine (99) or an “infinite repeat” 
setting   . 
 
The infinite repeat setting is useful when you don’t know when the event 
should stop. For example, you may want music to continue playing in the 
background when your script is playing. 
 
Use the Loops value control to define the number of plays you want. If the 
setting is infinity, the sample doesn’t stop until the next time a sound 
sample Stop command is encountered in the script or it is otherwise 
interrupted. The default setting is 1. Volume controls the loudness of the 
sound. Adjust the volume by dragging the slider to the position you want on 
the volume control. The sound gets progressively louder as the slider 
moves from left to right. 
 
The intensity and quality of the sound which is heard at the minimum and 
maximum settings, is determined by the sound card. Normally, there is not 
audible sound at the lowest setting; however, from some cards you may 
hear low-level noise when the sound is amplified by your audio system or 
computer speakers. 
 
To ensure the highest sound quality from the card, it is common to first set 
the volume in the Play panel to the maximum level and adjust the volume 
of the external amplifier as necessary to produce the loudest sound 
required. Then go back to the Play panels of the individual sounds and set 
the Volume sliders to the desired levels. 
 
The volume setting is at the maximum level by default. 
 
Fade In Time allows you to gradually increase the volume of the sound 
from zero to the level set on the Volume control. 
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The setting ranges from zero (0) to ninety-nine (99) seconds. When the 
setting is zero, the sound sample starts to immediately play at the loudness 
level defined by the Volume control. 
 
Use the Fade In Time value control to make the adjustment. The default 
time is zero and there is no fade-in period. 
 
If you have a stereophonic (stereo) sound card and amplification system, 
the Pan control changes the balance of the sound going to the left and right 
channels, moving the position the sound appears to be coming from. When 
the slider is in the center position, the same amount of sound is produced 
by each speaker. If the speakers are positioned equally to the left and 
right of the listening audience, the sound is heard as though it is coming 
from a position in the middle. 
 
Dragging the Pan slider to the left or right of the center will increase the 
amount of sound coming from one speaker, as it decreases the amount 
coming from the other. For example, when the slider is at the far left of the 
control, no sound will emanate from the right speaker. 
 
Changing the Pan setting of the sound can be very effective when the sound 
is coordinated with the position of an element on the screen. 
 
Unless you specifically change the setting, Designer assumes the sound 
should be balanced and the Pan slider is in the center position. If you have 
a monophonic (mono) card or system, adjusting the Pan control will not 
have an effect. 
 
Wait? instructs Designer to wait until the sound event is finished before 
proceeding to the next event in the script. When Wait? is on, nothing new 
will happen in the script until the sound event is complete. 
 
Duration overrides any wait setting. For example, if the sound sample you 
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are using is 15 seconds long, and a duration setting applied to the 
element or page is 10 seconds, the sample will be stopped before the 
script continues to the next page. 
 
If Wait? is off, after the sound starts, other script events will occur 
according to schedule. The sound can continue in the background as the 
script progresses, until it stops naturally, stops because it has completed the 
number of repetitions you defined in the Loops setting, or stops because 
you define a sample Stop command later in the script. 
 
NOTE: When Loops is infinite, the Wait option works like this: if Wait? is on, 
the sound continues until the page advances from interactive input. If 
Wait? is off the page advances when all remaining elements on the page 
have completed. 
 
14.4.2 Sample Wait command 
 
Like the Wait? button, the sample Wait command causes script execution 
to stop and wait for the completion of a sound sample event. The 
difference is the Wait? button is an additional option for the current sound 
sample event (which may be to play a sample, or fade it out, etc.). The 
sample Wait command stands on its own, and will cause the script to wait  
for a preceding sound sample to finish playing. It will ensure the current 
element or page continues to be displayed until any sound samples are 
done. 
 
In other words, you use the Wait? button only when you want the script to 
pause and wait for the sound event. Use the Wait command when on an 
earlier sound event you needed the script to continue— you left its Wait? 
button off—and now at a later point you need the script to wait for the 
sound event to finish. For example, you may need to ensure narration 
which accompanies the on-screen activity for several pages has completed 
before the script proceeds to the next explanation, or series of events. 



Designer5 
 

 
421 

 

 
The Wait command does not have parameters, therefore, its command 
panel is blank. 
 
14.4.3 Coordinating several sound events 
 
Designer will allow you to play as many sound files at a time as you want. If 
there are several continuing sound samples in the script, the sample Wait 
command will wait for every sample to complete, before continuing the 
script. 
 
When you need to ensure that several events continuing over several 
pages must be finished before the script continues, a useful option is to 
group pages in the Main view. When you apply the Play sound event to the 
group, you must also ensure the Wait? button in the command panel is on.  
 
14.4.4 Sample Stop command 
 
This sound event stops all sound samples currently playing. The Sample 
panel for the command looks like this: 
 

 
 
The function of the Fade Out Time control and The function of the Fade 
Out Time control and the time range available is the same as the Fade In 
Time control in the Play command panel. In this case, however, the time 
specifies the number of seconds which Designer should use to reduce 
(rather than increase) the volume of all the samples currently in effect. 
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The volume levels of the sound samples may vary when a sample Stop 
event begins, but they are all reduced to zero during the time allowed. 
For example, when the Fade Out Time is 3, all sound samples will diminish 
in loudness until, after the three second period defined, all sounds will be 
off. 
 
The default fade-out time is 0— sampled sound will immediately stop. 
 

 
 
Wait? is available only when a non-zero fade-out time is specified.  
 
The Wait? setting does not have priority over duration. For example, if the 
Fade Out Time is 10 seconds and the duration applied to the element or 
page is 5 seconds, only 5-seconds of the fade completes before the script 
continues. 
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14.4.5 Staying aware of your sound events 
 
As you work in the Sound panel, the text on the button in the Sound 
column is constantly updated to reflect the sound event you are currently 
defining, along with any others which have already been applied to the 
element or page. 
 
It is not possible, however, to look at the Sound button to determine if any 
sounds are playing at that point in the script. Even if the Sound button for 
one page or element is blank, a sound event which was started earlier with 
the Wait? button off, may still be playing. This means you must be aware of 
the sounds you are using in the script and their playing lengths. In most 
cases, it will be obvious when the effect of a sound is not what you 
intended. 
 
14.4.6 Play from Input Command 
 
The Play from Input Command lets you specify which type of audio capture 
input to listen to. 
 

 
 
When you select Play from Input from the Command list, you  
see a list of commonly supported audio capture line types: 
 

� Line in 
� Auxiliary 
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� Microphone 
� CD 

 
This list is not intended to represent the actual audio capture lines available 
on this computer’s audio card, and not all audio cards will support all of 
these types. 
 
14.4.7 Adding sound to several pages or events in a row 
 
When you have defined the sound events you want to apply to one element 
or page, you may click on another Sound button in the List panel or Main 
view and continue working in the Sound panel. As with the Wipe and Timing 
panels, this will confirm the settings you have just defined, without 
requiring you to close the Sound panel each time. Clicking on Cancel in the 
Sound panel will reset or cancel only the last sound event you worked  
with. 
 
When you have defined the sound events you want, click on Close to close 
the Sound panel. Click on Preview in the Page or Main views to test the 
effect of the sound events you have defined in the total scheme of the page 
or script. You can open the Sound panel and work in it at any time to refine 
your settings as necessary. 
 

14.5 Advanced Features 
 
14.5.1 Streaming Video 
 
A video file which is streamed on the Internet can also be used in your 
script, as long as the player has access to an uninterrupted Internet 
connection on the network. 
 
You can use a streaming windows media file as a background for a page, 
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similar to the above method - but instead of selecting a file from the File 
dialog, you will type in the URL of the movie file location and click the Open 
Button. This will place the file on the background of your page. 
 
To add a streaming windows media file to a page as an element, select 
the Streaming Video Clip option from the Add pull-down menu and type 
in the URL of the movie clip location. 
 

 
 
To add a streaming windows media file to a page as an element.  
 
You will see a dialog box. To specify the video source, type the URL to a 
Windows Media stream: 
 

� The http://URL to a Windows Media redirector file (which is 
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typically a .wmv or .asx file) 
 

� The mms://URL to a Windows Media video stream (which is 
typically a .wmv or .asf file) 

 
� The http://URL to a Windows Media video stream (which is 

typically a .wmv or .asf file) 
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Chapter Overview 
 
Many of the scripts we have used as examples have been relatively simple. 
They proceed from the first page to the last, playing every page and event 
in the order in which they appear in the script. 
 
However, there are also situations in Designer 5 which call for a script to 
execute in a non-linear fashion—that is, for pages and events to run in an 
order other than which they appear in the Main and Page views.  
 
This chapter will cover the Branch panel, and various usage of  
sub-scripts. 
 

15.1 Glossary of Terms in this Chapter 
 

Branch – Allows you to create variables and set their values, 
create expressions, use system functions and redirect script flow 
to create loops and other non-linear execution flows. 
 
Variable – A named “container” for a quantity which can change 
within a script in response to user input or a condition in the 
script’s execution; in addition to simple numbers and strings, a 
variable may also contain expressions. 
 
Expression – An expression is a statement which uses variables 
with arithmetic operations, such as addition and multiplication, as 
well as logical tests and comparisons. 
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15.2 The Branch Panel 
 
The Branch panel is primarily used when you want to branch from a script’s 
usual top-to-bottom (first-to-last) flow, or create new variables and 
change their values. 
 
A script’s flow is basically the sequence it follows when executing the 
corresponding pages and events. The Branch panel is available on the 
Main view and the Page view, allowing you too easily branch within 
pages, and from page to page. However, you cannot branch directly from a 
page to an element. Branching is necessary to ensure certain events 
happen (or do not happen) within specific situations.  
 
A branch can jump to a different location in the script, control whether a 
page or event will appear, or repeat a group of pages within preset 
parameters. Since branching often depends on the value of variables, the 
Branch Panel will also allow you to set and change their individual values. 
You can even combine options, like changing a value only if a condition is 
true.  
 
15.2.1 Exploring the Branch Panel 
 
To open the Branch panel, click the button in the Branch column for an 
existing page, element, group, sub-script or special event. The Branch 
panel has four Tabs from which to choose, including: Condition, Set 
Variable, Repeat and Go To. All branch events require additional 
information which define when and where the script should branch. The 
Condition and Repeat Branch panels are very similar, based on the Set 
Variable panel, and list system variables, functions and operators you can 
use in determining how to branch. 
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The Go To panel has no controls other than the Action: selector,  
except when the Go to Event or Show WWW page is chosen. 
 
Click one of the tabs to display the panel for one of the three  
types of branch events: 
 

� Condition 
� Repeat 
� Go To 
 

15.2.2 Condition branches 
 
This branch decides whether to execute an event depending on certain 
conditions. Said conditions are specified in the Show If Expression: text 
box. When the event for which you specify this type of branch is a group, 
you can conditionally execute or skip an entire series of events. 
 
The condition is usually an expression involving one or more variables. For 
example, the condition might be the expression “number > 95”. An event 
having this condition would execute if the value in the variable SCORE was 
greater than 95.  
 
15.2.3 Repeat branches 
 
The Repeat While and Repeat Until branches effectively repeat a group of 
pages. Additionally, they have slightly different methods of checking when 
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a loop is finished. Both branches may also be used to repeat an event, or 
group of events. Similar to the Show If branch, Repeats require a 
condition such as attempts = 4 in the text box. When the condition is true, 
the event with the Repeat While branch will be executed. When the 
condition becomes false, the script will continue to the next event.  

15.2.4 Go To branches 
 
As the name implies, a Go To branch tells the script to go to another point. 
It does not require a condition; it will always branch when it is reached by 
script execution. A Go To can be made conditional, by combining it with a 
Show If branch. In the Level: selector, specify the level of the script which 
contains the destination location, (the path to its group, if any). Then, using 
the Go To: selector locate the name of a page or event to provide a target 
for a Go To event. The Leave Bookmark? option makes it possible to return 
from a Go To branch. The bookmark is set immediately after the Go To. 
Once the script has finished in the target location, it will return and resume 
running from that point.  

15.2.5 A simple Go To Branch 
 
Using a Go To does not require variables or conditions. Following is a 
simple example: In the Branch column, click the button for the event after 
which you want the Go To to happen. The Branch panel with the Go To 
panel will appear. 
 

1. From the Action: selector, choose Go to Event. 
 

2. Click the arrows on the Go To selector to choose the name of the 
destination page or element. The selector will step through the 
potential destinations. In the display box, a miniature image of the 
destination page will appear. 
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3. Click OK to accept the modified event and close the panel. 
 
The script will navigate to the new location after it completes the event 
where the Go To was placed, skipping any interim events.  
 

 
 

15.3 Using Variables and Expressions 
 
The Designer Branch panel is used to create and modify variables and 
expressions. These expressions are used as the basis to branch to another 
part of the script.  
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15.3.1 Variables 
 
A variable is a “container” for a quantity which can change within a script. 
Because you can name variables, you can refer to what they hold by their 
names, regardless of the actual value. For example, you can create a 
variable which keeps track of how many times a page has been played 
with a name, such as “iterations”. You can also increase it for each time the 
page has played, and display its current value on a page at any time by 
referring to its name. 
 
There are four variable types in Designer: text, logical, integer, and real.  
Designer also contains various system variables. New EX Modules can 
make additional system variables available. Please refer to appendix A for 
a list of available system variables. 
 
15.3.2 Expressions 
 
An expression is a statement which uses variables with arithmetic 
operations such as addition and multiplication, logical tests and 
comparisons such as >= (greater than or equal to) and OR, and functions 
such as LEFT() which can manipulate variables.  Designer will evaluate an 
expression as a numerical value, a text value, or a logical value (TRUE/FALSE, 
ON/OFF) depending upon the type of expression.  
 
NOTE: To make the text easier to follow, variable names will be shown in 
small caps and functions and logical operators in ALL CAPS. However, 
you do not need to use capitalization when you use variables, functions or 
operators. You may also use mixed-case or lower-case.  
 
Some examples of expressions which assign values to variables  
are: 

 
• SEVEN=4+3 
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• ITERATIONS=ITERATIONS+1 

 
 
The result of the expression evaluation can either be placed in a variable, or 
its logical value (true or false) can be used as the basis for a decision by 
one of the branching instructions. 
 
15.3.3 Operators 
 
Operators are the symbols and keywords which are used with variables to 
construct expressions (see the preceding examples). Familiar operators 
include the arithmetic operators + (plus), - (minus), * (multiply), and / 
(divide). Other operators, such as ** (exponential), <= (less than or equal 
to), and NOT, perform logical, relational, or advanced arithmetic 
functions. Please refer to appendix A for a list of operators available in   
Designer, along with some additional examples. 
 
15.3.4 Functions 
 
A function is an automatic procedure. It can take text or numeric input 



Designer5 
 

 
436 

 

(constant values, variables, or expressions) and as a result, will return a 
value. You can use a function in an expression, as in the nameletters 
example above: LENGTH(str) takes a string as input, and returns a number 
which is the text length in characters. A function such as ABS() will take a 
number as input and will return a number. A function can also be used as a 
complete expression. 
 
Function syntax, for the most part, is fairly simple. A function always has 
one or more parameters after the function name, enclosed in parenthesis. 
If there is more than one parameter, they will be separated by commas. 
An example of a multiple-parameter function statement is: 
 
RANDOM(1,LENGTH (name)) 
 
This exhibits how one of the parameters of a function can be a function, in 
this case, one which provides a variable as its parameter. Please refer to 
appendix A for a list of functions which are available in Designer, as well 
as some additional examples. 

15.4 Creating Variables and Expressions 
 
When a variable is set to an initial value in the Set Variable: text box, a 
dialog will appear which will allow you to create a new variable by the 
same name. Simply choose the proper type: Text, Logical, Integer or Real. 
The first set of bulleted points under the previous heading, “Expressions”, 
will show examples of what you could enter in the Set Variable: text box 
to establish or change a variable value. 
 

• The variable creation dialog also offers the choice to make 
variables “external”, or common to any scripts where the current 
script is a sub-script. This will allow the scripts and sub-scripts to 
communicate through the shared values of the external variables. 
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• In order to facilitate entering expressions, the Branch panel reveals 

scrolling lists of the currently available system variables, 
functions, and expression operators. Variables which you can 
create in your script, are also shown at the top of this list. Simply 
click the items in the lists to add them to the expression in the text 
box. 
 

• Variable names can be up to 32 characters long, and can contain 
letters, numbers, and dots (.), and must begin with a letter or 
underscore (_). Names must be unique within a script. 
 

• A string is indicated by enclosing text between double quote marks 
(“”) as in the fourth of the preceding bulleted examples. Text 
variables in Designer can accept strings of any length, which may 
also contain any ASCII character. 
 

• Numeric variables can be either Integer (whole numbers, like 8949, 
0, and -23) or Real (decimal numbers, like 3.14159, 0.00007, and 
1088.6). It is possible to format integers for display as fixed-
point figures such as monetary values. 
 

• Logical variables and expressions can have one of two values, 
either TRUE or FALSE, which can also be given as the equivalent ON 
and OFF. 
 

• Although Designer is designed to ignore spaces, when creating or 
referring to variables, expressions, and functions, you can use any 
number of spaces between names and operators to help make 
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them more readable.  
 

• Designer ignores capitalization in variable, function, and operator 
names; you can use any combination of uppercase and lowercase. 
For example, Count, count, and COUNT would all refer to the 
same variable. Capitalization is not significant within strings: 
the string “Japan” is considered the same as “japan”. 
 

• Parenthesis are used to indicate the order in which operations 
should be performed. As in ordinary arithmetic, portions of an 
expression within parenthesis are evaluated before portions 
outside the parenthesis, and the innermost portions are evaluated 
first. The number of left and right parenthesis in an expression 
must match. 

15.4.1 To Create a Variable: 
 

1. Click on a button in the Branch column for an existing event. (Or 
choose Add Special Event from the Add drop-down, and then click 
the event’s Branch button.) The Branch panel will appear. 

 
2. If the Set Variable panel does not appear, click its tab. 

 
3. In the Set Variable: text box, type a name for the variable. It 

should be brief but descriptive, so you will recognize its function 
when you see it in different parts of the script. 

 
4. After the name, enter an equals sign (=) and an initial value for 

the variable. This can be an explicit value, or a variable, 
expression, or function, whose ultimate value is used. 
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• For an integer variable, the value can be any whole 
number between -2,147,483,648 and 2,147,483,647, or 
any expression which evaluates to a number within 
that range. 
 

• For a real variable, the value can be any number 

between approximately -3.40238 and 3.40238, or any 
expression which evaluates to a number within that 
range. 
 

• For a text variable, the value can be text of any length. 
Any “literal” text must be enclosed in double quotes: 
“Oscar”. Designer will preserve any capitalization, or 
spaces.  
 

• For a logical variable, the value can be ON or OFF. You also 
can use TRUE or FALSE, which are synonyms for ON and OFF 
respectively. 
 

• If you do not know what the initial value will be, you can 
enter a 0 for a numeric variable, two double quote 
marks for a text variable or FALSE for a logical variable. 

 
5. Press Enter. 

 
6. A dialog appears asking if you want to create this variable, and 

asking for a variable type. Choose Text, Logical, Integer, or Real. 
 
7. You can also choose to make the variable an external variable. If 

the script in which you are working is a sub-script, and you want 
the variable’s value to be available to the script(s) above it in the 
script structure, turn on the External? option. If the current script 



Designer5 
 

 
440 

 

is not a sub-script, making its variables external will not have an 
effect. 

 
8. Click Close to close the panel. 

 
Once a variable has been created, it can be referred to anywhere in the 
script without bringing up the corresponding prompting dialog. However, if 
you refer to a variable before the script has executed an event which 
explicitly assigns it a value, the variable will defer to a default value. For 
numeric variables, the default value is 0, for text variables, it is an empty 
string (“”), and for logical variables, it is OFF (FALSE). 
 
Once you have created a variable, it will remain the same type as when it 
was created (numeric, text, or logical). If you attempt to assign a different 
type of value, an error dialog will appear.  
 
15.4.2 Using variables 
 
Some of the most common situations in which you use variables include: 
 

• When you need to make a calculation or decision based on an 
input which can change. 

 
• When using a Repeat function on the Branch panel, to count the 

number of repetitions in a loop. 
 

• When you need to display information which has previously been 
entered, or was generated within a script. 

 
Defining constant values 
 
At times it is effective to define a variable for a value which is 
“constant”—not meant to change within the script. You can use the variable 
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name wherever you need the constant in your script. If at some future time 
the constant value must be changed, you won’t have to globally change it in 
your script. The constant value only needs to change in the location where 
you assigned it its constant value. 
 
Displaying variable values 
 
To display a variable value in a script, type the variable name preceded by 
an exclamation point (!) in any screen text, string, or text variable. When 
the script runs, Designer will automatically substitute the variable value for 
this variable reference. 
  
Displaying variable values not only works for your created variables, but 
also for system variables, such as time. It also works for expressions. For 
example, !(3+2) would display as “5”. When you embed a variable or 
expression in text, the displayed value will take on the same font and styles 
as the variable reference. Make sure your page layout allows for the 
longest possible value of the variable, otherwise the text could run off the 
screen, or the line could wrap to another line. When you embed functions 
or expressions, always put them in parenthesis, as in the example above. 
 
NOTE: For variable display to work there must not be any space between 
the exclamation point (!) and the variable name; and there must not be a 
style difference. When displaying the value of expressions, the entire 
expression must be enclosed in parenthesis. 
 
Auto-updating 
 
One special feature of the variables in Designer is auto-update: even after 
you have displayed a variable on the screen, if the value of the variable 
changes, the display will automatically update to reflect the new value. This 
is easy to see with variables such as TIME. Try running a script with the text 
line, “The time is: !TIME.”—you have created a simple on-screen clock! How 
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long a variable will continue to update is directly affected by the Update 
option on the Misc panel of the Element Design panels. 
 
Formatting numbers to display decimal values 
 
Although Designer can use decimal (floating point) numbers, you may want 
to use it to calculate and display fixed-point values, as in decimal 
monetary systems. You do this by starting with values which are 100 times 
their actual values, and then using Designer’s FORMAT(fmt, num) function, 
or embedded formatting codes, to display final values with two decimal 
places to compensate. For example, in a dollar-based system, this means 
you would convert all dollar amounts to cents. Therefore, if you wanted to 
add $24.95 and $17.02, you would actually add 2,495 and 1,702, which 
equals 4,197. The FORMAT() function will allow this to be displayed with 
two decimal places: 41.97. The formatting characters used by the 
FORMAT() function may also be used in embedded variables:  
“The cost was !(4197,“##.##”)”.  

15.5 Controlling Script Flow with Branches 
 
This section explains how and when to use the branching events in a script. 
 
Some important facts to keep in mind: 
 

• The events with branches can be groups, therefore, the branches 
can apply to more than one page. Grouping pages so you can 
adjust the flow of more than one page at a time is in fact one of 
the main uses of the Group option. Collecting related pages into a 
series makes it simpler to use branches to repeat - or avoid 
executing – the related pages. 
 
When using both Go To branches and grouping in the same script, 
you must plan carefully. You cannot branch into a group, only to a 
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group as a whole. Because of this, grouping pages that are the 
destination of Go To branches from outside the group is not 
possible without modifying those branches. If you attempt to 
group a Go To destination event without including the Go To itself 
in the group, a dialog explaining that this cannot be done will 
appear. 
 

• More than one branch can be combined on a single event; for 
example, you can use Show If with Go To or one of the Repeat 
branches. 
 

15.5.1 Using Show If 
 
Show If Expression literally translates into words and action: “If this 
condition is true, then show this event.” If the condition is not true, the 
event will be skipped, and the script will continue with the following event. 
 
The condition can be any logical expression which is legal in Designer. 
Because expressions in Designer can use logical operators, you can also use 
the condition to make more complex comparisons. Show If may also be 
combined with Go To and the Repeat branches, to make those operations 
conditional.  
 
15.5.2 Using Repeat While and Repeat Until 
 
The Repeat options provide an important “labor-saving” capability. You 
use Repeat While and Repeat Until when an action must be repeated 
several times. You can use these events to repeat a single event several 
times, or repeat a series of events. This is easily visualized: script execution 
runs through the series of events, then at the end of the series, jumps or  
“loops” back to the top of the series to repeat the loop. 
 
Which loop? 
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The difference between the two types of loops is the point in the loop 
where they evaluate whether the “while” or “until” condition is true. 
Repeat While evaluates the condition before executing the contents of the 
loop; Repeat Until evaluates the condition after each time through the loop. 
Repeat Until will always execute the events in the loop at least once. 
Repeat While, however, will look at the condition before starting the  
loop. If the condition isn’t true when the script first reaches the loop, the 
loop will be skipped.  
 
Another way to think of the difference is that Repeat While loops will 
continue while the condition is TRUE, but Repeat Until loops will continue 
while the condition is FALSE (until it becomes TRUE). 
 
You can use either type of repeat, by varying how and when you initialize 
the condition expression. Either type of repeat may require a special event 
to set the condition expression. This expression, which is evaluated to 
determine whether the loop should repeat, could have its initial value set 
within the loop, or before the loop. 
 
Generally, if the value of the variable used in the condition is set 
somewhere earlier in the script, it is easier to use Repeat Until. If the loop 
is self-contained—that is, its condition variable is created and set within the 
loop—Repeat While may be easier to use. The two types are mutually 
exclusive; a loop cannot be both a While and an Until loop. 
 
Following are some examples to illustrate when and how you would use 
loops. 
 
Defining a loop 
 
In the Branch panel click the Repeat tab and then use the selector to 
choose Repeat While or Repeat Until for the event. To define a loop, 
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group the page or series of pages which you want to repeat, then apply 
the Repeat branch to the group. 
 
Example 1: A simple loop 
 
This is the smallest and simplest loop. This example performs a page 
transition three times using Repeat While and a counter variable which 
keeps track of how many times the loop has been repeated. Here is a flow 
chart showing what it does:  
 
 

 
 
Step 1 is where Repeat While does its work: it decides whether to continue 
to the page event—the transition—based on the value of the count 
variable. Once count equals 4, the script exits the loop and goes on to the 
next page. 
 
To Create this Loop: 
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1. Create three pages with different backgrounds. On the first, put 
the text, “Going to loop...”, on the second, “Looping”, on the third, 
“Done. I Looped !count.”. (Be sure the exclamation point does not 
have a space after it.). Give the “Looping” page a pause of 1 
second. 
 

2. Click the Branch button for the first page to open the Branch 
panel. 
 

3. In the Set Variable panel’s text box, enter c o u n t =0. 
 
The Variable Definition dialog will appear. Choose the Integer 
variable type and click OK to create and set the count variable. 
 

4. Click the Branch button for the second page, and enter 
count=count+1 in the Set Variable: text box. 
 

5. Click the second page’s Transition button. In the Page Transition 
panel, give the page the ScrollDivide transition, and click Close. 
 

6. In the Main view, click Edit and choose Group to group the 
second page. 
 

7. Click the Branch button for the resulting group. 
 

8. Click Repeat, and make sure the selector reads Repeat While. 
 

9. In the Expression: text box, enter c o u n t <4. Click OK to exit the 
panel. 

 
In the Main view, the Branch button for the first page will read “Set”, and 
for the group it will read “Repeat”, reflecting your settings. Run the 
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script. After you click on the first page, you should see the “Looping” page 
transition onto the screen four times, followed by the “Done!” page. 
 
When Designer runs this script, it will notice there is a Branch event. Since it 
is a Repeat While instead of a Repeat Until, Designer will look at the variable 
c o u n t first. The first time it is tested, count has not reached 4, therefore, 
Designer will move to the page event—the page transition. Then the loop 
counter (count) is increased, and Designer goes back to the top of the 
loop. For a While loop, the condition test is at the top. After the fourth time 
however, the count equals four, therefore, Designer will display the third 
page. In this case, setting count equal to 0 is not necessary, because  
Designer sets numeric variables to zero when it starts a script. However, 
it is good to get into the habit of giving your loop counters a starting value, 
because a script will not always restart before its loops are run again; 
additionally, you may need to start a loop with a value other than zero. 
 
An infinite loop is one which will run “forever”. Eliminate steps 2 
through 4 above, and for the loop condition, enter TRUE. Since the 
condition is true by definition, the loop will always pass the condition test, 
and never exit. If necessary, an infinite loop like this can be jumped out of 
with a Go To. 
 
Example 2: A multiple-event While loop 
 
To create a While loop with additional events is basically the same as in 
Example 1. Simply group the events in the loop, and apply branching 
events to the group. 
 
To create a loop containing several pages: 
 

1. Create the pages you wish to loop. In the Main view, arrange 
them in whichever order you wish them to appear. 
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2. Select the pages you want in the loop (use Shift-click or Ctrl-
click). 

 
3. From the Edit drop-down in the Main view, choose Group. A new 

group page in the Main view will appear. (You may want to change 
its name to indicate it is a loop.) 

 
4. Enter the Branch panel and as described in steps 2–4 of Example 1, 

set up the Repeat While and counter variable as necessary to 
repeat the loop the proper number of times. 

 
You may also rename the counter variable, choose any number of 
repetitions, and otherwise customize the loop to your individual 
specifications. 

 
For this loop it is just as easy to use either type of Repeat, by reversing the 
comparison. To accomplish the same thing using Repeat Until, you set up 
the loop the same way, except choose Repeat Until, and for its condition, 
enter count >=4. 
 
Example 3: A multiple-event Until loop, indefinite length 
 
A loop does not need to have a predefined number of repetitions. You can 
have a loop which repeats until some expression becomes true.  
 
You would set up this loop as the preceding examples, except you do not 
have to set up a counter variable. (You may set up a counter for a reason 
other than controlling the number of repeats. Your condition expression 
would be something such as name=“Apollo”. 
 
Example 4: A loop with more complex variable usage 
 
Once you understand how to make simple loops with counter variables, you 
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can start using more complex expressions. You could make the loop 
condition dependent on two or more variables, and use operators such as 
AND, OR, and NOT to make more comprehensive decisions. You can also 
create special events as necessary, to set variables at predetermined 
places in a loop. 
 
Example 5: Conditional loops 
 
You can specify both Repeat While/Repeat Until and Show If for a group, to 
create a conditional loop. The Show If is evaluated first, and the loop will 
be skipped if the condition is not true. To do this, simply set up the loop, 
then, after specifying the loop condition in the Branch panel, click the 
Condition button and enter the expression which must be true for the loop 
to be executed. 
 
Example 6: Jumping out of a loop 
 
In the loop condition, it may not possible to cover every possible situation 
under which you might want to exit a loop. In such cases, a conditional Go 
To can jump out of a loop based on another factor, even though the 
Repeat expression is still true. 

15.6 Using Go To Actions 
 
Go To actions are the most powerful of the branching instructions, because 
they can remove all linear, sequential limitations to the order in which 
events are executed. This will allow much more flexibility in your script.  
Designer also has the powerful capability to set a bookmark when you use a 
Go To action, allowing you to return at a later time, and continue running 
the script from the point after the action. Go To branches should be used 
sparingly. Overuse of such actions, especially Go to event, can make a 
script difficult to understand and edit. Before you use a Go To branch, see 
if there might be another way to accomplish your objective by rearranging 
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events to make the branch unnecessary. 
 
To use a Go To Branch: 
 

1. Click on the button in the Branch column for the event after 
which you want the Go To to happen. The Branch panel will 
appear. 

 
2. The Go To tab will appear. Click the Action: selector to see 

the possible types of Go To. 
 

 
 

Choose a Go To action. 
 

If you choose Go to Event, the Go To: and Level: selectors, and the 
Leave Bookmark? Button will appear. The default Go To setting 
will continue with the next event after the Go To without 
branching. 
 
The Level: selector allows you to specify where the script 
structure the branch target is. Its settings vary depending on 
whether the current event is within a group, and whether you 
entered the Branch panel from the Main view or the Page view. 
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You can branch to any place earlier or later in the current script. 
However, you cannot branch into a separate script, or to a group 
which is below the current level in the script structure. 

 
From the Main view, if the branch event is not within a group, the 
level selector will be disabled and reads <this script>. Within a 
group, the options will include the current group, any group(s) 
above it in the structure, and the top level of the script (<this 
script>). 

 
From the Page view, the level selector will work the same, except 
it is never disabled and the choice <this page> is also present. 

 
3. Choose a level using this selector if necessary. 

 
4. In the Go To: selector, choose the destination page or element. 

The selector will step through every possible destination on the 
script level. In the display box on the right, a thumbnail of the 
destination page or the name of the destination element/event 
will appear. 
 

5. If you do not need to return to the point immediately after this Go 
To, after executing events at the destination location, turn off the 
Leave Bookmark? option. 
 

6. Click Close to close the panel. 
 
There are several situations in which you would typically need to use a 
Go To: 

 
• (with Leave Bookmark?) to execute a different section of the 

script and then return to the original location—often this 
usage is from a button 
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• to exit a loop 

 
• to branch around one or more events which you do not want 

to execute 
 

• (with Show If) to branch to another location if a certain 
condition is true 
 

• (using Action: Exit from Script) to exit from a sub-script at 
someplace other than the end of the script 

 
15.6.1 Exiting a loop 
 
Using Go To as an additional way to exit a loop was discussed in the 
preceding section. 
 
15.6.2 Branching around events 
 
Before using Go To to branch around some events, consider whether you 
could structure the script so it is unnecessary. If the Go To is unconditional, 
it is likely there is a location for the events, (which you want to branch 
around) which would eliminate the need for the Go To. 
 
15.6.3 Using Go To with a bookmark 
 
The real power of Go To comes when you also use the bookmark feature 
allowing you to return from a Go To. If you place an Action: Return to 
Bookmark at the end of a section of events, execution will return to the 
place where you last left a bookmark. 
 
This, in effect, will allow you to define sections of a script as independent 
units which you can navigate to and return from at any point in the script. 
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This is particularly valuable if you have a sequence of events which may 
need to run several times in the course of a script, but from different 
places, (rather than several times in a row like a loop). 
 
Following is an example of the Go To-with-bookmark structure: 
 

In the above script, the pages would run in the order: 1, 2, 7, 8, 9, 3, 4, 5, 6, 
10.... 
 
A more important reason for skipping over a script unit this way is to keep a 
Return to Bookmark from being executed again. Executing a Return to 
Bookmark, (when that was not your intent) will disrupt the proper order of 
events. If Designer encounters a Return to Bookmark for which it cannot  
find a bookmark, it will continue without branching, and subsequently 
display a message dialog when you exit the script. Using Go To with 
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bookmarks and Return to Bookmark requires very clear planning in which 
events and script units will be executed. Typically, if you use more than one 
unit in a script, you should place them all at the end of the script, and 
execute them only through Go To branches with bookmarks. The event just 
before the first of these units can be the Go To which keeps script execution 
from “falling through” to execute the unit. Another option is to use sub-
scripts. 
 
15.6.4 Using a conditional Go To 
 
A conditional Go To, created by defining a special event which contains 
both a Show If and a Go To, is often useful. When the script reaches this 
event, it will evaluate the Show If condition, and if it is true, it will move 
execution to the point specified by the Go To. However, if your intent is to 
conditionally branch around some events you do not want to execute, a  
better solution would be to group those events, and apply the Show If to 
the group. 

15.7 Using Sub-Scripts 
 
The ability to use sub-scripts—scripts which are run from within other 
scripts—adds flexibility to Designer. Although there is nothing you can do in 
Designer which requires a sub-script, there are various situations in which 
subdividing a script can be worthwhile. 
 
Breaking a large script into sub-scripts is similar to breaking any large task 
or object into smaller sections. Working with smaller pieces makes each 
piece more manageable, and will allow you to work on one area of the 
script without affecting others. 
 
In particular: 
 

• Parts of the script are loaded only when needed, reducing initial 
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start-up time. 
 

• Testing and development time is reduced because the complete 
script does not have to be edited and run each time it is tested. 
 

• It is easier and safer to distribute work on a large script project 
among different people as separate pieces. 
 

• Sub-scripts reduce the need for Go To/Return to Bookmark 
structures in the main script, which can be difficult to track as 
projects grow larger. 
 

15.7.1 Variables in sub-scripts 
 
By default, variables which are created in Designer are “local”—specific to 
the scripts within which they are used. For example, the value of a count 
variable in a parent script is normally independent of a count variable in any 
sub-script it may contain. This makes it possible to use standard variable 
names such as count or loops for indexing and other utility purposes in 
various scripts, without worrying about their values interfering with one 
another. However, it is often quite useful to communicate variable values 
between scripts and sub-scripts. This defines the purpose of the External? 
option which is available when you create a variable. The value of an 
external variable is “global”—available not just within the script in which it 
was created, but in any parent script (one above it in the script structure) as 
well. 
 
For example, a sub-script which calculates a score could then pass the 
score value to a parent script which displayed the score, using a score 
variable declared as external. Using variables in the aforementioned 
manner requires planning. You must keep track of which variables are 
external, and which variables are not. 
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When multi-leveled scripts, (which use variables extensively) do not work 
as expected, the reason may be related to variable values not being 
passed, (because a variable was not made external), or variables 
unexpectedly affecting one another (because a variable used in several 
places was made external). You can eliminate potential problems by 
initializing your variables with a starting or default value. 
 
15.7.2 Exiting a sub-script 
 
If you use sub-scripts, the physical end of the script is not likely to be 
where the script finishes. Therefore, you should define a point other than 
the last event in the script as the end. You can do this by inserting a Go To 
with the action Exit from Script. When the script reaches a Action: Exit from 
Script, the sub-script will end. 
 
NOTE: You can now right-click on a sub-script event and select Open Sub-
script in New Tab. 

15.8 Scheduling in Designer  
 
Designer’s scheduling abilities distinguish it from most other multimedia 
products. Scheduling will allow you to communicate timely information, 
freeing you to leave Players unattended, even when displayed information 
must change from day to day. 
  
Most of your scheduling tasks and calendar events will be managed through  
Content Manager, however, you can still use the creative scheduling 
features built into Designer. 
 
You can schedule events to be run according to various criteria: 
 

• at regular intervals—hourly, daily, or weekly 
• continuously between two given times or dates 
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• once, at a specific date and time 
 
For example, you may need an event to be repeated between two and four 
o’clock in the afternoon, only on Fridays, during January. This kind of 
scheduling is useful when promoting special events and will prevent 
outdated information from being displayed. Scheduling a page in your script 
to appear only once at a specific time can be used. 
 
15.8.1 What can be scheduled? 
 
The Schedule panel can be used for all of the following (although some have 
limited scheduling options, as explained in the next section, “Types of 
scheduling”): 
 

• a page, consisting of a background and all its elements 
• individual elements on a page such as text, clips and sounds 
• a group, a collection of pages which you can treat as a unit 
• a sub-script, another script which is run from within the current 

script 
 
Scheduling works essentially the same with pages, special events, 
elements, sub-scripts, and groups. We use the term events to apply to all 
types of things or events you can schedule. However, some types of 
scheduling will not apply to elements. Wherever a distinction is important, 
we will use the term page similar to how it is used in the Main view— to 
apply to any page, be it a page, special event page, group or sub-script. 
 
15.8.2 Types of scheduling 
 
There are three types of scheduling in Designer: periodic, interrupt and 
timeslot. Each contains its particular uses, depending on your production 
needs. Periodic scheduling can be applied to any script event. Interrupt 
scheduling can be applied to any kind of page (including special event  
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pages, groups and sub-scripts), but not to elements on a page, and not to 
pages within groups. Timeslot scheduling is similar to interrupt scheduling, 
however, timeslots are more structured than exact interrupts, since 
playback respects them when determining what to play. This is true even if 
the exact start time was missed due to a down-time, if the segment is  
temporarily interrupted by other content. 
 
15.8.3 Periodic scheduling 
 
Periodic scheduling creates “windows” of time, which are defined as 
valid time periods. It uses four successively more specific levels which you 
may use to define a valid time period: 
 

• Valid Range – the overall schedule time period 
• Valid Weeks – whole weeks by week number 
• Valid Days – days of the week 
• Valid Time of Day – the single-day level 

 
15.8.4 Enabling or disabling an event for the period 
 
Given a time period which you have defined as valid, you can specify one of 
two possible results for a periodic schedule entry: you can either enable 
or disable the event for that particular period. 
 
In other words, the valid period can operate “positively”, to specify 
when the event can run, or “negatively”, to specify when it cannot run. 
Although it is ultimately possible to accomplish the same result with 
positive scheduling alone, in certain kinds of scheduling situations it is much 
easier to use the negative approach. 
 
Most descriptions of periodic scheduling in this manual assume you are 
using the positive, periodic/enabled approach. As Designer runs a script 
and reaches an event which has a periodic schedule setting, it will check 
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to see whether the current date and time is within the valid period defined 
by the schedule. If it is, then: 
 

• a periodic/enabled event will run (it cannot run outside the valid 
period) 
 

• a periodic/disabled event will be skipped (it can run at any time 
outside the valid period) 

 
In short, the periodic/disabled type of schedule will invert the sense of the 
valid period. 
 
15.8.5 Periodic Scheduling 
 
It is important to emphasize which periodic scheduling will not cause events 
to run at a certain time, or guarantee which event will run during any given 
scheduled period. It simply allows the event to run if, in the normal pace 
and sequence of the script’s execution, the event is reached during a 
period for which it is enabled. 
 
In short, periodic scheduling specifies when something can happen, not 
necessarily when (or even if) it will happen. Interrupt scheduling can 
ultimately be defined as a definitive execution time for an predetermined 
event. The following diagram graphically illustrates how three levels of 
periodic scheduling (for simplicity, omitting consideration of the Valid 
Weeks level) work together to “filter” the possible execution times of a 
script event.  
 
The example schedule has an overall Valid Range setting of one week, 
with Monday, Wednesday, and Friday selected in Valid Days, and 
periodic/enabled daily in and out times of noon and Midnight.  
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15.9 Interrupt Scheduling 
 
The Valid Range, Valid Weeks, and Valid Days levels of scheduling are active 
and work for interrupt scheduling just as they do for periodic scheduling. 
However, in contrast to periodic scheduling, at the daily level, interrupt 
scheduling is definite. When the scheduled time arrives, Designer will 
interrupt whatever is happening in order to run the page which is interrupt-
scheduled for that particular time. 
 
 

 
 
During normal running of a script, Designer will skip over interrupt- 
scheduled pages. After running an interrupt-scheduled page, Designer will 
continue by running the next page in the script after the interrupt-
scheduled page. It will not automatically return to the interrupted page—
however, there is an option to set a bookmark to allow resuming playback 
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from the point of interrupt. 
 
For periodic-scheduled events, the location of the event in the script will 
dictate when the event may run. For interrupt-scheduled pages, the 
location of the page in the script is irrelevant to when the event will run. It 
does, however, dictate which page will run after the interrupt-scheduled 
page, especially if the bookmarking feature is not used. 

15.10  Timeslot Scheduling 
 
Timeslot Scheduling is a new feature in Designer. Timeslots are more structured than 
exact interrupts. Playback respects them when determining what to play, even if the 
exact start time was missed due to a down-time, if the segment is temporarily 
interrupted by other content. This means a script with a Timeslot schedule applied, 
will interrupt the current running schedule at the beginning of the Timeslot period, 
and will continue until the end of that period. 

15.11  Factors Affecting Scheduling 
 
Many of the important issues in scheduling are related to issues in timing. 
For further information, please refer to Chapter 11: Timing. Timing of 
events is relative. Neither type of scheduling will adjust duration lengths, 
transition speeds, or other factors which control a production’s pacing. 
 
To make the best use of scheduling in a complex production, you may need 
to utilize grouping and/or sub-scripts. Please review Chapter 3: Working in 
the Main View, where these topics were first introduced. The use of 
groups and/or sub-scripts have special considerations (for more details, 
please review the section “Scheduling with groups and sub-scripts”, later  
in this chapter). 
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When using interrupt scheduling, you may want to take advantage of 
branching, which was explained earlier in this chapter. 
 
15.11.1  Working in the Schedule panel 
 
Events are scheduled in the Designer Schedule panel. Click a page’s 
Schedule button in the Schedule column in the Main view to schedule a 
page, or click an element’s Schedule column button in the Page view List 
panel to schedule an element. In either case, the Schedule panel will 
appear: 
 

 
 
As with other panels in Designer, you can select several events at once 
before clicking in the column, allowing you to edit them at the same time. 
Editing as previously described can be unpredictable due to the numerous 
schedule parameters, and the fact that each event’s schedule can consist  
of multiple entries (please see the following section). 
 
The Schedule panel specifies entries in the schedule for an event. Each 
entry consists of a collection of time-related information which determines 
when the scheduled event can or will play. 
 
The entry information controls are grouped into four sections, 
corresponding to successively more specific levels of scheduling: 
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• Valid Range – the controls in this section establish the overall 
date/time range within which an event can play, and outside of 
which it cannot play 

 
• Valid Weeks – the controls in this section make it possible to 

schedule events through the year on the basis of week numbers 
 

• Valid Days – the controls in this section operate on the level of 
individual days, and allow you to permit the event to play on 
certain days of the week 

 
• Valid Time of Day/Exact Time of Day – the controls in this section 

operate on the level of the individual days which are valid as 
defined by other controls, and establish whether the schedule 
entry is of the periodic or interrupt type. Other buttons in the 
Schedule panel let you add, view, and remove entries. 

15.12  Schedule Entries 
 
The schedule for a script event can contain more than one entry. For 
example, you may want the same page to run only during an hour in the 
morning and another hour in the afternoon.  
 
Each hour would then be one entry in the schedule for that corresponding 
page. When you open the Schedule panel, you’ll start at entry 1. Once it 
has been edited you can add additional entries for the event as necessary. 
 

• To add another entry for the event, click the Add Entry button. 
 

• To edit or review other entries in the schedule for a page once you 
have more than one entry, use the Entry Number value control to 
move to the different entries. 

 



Designer5 
 

 
464 

 

• To delete a single schedule entry, click the Remove Entry button. 
 

• To delete all the entries in the schedule for an event, click the 
Remove All button. 

 
With either Remove button, a confirmation dialog will appear. You can edit 
the schedule for a single event at a time. To edit the schedule for another 
event, simply select the event you wish to edit. 
 
CAUTION! Nothing will prevent you from creating pointless multiple-entry 
schedules which can cause an event to always or never run – or which can 
make interrupt-scheduled events interrupt each other. You must keep 
track of the cumulative effect of the entries. It is easier to create your 
schedules within the Schedule interface in Content Manager. 
 
You can multi-select several events, and set a collective schedule at the 
same time. Doing so is hazardous if you are editing existing schedule 
settings and not all the events have identical schedules. Editing an entry 
while multiple events are selected gives the entry number the same 
settings in all those events, regardless of what the individual events 
original settings might have been. 
 
To accept the changes you have made to the displayed schedule entry 
and exit the Schedule panel, click Close. To discard changes and exit the 
panel, click Cancel. 
 
15.12.1  Combining entries 
 
Use multiple entries to create complex schedules for an event. You can 
combine entries which use different types of scheduling—periodic/enabled, 
periodic/disabled, interrupt—freely, and timeslot. 
 
When the periodic/enabled and periodic/disabled types are combined, the 



Designer5 
 

 
465 

 

valid period(s) created by the cumulative effect of all enabled entries will be 
determined first, then the disabled entries are will be used to “cut holes” 
in the valid period. 
 
15.12.2  Schedule information in the column button 
 
A good way to help you keep track of whether your work in the Schedule 
panel is having the desired effect is to look in the Schedule column for 
the event. Information about the entry will be displayed in the column 
button. 
 

 
 
Of particular note is the information in parenthesis, which is  
interpreted as follows: 
 

• (current) – the schedule includes the current moment; the event 
could play immediately 

• (next: <date> <time>) – the date and time determining when the 
event will be able to play 

• (expired) – the scheduled period has passed; the existing schedule 
will not allow continued playback 

 
If you are scheduling something for future playback and you see 
“(expired)”, it is an immediate indication that something wrong. If you see 
“(next: ...)”, compare the date and time shown with what you believe the 



Designer5 
 

 
466 

 

next scheduled playback should be to help you determine if your scheduling 
is accurate. Make the Schedule column wide enough so you can see the  
indicators appear as you change the settings in the Schedule panel. When 
the column button is blank, the event is not scheduled and can play at any 
time. 
 
15.12.3  Setting the overall schedule range 
 
The first step in creating a schedule is to define the overall range for the 
event, using the controls in the Valid Range section of the Schedule panel. 
 
When you turn on the From? and To? buttons, start date, start time, end 
date and end time value controls will become available. You can adjust the 
date, or use the time value controls to specify the beginning and ending 
points of the range.  
 
Defaults 
 
In the Schedule panel, times are displayed in the 24-hour time format, 
and default start and end times are 00:00:00 and 23:59:59, respectively. 
Therefore, the default start time or In time is the beginning of the day (at 
midnight) and the default end time or Out time is the end of the day (one 
second before midnight). Dates default to the current date. Creating a To 
setting without a From setting implies a start date of now; setting a From 
date without a To date implies the schedule will continue indefinitely. 
Setting neither a From date nor a To date means the schedule will not be 
restricted within a date range. 
 
15.12.4  Scheduling by week number 
 
For applications which require scheduling on a week-to-week basis, 
Designer offers the Valid Weeks option, which allows you to use week 
numbers. The Weeks: button has a default setting of All, so week numbers  
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will not considered in establishing the valid period. To create weekly 
scheduling, simply click the button. When you click the Weeks: button a 
dialog, which allows you to choose the desired weeks graphically, will 
appear. 
 

 
 
In the dialog are a series of buttons, one for each week of the year. (The 
week numbering obeys the ISO standard, which uses whole weeks, Week 
1 being defined as the week which includes January 4.) 
 

• Click a button so it is indented to select that particular week 
number. 

 
• You can also select the weeks in which the event should not run. 

After your selection, click Invert to navigate to your desired weeks. 
 
• Click All to select all weeks, or None to clear any selection you have 

made and start again. 
 
When you have finished selecting the week numbers in the valid period, 
click Done to return to the Schedule panel. 
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The Weeks: button lists the selected weeks numerically, with ranges of 
continuous weeks shown as, for example, 17-32, and discontinuous ranges 
and individual week numbers separated by commas. 
 
Keep in mind the Valid Weeks setting is beneath the Valid Range setting, 
in the scheduling hierarchy. This means that although you can choose any 
weeks of the year, weeks or parts of weeks which are outside the Valid 
Range setting, are not in the schedule. 
 
15.12.5  Setting valid days of the week 
 
In the Valid Days section of the Schedule panel are buttons which may be 
used to limit the days of the week which an event runs. 
 
The Days: selector contains two possible settings: All and Selected Only. The 
default is All, therefore, the individual day buttons are disabled. To enable 
them, choose Days: Selected Only. 
 

 
 
If you select a weekday button, you allow the event to run on which day of 
the week within the overall valid range. You can select any combination of 
days during the week. 
 
15.12.6  Periodic scheduling: setting a daily range 
 
Use the controls in the Valid Time of Day section to specify a limited time 
range within each valid day which an event may play back.  
 
Set the Event: selector to Is Enabled within Valid Period. With periodic 
scheduling selected, the Daily In Time and Daily Out Time value controls in 
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the Valid Time of Day section of the Schedule panel will appear. 
 
Adjust the Daily In Time and Daily Out Time values to specify the times of 
day to begin and end, allowing the event to play back. These daily times will 
apply to every day permitted by the Valid Range, Valid Weeks, and Valid Days 
settings. If the Out time occurs after the event has already started, the 
event will complete; it is not cut off. 
 
Keep in mind if your script is long and the period defined by the In/Out 
times is short, your event may be skipped altogether—the running script 
may not reach the event during the specified time. With a short script, your 
event may also run many times within the period. With periodic scheduling, 
you cannot specify how many times an event will run within the time 
“window” specified by the schedule. 
 
15.12.7  Interrupt scheduling: setting an exact playback time 
 
When using interrupt scheduling, the Valid Range, Valid Weeks, and Valid 
Days controls function similar to periodic scheduling. Switching to interrupt 
scheduling will only change the controls available on the daily level. 
 
Interrupt scheduling is only available for pages. 
 
To interrupt-schedule a page, change the Event: selector to Interrupts 
Exactly. The Valid Time of Day section becomes Exact Time of Day. The At 
Time value control in this section will indicate the first (or only) time you 
want the page to run. 
 

 
 
You will see three new controls, Repeat?, Every, and Until, for interrupt 
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scheduling. The Every and Until controls will be disabled unless Repeat? is 
on . 
 
Repeating an interrupt-scheduled event 
 
Without using any other controls, an interrupt-scheduled page will run 
once per day at the time specified by At Time. If you want to repeat the 
page—once every hour, for example, turn on Repeat?  This will enable the 
Every and Until value controls, so you can adjust the frequency and extent 
of the repetition. 
 
Specify the repeat time interval with the Every value control, in hours, 
minutes, and seconds. The interval will be measured from the time the 
page last began. (Leaving the default setting of 00:00:00 results in no 
repeats taking place, even if Repeat? is on.) 
 
Use the Until value control to set a time to stop repeating the page. Leaving 
the default time of 23:59:59 will allow the page to repeat for the rest of 
the day. As long as the repeated page begins before this time, it will run to 
completion—if the Until time occurs while the page is running, it is not cut 
short. Remember, when an interrupt-scheduled page’s At time initiates, 
it will interrupt whatever the script is doing at that moment. It will not wait 
for any event which may be running to finish—it will also interrupt an 
element transition, just as readily as a page pause. 
 
Leaving a bookmark 
 
An interrupt-scheduled page will disrupt the normal script flow, effectively 
acting as a branch to that page. Script execution will continue with any 
pages which follow the scheduled page in the script. 
 
If you want to resume the script from the point of interruption, so the 
interrupt-scheduled page works as a temporary “detour” rather than a 
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branch, simply use the Leave Bookmark? option. This option appears, and 
is enabled by default, when Event: Interrupts Exactly is chosen. 
 
When Leave Bookmark? is on , a bookmark will be left at the point of 
interruption. A Goto: Return to Bookmark branch, will be applied to the 
interrupt-scheduled page, causing script execution to return to the 
interrupted page and begin playing from the beginning. This is illustrated in 
the following example. 
 
15.12.8  Viewing a summary of schedules 
 
The Schedule panel offers a way to look at the schedule entries in a 
summary view. Click View Schedules to see a listing of schedule entries, 
identified by page/element name. The View All Entries In: selector will 
allow you to choose whether to see the entries for just the selected 
event(s), or for all events in the script. 
 
If your script uses scheduling extensively, this will allow you to quickly 
review and compare entries, verify them, and help spot possible conflicts. 
 
Click the Copy to Clipboard button to copy the entire listing to the 
 

 
 
Windows clipboard in plain text format. By pasting into a text editor, 
database, or other application, event scheduling can be conveniently 
reviewed outside Designer. 
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When you have finished reviewing the schedule entries, click Close to 
return to the Schedule panel. 

15.13  Advanced Features 
 
15.13.1  Scheduling with more Complex Scripts 
 
If your scripts use groups or sub-scripts, you should be aware of the 
possible effects on the execution of scheduled events. 
 
15.13.2  Interrupt scheduling with groups and sub-scripts 
 
Interrupt-scheduled pages cannot be grouped or moved inside a group.  
 
Additionally, they will execute at their scheduled time, only if the sub-script 
is running. While the main script is running, Designer will not “see” the 
scheduled events in its sub-scripts. If the start time of an interrupt-
scheduled page in the main script occurs while a sub-script or grouped 
page is running, Designer will return to the top level of the main script in 
order to run the interrupt-scheduled page. After an interrupt-scheduled 
page runs, the script will continue with the following page in the main 
script. Using a Return to Bookmark branch in a sub-script will always bring 
you back to the beginning of the subscript, not to a specific page. 
 
15.13.3  Timeslot scheduling with groups and sub-scripts 

 
Timeslot-scheduled pages cannot be grouped or moved inside a group.  
 
Additionally, they will execute at their scheduled time, only if the sub-script 
is running. While the main script is running, Designer will not “see” the 
scheduled events in its sub-scripts.  
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If the start time of an timeslot-scheduled page in the main script occurs 
while a sub-script or grouped page is running, Designer will return to the 
top level of the main script to run the timeslot-scheduled page. After a 
timeslot-scheduled page runs, the script will continue with the following 
page in the main script. Using a Return to Bookmark branch in a sub-script 
always bring you back to the beginning of the subscript, not to a specific 
page. 
 
15.13.4  Periodic scheduling with groups and sub-scripts 
 
Periodic-scheduled events may not execute according to schedule when 
groups or sub-scripts are involved. As a script steps through each event, 
including those in groups and sub-scripts, it will run a periodic-scheduled 
event within a “window” of time specified by the event’s schedule.  
However, if a sub-script or group uses branching to create a loop, avoiding 
the main script, periodic-scheduled events in the main script will not run.  
 
15.13.5  How not to schedule 
 
Scheduling features in Designer are very powerful, requiring careful 
attention for optimum results. 
 
Here is a summary of scheduling pitfalls to avoid: 
 

• Too-short valid periods with a long script 
 

If your script is long, and the scheduled valid periods are few 
and/or short, a scheduled event will not be regularly played.  

 
• Periodic-scheduled events which are never reached: 

 
Periodic scheduling does not cause events to run, it allows them 
to run, only if they are reached. Therefore, running a scheduled 
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event depends entirely on the execution of the script regularly 
reaching it. A periodic-scheduled event, which is never reached—
for example, because of its location in the script relative to a 
branch, looping group, or non-exiting sub- script—will not run. 

 
• Conflicts at different levels of scheduling: 

 
Careless scheduling may cause scheduled events that appear to 
remain, unscheduled. For example, scheduling a page to run 
only on Monday, Wednesday, and Friday, and scheduling certain 
clips on the same page to run only on Tuesday and Thursday, will 
result in those clips never being seen. This will also occur if you 
schedule a group, and then individually schedule pages within the 
same group. Scheduling events on lower levels must occur within 
the “window” provided by the levels above them, otherwise, they 
will not run. 

 
• Interrupt-scheduling everything: 

 
In Designer, you cannot reasonably set a schedule to determine 
exactly what is going to be displayed at each minute of the day. 
As a general rule, interrupt scheduling should be used for any page 
which must run at a particular time. 

 
• Interrupt-scheduled pages too close together 

 
Interrupt-scheduled pages—and their Repeat intervals—should be 
far enough apart (in terms of script execution time) to avoid them 
interrupting one another. 

 
• Leaving out a Return to Bookmark “go to” branch 

 
Even if the Leave Bookmark? option is on for an interrupt-
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scheduled page, a Return to Bookmark branch is also required on 
the same page, or a succeeding page, to resume at the nterrupted 
page.
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||||| 16 Publishing, Exporting 
  & Printing 
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Chapter Overview 
 
Once you have created an Designer production, you will want to publish the 
script to a location so it can be transmitted to your network of players, 
using Content Manager. A Scala 5 Network consists of a system of remote 
PCs running Scala Player software, controlled through the Scala Content 
Manager application. Both of these applications are sold separately. 
A completed Designer script cannot be seen by a player until it has been 
published to a determined location and scheduled to play in a channel using  
Content Manager. 
 
The publishing process involves collecting every file which composes the 
production (including the script, art, graphics, video, and sound) and 
putting them together in a conveniently portable form. You can publish 
either to a local folder, or publish to the Network. Whichever publishing 
medium you choose, the procedure is substantially the same. Different  
available options will depend on the final destination of your published 
script. 

16.1 Glossary of Terms in this Chapter 
 

Publish – To prepare an Designer script for distribution to any of 
the publish media locations which Designer supports. 
 
Publish Location – A local or network folder, defined in 
Content Manager, where scripts and media are published for 
scheduled broadcast to the Scala player(s). 

16.2 Publishing Features 
 
Designer will allow you to make choices about what you want to include in 
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your published production. Options are set in the Publish Script dialog. 
This dialog makes it easy for you to make various global settings  
regarding the script’s final published form and destination. It also addresses 
possible licensing and software setup issues. (Scala gives you the right to 
reproduce and distribute the clip art which it contains, however, your script 
may use content which requires other licenses.) 
When you click the Publish icon from  
the Main view toolbar, a dialog with the  
previously selected network options will  
appear. If you click on the small down  
arrow to the right of the  
icon in the toolbar, a pop- 
up list will appear, allowing  
you publish to the selected  
target location. You can also  
access the target location  
through the File pull-down  
menu, File > Publish to… >  
[current location selection] or 
Other Publish Targets… 
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Network – Publish to Network is for customers who have an installation 
which also includes Content Manager; Scala’s facility for transmitting  
and updating scripts on systems of remote PCs running Player software. 
Publishing to the network is the first step in the transmission process. 
Choosing this opens the Publish Script dialog. 
 
16.2.1 Options column 
 
The Options column on the left hand side of the dialog contains the 
publishing options. 
 
16.2.2 Connection Type: 
 
Selecting this option will direct you to the type of connection you will 
publish to: Content Manager Direct, Web or FTP Folder, or Local or Shared 
Folder. The options which appear in the dialog, will depend on which 
method you select. These will be explained in more detail throughout this 
chapter. 
 
16.2.3 Script Information box 
 
The Script Information box provides information about the script which you 
have chosen to publish, such as the approximate size in megabytes.  
 
Designer will automatically scan your script and display its information in 
the Script Information box. It will also display information regarding data 
which is currently being processed.  
 
16.2.4 Publish! 
 
After you have chosen your publishing options and clicked the Publish! 
button, you will see a status of the process. When the status reaches 
100%, the published production has been saved. Designer will allow you 
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to assign a password to your scripts, which will protect them from being 
inspected or edited by anyone who does not have access to your 
password. A password is not required to simply to run the production. 
Whichever script is currently showing in the Main view is the one which 
will be published. The original script’s files are not affected by publishing. 
 
More details about the Publish process and password protection will be 
covered later in this chapter. 

16.3 Publishing to Content Manager 
 
The Publish to Content Manager dialog is where you prepare a script for 
distribution to a network of remote Player machines on an Scala 5 Network. 
The publishing process will collect all of the script’s constituent files and  
arrange them in a structure which is appropriate for efficient and reliable 
transmission. 
 

 
 
The published script will be deposited in either the Content Manager or a 
Publish Location (a folder defined in and accessible to Content 
Manager). Content Manager is Scala’s companion software for 
administration of Networks. 
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16.3.1 Media Item Options 
 
If an existing Media Item Folder: is in the selected network, it will appear 
in this location – or you may select this option and type in the name of the 
folder you wish to use. The name of the script you are publishing will 
appear in the Media Item Name: location. 
 
16.3.2 Connection Type: Content Manager Direct 
 
The Content Manager network address will appear under this setting. When 
it is selected, a dialog will appear which will allow you to select the 
connection protocol, URL and/or directory of your connection 
destination, User Name and Password. 
 

 
 
When publishing to Content Manager, the URL is case sensitive. 
Depending on how Content Manager was configured, you may need to 
specify a port in the URL.  
 
IE: http://localhost:8080/ContentManager (note the port number in this 
case is 8080) 
 
When publishing to Content Manager,  if the server supports https, you 
can select that option. 
 
When you click on Refresh, it will search for any Available Networks to 
which you can publish.  
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16.3.3 Protect Media Item From Editing 
 
This option will lock down the editable components of the script you are 
publishing. This is a security measure, therefore, it cannot be reopened and 
altered from anyone else which may have access to the publish location.  
 
By selecting this option, you will be asked to provide a password to 
protect the published media. 

16.4 Advanced Options 
 
Clicking on Advanced Options will open a dialog which allowing you to 
specify whether to include transition files and font files with the published 
script. When these options are on, reminder messages will appear in the 
Script Information box.  
 
16.4.1 Include Fonts 
 
Turn on the option to Include Fonts? when your production uses fonts 
which may not be installed on the Player machine. Turning Include Fonts? 
on ensures they will be included with the script files. TrueType fonts, if their 
distribution is permitted, are provided as embedded binary data. If a 
TrueType font is internally defined as non re-distributable, it will not be 
included. You must acquire and install that particular font independently, 
before the production can be played. 
 
Important: You must be sure to check the licensing requirements for any 
fonts you use . The TrueType fonts included with Scala Designer are freely 
re-distributable for any production you create, but only for non-
commercial purposes. TrueType fonts which you acquire from other sources 
may have licensing restrictions which vary from manufacturer to 
manufacturer. It is your responsibility to comply with their requirements.  
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16.4.2 Include Transitions 
 

Include Transitions? should be turned on when your production includes  
Designer transitions which you have to perform on the Player. For example, 
Alpha transitions use special image files to generate their reveal patterns. 
When this option is on, the transition files in your production will be  
included with the other script files. If this option is not included, transitions 
will become simple Cut transitions on a Player which does not contain the 
necessary transition files. 

16.4.3 Remember Media Item Folder in Target 
 
When this is selected, as indicated by a check, the media item folder name 
will automatically be added to the target. This is helpful when subsequent 
publishing attempts are made. 

16.4.4  Remember Target As 

 
This is the current location selected. You may change the name of this 
location by typing it in the space provided. 

16.5 Connection Type: Publish to Web or FTP 
Folder 
 
The URL: button appears below the pop-up when Connection Type: Web or 
FTP folder is chosen. Click to open a dialog in which you can enter or 
change your URL and login information. Protocol: select the correct 
protocol for the URL which you will be using. The options are http, https, or 
ftp 
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URL: – enter the URL to which the script files should be sent. For  
example: 
 

http://192.168.0.10/Aserver/NetMgr/PubContent 
 
Or 
 
https://ICNMserver.com/Publish 
 
Or 
 
ftp://192.160.0.15/Publish 
 

Be sure to include the path from the root to the directory on the server into 
which the published files should be deposited. 
 
Use forward slashes to separate directory levels in the path. 
 
User Name: – To gain access to the server to upload the published script, a 
logon may be required. Enter the name in the User Name: text box. 
 
Password: – A password may also be required to complete the logon to the 
server. Enter it in the Password: text box. The characters you type will 
appear as asterisks (*), for security reasons. 
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Confirm Password: – Type the password again in this box. Whatever you 
enter must exactly match the Password: entry. 
 
Click OK when you have entered the login information. 
 
In the URL: button, you see the URL with the username you embedded, 
like this: 
 

http://Designer@ICNMserver.com/Publish 
 
Use Passive FTP? – If you have selected FTP as your publishing protocol, you can 
enable the passive FTP option. This is may be required for certain FTP servers. 
 
16.5.1 Connection Type: Local or Shared Folder 
 
If you choose Connection Type: Local or Shared Folder, the Folder: button 
will appear below the pop-up. Click this button to open the File dialog, 
where you can specify the folder into which the script-related files should 
be published. 
 
Designer uses a Default Publish Location folder as the destination. This 
folder is normally located at: 
 

<systemroot>:\Documents and Settings\All Users\Documents\ 
Scala\Network Transmission\Publish Locations\Default 

 
where <systemroot> is the letter of the drive where Designer is installed—
which is set up automatically for you during installation. 
 
If you need to choose your own destination folder, it does not already have 
to exist. Navigate to the folder where you would like to create the publish 
folder, click the New Folder icon, rename it, then open the new folder. 
If you have previously published this script to the folder, any previously 
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published versions will be deleted before publishing of a new script is 
performed. 
 
16.5.2 Completing publication of a script 
 
When you have chosen your publishing options, there is one more question 
to consider before publishing your script, namely whether to protect it with 
a password. 
 

 
 
Password protection for published scripts 
 
Protection and confidentiality are important for many multimedia 
publishers, which is why Designer will allow you to encrypt or “lock” scripts. 
Encryption facilitates protecting your work from unauthorized editing. It 
will also allow you to keep any scripting “secrets” from being revealed. 
When you lock a script, it is automatically encrypted. This means the script 
is encoded and must then be decoded before it can be inspected. The 
only way to decode the script is to enter the correct password—which 
you, the producer of the script, will personally create.  
 
A locked script can still be run just like an unlocked script. However, it 
cannot be edited or its events viewed. An “open” script will allow viewers 
who already have Designer and the necessary fonts installed, to edit or 
review the techniques of your production. If you do not choose a 
password for a script, it will remain an open script: a password will not be 
required when it is opened by the viewer. Every event will be listed in the 
views, and easily edited. 
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Opening a locked script 
 
Anyone can open a locked Designer production by running Designer and 
choosing the script (named <project name>.SCB) in the Open Script File 
dialog. A password will be requested. 
 

• Entering the correct password will allow the script to open like a 
normal script. The viewer can then review the techniques of the 
production and if necessary, make changes. 

 
• Entering the incorrect password, or no password, will allow the 

viewer to run the script to see the production, however, the viewer 
will not be able to review the techniques of the production or 
make any changes.  

 
16.5.3 Publishing 
 
Clicking the Publish! button will perform the publication of the script to 
your chosen medium. Messages concerning the progress of the 
publication, will appear in a separate dialog. 
 
To Complete Publishing: 
 

1. Click the Publish! icon in the toolbar. 
 

2. If there is another script of the same name in the publish folder, 
an Designer Message dialog will appear asking whether you want 
to delete the contents and continue publishing.  

 
3. Click OK. The dialog box will reveal whether or not your 

publishing was successful. 
 
If successful, Designer has published your production into your specified 



Designer5 
 

 
488 

 

location.  
 
16.5.4 Cancel/Close 
 
Choose Cancel to cancel publishing and return to the Main View. 
 
If you have already successfully completed publishing, this button will 
change to Close and exit the Publish dialog. 

16.6 Export to HTML Slides 
 
Choose Export to HTML Slides from the File drop-down to reveal the 
Export to HTML Slides dialog. Designer includes the Export to HTML Slides 
feature to make it easier to share Designer script ideas over the Web. This 
type of publishing will not make a script play in a Web browser.  
Instead, Export to HTML slides will create a set of HTML files. These files 
define a Web page which provides an overview of a Designer script. 
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The Web page created by this type of publishing simply consist  
of a grid of thumbnail images of the screen pages in the script, much like 
the Thumbnail view of the Main view. When a thumbnail image in this 
index page is clicked, a full-sized image or “slide” of the screen page will 
be displayed in the browser window.  
 
The title bar of the full size pages contains navigation buttons allowing you 
to move forward and back through the slides, or return to the index page. 
In a browser, it would look something like the samples on the following 
page. 
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The displayed slides reveal every text, clips, and draw objects on the page. 
However, only the initial frame of an animation background, movieclip or 
animclip will be shown. Page and element transitions, sound, and other 
dynamic aspects which may be included in the script, are not represented. 
 
Putting up a Web page of a script exported to HTML slides is a way to 
achieve extremely wide, fast and efficient distribution of a script for review 
and commentary. It does not require viewers to have a special plug-in—a 
standard browser is sufficient. This also means it is platform-independent, 

allowing you to share your script concept with users of Macintosh®, UNIX®, 
and other operating systems. Although it omits certain significant  
components of a finished script, its storyboard-like format will allow you to 
easily publicize and receive feedback on the graphic design aspects of a 
script,. This can be very important in a time-critical authoring 
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environment. 

16.6.1 Destination: Local or Shared Folder 

 
Select a local folder or network location in which to save your HTML slides 
folder.  
 

16.6.2 Destination: URL 

 
If you select this option, you have to provide a URL to save the folder of 
HTML slides content. You must also be on an active network or connected 
to the Internet to choose this option successfully. 
 

 
 

16.6.3 Include Page Names 
 
When the Include Page Names? option is turned on, the names of the 
screen pages as seen in the Main view will be displayed under the page 
thumbnails in the generated Web page. 

16.6.4 Thumbnails Per Row 
 
Similar to the Thumbnail view, you can also specify how many page images 
should appear in a row. Use the Thumbnails Per Row value control to 
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increase or decrease the number of thumbnail images which appear in a 
horizontal row. The default is 5. 

16.6.5 Thumbnail Size in Pixels 
 
You can specify how large each thumbnail should be using the Thumbnail 
Size in Pixels value control. Enter a horizontal and a vertical size. If these 
settings are not proportional to the aspect ratios of the pages themselves, 
the resulting thumbnails will be as large as possible to fit within a box of 
your specified size. Every page will be converted to JPEG images for Web  
publication, regardless of the original format of their component images. 
 
The Scale Pages? option allows you to decide whether the full-size images 
should be scaled to a particular size, when the thumbnail images are 
clicked. Typically, this would be used to make the full-size pages somewhat 
smaller to fit more conveniently into the browser window. This could be less 
than a full-size screen. 
 
By default, the full-size image has the same pixel dimensions as the 
original background. Turning this option on   turns the option button into  
a value control which will allow you to specify horizontal and vertical pixel 
dimension values for the full-size images. If these settings are not 
proportional to the aspect ratios of the pages themselves, the resulting 
images will be as large as possible to fit within a box of your specified 
size.  

16.7 Printing scripts with ScalaPrint 
 
Scala Designer gives you the ability to print your scripts. Using ScalaPrint, 
you can produce color or black and white hard copies on paper or 
transparencies to enhance or accompany your Designer production, or 
simply to aid in your design process. You may want to summarize your  
script, print certain pages of your script, or print a permanent record of the 
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entire script. You may also find a need for a cue card-type list of notes for a 
presenter to follow during the presentation of your script.  
 
Using ScalaPrint, you can choose how much of your script to print, 
whether it be the entire script or only selected pages. You can also lay out 
your pages in different formats. Whatever you choose, ScalaPrint provides 
you the ability to customize your script printouts in order to 
accommodate your particular needs. ScalaPrint produces printed output in 
a graphical format similar to the way the Thumbnail view in the Main view 
displays your scripts. You can print all script pages on one sheet of paper, 
or each on its own page—as well as every option in between. The ScalaPrint 
view will allow you to arrange the size, numbering, and arrangement of all 
the script’s pages on the printed page, and direct that output to a specific 
printer device. 
 
16.7.1 Slides 
 
Using Designer, you will create scripts consisting of pages and groups of 
pages. Within ScalaPrint, however, the individual script pages as they 
appear when printed are titled slides in order to distinguish them from the 
physical pages which are printed out. Each script page you select from the 
Main view to print will be condensed into a slide, much like a photographic 
slide. It will then be placed on the page according to your layout selections. 
Subsequently, you may select options to size, order, label, number, and 
frame the slides to suit your needs.  
 
16.7.2 Print job 
 
Your intended output from the printer device is referred to as a print job. A 
print job consists of the slides for the selected script pages which you 
intend to print, their size and layout on the page, and how they are 
ordered, labeled and framed. You may select to print every script page, or 
just some of them. Depending on how you arrange the slides on the printed 
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pages, you may end up with a multiple-page print job, or a print job 
consisting of every slide on just one page. 
 
16.7.3 Matrix 
 
The script pages you select from the Main view to print will be formed into 
slides, and the slides will then be arranged on pages, depending upon the 
matrix, or column and row arrangement of the slides. 
 
You can choose to place each slide on its own page, or possibly 6 slides on 
a page, arranged in 2 columns of 3 rows. The matrix, in this example, 
would be 2 × 3. Should you decide you’d like to have each slide print on 
its own page, the matrix you use is 1×1. You cannot select different 
matrixes for different pages in the same print job. In order to have different 
slide arrangements on different pages, you must configure a separate print 
job for each intended layout. (See “Different layouts for different pages” 
at the end of this chapter.) 
 
16.7.4 The ScalaPrint view 
 
To open ScalaPrint, click the Print icon on the Main view toolbar or select 
the File drop down menu and click Print. 
 
The ScalaPrint view will appear on the screen, divided into two main 
areas: the page preview section and the ScalaPrint tabbed options. 
 
The page preview section, located across the top of the screen, will 
provide a graphical representation of how your script’s slides will be 
positioned on a sample printed page. You will not see your actual script 
pages images or content on the screen; just boxes which represent the 
size and position of each slide. The tabbed options panels will allow you to 
select the options which control the layout of your slides on each page, as 
well as choose the destination printer to generate the hard copy. As you 
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change most layout options, the page preview update will automatically 
reflect your changes. 
 

 
 
Remember, the slides are only a representation of the physical position of 
your script pages; they are not a preview of what will actually print. 

16.8 ScalaPrint Tabbed Panel Options 
 
Click one of the five tabs to see the available options on each panel: 
General, Layout, Labeling, Margins, and Printer. 
 
The General panel 
 
The General panel options deal with the overall arrangement of the script 
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pages you want to print.  
 
Slides 
 
The Slides: selector allows you to choose whether to print slides for all 
script pages, or only the slides corresponding to the script pages which you 
have selected in the Main view. Use the selector to switch between All 
and Selected. If you have more than one script page selected in the Main 
view before you start ScalaPrint, the Slides: selector will default to Selected. 
 
Pages 
 
The Pages: selector allows you to print every page in the current print job, 
or select a range of pages from the print job. Use the selector to switch 
between All and Range. Choosing Range will enable the Print Range 
control below. 
 
Note that this control refers to pages of the print job, not script pages. For 
example, if your script has twelve pages and your slide layout places six 
slides on each printed page, the print job has three physical pages, 
controlled by this option. Choosing Pages: All does not print all script pages 
unless the Slides: All option has been selected. 
 
Print Range 
 
When you select Range from the Pages: selector, the Print Range value 
control becomes active, allowing you to specify the beginning and ending 
pages of a range you wish to print from the current print job. Select the 
page number range using the value control. You can use the arrows or enter 
the page range numbers manually. 
 
Possible values for this control are from 1 to 999. The Print Range value 
control is not limited to the actual number of pages in the current print job, 
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therefore, it is possible to set page numbers which are higher than the 
maximum number of pages. If the starting page number is too high, pages 
will not be printed. Entering an ending page number greater than the 
maximum number of pages will have the same effect as entering the  
maximum number. 
 
Copies 
 
Use the Copies value control to set the number of copies of the current 
print job you wish to print. 
 
Include Background? 
 
You have the option to exclude the background images from your slides so 
they will not be printed as part of the slide. Turning off Include Background? 
excludes background images from all slides in the current print job. For 
example, if your slides contain text overlying busy background graphic 
images, and you are using ScalaPrint to generate transparencies. You want  
to emphasize only the text, so you might choose to exclude the background 
images from the slides. The Include Background? option is on by default. 
 
The Layout panel 
 
The Layout panel contains options which tailor how slides are laid out on 
the pages of your print job. 
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Orientation 
 
Choose the direction in which the slide’s contents are positioned on the 
page with the Orientation: selector. You can select either Portrait, in which 
the page height is longer than its width, and columns are positioned across 
the narrower dimension of the page; or Landscape, in which the page 
width is longer than its height, and columns are positioned across the 
widest dimension of the page. 
 
Matrix 
 
You can specify the number of slides which will appear on a page as well as 
how they are arranged in columns and rows by using the Matrix value 
control. The first value represents the number of columns of slides, and the 
second value represents the number of rows of slides. 
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You can have as few as 1 slide per page (a matrix value of 1×1) to as many 
as 100 slides per page (a matrix value of 10×10). Obviously, as matrix 
values increase, the number of slides on a page will increase. 
Subsequently there will be less room to display each slide. ScalaPrint will 
reduce the size of every slide equally, maintaining their original aspect 
ratios. As you adjust the matrix values, the page preview slides will change  
correspondingly. 
 
To change the Matrix value, use the value control. You can use the arrows or 
enter the numbers manually. 
 
Slide Order 
 
Placing multiple rows and/or columns of slides on a page requires you 
decide their order. Using the Slide Order: selector, you can specify 
whether the slides’ order is Across, filling each row to progress to the 
bottom of the page, or Down, filling each column to progress to the right 
side of the page. The default order is Across. 
 
Scale 
 
Sometimes when printing a script you may need more white space around 
your slides, whether it be for notes, framing, titles or labels, or just for 
aesthetic reasons. Using the Scale option, you can scale down or reduce 
slides to a percentage of their maximum size. Keep in mind the maximum 
slide image sizes are initially determined by the number of slides you 
choose to place upon each page with the Matrix control. Scaling does not  
increase the number of slides on a page; it merely reduces each slide’s 
image size. You cannot scale up, or enlarge a slide to greater than 100% of 
its maximum size. 
 
Row Alignment 
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Just like you justify or align text, you can align slides. However, with 
ScalaPrint, you are actually aligning the slides within the boundaries of their 
individual matrix areas. Row Alignment: will allow you to align the rows of 
slides vertically on the page. Choose from among Center, Top, and Bottom 
alignments. Selecting Center will align the slide row(s) at the centers of 
the matrix areas. Selecting Top will align the slide row(s) along the top 
edges of their matrix areas. Selecting Bottom will align the slide row(s) 
along the bottom of their matrix areas. 
 
Aligning slides will create a visual effect only if the slides have room to 
move vertically within their matrix areas. If your slides do not move when 
you change their alignment, use the Scale option to reduce their size. 
 
Column Alignment 
 
Column Alignment: will allow you to align the column(s) of slides 
horizontally on the page. Choose from among Center, Left, and Right 
alignments. Selecting Center will align the slide row(s) along the centers 
of the matrix areas. Selecting Left will align the slide row(s) along the left 
edges of their matrix areas. Selecting Right will align the slide row(s) along 
the right sides of their matrix areas. Further adjustments may need to be 
applied to the page’s margins using the Margins option tab. This will be  
discussed later in this chapter. Aligning slides will create a visual effect 
only if the slides have room to move horizontally within their matrix areas. 
If your slides do not move when they have been justified, use the Scale  
option to reduce their size. 
 
16.8.1 The Labeling panel 
 
ScalaPrint’s Labeling panel offers a variety of options to control the 
labeling of your slides on the printed pages. 
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Title? 
 
The Title? option, which is on by default, will place the name of your script, 
without its file extension, at the top of each page of your print job. With the 
Title? option turned on, you will see a greeked representation of the title 
displayed at the top of the page preview. With the Title? option turned off, 
the printed pages will not contain a heading. 
 
Page Number? 
 
The Page Number? option enables or disables printing the print job’s 
page number at the bottom of each page. The page number represents 
the order of the pages as they are generated by the printer for the current 
print job, and does not necessarily correspond to the numbering of pages in 
the script. With the Page Number? option on, you will see a greeked 
representation of the page number displayed at the bottom of the page 
pre-view. 
 
For example, suppose you select pages 1, 3, and 5 from the Main view, 
and set the matrix to 1×1 in ScalaPrint, so each slide prints on one page. 
You have defined a print job of 3 pages. These pages, if you turn on Page 
Number?, will be pages 1, 2, and 3 of the print job. The print job’s page 
numbers do not correspond to the script’s page numbers. 
 
Frames? 
 
You can choose to have a beveled frame, similar to a picture frame, 
placed around your slides. If you turn the Frames? option on, a 
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predefined frame is placed around each slide; if left off, which is the 
default, the slide will be displayed and printed without a border. With the 
Frames? option on, thin lines representing the frames outlining each slide, 
will appear in the page preview. ScalaPrint frames are the same thickness 
regardless of slide size. 
 
Slide Name? 
 
Turn Slide Name? on to enable the name of a slide to print directly 
underneath the slide image. The slide’s name corresponds to the script’s 
assigned page name, including the extension if a file name is used. With 
the Slide Name? option on, you will see a greeked representation of the 
slide name displayed underneath and to the left of each slide in the page  
preview. This option is off by default. 
 
Slide Number? 
 
Slide Number? enables or disables printing the slide’s script page number 
directly underneath the slide image. This number is the same as the script’s 
page number. If a slide is part of a group of pages in the Main view, the 
slide number will be printed as the Group number, followed by a dash (-), 
and then the page number within the group. With the Slide Number? 
option on, you will see a greeked representation of the slide number 
displayed underneath and to the right of each slide in the page preview. 
 
16.8.2 The Margins panel 
 
You can adjust the margins of the printed page by using the Top, Left, 
Bottom, and Right value controls on the Margins panel.  
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The units of measure indicated on the value controls are controlled by the 
Margin Units: selector. Adjusting the margins is especially useful when you 
need to leave room for binding your printout. 
 
Printer devices have different minimum margin settings, and you may find a 
minimal margin which you have selected, is not supported by your printer. 
If your images, text, or labels seem to be cut off near the page edge, consult 
the printer manual to determine the printer’s minimum supported margin. 
 
Margin Units 
 
Margins can be specified as either 16ths of an inch (English units) or 
millimeters (metric units). Use the Margin Units: selector to switch 
between English and metric. When you change between millimeters and 
16ths of an inch, the individual margin values will accurately convert from 
metric to English and vice versa. 
 
16.8.3 The Printer panel 
 
The Printer options panel will allow you to adjust physical printing options, 
including allowing you to choose the print device itself. 
 
Printer 
 
Use the Printer: selector to choose from the list of available printers which 
your computer is set up to use. You can select only from those printers 
configured in the Windows Printers folder. If the desired printer name is not 
available from the selector, check your system’s printer settings. The 



Designer5 
 

 
504 

 

default printer displayed in ScalaPrint will match your default Windows  
printer. 
 
Paper 
 
Use the Paper: selector to choose a paper size for your print job. The sizes 
listed are those which the currently selected printer accommodates. 
 
Printer Properties 
 
Clicking the Printer Properties button will open the Windows Printer 
Properties dialog. You can then select from among the other features 
which is offered by the selected printer driver.  
 
Other than to select printer device, paper size, number of copies and paper 
orientation, you must use the external Windows Printer Properties dialog to 
change the current printer’s features. 
 
For these printer settings which you can also make directly in ScalaPrint, the 
corresponding settings in the Printer Properties sheet will reflect 
whatever choices have already been made. Similarly, changes which are 
made in Printer Properties are immediately reflected in ScalaPrint, when 
you click OK and return. 
 
Reset Settings 
 
Clicking Reset Settings changes all of ScalaPrint’s settings back to their 
defaults. Any selections which have been made, will be discarded. 
 
Print! 
 
When you have made your choices for your print job’s content, layout, and 
destination, you are ready to print. Click the Print! button to send the 
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currently configured print job to the printer you have selected. 
 
Close 
 
Selecting Close exits ScalaPrint and will return you to the Main view. All 
General, Layout, Labeling, Margins, and Printer settings will automatically 
be saved when you close the ScalaPrint view. 

16.9 Advanced Features 
 

16.9.1 Different Layouts for Different Pages 
 
ScalaPrint supports only one matrix or layout for the entire print job. If you 
want to select more than one matrix arrangement for different pages, you 
must configure separate print jobs for each intended layout. 
 
For example, if you want pages 1, 6, and 11 to print by themselves, each 
being the only slide on the page; however, you also want pages 2-5 
together on a page, and pages 7-10 together on a page; you could 
accomplish this by setting up two separate print jobs. First select pages 1, 
6, and 11 from the Main view, set the Matrix selector to 1×1, and then 
send the print job to the printer. Then select pages 2, 3, 4, 5, 7, 8, 9, and 10 
from the Main view, and set the Matrix selector to something which would  
allow 4 slides to print on a page, such as 2×2, or 1×4, or 4×1. Then simply 
send the second print job to the printer. 
 
16.9.2 Finding Missing Files in a Script 
 
When you’re publishing, exporting or printing a script in Designer, you may 
encounter a missing media file warning. If this occurs, processing will not 
continue, until the problem has been corrected. Return to the Main view  
Thumbnail mode. The page with the missing media will reveal a missing file 
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warning icon in the thumbnail.  
 
To find the missing file(s), use the Collect Files option under the File pull-
down menu. Whichever files are missing will be displayed, with their 
original path. You can then replace or reload the files, thereby correcting 
the problem. 
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 Designer 

  



Designer5 
 

 
509 

 

 
Chapter Overview 
 
Scala Designer allows you to customize your working environment to suit 
your hardware setup and personal preferences. You can adjust the 
appearance of the application’s window “skins”, set options to improve 
performance, or choose the time and date format for your national region. 
The majority of customizable options are conveniently located in the 
Options dialog, which you can access from the Tools pull-down menu in the 
Main view. 
 

17.1 Glossary of Terms in this Chapter 
 

Skin – This is defined as the graphical appearance of the User 
Interface (UI) in the Designer 5 window. By changing a Skin in the 
Options pop-up, you will change the color scheme and overall look 
of the buttons, tabs and other window elements. 
 
EX Module – A Scala EX Module is an extension which allows the 
user additional control over a variety of options such as Timing, 
Sound, Database, Schedule and more. 
 
Multi-tile– Multi-tiles are edited bitmap images which are divided 
into 4 parts in the Scala Multi-tile Editor, and stretched in the 
middle sections to accommodate scaling without distortion or 
resolution degradation.  

17.2 The Options Dialog 
 
In the Main view, choose Options from the Tools pull-down menu to open 
the Options dialog. 
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The Options dialog contains the following tabs: Playback, Authoring, 
Thumbnails, Modules, Spelling, and Info. 
 
Most of the settings discussed in the first half of this chapter will pertain to 
this dialog. 

17.3 Setting How Scripts Play Back 
 
The Playback tab panel allows you to customize how scripts will be played 
back on your system. Before you begin, you should decide whether your 
scripts will play back in a window, or fill the entire screen. Additionally, you 
will have to decide upon which display mode will be used for playback. 
 
You can choose one of two ways to make these decisions on the Display 
Configuration: selector, by picking either Window or One Screen or Cloned 
on Two Screens. The options on this panel will change depending on which 
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mode you choose. 
 
Note: When you choose Cloned on Two screens you are given the option to 
span the screens horizontally or vertically. You must then ensure that you 
set the screen options for both screens. 
 

 
 
17.3.1 Ensuring full screen playback 
 
The default for playback is full screen. 
 
To make scripts fill the screen when you click Play: 
 

1. Set Display Configuration: to One Screen.  
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2. To keep the display mode from changing from the current 
Windows setting, turn on the Same As Desktop? option. 
 

3. If you want to ensure the script fills the screen, make sure the 
Content Scaling: selector is set to Fit Inside Display (Preserve 
Aspect Ratio). 

 
There are several Channel Options you can choose to ensure the correct 
dimensions and resolutions of your display settings will be available during 
playback.  
 
17.3.2 Custom Full Screen Playback 
 
Designer will allow any script to be played back with a specified resolution, 
color depth, or refresh rate. An example for using this customizable feature 
would be if you were using a laptop computer which offered only one 
display mode. 
 
To ensure full screen playback in a particular display mode: 
 

1. Set Display Configuration: to One Screen. 
 

2. Click the Same As Desktop?: button (unchecked or Off ) to 
activate the selectors. 
 

3. Choose the active Screen: as well as the size and color depth you 
prefer, from the Screen Settings: selector. 
 

4. Select the desired Screen Orientation: (in 90 degree increments) 
 

5. Choose from the Content Scaling: selector, your desired method 
of filling the screen: Fit Inside Display (Preserves Aspect Ratio), Fill 
and Trim to Display (Preserves Aspect Ratio) or Fill Display Exactly 
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(which stretches the script to the edges of the display 
boundaries). 

 
17.3.3 Controlling Mode Switches While Previewing 
 
When a computer switches display modes to accommodate a different 
size or color depth setting for a script, there is usually a brief pause while 
the monitor clears to adjust to the new mode. Designer offers a special 
option, Quick Preview?, to control mode switching during preview playback. 
It is available in the Playback panel in both Standard and Custom playback  
modes. 
 
Normally, this option is on, which means that during preview playback, the 
display mode switches are suppressed, regardless of other settings. This is 
primarily used when you author in a window and play back in full screen 
mode. With Quick Preview? on, preview playback will be revealed in a 
window, therefore, a mode switch will not take place. To have previews 
work similar to normal playback, simply turn Quick Preview? off. 

17.4 Customizing Your Authoring Environment 
 
The Authoring panel in the Options dialog offers various settings which 
allow you to adapt the appearance and operation of Designer’s authoring 
environment to your individual preferences. 
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17.4.1 Choosing a toolbar style 
 
The toolbar in most Designer views is fully configurable. It can show an icon 
for each function and/or text, describing the function underneath. Using 
the Toolbar: selector from the Authoring tab, you can choose from the 
options Text and icons, Text only, and Icons only. 
 
17.4.2 Turning off the Status Bar 
 
The Status Bar is located at the bottom of the Designer screen. The Status 
Bar displays brief messages about Undo/Redo usage, along with other 
program operations. You can remove the Status Bar to give your  
Designer screen more vertical room simply by clicking the Status Bar? 
button off.  
 
17.4.3 Changing the Application’s Color Scheme (Skin) 
 
Scala provides several preset color schemes, or “Skins” for the Designer 
authoring environment window. Click the Skin: selector and choose a 
preset color scheme. Each skin contains a variety of characteristics, 
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however, if you’re used to working in the classic InfoChannel Designer 3 
environment, and wish to continue with a familiar color scheme, the 
classic skins are still available.  
 
17.4.4 Changing Application Fonts 
 
There are two fonts used in Designer’s views, a large font, which is used on 
most controls, and in the Information window, and a small font, which is 
used for column headings, toolbar labels, and panel tabs. You can change 
these fonts at any time, according to your sense of style, or to match  
the user interface to the size of the screen or window. To change the font: 
 

1. Click the Large Font: selector or the Small Font: selector, and the 
Font panel will open across the bottom of the window. 

 
2. Click your desired typeface design, in the Typeface column. An 

example of the selected typeface will appear in the Sample box. 
 

3. Choose a size for the font in the Size Column. 
 

4. You may also turn on the Bold? or Italic? styles for the font. 
 
The Main view and Page view will change to correspond with your selected 
font when you click OK. The name, size and style of your font will be 
displayed on the Font button. If you pick a larger font for better legibility on 
high-resolution screens, make sure to check the toolbar, and a few  
representative menus, to ensure the icons, buttons, and control labels 
remain visible. 
 
17.4.5 Save New Scripts as Plain Text 
 
When this option is on, any new scripts which are created, by default, will 
be saved in a form which is completely editable with a standard text editor. 



Designer5 
 

 
516 

 

In some cases, this will result in an extra .DAT file, which contains some of 
the script contents. This option applies only to new scripts. Existing 
scripts will be saved in the same form in which they were opened. You can 
change this setting on a per script basis in the Save Script File dialog,  
under Advanced Options. 
 
17.4.6 Smart Quotes 
 
When this feature is on , straight quotes (‘) and (“) will be replaced with 
Smart Quotes, (as you type).  

17.5 Configuring the Thumbnail views 
 
You can specify the size of the thumbnail images for the Main view.  
 
The Thumbnail view can also be adjusted in the Authoring tab, using the 
left/right arrows in the selector for Thumbnail Width (in pixels). If you 
prefer, you may select the number between the arrows and type in the 
pixel width numerically. Decrease the value if you want to see more 
images, increase the value if you want to see larger, more detailed 
images. Click the OK button to accept the new changes and close the dialog.  
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17.5.1 The Scala Module system 
 
Designer enables various functions and “talks” to hardware devices 
through special software modules called Modules. A module works like a 
printer driver. It seemingly “knows” about the kind of signals and the 
data format needed by a particular device. It also knows how to talk to   
Designer, so in effect it translates commands which come from a script—
for example, an event which runs a videotape—into the form required by 
the device. 
 
However, a module is more than a simple driver. Modules actually add new 
capabilities to Designer. Modules which enable you to use a new device, 
frequently have their own menus, and add a column of buttons to the Main 
view. Others might operate entirely in the software, such as a Module 
which would allow Designer to exchange data with another software 
application. 
 
Modules can be supplied by Scala or by third-party developers. You can 
enable new Modules on your Designer sysytem at any time – however 
some Modules will not function without being licensed. The Modules panel 
displays Modules in two scrolling lists. Modules which are integral to the 
Designer software, and have no optional settings, will not be displayed. 
Only Modules which have configurable settings and/or are optional will be 
listed. 
 
17.5.2 Module menus and settings 
 
When you click a button in a Main view column, a menu for the 
corresponding Module will appear. You can then adjust the settings just as 
you would for similar columns in the Main view. Some Modules contain 
configuration settings. Modules such as Timing and Launch in the default  
Designer installation—are shown in the Options dialog Module Settings list.  
The settings which are available with these dialogs are global settings. 
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Any event or script which uses the corresponding Module will be affected. 
In contrast, the Module menus which you see on the Main and Design List 
views control settings which are specific to a particular script event. 
 
Configuring the Timing Module 
 
The Timing Options dialog primarily controls how the Designer system 
variables, Time, Date and WeekDay display their information. With several 
options available, you can use the formats best suited for your geographic 
region (or the region in which your scripts will run). Day, date, and time are 
displayed in scripts by embedding those variables in the normal text. To 
choose time and date formats, simply click the Timing Module button in the 
Module Settings column. The Time, Date, and Weekday variables dialog will 
appear with Time format:, Date format:, and Weekday format: options. 
The options will be indicated by on three pop-ups. 
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There are three options for Weekday format:, Use Windows Regional 
Options, Use Installed Language, and Use English. 
 
If you prefer your text which appears in the timing variables (am/pm, 
October, Thursday) to be all in upper-case (AM/PM, OCTOBER, THURSDAY), 
simply turn on the Upper-case only? option. 
 
To save these settings as your defaults, and exit the Timing dialog, click 
OK. Click Cancel or the dialog close button, to discard any unwanted 
changes.  
 
Configuring the Launch Module 
 
The Launch Module allows an Designer script to launch external 
applications and commands under script control. The Launch Module has 
one option, which is accessible from the Launch Module Options dialog. 
 
The Security: pop-up will allow you to set a security level when opening 
scripts which contain Launch events. It will determine whether Designer 
displays a warning dialog before running a script which contains Launch 
events. The dialog will also advise if an application launched from a script  
could potentially have undesired effects, such as overwriting or deleting 
files without notice. An option to abort opening the script, will be offered. 
 
The default choice is Warn when opening, which will cause a cautionary 
dialog to be displayed whenever you open a script containing Launch 
events. Use this choice if you are opening scripts from un-trusted 
sources. Disallow opening prevents the opening or authoring of scripts 
which contain Launch events. If the scripts which you will be creating or 
using do not contain Launch events, select this choice. 
 
No warning when opening will disable Launch event warnings. This can be 
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convenient for those who often work with scripts which contain Launch 
events and prefer to avoid the dialogs. The Launch Module’s power makes 
the playback machine vulnerable to software which may be damaging. 
Because of this risk, it is recommended you do not set the Launch Module  
security level to No warning, especially if you are opening scripts from 
unknown sources. 
 
To save the setting as the default and exit the Launch dialog, simply click 
OK. Click Cancel or the dialog close button to discard any unwanted 
changes.  
 
Configuring the Schedule Module 
 
The two choices for this option are for the First Day of the Week: select 
Sunday or Monday. 
 
17.5.3 Enabling and disabling Modules 
 
The Module buttons in the Optional Modules list will allow you to turn an 
optional Modules on and off. Modules which are “on” have a on the 
button; those which are “off” do not. When you turn an Module off, its 
column, if any, will no longer appear in the Main view. 
 
You always have an option to turn off a Module for any reason. If a Module 
adds new script production capabilities to Designer, a column will appear in 
the Main view when the Module is on. The column for a new Module will 
appear to the right of the Main view columns. You may need to use the 
horizontal scroll bar on the Main view to see additional columns of new 
Modules.  
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17.6 Spelling Options 
 
There are several options associated with the spell checker, which are 
found in the Spelling tab on the Options dialog. 
 
17.6.1 Choosing a language 
 
The spell checker can check spellings of words in many different 
languages, however, it can only check one language at a time. The default 
is US English. The Language: pop-up lists the languages available for spell 
checking. For a language to appear, a dictionary file for that corresponding 
language must exist.  
 
17.6.2 Resetting the Ignored Words List 
 
The spell checker builds a list in memory of words which you have specified 
for the checker to temporarily ignore. Any words which are on this list will 
not be checked by the spell checker for the rest of that corresponding 
Designer session. 
 
You may clear the ignored words list at any time to enable spell check to 
reset. For example, you could have a script which deliberately uses a 
misspelled word, such as a trademarked name. To prevent the spell checker 
from continually stopping at this word, simply click Ignore All when spell 
check initially stops at the word. ( Do not add this word to the user 
dictionary. By doing so, the misspelling would always be ignored, and never  
caught in normal usage outside this particular script.) To clear the ignored 
words list, so text will be re-checked, click Reset Ignore All. Once the list has 
been reset, the text it contained, cannot be refreshed. 
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17.6.3 Editing the User Dictionary 
 
The spell checker will allow you to build a custom user dictionary of words 
which will never be flagged as misspelled. Having misspelled words in the 
user dictionary prevents those misspellings from being noticed and 
corrected; the inclusion of correctly-spelled common words is redundant, 
because those words are already in the main dictionary. An excessively 
large user dictionary can also slow down the spell checking process. For 
this reason, it is possible to view the user dictionary’s contents, and 
delete words from it, as necessary. The Custom Dictionary scrolling list in 
the lower part of the Spelling panel displays the words in the user 
dictionary. To delete a word, simply select it and then click the Delete 
button at the bottom of the panel. 
 
There is an independent user dictionary for each language. If you spell-
check in multiple languages, you will need to choose the correct language 
before you can edit its corresponding user dictionary. 
 
17.6.4 Information Options 
 
The Info panel displays product identification information. It reveals the 
name, release date and language of the Designer installation as a whole, 
and version numbers of various system software modules, including EX 
modules. You can click in the list to highlight an entry, making it easier to 
read. 
 
If you have problems with Designer or with Modules, it may help to record 
the version numbers, so you can report your system setup accurately to 
technical support personnel. 
 
17.6.5 Using and Resetting Options Settings 
 
When you have made changes to settings in the Options dialog and want to 
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return to working with scripts using the same a settings, you have a few 
possible choices. 
 
OK will confirm any changes made since you entered the Options dialog, 
Cancel will discard them. In either case, the dialog will close. If you 
confirmed the changes, your settings will remain in effect for the rest of 
your editing session Additionally, they will be saved for future sessions. 
 
17.6.6 Resetting all options 
 
Click Reset Settings to return to Designer’s default settings. 

17.7 Multi-tile Editor 
 
The Multi-tile Editor is similar to a built-in graphics editor, which splits 
bitmapped elements into sections that can be stretched and scaled; while 
keeping their 4-corner integrity in shape and resolution. This tool will 
work with any imported JPG, BMP or PNG image file. This is a highly 
effective tool to quickly and seamlessly create scalable screen graphic 
elements, lower-thirds, title bars, etc… 
 
17.7.1 How multi-tiles work 
 

A multi-tile is a bitmap image file which begins as an ordinary clip. The file 
format used for multi-tiles, however, is extensible in such a way which the 
image can behave differently when resized than a regular clip does. 
 
Multi-tiles make it possible to resize clip-art imagery without distortions 
which may be seen when stretching an ordinary bitmap. When you resize a 
bitmap, such as a clip, the pixels in the image are elongated equally, 
resulting in an overall stretched appearance to the clip image. 
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For example, if you start with a clip of a painting in a picture frame, after 
resizing it to twice its original width, the left and right sides of the frame will 
appear to be twice the thickness of the top and bottom of the frame. If the 
clip were made into a multi-tile, the frame would retain its original 
proportions on all sides. The “framing” portions of an image—the top, 
bottom, left and right sides—will retain their original proportions regardless 
of resizing. 
 
Making a multi-tile from an ordinary image is accomplished by using the  
Designer Multi-tile Editor to slice the source image into nine tiling regions. 
There are three slices in each direction. The four corner regions will not 
change size, and will not be duplicated when the multi-tile is sized. 
 



Designer5 
 

 
526 

 

 
 
The middle regions of the four outer slices are duplicated in the appropriate 
direction when the multi-tile is sized: the Top and Bottom middle regions 
are duplicated horizontally, and the Left and Right middle regions are 
duplicated vertically. This will ensure that the sides of the image, where you 
would typically have features such as beveled edges, shadows, etc.,  
will continue to fit with the corner regions. The “center-middle” region is 
tiled, or duplicated both horizontally and vertically as necessary, to fill the 
internal area of the multi-tile for the desired size. 
 
The process of creating a useful multi-tile is primarily a matter of defining 
the slices, therefore, the multi-tile will be proportionately correct at any 
size. This involves determining where the edges of each slice must be so 
which the internal pattern, if any, is tiled without any ugly discontinuities. 
Properly adjusted, the edges will line up with the image’s internal areas  
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for a smooth and consistent look, regardless of resizing. 
 
17.7.2 Accessing the Multi-tile Editor 
 

 
 
Access the Designer Multi-tile Editor through the Tools pull-down menu 
from the Main view (Tools>Multi-tile Editor). This will open the Multi-tile 
Editor screen. 
 
You can create a multi-tile image in the Multi-tile Editor by modifying a 
source image file. The source image can be any BMP, JPG or PNG graphics 
file, although for the purpose of creating a multi-tile, the image should 
ideally be fairly small, and contain some type of pattern, suitable for tiling. 
 
Defining the multi-tile involves specifying the dimensions of the six slices of 
the image file, as well as a sizing increment, called granularity. 
 



Designer5 
 

 
528 

 

17.7.3 Open 

 
Click the Open icon in the Multi-tile Editor toolbar to open the File dialog. 
Choose a source image in any format, or an existing multi-tile (PNG 
format). When you have chosen an image, click OK. The Multi-tile Editor 
containing your chosen image will appear, ready for editing. The name of 
the image will appear in the bar below the toolbar. 
 
17.7.4 Save 

 
To save a multi-tile which you have created or edited, simply click the Save 
icon in the Multi-tile Editor toolbar to open the File dialog. You can also save 
the multi-tile to any location. Regardless of the format of the source 
image, multi-tiles will be saved as PNG files. 
 
17.7.5 Close 

 
Click Close to exit the Multi-tile Editor and return to the Main view. You will 
be prompted to save any unsaved changes. 
 
17.7.6 Image areas 
 
The Multi-tile Editor screen has two display areas. The large area to the 
left is the Graphic Editor, which shows an enlarged version of the source 
image. This is where you actually define the slices. The name of the 
currently open file will be shown in the bar above this area. In the lower 
right of the editor is a tabbed display section which contains the Preview 
tab, which shows a stretched version of the source image, using the 
settings you have defined for it, and the Original tab, which shows the 
image at its natural, un-expanded dimensions. 
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17.7.7 Slice Controls 
 
Above the Preview/Original tabs are the buttons of the Numeric Editor, 
which control the vertical and horizontal slices. Each of the six slice buttons 
displays two pixel values: the first is an offset (the number of pixels from 
the top edge or left edge of the source image) and the second is width. 
 
When you select one of the buttons, the corresponding slice will be 
highlighted on the Graphic Editor’s enlarged image. Changing the 
Numeric Editor values will change the dimensions of the slice in the editor. 
Similarly, clicking in the enlarged image will select a slice. By dragging the 
graphic handles on the sides of the slice, the pixel values on the 
corresponding button will automatically update. You can use either or both 
methods to define your slices.  
 
17.7.8 Granularity 
 
In Designer, you can resize a clip arbitrarily to any pixel size. However, 
multi-tiles are resized in discrete increments which may be larger than a 
single pixel. The Granularity value control specifies the increments by the 
size which the multi-tile can be changed. A large granularity limits the 
number of possible sizes you can make; a small granularity allows you to  
resize more freely. 
 
The control will allow you to adjust the horizontal and vertical granularity 
independently, in pixels. Click the Granularity control to activate it. This will 
also highlight the granularity setting graphically on the enlarged image. You 
can adjust the setting using the handles, similar to working with slices. 
Generally, granularity should be small, such as 3 × 3. This will allow greater 
precision in sizing the multi-tile. The limiting factor in specifying the 
granularity is the source image, and the desired look when it is adjusted 
to its final size. With some source images, the exact granularity setting is 
not critical. However, others may call for a particular granularity value. 
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Following are two main reasons for specifying a particular granularity value:  
 
� to prevent discontinuities between the center-middle slices and the 

Bottom and Right slices. 
 
If the granularity is smaller than the size of the center-middle slice, 
segments of the Center and Middle slices (in granularity-sized 
increments) are used to complete any odd-sized area on the right and 
bottom of the fill area. These segments might not match with portions 
of the central pattern that could be present in the Bottom/Right  
slices. 
 

� to ensure the pattern contained in the center-middle region will always 
reproduced in its entirety, not cut off from the bottom or right sides. 
 
When the granularity is made equal to the size of the tile defined by 
the Center and Middle slices, only whole center-middle tiles will be 
displayed, and the pattern will not be cut off. 
 

If the source image contains a repeating pattern, the granularity should 
match the size of the smallest unique portion of the pattern, therefore, 
when duplicated, the slices will fit together seamlessly. You might also want 
to do this to prevent the repeated part from appearing cut off on the 
bottom and right side of the multi-tile. The granularity values can range 
from 1 ×1 to a maximum equal to the size of the center-middle region of  
the image. 
 
17.7.9 Relationship between granularity and center-middle 
region 
 
The granularity of a multi-tile is not necessarily the same as the size of the 
center-middle region. Aside from the fact that granularity cannot be larger 
than the size of the center-middle region, the settings of Granularity, 
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Center, and Middle are independent. 
 
This will allow you to optimize both the precision with which you can resize 
the multi-tile and the quality of the resulting image. The center-middle 
region is used as the basic tile unit to fill the multi-tile; Designer will 
always reproduce the full tile, or as much of a full tile as possible within the 
space available. When the final size of the multi-tile cannot be filled by 
complete tiles, partial tiles will be used. The size of the partial tiles can 
vary in granularity-sized increments. Some multi-tile images have a large-
scale pattern or shape, therefore, they will simply look better with a large 
center-middle tile. However, the nature of some large-scale patterns may 
allow a small granularity. 
 
Some examples help to illustrate these different possibilities. If the 
pattern filling the source image is a checkerboard, alternating pixels of two 
different colors, the ideal dimensions of the center-middle region would be 
2 pixels wide and 2 pixels high. Other even numbers would also be effective. 
A setting which included an odd number, however, would disrupt the even 
checkerboard pattern, producing an unattractive discontinuity within the 
boundaries of each slice. Any granularity setting would work equally well. 
 
Create a blank page and use Add from the Page view and select RedRing-
MT.png. Initially the source image will appear, the simple Red Ring. 
 
To enlarge the multi-tile, the center and middle slices are duplicated. 
Additionally, since the slices are from the center of the sphere, (where the 
colors are solid and smooth), the resulting multi-tile surface will be solid 
and the edges will be smooth. 
 
Select the side handles and drag them toward the center until you see 
you’re half-way in the preview window in the right. 
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Repeat with the opposite side handle and move to the top handle and pull 
it half-way down. 
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Pull up the bottom handle to the center and make any adjustments with the 
numeric selectors in the upper-right. 
 

 
 
You’ll notice the rectangular shape that’s being generated in the preview 
window. Save your multi-tile so it can be imported into your Designer 
projects. Several multi-tiles can be used on a page, maintaining their 
transparency. Use them to create interesting graphic blocks and text 
boxes. 
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Another type of multi-tile that has texture requires the granularity setting 
to be adjusted to make a smoother center of the tile. For example, this 
grass image has beveled edges and an intricate patterned center. 
 

 
 
Select the side handles and drag them toward the center, but only about a 
third of the way. Repeat with the top and bottom handles. 
 
Adjust the Granularity at least 30 pixels in each direction to create a smooth 
blending of the tiling edges. 
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17.7.10  Working in the Multi-tile Editor 
 
The basic strategy to make a multi-tile is to make the framing slices (Left, 
Right, Top, and Bottom) just wide enough to contain the parts of the source 
image which form the borders of the image. The Center and Middle slices 
contain the areas of the image which can be duplicated. 
 
The trick is to adjust the slice edges so they will precisely match the edges 
of the pattern which is to be repeated. The Center slice should be exactly 
as wide as the pattern, while the Middle slice should be exactly as tall. 
These slices may also be multiples of the width/height of the pattern. If the 
framing slices contain any of the central pattern, their edges should be at 
the edges of the patterns when you try it for yourself. Although you can  
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use any image to make a multi-tile, to achieve optimal results, you should 
use a source image which was specifically created for this use. Typically 
this will be a rectangular graphic which contains shading or other special 
treatment of its edges and corners; along with a central pattern which is 
designed to fit seamlessly together when tiled. By using the 
aforementioned image, the tiling won’t be apparent: the multi-tile interior 
will look like a single, unbroken surface and the edges will be continuous. 
Clip-art libraries, particularly those intended for Web authoring, often 
contain graphics which have been specifically designed with this purpose 
in mind. You can also use an external paint program to create effective 
images. 
 
17.7.11  Working With the Source Image 
 
When you first open a plain image (one which is not already a multi-tile) 
into the Multi-tile Editor, the Center and Middle slices are set to occupy the 
entire image. If your image is a uniform pattern, the other slices will be 
superfluous allowing you to simply adjust the granularity and immediately 
save the image.  
 
NOTE: If you open a new image which is the same size as the current image, 
the slice definitions for the current image will be retained. 
 
Assuming your source image contains edge features which should be 
preserved, you will have to reduce the dimensions of the Center and 
Middle slices, thereby increasing the dimensions of the Left, Right, Top, 
and Bottom slices enclosing the borders of the image. 
 
17.7.12  Selecting slices 
 
A given area of the image is usually a part of two slices, a horizontal slice 
and a vertical slice. The bottom left corner of the image is part of both the 
Bottom and Left slices. By clicking the corresponding button in the 
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Numeric Editor, you can select whatever slice you desire. 
 
As a shortcut, you can also click on the image in the Graphic Editor. By 
clicking within the selected slice, you can switch between a given area’s 
vertical and horizontal slice. Whenever you click within a slice which is 
already selected, the enlarged image will change from displaying horizontal 
to vertical slices, or vice versa. The place in the selected slice where you 
click to change modes determines which of the three possible slices in  
the other direction will be selected. 
 
For example, if the Left slice is selected, and you click in the lower part, 
the Bottom slice will also be selected. If the Center slice is selected, and you 
click in the middle, the Middle slice will also be selected. Use the dashed 
lines, which indicate the boundaries of other slices, as your guide. 
 
Clicking in an un-highlighted area of the image, or in an area outside the 
image, will select another slice without changing the horizontal/vertical 
display mode. If you click somewhere within some other slice, that slice is 
then selected. If you click somewhere which is not part of any slice, the 
nearest slice is selected. For example, when the Bottom slice is highlighted,  
clicking anywhere in the Top slice or above the image will select the Top 
slice. 
 
Slice selection in the Graphic Editor will become clear with a little 
practice. 
 
17.7.13  Adjusting slices 
 
First, click on the enlarged image. A newly-opened image will be 
highlighted, and the entire image will be enclosed in a box with graphic 
handles on the left and right. The Center button will also highlight, 
indicating you have selected the Center slice. When a slice is highlighted, 
dashed lines will indicate the boundaries of other surrounding slices, for 
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reference. At this point, a dashed box around the entire image will appear.  
Drag both of the graphic handles toward the center of the image. The offset 
and width values in the Center button will change accordingly. The 
boundaries of the adjacent slices will also adjust so their edges coincide. 
Think of the edges of the adjacent slices as being attached, so as you 
adjust the slices, gaps and overlaps will be prevented. Only the area of the 
current slice, within the solid box, will remain highlighted. If you click again 
within the highlighted area, the Middle slice will be selected. The Middle 
slice is still the full height of the image, therefore, it will be highlighted 
accordingly. The handles will appear on the top and bottom of its bounding 
box. Drag the handles toward the middle of the image.  
 
17.7.14  Separating the edges of the slices 
 
By default, the edges of neighboring slices are “stuck together”: For 
example, when you move the right edge of the Middle slice, the left edge of 
the Right slice will move in tandem. This will ensure that the source image’s 
pattern will match from slice to slice. The edges of the slices may also be 
adjusted independently. 
 
To independently control the edge of a slice, hold down Ctrl while dragging 
its handle. As you position the selected slice edge, the edge of the 
neighboring slice will not move. Once separated, the two edges will remain 
independent of one another, until they are moved, once again. The 
capability to separate slices may occasionally be useful, for example if 
there is one part of the source image which you want to constitute the 
repeated multi-tile pattern. 
 
17.7.15  Using the Preview Image 
 
As you drag the handles, the Preview image will change in real time to 
reflect your settings. The example will then expand to fill the preview box, 
given the current settings. (If the source image is too large, it may not be 
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possible to fit a stretched image in the Preview panel. With a very large 
source image, the sample may extend beyond the edges of the box. If this 
occurs, simply drag the sample around in the Preview panel so you can 
easily see the outer areas.  
 
Because the size of the box is limited, changing settings may occasionally 
cause the size of the sample to jump. It is important to inspect the sample 
multi-tile carefully to see how your slice adjustments will affect the 
stretched image.  
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||||| 18 Making Scripts 
 Interactive 
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Chapter Overview 
 
A script that is interactive can accept input from the user. Buttons and fields 
are the key to the world of interactivity. A button is an element in your 
script that provides interactivity. These elements give the viewer control 
over the direction of the production. By using the mouse (or another type 
of input device, like a touch screen) to select buttons, the viewer can make 
choices about how the script should proceed. 
 
A button can trigger almost any kind of event: jumping to a new page, 
playing a sound, wiping in an element, even making calculations with 
variables. This makes it possible for you to create flexible, powerful scripts 
that can adapt themselves to respond to a wide variety of audiences. Your 
interactive button, then, could be anything from a cat illustration that 
“meows” when clicked, to a catalog of product photos and text that a 
potential customer can browse for information. 
 
Buttons are created and edited in the Design Buttons menu, where you 
work with unique button features: 
 

� Go to other locations in the script 
� Link sounds to butt 
� Specify hotkeys for buttons 
� Set variables based on button activity 
� Use custom mouse pointers 
� Independently set options for various button states 

 
Although buttons have special features, they are elements that can be 
manipulated just like other elements - using wipes, cut and paste, and the 
other Designer menus. You have all the Element Design options open to you 
to make the element look the way you want. 
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Designer gives you great freedom to design your own buttons, but you 
don’t have to do so. The Buttons menu also gives you the option of 
choosing from a selection of predefined buttons and button backdrops 
supplied by Scala, which have matched images for the various states. 
 
This chapter introduces you to the Buttons menu, and walks you through 
the process of creating these interactive elements. It also discusses the 
Input menu, where you can set various options related to mouse input, 
keyboard input, and pointer images. 

18.1 Glossary of Terms in this Chapter 
 

Push Button - Push buttons are the most common and versatile 
type of button. They are typically used for branching to another 
page of the script, or accepting some kind of response from the 
viewer. A Push button can have one, two, or three visual state. 
 
Toggle Button - A Toggle button is used to switch a logical 
variable between its two possible values, on and off. This makes 
it easy for a script to accept and respond to Yes/No kinds of input 
from the viewer. The button itself can have either two or four 
visual states. Unlike a Push button, a Toggle button remains in its 
selected state after being clicked so that its value is obvious. 
 
Radio Button - A Radio button is similar to a toggle button, but it 
works with any kind of variable, so it can assign any type of value 
(text, numeric, or logical). Like a Toggle button, it has either two or 
four visual states, and remains in its selected state after being 
clicked.  

18.2 Getting started: Creating push buttons 
 
To use a button, you generally need a script consisting of at least a few 
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pages. Once you have some pages in your script, you can begin making it 
interactive. 
 
The following examples, Creating a text button and Creating a predefined 
button show you how to create simple buttons and illustrate how the use of 
buttons can change the normal script sequence. 
 
The examples are intended to show you the basics, but there is much more 
that you can do when creating buttons.  You are encouraged to 
experiment with Designer’s interactive capabilities and use your 
imagination to create productions that get your audience involved in the 
multimedia experience. 
 
18.2.1 Creating a text button 
 
A button can be almost any element, so text can also be a button, even 
when there is no separate button image associated with it. The following 
example shows you how to make text into buttons. 
 

1. Create four new pages by loading the four backgrounds provided in 
the ScalaArt:\ClipArt\GuideExamples folder. For the sake of this 
example, choose “look” for page 1; “clock” for page 2; 
“hourglass” for page 3; and “idea” for page 4. 
 

2. Go to the Design Text menu for the first page, choose a large font, 
then type Clock, Hourglass, and Eureka!, each on its own line.  
 

3. Click the Buttons icon. You see the Design Buttons menu, which 
looks like this to start with: 
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You make an element a button by choosing a kind of button from the Type: 
pop-up while the element is selected. 
 

4. Select all three elements, then choose Push Button for the Type: 
pop-up. You will see a dialog asking if you want to change the 
timing of the page to Wait Forever. Click Yes in this dialog. 
 

5. Select the 3-state button. This makes each text element into a 
three-state push button. 
 

6. Press F12 or click the middle indicator in the title bar to change 
the buttons visual state from Normal to Highlight. 
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7. Go to the Design Text menu and click Shadow.  This gives each 
word a shadow when highlighted. 

 
8. Press F12 again, to change to the Select state. 

 
9. Turn on Shadow , and also change the Front color.  The buttons 

will have a shadow and a new color when selected. 
 

10. Return to the Buttons menu and go to the Select Action tab.    
Select Clock by itself. 
 

11. Choose Action: Go to Next Page. 
 
The Select state is where a button actually does its work. Usually, this 
means jumping to another location in the script. You choose the destination 
for a button with the Action: pop-up on the Select Action tab.  The Go to 
Event, Go to Next Page, and Go to Previous Page options let you specify that 
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execution flow should branch to another page when the button is selected.  
The Action: pop-up is described in more detail on See Using Go to actions 
in this chapter. 
 
The Level: selector is also visible on the Select Action tab when Go to 
Event is chosen displays the level of the script where the destination is. If 
your script doesn’t have any groups, as in this example, your only choices 
are <this script> and <this page>. 
 
The Go To: selector indicates which page or event you want the script to 
advance to. 
 

1. Select Hourglass and choose Action: Go to Event . Set the Go to: 
selector to page 3, and finally select Eureka! and set Go To: to 
page 4. 

 
2. Select Preview to see the buttons in the three button states; move 

the mouse pointer over the buttons and click on them to see the 
highlight and select states. (Preview cannot, show the effects of 
Go To: settings. To see how buttons change script execution, you 
must play the script.) 

 
3. Click the Main icon to exit to the Main menu 

 
Now play the script and click on the interactive text buttons you have 
created to see how they affect the flow of the script. See if you can figure 
out what needs to be done to return to page 1 after your buttons branch to 
the other pages. 
 
You have now created three simple interactive text buttons. You can follow 
the same basic procedure to create buttons that start with clips instead of 
text. There are a number of ways to do this, but one of the simplest is to 
use Designer’s predefined buttons, as in the following example. 
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18.2.2 Using a predefined button 
 

1. Create four different pages by loading four different backgrounds 
from the Guide Examples folder. Choose “Paper” for page 1; 
“BlueBG” for page 2; “YellowBG” for page 3; and “RedBG” for page 
4. 

 
2. Go to the Text menu on the first page, and type: blue yellow and 

red, each on its own line. 
 

3. Goto the Buttons menu by choosing the Buttons icon 
 

4. Click the Add icon, which opens the File dialog, where you can 
choose button (.btn) files from the Guide Examples folder. 

 
5. Choose the Blue1 button. After you choose the button, you return 

to the Buttons menu, and you see a round button. The button is 
automatically created as a three-state Push button. 

 
6. Place it next to the blue text, which will serve as a label. 

  
7. Follow the same procedure to add the Yellow1 and Red1. 

 
You see three round buttons, each having a label of blue, yellow, or red.  
The buttons appear in their Normal states. 
 
Predefined buttons, like the one in this example, have matched images for 
these various buttons states, so you don’t have to load, create or 
position separate imagery for each state. 
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1. Choose one of the three buttons you just created then press F12 to 

see how the button looks in its highlighted state. 
 

2. Press F12 again to see how the button looks in the selected state. 
 

3. Select the blue button and click the Select Action Tab. 
 

4. Choose Action: Go to Event and set the Go To: selector to page 2.  
(You could also use Action: Go to Next Page for this button.) 
 

5. Select the yellow button, choose Action: Go to Event, and set the 
Go To: selector to page 3. 
 

6. Select the red button, choose Action: go to Event, and set the Go 
To: selector to page 4 
 

7. You can click Preview to see how the buttons appear in the 
different states. 
 

8. Run the script and try out the buttons 
 

18.2.3 Working in the Design Buttons menu 
 
The Design Buttons menu can be accessed by clicking the Buttons toolbar 
icon from the Design page menu. When you enter the Buttons menu, you 
see the Type tab, which gives you several options for button type. 
 
18.2.4 Button types 
 
The button Type: pop-up controls whether an element is a button, and if so 
what type of button it is. The possibilities are:  
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Push Button - Push buttons are the most common and versatile type of 
button. They are typically used for branching to another page of the script, 
or accepting some kind of response from the viewer. A Push button can 
have one, two, or three visual states. 
 
Toggle Button - A Toggle button is used to switch a logical variable 
between its two possible values, on and off.  This makes it easy for a 
script to accept and respond to Yes/No kinds of input from the viewer. The 
button itself can have either two or four visual states. Unlike a Push button, 
a Toggle button remains in its selected state after being clicked so that its 
value is obvious. 
 
Radio Button - A Radio button is similar to a toggle button, but it works 
with any kind of variable, so it can assign any type of value (text, numeric, 
or logical). Like a Toggle button, it has either two or four visual states, and 
remains in its selected state after being clicked. 
 
18.2.5 Changing a button’s type 
 
It is possible to change a button from one type to another. Just select the 
button and then choose the new type from the Type: pop-up. When you do 
this, you see a confirmation dialog telling you that button attributes 
unique to that button type will be lost in the conversion. 
 
Turning a button back into a normal element 
 
For any element selected while in the Buttons menu that is not a button, 
the Type: pop-up shows None. If you need to turn a button back into a 
normal element, select it and then choose Type: None. A warning dialog 
indicates that you will lose any button attributes you may have already 
defined if you do this. 
 
Button basics 
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In Designer, there are many ways to create a button. You can start with 
ordinary text, or a clip or graphic object, and turn them into buttons. You 
can start with predefined button files supplied by Scala, and add text or  
imagery as labels. You can build buttons using your own text along with 
predefined files from Scala in various combinations, or by modifying 
buttons that you have previously created and exported. 
 
Face and backdrop 
 
Buttons you make in Designer have two possible components for each 
state: backdrop and face. The face (text, for example) is generally used to 
identify the button. The backdrop is an area underneath the face that helps 
make the face visible against background imagery and emphasizes it or 
makes it look more presentable. 
 
Buttons with a backdrop image and no visible face, or with a face and no 
visible backdrop, are possible and may be useful. Keep in mind, however, 
that the face must be a single element only. You are always free to label 
your buttons with additional plain text or clips that are next to or on top of 
a button. If you do so, however, you will then have to move and adjust 
those items separately whenever you edit the button, as they will not  
change when the button changes state. 
 
18.2.6 Button states and state events 
 
Different types of buttons have different state options. Push buttons can 
have one, two, or three visual states. Toggle and Radio buttons can have 
either two or four visual states. 
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When you have selected a type of button that has multiple visual states, a 
series of buttons appears on the menu showing the choice of number of 
states for that button. Click one of the choices to establish the number of 
states for the button you are creating. 
 
18.2.7 Choosing and keeping track of button states 
 
When you create a multi-state button, or select an existing multi-state 
button, a row of three or four identical buttons appears in the title bar of 
the Design menus, just to the right of the menu name. Each button has a 
“button” icon on it, and represents a particular state of the currently 
selected button. You see these indicators in the title bar of any Design 
menu whenever a Push, Toggle, or Radio button is selected. 
 
At least one of these button icons is always selected, indicating the 
current state of the selected button. If you have defined a Push button with 
fewer than three states, or a Toggle or Radio button with fewer than four 
states, the title bar icon(s) for the unused state(s) are disabled. 
 
More than one state of the selected button(s) may be current at a given 
time, so that you can apply the same styles and attributes to several states 
at once. Select multiple button states to affect them all with the same 
attributes by Ctrl-clicking as many title bar state indicators as desired. 
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To cycle through the states of the currently selected button, use the F12 
shortcut. Or you can click the button icons to switch directly to a particular 
state. Hold the mouse pointer over button icons to get tool tip information 
about which state each icon represents. Both F12 and the button icons 
are available in any Design menu. 
 
Most of the options in the Appearance and Action tabs can be applied 
independently to each of a button’s states. 
 
18.2.8 Push button states 
 
A Push button with one state has a single appearance. It can respond to 
being selected, but the button itself cannot give any visible response to the 



Designer5 
 

 
553 

 

mouse passing over it or clicking on it the way a button with multiple 
states can. 
 
A two-state Push button can have a different appearance for its Normal 
(idle) state and its Select state (when it is clicked by the mouse). 
 
A Push button with three states can have separate appearances for 
Normal, Highlight (mouse pointer touching it but not clicked, or highlighted 
by using arrow keys) and Select (clicked-on) states. 
 
If you do not make changes to the button for its Highlight state, the button 
keeps its normal imagery when the mouse pointer is over it. Using the 
Highlight state is valuable in most interactive productions as a way of letting 
viewers know where buttons are, so they know when they can click or 
press Enter to choose a button. 
 
During playback, a button displays the Select state when it is chosen by 
clicking on the mouse, when the viewer presses Enter while the button is 
highlighted, or when the viewer touches the button if using a touch screen 
device. Using different imagery for the Select state helps confirm for the 
viewer that his or her choice has been noticed and accepted. 
 
You can also create hotkeys to select buttons. See the section, Creating 
hotkeys later in this chapter for more information. 
 
18.2.9 Toggle and Radio button states 
 
The states possible for Toggle and Radio buttons are somewhat different 
from those of Push buttons. These button types are always in either an Off 
or On state. Additionally, for a four-state button, both the Off and On states 
can have a Highlight state as well as a Normal state. 
 
A two-state Toggle or Radio button can be either Off (typically appearing 
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like a Push button in the Normal state) or On (typically appearing like a Push 
button in the Select state). It does not respond to the mouse pointer until 
clicked on. 
 
A four-state Toggle or Radio button works the same way, but both the Off 
and the On positions also have a Highlight state to indicate when the 
pointer is over the button. 
 
When a Toggle or Radio button is clicked on, the button changes state, but 
unlike a Push button, it remains in the changed state after the mouse 
button has been released. A Toggle button switches from its current state 
to the opposite state whenever it is clicked. Clicking a Radio button, can 
only switch it from its Off to On state. However, clicking a Radio button in 
its On state does not switch it back to Off. For this reason, several Radio 
buttons are typically used together to let the user make choices. 
 
See the section Working with Toggle and Radio buttons for information. 
 
18.2.10  Select Action options 
 
There are two tabs in the Buttons menu for controlling the actions that can 
happen when using the action-oriented button types (Push, Toggle, and 
Radio buttons): the Select Action tab and the Other Action tab. 
 
18.2.11  Actions on button selection 
 
The Select Action tab is for specifying the primary purpose for an action-
oriented button. In particular, it lets you choose what happens when the 
button is put into the Select or On state. (This occurs when the button is 
clicked on, or the viewer presses Enter or a defined hotkey while the 
button is highlighted.) Most often, the action is a branching type of 
operation (moving to another event or page within the script). However, 
other action types are possible. 
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The Action: pop-up on the Select Action tab has the following options: 
 

� None 
� Go to Event 
� Go to Next Page 
� Go to Previous Page 
� Return to Bookmark 
� Exit from Script 
� Show WWW Page 

 
18.2.12  Using Go to actions 
 
The three “Go to” actions allow you to make script execution move to 
some other location in the script, from which execution continues. The new 
location can be another page or another event on a page.  This lets the 
response to a button be almost any series of scriptable events. You can 
return to the original button location after a button Go to by setting a 
bookmark. 
 
18.2.13  The Go to Event action 
 
Go to Event is the most flexible button branching action. Consequently it 
requires you to specify both the destination itself and the level of the script 
where the destination exists. You see the controls for these on the tab 
when you choose Action: Go to Event. 
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Use Level: to choose the level of the script where the destination is. Use 
the selector to cycle through the levels. If the destination is in the same 
group you are in, you can leave the selector as is. If your script has no 
groups, the only choices are: <this script> and <this page>. Only levels at 
or above the current level are accessible. 
 
Use the Go To: selector to choose the page or event that you want the 
script to advance to when a button is selected. In most cases, the Go To will 
be set to a page. Use the selector to choose a page number. A thumbnail of 
the destination page is shown in the box to the right of the button. Note 
that if you just want to advance to the immediately following or preceding  
page in the script, it is simpler to use the Go to Next Page or Go to Previous 
Page actions. 
 
Setting a Go To an event on the current page is also possible: set the Level: 
selector to <this page>, then use the Go To: selector to cycle through 
events on the page. 
 
Leave Bookmark? allows you to return from a series of events after 
branching with a Go to Event . Click on Leave Bookmark? to turn it on.  
Then, at the end of the button’s series of Go to events, insert a special 
event. On this special event, open the Branch menu and select the Go To 
tab. Choose Action: Return to Bookmark. When executed, this returns the 
script to the bookmark location, which is immediately after the original Go 
to Event. 
 
Using Go to Event with a bookmark lets you define sections of a script as 
independent units that you can go to and return from whenever a button is 
clicked. 
 
18.2.14  Going to the next or previous page 
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A very common type of button-activated branch is advancing to the next 
page in the presentation, or returning to the preceding page. 
 
The Go to Next Page and Go to Previous Page actions do just what their 
names imply, advancing to the page that immediately follows or precedes 
the current page on the Main menu. 
 
18.2.15  Returning to a bookmark 
 
When using a Go to Event branch on a button or in the Branch menu, you 
can choose to use the Leave Bookmark? option. This allows you to set a 
marker to which a later event can return. In this way, you can define 
sections of a script as independent units that you can go to and return 
from at any point in the script. 
 
As with bookmarks and GoTo’s on the Branch menu, bookmarks left with 
a button Go to Event action are used in conjunction with an action that 
restores the current execution location in the script to the bookmark 
location. This is Action: Return to Bookmark. The typical usage of this 
action would be as the Select Action of a “Return” or “Back” interactive 
button that you would place on a page that was the last in a series of 
pages branched to by a Go to Event button. 
 
18.2.16  Exiting from a script 

 
Although most productions are designed to run continuously, some need to 
allow the viewer to exit from the script. Creating a button to do this is very 
simple. Just give a button the Exit from Script action as a Select Action.  
This ends the script, returning the viewer either to Windows, or to the Main 
menu if the script was run from within Designer. 
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18.2.17  Viewing a Web page from a script 

 
The last Action: Show WWW Page , actually allows the viewer to jump out 
of the playback environment. You see the URL: text box when Show WWW 
Page is selected. Enter the address of the desired Web page there (for 
example, enter http://www.scala.com to jump to Scala’s Web page).  
When someone clicks a button that has this as its Select Action,  
Designer attempts to launch or activate the preferred Web browser. If  
successful, it then tries to connect to the Web page specified. 
 
If playback is setup to run full-screen, playback is minimized so that the 
Web browser window is visible on the desktop. 
 
18.2.18  Creating hotkeys 
 
You can specify a hotkey for any Select action. When a hotkey is defined 
for a button, instead of using the mouse or Enter to choose the button, the 
user can employ the hotkey. Set a hotkey by using the Hotkey: selector in 
the Select Action tab to cycle through the most common possible hotkeys, 
or type the hotkey you want into the space between the arrows. 
 
With the selector, you can choose any key from A to Z, 0 to 9, F1 to F12, 
standard symbols and Space as hotkeys. To specify other keys than these, 
such as accented characters that might be unavailable on the keyboard, 
you can enter a keycode value in the format 0nxxx, where xxx is replaced by 
the keycode. For example, enter 0n214 to make Ö a hotkey. 
 
Shift, Alt, and Ctrl can be used as qualifier keys, singularly or in 
combination. Use those key names, and link the qualifier(s) and the main 
key with a hyphen. For example: 
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Capitalization is ignored in the Hotkey: selector, so ctrl-C, CTRL-C, and ctrl-c 
all define the same hotkey. So to define an uppercase letter as a hotkey, 
you must enter shift with the letter. Entering the capital letter will not 
work, so use shift-k to make the uppercase K a hotkey. 
 
You can also use some special key names: 
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Secondary actions are available for button selection status transitions. In 
other words, these actions take place when a button changes selection 
status. Selection status is closely related to a button’s visual state, with the 
important distinction that any the selection status transitions can occur 
regardless of how many visual states you have defined for a button. For  
example, a 1-state Push button can have secondary actions defined for a 
transition to the Highlight state, regardless of the fact that the button itself 
does not have a visual Highlight state. 
 
The possibilities available from the Transition: pop-up are: 
 

� Mouse off button - the action takes place moves off a button or 
otherwise becomes idle, typically changing to the Normal state 
from the Select/On or  

 
� Mouse over button - the action takes place when a button is 

passed over by the mouse pointer or otherwise is highlighted, 
typically changing to the Highlight state from the Normal state 

 
� Button selected - the action takes place when a butt selected, 

typically changing to the Select/On state from the Normal or 
Highlight states. 

 
From the Transition: pop-up, choose the state transition to which the 
secondary action should apply. Then choose one or more of the three 
actions. The actions happen when the state transition displayed on the pop-
up takes place. 
 
18.2.19  Adding sound 
 
To add sound to your buttons, click on the Sound: button on the Other 
Action tab. This opens the Sound menu, where you can choose and adjust 
sounds. 
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Each button state can have a different sound. You may, for example, give 
your button a click sound when it is highlighted, and, if you are working 
with a button showing a bus, for example, the sound of a horn honking 
when the button is selected. 
 
When the state transition for which you have set a sound on the button 
occurs, the sound event plays. It plays to completion, even if the button 
does not remain in the state that triggered the sound. 
 
18.2.20  Setting variables 
 
Designer lets you set a variable value when a button changes state. 
Clicking on the Variable: button in the Other Action tab opens the 
Variables menu, where you can set variables. The Variables menu for 
buttons is the same as the Set Variables tab of the Branch menu. 
 
For example, you may want explanatory text to appear at the bottom of the 
screen each time a particular button is highlighted. To do this, with the pop-
up set to Mouse over button: 
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Now each time that button is highlighted, explanatory text appears at the 
bottom of the screen. 
 
18.2.21  Using alternate mouse pointers 
 
You can change how you want the mouse pointer to appear depending on 
button state. The Pointer: button in the Other Action tab lets you change 
the mouse pointer shape when the interactive button changes states.  
Click Pointer: to open the File dialog, where you can select and load a clip 
to use as a mouse pointer. 
 
The pointer is ordinarily the default arrow, or the pointer image specified by 
the most recent Input menu event. When you move the pointer over a 
Push, Toggle, or Radio button, its appearance changes by default to a hand 
with the finger extended. 
 
Changing the mouse pointer by using the Pointer: button does not change 
the default pointer for your script. If you want a different pointer image 
that affects the entire script, you must use the Input menu. (See Changing 
mouse pointer designs in the Advanced features section in this chapter.) 
 
Changing the pointer image is particularly useful if the button image is 
invisible, to let the viewer know that buttons are present. You may, for 
example, have a picture of a flower, on which you have placed an invisible 
button. To let people know that the flower has been highlighted, you could 
change the pointer from the default arrow in the Normal state to a bee in 
the Highlight state. Now when someone moves the mouse pointer over the 
flower, a bee appears, which indicates that the flower is a button and has 
been highlighted. 
 
To remove a pointer image from a button state transition, while that 
transition is selected on the pop-up, click the Clear button next to the 
Pointer: button. 



Designer5 
 

 
564 

 

 
18.2.22  Appearance options 
 
As described previously, buttons made from text elements, clips, or 
graphic objects can always be edited using the facilities of their Element 
Design menus to change how those buttons look. The Buttons menu has 
some additional options for controlling button appearance, accessible in its 
Appearance tab. The appearance options apply to whichever button state is 
currently selected, as indicated by the highlighted title bar button-icon  
buttons. 
 

 
 
18.2.23  Button backdrops 
 
Backdrop Image: lets you choose a backdrop, a predefined image that you 
can put underneath a “face” element. The backdrop image stretches to fit 
the size you want. You can use any normal clip image, and it will stretch to 
fit the button. If you use the Scala “multi-tiles”, the image will not look 
distorted the way stretched bitmap images often do. 
 
These backdrop images typically have beveled edges, with special effects 
like rounded corners and patterned backgrounds. They are the ideal way to 
make plain text buttons look like they were custom-drawn by hand. You can 
create and edit multi-tiles for custom button backdrops using the Multi- 
tile Editor available from the Tools drop-down. 
 
To use a button backdrop, select a button and click Backdrop Image:. You 
see the File dialog. After you choose a backdrop, you see the Buttons 
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menu again, and the button you selected with the backdrop image 
underneath it. You can select a different backdrop image for each button 
state, if desired. 
 
The backdrop stretches to fit the button element; for example, if you type 
more text into the button, the backdrop becomes longer. You can also make 
the backdrop larger than the normal size of the element with the Border 
width and height attributes on the Effect tab of the Element Design menus. 
 
18.2.24  Loading clips on the Buttons menu 
 
Clicking on the Image: button on the Appearance tab opens the File dialog 
where you can choose a clip to replace a clip currently being used as a 
button face. When a text button is selected, the Image: button is disabled. 
 
Note that you cannot use the Image: button for adding button preset or 
predefined button ( .BTN ) files.  To add a predefined button, with its 
matching images for the various button states, you use Add, from the icon 
toolbar; to put a preset backdrop under a button, use Apply Preset: (see 
Using predefined buttons and presets, for more information). 
 
18.2.25  Shifting the button face 
 
The Shift option makes it easy to center a button face within a backdrop, 
and to make an “indenting” 3-D button look more realistic. It allows you 
to specify an offset, in pixels horizontally and vertically, that the button face 
(text or a clip) has from its normal position in relation to its bounding box.  
You can specify the same offset for all button faces, or a different offset for 
each. 
 
The most typical use of Shift is to use a small offset down and to the right 
for the selected face of a button that has a beveled style. This heightens the 
illusion that the button is being pressed down when it is clicked. Or, if one 
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state of your button uses a shadow down and to the right, a simultaneous 
offset up and to the left makes it appear that the button face has moved up 
off the surface of the screen. Button backdrops automatically stretch to fit 
the larger area created by the offset. 
 
18.2.26  Global button state options 
 
The three on/off options in the middle column of the Appearance tab are 
not per-state, but affect all the states of the selected buttons. 
 
18.2.27  Adjusting the hit area 
 
The Boxed Hit Area? button lets you adjust the button’s hit area (the area 
in and around the button that responds when the mouse pointer moves 
over it or clicks on it). The hit area of a button can be rectangular or it can 
be an irregular shape. 
 
When Boxed Hit Area? is on, as it is by default, the hit area of the button is 
rectangular. When this option is off, the hit area is defined by the pixels of 
the button image, as opposed to the background. 
 
The primary use of this option is with clip images that have transparent 
areas. The hit area of a round button (which has transparent corners), then, 
can be round. 
 
If you have selected three elements with different sizes for the three 
different buttons states, Designer uses the size and position of the Normal 
state image for the hit area determination. 
 
18.2.28   Maintaining consistent button size 
 
Because you can adjust the different button states independently, it is 
possible to have different sized buttons for each state.  This is occasionally 
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useful, but normally you want the button states to match in size. For this 
reason, the Link Sizes? button is on by default. Link Sizes? forces any size  
changes you make in one button state to be reflected in the other state(s) 
so that their sizes match. If this causes problems and you need to have 
independent control of the sizes of a button’s states, turn this option off. 
 
18.2.29  Maintaining consistent position 
 
Designer also lets you position button states independently, if you desire. 
However, most buttons are designed so that the states overlap each other 
and thus must be in the same position. The Link Positions? button 
therefore defaults to being on, causing button states to retain their relative 
positioning as you move any one of them. If you do need to position button 
states independently, turn off Link Positions?, move the individual button 
states to the correct places, and then turn the option back on again. You can 
then move the entire button (all states) as necessary without losing the 
relative positioning. 
 
18.2.30   Using predefined buttons and presets 
 
Designer offers two ways to reduce the amount of time and effort you must 
spend creating buttons: predefined buttons and button presets. Both allow 
you to load a single file that can create all three button states for you, with 
appropriate Shift and Border values, and even predefined sounds and 
custom pointers, so that you do not need to set all these things yourself. 
Nonetheless, once they are loaded, you can modify the buttons to further 
customize them to your purpose. 
 
18.2.31  Button presets 
 
Button presets load a set of backdrop images that are already aligned, 
and contain appropriate Shift and Border settings so that an element fits 
neatly into the backdrop with no additional effort. Button presets are much 
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like an elaborate kind of style that you can apply to buttons. 
 
You use button presets by choosing Apply Preset: from the Appearance 
tab when a button is selected. You see the File dialog open to the Buttons 
folder, where you can choose a preset .BTN file. 
 
Presets are used primarily a simple way to “dress up” text buttons: if a text 
button is selected when you load a preset, the button backdrop 
automatically adjusts to fit the text. The same is true if you begin with a 
clip; the backdrop stretches to follow changes you make in clip size. 
 
18.2.32  Predefined buttons 
 
Predefined buttons provide complete matched, professionally designed 
images for three different button states. 
 
Load predefined buttons by clicking the Add icon. You see the File dialog, 
where you can choose predefined buttons ( .BTN files) from the Buttons 
folder. Clicking Open returns you to the Buttons menu with the button 
design you chose visible on the page in its Normal state. 
 
The images in predefined buttons are face images, which means that you 
cannot attach further face elements to the button. You can, however, add 
text or other clips as separate elements on top of or next to predefined 
buttons if necessary. The button will not adapt to these elements, and 
options like Shift and Link Positions? do not apply. 
 
18.2.33  Invisible buttons 

 
You can create invisible buttons by using the button file “Invisibl.btn”. An 
invisible button does not have any imagery associated with it, but a 
rectangular button “hit area” on the page is still created. 
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You may, for example, have a page showing a photo of several people, 
which displays a person’s name when his or her face is highlighted, and 
displays further information when selected. By using invisible buttons, there 
is no button imagery to interfere with the photo. 
 

18.3 Working with Toggle and Radio buttons 
 
For certain kinds of applications, the type of interactive input and visual 
feedback afforded by Toggle buttons and Radio buttons is more 
appropriate than standard Push buttons. When the viewer needs to make 
choices on the same page, and see the various choices before proceeding, 
the fact that these button types remain in their clicked states is helpful. 
 
18.3.1 How Toggle and Radio buttons use variables 
 
Both Toggle and Radio buttons are automatically set up to control and 
respond to variables. Toggle buttons control only logical (on/off) variables. 
Radio buttons can control logical, text, or numeric variables. 
 
For either type, you associate a given button with one variable. The same 
variable can be associated with more than one button. 
 
The variable’s value changes based on the button state (whether the 
mouse has moved over it or clicked it). Likewise, the button responds to 
changes made to the variable’s value, by changing to the corresponding 
state. This means that buttons can be made to change their state, and thus 
their appearance, by changing their variable values, not just by responding 
to mouse clicks. In this way, you can have different buttons that visibly 
respond to each other, or to other events in a script. 
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18.3.2 Toggle buttons 
 
A Toggle button functions just like a switch: it flips a logical variable 
between its two possible values, Off and On. For a two-state Toggle 
button, the Off and On states correspond to Normal and Select. For a four-
state Toggle button, there are Normal Off and Highlight Off states, and 
Normal On and Highlight On states. (In this case, “normal” means non-
highlighted, rather than Off.) A four-state Toggle button is usually in the 
Normal state; it can be highlighted when either On or Off. If another button 
or some other event in the script sets the variable to On or Off, the button 
state is automatically switched accordingly. 
 
Creating a Toggle button 
 
To create a Toggle button: 
 

1. Select the element you want to make into a Toggle button 
 

2. From the Buttons Menu Type: pop-up, choose Toggle Button. You 
see the 2-state and 4-state buttons for selecting the number of 
states, and a variable list. 
 

3. If there are already logical variables defined in this script, their 
names are shown in the variable list and you can choose one to 
associate with this button. Otherwise, enter a name to create a 
new logical variable with a default value of Off. Turn on the 
External? option if you want a new variable to be common to this 
script and any scripts above it in the script structure. Click OK to 
close the dialog. 
 

4. By default a two-state button is created. If you want a four state 
button, click the 4-state button. 
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The Variable: button on the Other Action tab can be used to change 
another variable associated with this button. 
 
You can now use the options on the Appearance and Select Action tabs, 
described earlier in this chapter, to define what the button looks like in 
each state, and what it does. 
 
18.3.3 Radio buttons 
 
Radio buttons are closely related to Toggle buttons. The difference is that 
Radio buttons allow you to use any type of variable, not just logical 
variables. This also implies that, when using text and numeric variables, 
you are not limited to in your choice of values to assign to the button 
states. You can choose any valid value you like for the button variable in a 
given state. This makes Radio buttons more versatile than Toggle buttons. 
 
Creating a Radio button 
 
The procedure for creating a Radio button is basically the same as for a 
Toggle button, except that you also must specify a variable value: 
 

1. Select the element you want to make into a Radio button. 
 

2. On the Buttons menu Type: pop-up, choose Radio.  You see 
the 2-state and 4-state buttons for selecting the number of 
states, and the variable list. 
 

3. If there are already variables defined in this script, they are shown 
in the list and you can choose one to associate with this button. 
Otherwise, choose a variable type and then enter a name to create 
a new variable. Turn on the External? option if you want a new 
variable to be common to this script and any scripts above it in the 
script structure. Click OK to close the dialog. 
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4. In the Value: text box, enter a value for the variable you have 

chosen or created. 
 

5. By default a two-state button is created. If you want a four state 
button, click the 4-state button. 

 
The Variable button on the Other Action tab can be used if you want to 
change another variable associated with this button. 
 
You can now use the options on the Appearance and Select Action tabs, 
described earlier in this chapter, to define what the button looks like in 
each state, and what it does. 
 
18.3.4 Editing buttons 
 
Clicking on the Edit drop-down gives you the same editing options as other 
Edit drop-downs, with a few differences. 
 
Cut, Paste, Select All, Appear Later, and Appear Earlier function the same 
way for buttons as for other elements. Copy has special results when used 
from the Buttons menu. 
 
Copy copies selected buttons to the clipboard. Copied buttons retain all 
of their styles and GoTo’s when pasted, except in cases where it is not 
physically possible. 
 
For example, a button that is pasted into a different script, which does not 
contain the original Go To destination page, cannot retain the original Go 
To. 
 
You can use the Go to Event selectors to see which GoTo’s have not been 
retained in your copied buttons. A Go To destination page from the original 
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button that does not appear on the selector of the copied button has not 
been retained because it physically does not exist there. 
 
To Export a button, click File->Export->Button as Preset.  This action opens 
the file dialog for you to save the selected button. In the Save as type: pop-
up, Buttons is available. 
 
If you choose Save as type: Buttons, Designer automatically adds the file 
extension .BTN and saves the button, including each of its states, as a 
predefined button file. All its appearance-related settings are retained, 
but Action settings and variables are discarded. 
 
18.3.5 Toggle buttons 
 
A Toggle button functions just like a switch: it flips a logical variable 
between its two possible values, Off and On. For a two-state Toggle 
button, the Off and On states correspond to Normal and Select. For a four-
state Toggle button, there are Normal Off and Highlight Off states, and 
Normal On and Highlight On states. (In this case, “normal” means non-
highlighted, rather than Off.) A four-state Toggle button is usually in the 
Normal state; it can be highlighted when either On or Off. If another button 
or some other event in the script sets the variable to On or Off, the button 
state is automatically switched accordingly. 
 
Creating a Toggle button 
 
To create a Toggle button: 

 
1. Select the element you want to make into a Toggle button 

 
2. From the Buttons menu Type: pop-up, choose Toggle Button. In 

the panel you see the 2-state and 4-state buttons for selecting a 
number of states, and a variable list. Four state indicators appear 
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in the menu title bar. 
 

3. their names are shown in the variable list and you can choose one 
to associate with this button. Otherwise, click New Variable and in 
the dialog, enter a name to create a new logical variable with a 
default value of Off. Turn on the External? option if you want a 
new variable to be common to this script and any scripts above it 
in the script structure 
 

4. By default a two-state button is created. If you want a four state 
button, which highlights when the mouse pointer moves over it, 
click the 4-state button. 

 
The  Variable button on the Other Action panel can be used to change 
another variable associated with this button. 
 
Note: It is possible to produce exactly the same functionality as a Toggle button 
with a Radio button, but there is no advantage in doing so. 
 
You can now use the options on the Appearance and Action panels, 
described earlier in this chapter, to define what the button looks like in 
each state, and what it does. Note that it is possible but generally does 
not make sense to use a Toggle button for branching. 

18.4 Working with Text Entry Fields 
 
Text Entry Fields allow a viewer to enter data with a keyboard. For 
example, the viewer could be asked to enter his or her name, and the 
script could then refer to the viewer by name. More sophisticated 
applications of Text Entry Fields can gather, store, and process information 
entered, use it as a basis for branching, and display choices made by the 
script. 
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Like Toggle and Radio buttons, Text Entry Fields require a variable. The 
variable must be a Text variable, and whatever the viewer enters in the 
button is stored in this variable. The variable can be displayed and 
manipulated the same as any other variable in Designer. 
 
Unlike buttons, Text Entry Fields do not have different states, or any 
possible action other than accepting keyboard input. Thus a Text Entry 
Field has only one possible appearance. 
 

18.5 Creating a Text Entry Field 
 

1. From the Add drop-down, choose Add Text Entry Field. You see a 
dialog asking you to choose or create a variable for the field. 
 

2. If there are already any user-defined Text variables, they are 
listed and you can select one. Otherwise, enter a name in the 
Variable: text box to create a variable by that name. 
 

3. Turn on the External? option if you want a new variable to be 
common to the script and any sub-scripts that it has.  
 

4. On the page, you see the variable name within a dashed box 
with graphic handles, representing the size of the field. The menu 
changes to the Design Text Entry Field menu. 

 
You can now move and/or resize the field as necessary. 

 
5. Specify options for the field, its text, and the mouse pointer. 
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You have all the options normally available to text elements in the Design  
Text Entry Field menu.  (The illustration above shows a field that has been 
given a backdrop; the text has a contrasting color and an outline.) 
There is also an additional panel in the menu devoted to options 
specific to field elements. 
 
18.5.1 Text Entry Field Options 
 
The Design Text Entry Field menu is nearly identical to the Design Text 
menu. Aside from the addition of the Field panel, the only differences 
between the two menus are: 
 

• the Text Entry panel of the menu contains a Cursor button with a 
color block 
 

• the Position panel contains an Element Size control 
 

• the Misc panel does not have the Update: pop-up 
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• the Alignment panel does not have Word Wrap or Line Space 

options, but does have a Vertical Text Alignment pop-up 
 

18.5.2 Field Appearance 
 
As it first appears on the script page during playback, the Text Entry 
Field contains nothing. The viewer just clicks in the field and begins 
typing a response. 
 
If you want the field to have something particular in it to begin with, 
assign the text you want to the field’s variable with a Branch menu special 
event. 
 
Also, in playback the field initially is invisible; you should use one of the 
available options to make the field apparent to viewers. Once a viewer 
clicks within the field a text cursor appears. 
 
The appearance of the variable name text that you see while working 
with the field (its font, styles, etc.) is what the viewer will see when typing 
into the Text Entry Field.  Adjust the styles as necessary. Note that because 
you can adjust the size of the field, both Horizontal Text Alignment and 
Vertical Text Alignment options are available. 
 
18.5.3 New / Edit Variable 
 
Click the New / Edit Variable... button to create additional variables to be 
associated with Text Entry Fields, or to change the External? option of 
variables. 
 
If you only want to change the association of the field to another existing 
variable, you can just select it in the scrolling list above this button. 
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18.6 Advanced Features 
 

18.6.1 Creating more advanced buttons 
 
The examples in the beginning of the chapter showed you how to create 
simple buttons. Now that you are more familiar with the Buttons menu, you 
can begin experimenting more, implementing more buttons features. The 
following example takes you through the process of creating more 
advanced buttons to give you practice implementing more button features, 
like: 
 

• using clips 
• giving buttons sound 
• setting variables to your buttons 
• using Go To with bookmarks 

 
For the following example, let’s say that you are creating an interactive 
production that will be displayed in the lobby of a hotel. You want the 
production to tell people what the hotel has to offer, so you have a page in 
the script that is like a menu, where viewers can choose a button to get 
more information. We’ll create a menu with buttons for Entertainment, 
Food, and Services . 
 

1. Create pages to work with by loading backgrounds for four 
different pages.  
 

2. Go to the Design Text menu, and on page 1, type Choose a button 
for more information at the top of the page. On page 2, type: Cafe 
in the middle of the screen, and !special at the bottom. Type: 
Entertainment on page 3, and Services on page 4. 
 
Since you are creating buttons that will advance the viewer to 
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pages with information, be sure to give the viewer ample time to 
absorb the information by setting a long enough duration for those 
pages.   

3. On page 1, open the Buttons menu. 
 

4. Click on the Image: button in the Appearance tab. This opens the 
File dialog where you can choose a clip to load. 
 

5. Load the coffee cup image from the Guide Examples folder. You 
see the clip on your page in the Clip menu.  
 

6. Adjust the size of the clip and place it next to the word Cafe. 
Make any other changes you want to its appearance, then return 
to the Buttons menu. 
 

7. While the clip is selected, choose Push Button on the Type tab, and 
make it a three-state button. The clip is now a button in the Normal 
state. 
 

8. Press F12 to switch the button to its Highlight state. 
 

9. Switch to the Other Action tab and choose Mouse over button 
from the pop-up. Click on the Sound: button to add sound to the 
clip in its highlighted state. You see the Sound menu. 

 
10. Choose a sampled sound that is appropriate. After you select a 

sound and click Close, you see the Buttons menu again. 
 

11. Go to the Clip menu and change the appearance so that it looks 
different when highlighted. Try changing its Front color, or turning 
on Shadow. 
 

12. Return to the Buttons menu, and on the Other Action tab click 
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the Variable: button. In the Set Variable: text box of the resulting 
menu, enter: 

 
special=”Today’s special: Double mocha cappuccino” 
 
and click OK. In the Variable Definition dialog that appears,  
the variable type Text is already selected, so just click OK. 

 
13. Press F12 again to switch to the Select state, then go to Clip 

menu to edit the appearance of the clip in its Select state. If you 
need to refer to what you did for the Highlight state, press F12 to 
cycle through the states while on the Clip menu. You can also use 
the indicators in the title bar, which identify the current state. 
(You could also add sound for this state as you did for Highlight.) 
 

14. Return to the Buttons menu, and go to the Select Action tab. On 
the Action: pop-up, choose Go to Event. 
 

15. Use the Go to: selector to tell the script where to branch to when 
that button is selected. (Since there are no groups in the script, 
and you are going to branch to another page, the Level: selector 
can be left unchanged being <this script>.) Set the Go To: 
destination to page 2. 

 
16. Make sure that Leave Bookmark? is on.  This will let the user  

return to the hotel menu after page 2 is finished running. 
 

17. Click the Main icon on the toolbar to exit the Buttons menu to the Main 
menu. 
 

18. Click on the Branch column button for page 2.  You see the Branch menu. 
 

19. You see the Go To tab. Use the Action: pop-up to choose Return to 
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Bookmark. This makes the script return to the location from 
which you branched (page 1), because of the Leave Bookmark? 
setting for that button. 

 
You have now created an interactive button for Cafe. You can go back to 
page 1 and create buttons in a similar way for the Entertainment and 
Service categories, too, by following the same steps. 
 
Some other approaches you could use to create these buttons: 
 

1. Instead of modifying the clip’s appearance for each state, use 
Apply Preset: to load backdrop images for all three states. This 
would make the image look more “button-like”, and would 
remove the need for steps 11 and 13. 
 

2. Rather than make the clip a button, leave it as an illustration,  
and make the label text into a button. You could use Apply Preset: 
here also. 
 

3. Make neither the clip nor the text a button, and instead load a 
predefined button with Add and place it next to the label text.  
This too eliminates the need to create separate appearances for 
each button. 

 
So far, you have worked in the Buttons menu to create and edit buttons. 
There are some options related to buttons, however, that cannot be made 
in the Buttons menu, but must be made in the Input menu instead, which is 
explained in the following section. 
 
18.6.2 Using the Input menu for custom input options 
 
Designer offers several options related to interactive input. Some are 
specific to the use of buttons, but others involve the mouse and keyboard. 
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From the Main menu, click on the button in the Input column for a page in 
your script. You see the Input menu, which looks like this: 
 

 
 
The Input menu has three tabs: Button Controls, Mouse Pointer, and 
Slideshow Controls. 
 
18.6.3 Specifying button input options 
 
On the Button Controls tab, you can choose the type of input recognized in 
a production using the Mouse?, Touch Screen? or Keyboard (arrows + 
Enter)? options. At least one of these options is always on; so you cannot 
turn off all three. 
 
Mouse? allows the viewer to use the mouse to highlight and select buttons 
when the production plays. The mouse pointer appears and the script can 
respond to mouse clicks if the page uses buttons. The option is on by 
default. 
 
Touch Screen? should be turned on when the system playing the production 
uses a touch screen. 
 
Turning on the Touch Screen? option turns off the Mouse? option so that 
the mouse pointer does not appear. Because mouse and touch screen 
input are mutually exclusive, the appearance of the pointer would be both 
unnecessary and misleading to the viewer. Pointer Image options are not 
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necessary with touch screens, so they are also disabled. 
 
Turning the Keyboard (arrows + Enter)? option on lets you use the 
keyboard rather than the mouse and main mouse button to highlight and 
select buttons on the screen. When this option is on, you can move to and 
highlight buttons with the arrow keys, and select the highlighted button by 
pressing Enter. 
 
This option is available whether the touch screen or mouse options are on, 
and can be used by itself. 
 
18.6.4 Changing mouse pointer designs 
 
As mentioned previously in this chapter, to change the pointer image for 
buttons in the Highlight and Select states, you use the Buttons menu. 
However, to change the default pointer images for entire pages and 
scripts, or to choose when the pointer is visible in your script, you must 
use Input menu options in the Mouse Pointer tab. 
 
The Pointer: pop-up lets you choose when you want the pointer visible in 
your production. Even on a page that has no buttons, for example, you 
might want to use the pointer for illustration purposes, to point to items 
on the page as you discuss them. Or, alternatively, you may want the 
pointer visible only when buttons are available for selection. 
 
Use the pop-up to choose Always or For Selection Only. The default is For 
Selection Only. Choose For Selection Only when you want the pointer to 
be visible only if there are buttons on screen. 
 
Choose Always when you want the pointer visible regardless of whether 
there are buttons on screen or not. 
 
In addition to choosing when the pointer is displayed, Designer lets you 
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change pointer images using the Pointer Image: and Busy Pointer Image: 
buttons. These options affect the pointer designs you see when the script 
runs. 
 
The Pointer Image: button controls the design of the normal mouse pointer 
used on screen. You may, for example, want the image to be a pointing 
finger instead of the standard arrow. When you click on Pointer Image: you 
see the File dialog open and you can and choose any clip to use as a 
pointer image. 
 
The Busy Pointer Image: button lets you change the image of the busy 
pointer, which appears on the screen when the script is busy and 
temporarily cannot accept input. By default, there is no busy pointer. Click 
this button, and in the File dialog, and choose a new image. 
 
To stop using a custom pointer image in a script, click the Clear button 
next to Pointer Image: or Busy Pointer Image: buttons. This returns the 
pointer images to the default settings - an arrow as the normal pointer and 
no busy pointer. 
 
18.6.5 Changing the script default pointer 
 
To change the pointer for the entire script, you can group the script’s pages 
and apply the Input event to the group. Choose Select All from the Edit 
drop-down on the Main menu, and then Edit->Group. Input menu settings 
you make for the group become defaults for the entire script. 
 
18.6.6 Controls for advancing pages 
 
The buttons on the Slideshow Controls tab, Mouse Buttons? and Keyboard 
(Page Up/Down)? let you choose how you want your script to advance 
when you are working with a slideshow-style production. With these 
buttons, you can choose the mouse, the keyboard, or both the mouse and 
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keyboard to advance. 
 
Mouse Buttons? controls whether the mouse buttons by themselves 
control the advance to another page. Pressing the main mouse button 
moves forward in the script, and the secondary mouse button moves back. 
It is on by default. Note that on any page with buttons, the button-selection 
function of the mouse buttons takes precedence over the page-advance  
function, regardless of the setting of the Mouse Buttons option. 
 
Keyboard (Page Up/Down)? controls whether the keyboard can advance 
the script. The Page Down key moves to the next page, and the Page Up 
key moves to the previous page. It is also on by default. 
 
Slideshow Controls ONLY work when playing back your script in Designer.  
They do not work if you publish your script to the Network and schedule 
that script to play on a player. 
 
18.6.7 Input event scope 
 
The events you set in the Input menu are different from other events on 
column buttons in an important way. All other events apply only to the 
page for which you have set the event. Input events, are “sticky” meaning 
that they remain in effect from page to page until another Input event 
changes them. 
 
For example, if you turned on Touch Screen? for page 3, and Mouse? for 
page 8, the pages from 3 to 7 would have touch screen control, even 
though you did not explicitly set it on all those pages. This can save you 
some effort, but it might also be confusing at times. 
 
18.6.8 Removing Input menu events 
 
When you need to remove an Input event you have set for a particular 
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page, click the Delete button on the Input menu. The page and those 
following it then assume the Input settings from the most recent previous 
Input event, or the default settings if there was no previous Input event. 
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||||| 19  TV Tuner EX Module 
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Chapter Overview 
 

Scala 5 software products support use of various TV-capable add-on 
cards through the Scala TV Tuner EX Module. 

The TV Tuner EX Module gives you the capability of controlling TV 
Tuner hardware that accepts and displays a video input. This makes 
it possible for you to incorporate video inputs within your Designer 
5 scripts. 

The TV Tuner EX Module has been designed and tested to work with 
certain TV-capable hardware,. Please visit: 

http://www.scala.com/infochannel-5-TV-Tuner-faq/infochannel-5-
TV-Tuner-faq.html 

for an updated list of recommended TV Tuner cards. 

19.1 System configuration 
 

1. Install the latest version of Microsoft DirectX (currently 
version 9.0c). 

2. Obtain the latest WHQL certified drivers for your video card 
by going to its manufacturer’s Web site. 

3. Install the TV Tuner hardware in your system according to 
the manufacturer’s instructions. 

4. Install the device driver software that came with the TV 
Tuner hardware. 

5. Configure your hardware so that it works in the Windows 
environment. by following the instructions that are 
provided with the documentation until the hardware 
operates correctly. 
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6. Configure the Scala TV Tuner EX Module. (Please 
refer to the next section for detailed information.) 

19.2 Licensing 
 

Once the hardware, the supplied vendor software and the device 
drivers have been installed, you must obtain an updated license 
before attempting to configure and use the TV Tuner EX Module. 

To obtain an updated license for Designer 5, follow these steps: 

1. Start Designer 5 

2. Click Help > About InfoChannel Designer 

3. Click the Get License File Online button 

When prompted to overwrite the existing license, click Yes 
 

4. If you want to Save a copy of the license file in My 
Documents, click Yes. Otherwise click No.  

To obtain an updated license for Content Manager 5, follow these 
steps:  

1. Login to Content Manager 5 using the Administrator 
account with the password.  

2. Click Settings > License Status . This will take you to the 
license status page.  

3. Click the Get License File Online link.  

4. Click OK to get an overview of the updated license.  

5. Click Accept to install the updated license.  
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19.3 Allocating Licenses to Player(s)  
 

Once an updated Content Manager license has been installed, you 
can then choose which players you want to allocate the TV Tuner 
licenses to. Any players that do not have a TV Tuner license will not 
play any TVClips or TV Tuner events. To allocate a TV Tuner license 
for a player, follow these steps:  

1. Go to Network > Players  

2. Select a Player, and click Properties  

3. Click the EX Modules tab. You see this screen: 
 

 
 

4. Click the checkbox next to TV Tuner EX Module to enable it 
for this player.  

5. Click Save to keep the changes.  

6. Generate a new plan for the player so that the player gets 
an updated license. 

19.4 Configuring the TV Tuner EX Module  

Configuring the TV Tuner EX Module for Designer and Player is 
identical.  
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1. If using Designer, click Tools and choose Options. If using 
Player, click Start > Programs > Scala Player 5 > Player 5 
Configuration.  

2. Click the Modules tab. Look for the TV Tuner EX Module? 
button in the Optional Modules list. If it is off, turn it on by 
clicking the button.  

3. Now click TV Tuner EX Module... under Module Settings to 
open the TV Tuner configuration dialog. A dialog similar to 
the one pictured here is shown: 

 

 
 
In the dialog, it is possible to select the default settings for TV Tuner 
EX Module. These settings are important! If not setup correctly the 
TV Tuner input may not appear on screen or no audio is heard. 
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4. Video Capture Device: – Select the device that you want to 
edit. More than one device can be listed:  

 
 

5. Enabled Device? – If you want to allow the device to used, 
check this option. Otherwise, un-check this option.  

6. Name: – Assign a unique name for the device. By default the 
name is captureXX (where XX is a sequential number 
starting with 01).  

7. Capture Size: – By default, the software enumerates the 
best capture resolution that the device supports. We do not 
recommend modifying this option unless you know the 
device supports the capture resolution you intend on using.  

8. Deinterlace Video? - Scala 5 is able to deinterlace video if 
needed. Enable this option if you want the TV Tuner EX 
Module to deinterlace the video input. Enabling this option 
allows you to configure the video deinterlacer properties.  

9. Deinterlacing Properties... - Opens a separate dialog which 
allows you to configure the video deinterlacer.  
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10. Tuner Type: - Pop-up that can be switched between Cable 
and Antenna, depending on whether your television input is 
from a cable TV or an antenna hookup. By default, Antenna 
is chosen. 

11. Country Code: - Pop-up that lets you specify the country 
code to use. By default, the country code is set to match the 
current system locale settings. This setting is used when a 
channel scan searches for available channels. 

12. TV Standard Type: - Pop-up that lets you specify the 
television standard type to use (NTSC, PAL, SECAM, as well 
as the subtypes for each standard). This setting can be used 
to override the Country Code TV Standard especially when 
using Composite or S-Video inputs. Not all TV Tuner 
hardware supports each type. We do not recommend 
changing the default value unless you specifically know that 
the device supports the TV Standard you want to use AND 
it’s not selected. 
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13. Default Channel: - Pop-up that lets you select what video 
input is displayed if a value has not been specified. The 
available options are... 

� Custom - Allows you to specify a custom channel for 
the default channel. 

� Channel - A listing of the channel numbers 
(available only if a channel scan has been done). 
Composite – Yellow RCA connector and SVideo – S-
video mini-DIN connector are listed at the bottom 
of the list (if available). 

14. Custom Channel - If Custom was selected for the Default 
Channel drop down menu, then you can enter the channel 
you want to display directly. 

15. Audio Capture Device – Select the audio capture device you 
want to use in conjunction with the TV tuner. By default, 
the software tries to determine what audio device is being 
used. 

16. Line – If the audio device “<video device’s built-in audio>” is 
selected for audio capture device, then this option is not 
available. However if you choose another audio device, the 
software shows other options available for you to select for 
audio input. 

17. Make Default – If you want the current device to be the 
default TV tuner, select this option. Otherwise leave this 
option unchecked. 

18. Channel editor – By clicking this button, the TV Tuner 
Channel Editor dialog is shown that allows you to edit the 
existing channels that can be received by the TV tuner 
device. The first time a device is configured, no channels are 
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shown. Click AutoScan to have the software automatically 
search for available channels.  

 

 
 

19. Click Close to store the settings and exit the TV Tuner 
Options dialog, or click Cancel to discard your changes.  

20. Click OK to exit the configuration dialog.  

If your using Designer, you will now be allowed to create and 
playback TV Tuner clips and TV Tuner events. If you are using 
Player, TV Tuner clips and TV Tuner events will now function.  
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19.5 Using the TV Tuner EX Module 
 
There are two basic ways you can use the TV Tuner EX Module.  

A TVclip allows a video input to occupy a part or all of the page, with 
a normal background in other areas. Other Designer 5 elements can 
appear above or below the video input.  

A TV event is used when you want a modify a property of an existing 
TV Tuner device. 

19.5.1 A TVclip  
 
To display a video input from the TV Tuner hardware on a page, you 
must add a TVclip to a page. A TVClip is similar to a movie clip in 
that you can apply transitions, clip styles, etc. to it. To create a 
TVClip:  

1. From the Main menu, click the right-hand side of the Add 
icon and choose Add Plain Page from the drop-down (you 
may alternatively choose a background instead). You see 
the Design Text menu for that page.  

Click the right-hand side of the Add icon and choose Add TVclip.  
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This action will add a TVclip to the current page. 
 

2. SMPTE color bars are now visible (this is an on-screen 
representation of a TVClip that you can use to manipulate, 
size, position, etc.). The Design TVClip menu is automatically 
shown below. The TVClip is very similar to a movie clip.  

 

 
 

3. By clicking the video tab, you can choose to modify the 
default Device and Channel. Normally, the Device and 
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Channel are set in the TV Tuner EX Module Options menu, 
and do not need to be set here.  

 
 

4. If you have more than one TV Tuner device, you can select it 
by clicking the Device pop-up menu: 

 

 
 

5. If you want to display a channel other than the default, click 
the Channel pop-up menu, then select the input that carries 
the video you wish to use in the script. You see a pop-up 
similar to this: The Channel choices are...  
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� Use player default - Allows you to use the default player 

channel.  

� Custom - Allows you to specify a custom channel for the 
default channel.  

� Channel Number - A listing of the channel numbers 
(available only if a channel scan has been done). 

� Composite – Yellow RCA connector and SVideo – S-video 
mini-DIN connector are at the bottom of the list (if 
available).  

If Custom was selected for the Default Channel drop down 
menu, then you can enter the channel you want to display 
in the Custom Channel button.  

Add other elements to the page as desired.  

Preview the page as necessary to see how the other elements align 
with the video window.  

Like other elements on a page, if you want the TVclip to be shown 
on all pages, turn on the Global? option on the Misc tab.  

19.5.2 A TV event  
 
To use a TV event, you need to add a special event in the Designer 5 
Main menu or Design List menu: 
 

1. In the Main menu, click the right-hand side of the Add icon 
and choose Add Special Event from the drop-down. You see 
a new special event page visible in the Main menu.  

Or, add a plain page in the Main menu. Then click the right-
hand side of the Design icon and choose List from the drop-
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down. Now click the right-hand side of the Add icon and 
choose Add Special Event from the drop-down. You see a 
new special event page visible in the Design List menu.  

2. Move the horizontal scroll bar if necessary to see the TV 
Tuner column, and click in that column for the special event 
page you just added. You see the TV Tuner menu:  

 
 

The Command: pop-up determines the action of this TV 
event. The available options are:  

� None - Removes this TV Tuner event.  

� Set Channel - Lets you set the channel for a 
specified TV Tuner device.  

� Channel Up - Increments the channel for a specified 
TV Tuner device. If a channel scan has not been 
performed, the channel will be incremented by one. 
If a channel scan has been done, then this 
command will show the next channel in the channel 
list.  

� Channel Down - Decrements the channel for a 
specified TV Tuner device. If a channel scan has not 
been performed, the channel is decremented by 
one. If a channel scan has been done, then this 
command will show the preceding channel in the 
channel list.  
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� Volume - Lets you adjust the volume of a specified 
TV Tuner device. Valid range is from 0 to 255.  

� Reset - Re-initializes a specified TV Tuner device.  

The default choice is None. By changing this setting allows 
you to modify a given property for an existing TVClip. If no 
TVClip is visible on screen then the command has no effect.  

Click Close to exit the menu.  

19.6 Set Channel 
 

The Set Channel command allows you to select the channel 
that is displayed on a specified TV Tuner device. The Set 
Channel menu:  
 

 
 
You can set these options:  

� Device - Select the device that you want to change.  

� Channel - Select the channel you want to display.  

� Custom Channel - Available only if Channel is set to 
Custom. You can then enter the channel you want 
to display directly.  
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19.7 Channel Up  
 

The Channel up command allows you to increment the channel 
number that is displayed on a specified TV Tuner device. The 
Channel Up menu:  

 
 
You can set this option:  

� Device - Select the device that you want to change. 

19.8 Channel Down  
 

The Channel Down command allows you to decrement the channel 
number that is displayed on a specified TV Tuner device. This 
command is the opposite of the Channel Up command.  

You can set this option:  

� Device - Select the device that you want to change.  

19.9  Volume  
 

The Volume command allows you to set the volume level of a 
specified TV Tuner device. The Volume menu:  
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You can set these options:  

� Device - Select the device that you want to change.  

� Volume - Set the volume level for the TV Tuner hardware 
specified.  

19.10  Reset  
 

The Reset command allows you to re-initialize the specified TV 
Tuner device. This command is normally not needed.  

 

You can set these options:  

� Device - Select the device that you want to reset. 
 

19.11  Advanced features 
 

Two functions are available while you are using the TV Tuner EX 
Module. 

19.11.1 TVTuner.GetVolume (TV Tuner Name)  
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This function takes a capture device name as a string and returns 
the volume as an integer. 

For example: 

CurrentVolume = TVTuner.GetVolume(“Capture01”); 

You could then display the CurrentVolume in your script by typing 
this on a page: 

!CurrentVolume 

19.11.2   TVTuner.CurrentChannelName (TV Tuner Name) 
 
This function takes a capture device name as a string and returns 
the current channel name as a string (as listed in the channel scan). 

For example: 

ChannelName = TVTuner.CurrentChannelName(“Capture01”); 

You could then display the ChannelName in your script by 
typing this on a page:  !ChannelName 
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||||| 20  Weather EX Module 
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Chapter Overview 
 
Scala software products support use of the Davis Instruments 
Vantage Pro™ and Weather Wizard III® weather station units 
through the Weather EX Module. The Weather EX allows the display 
of weather information from a Davis weather unit within a Scala  
Designer 5 script. This information is gathered electronically from 
the weather station, which is connected to the computer through a 
serial port. 
 
The data received from the weather station is written to variables, 
the values of which can be displayed on a script page. 
 
The variables update in real time as they change, so the script 
becomes like a remote terminal for the weather station. The 
variable values can also be written to a file. 
 

20.1 Licensing 
 

Once the hardware and the supplied vendor software have been installed, 
you must obtain an updated license before attempting to configure and 
use the Weather EX Module. 

To obtain an updated license for Designer 5, follow these steps: 

1. Start Designer 5 

2. Click Help > About InfoChannel Designer 

3. Click the Get License File Online button. When prompted to 
overwrite the existing license, click Yes. 

4. If you want to Save a copy of the license file in My Documents, 
click Yes. Otherwise click No.  
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To obtain an updated license for Content Manager 5, follow these steps:  

1. Login to Content Manager 5 using the Administrator account 
with the password.  

2. Click Settings > License Status . This will take you to the license 
status page.  

3. Click the Get License File Online link.  

4. Click OK to get an overview of the updated license.  

5. Click Accept to install the updated license.  

20.2 Allocating Licenses to Player(s)  
 
Once an updated Content Manager license has been installed, you can 
then choose which players you want to allocate the Weather licenses to. 
Any players that do not have a Weather license will not display any 
weather data. To allocate a Weather license for a player, follow these 
steps:  

1. Go to Network > Players 

2. Select a Player, and click Properties  

3. Click the EX Modules tab. 

4. Click the checkbox next to Weather EX Module to enable it for 
this player.  

5. Click Save to keep the changes.  

6. Generate a new plan for the player so that the player gets an 
updated license. 

 

20.3 Configuring the Weather EX Module 
 
To configure the Weather EX Module, click the Weather EX Module 
button in the Module Settings list to open the Weather EX Options 
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dialog. It allows you to choose the weather station model you are 
using, set up its communication and timing parameters, and 
configure its variables. 
 

 
 

20.3.1 Specifying a weather station model 
 
The different Davis weather station models have different 
capabilities, so you must configure the Weather EX for the one you 
are using. Using the Model: pop-up, choose either Davis Weather 
Wizard for Weather Wizard III models, or Davis Vantage Pro for the 
Vantage Pro model. 

20.3.2 Units of measure 
 
In the case of variables for which there is a choice of units of 
measure, the value stored can be either metric (degrees Celsius, 
kilometers per hour, centimeters/millibars) or English (degrees 
Fahrenheit, miles per hour, inches) as shown in the following table. 
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20.3.3 Variable English units Metric units 
 

 
 

 
 
Using the Units: pop-up, choose either of two values, English 
or Metric. The default is English. 
 
An indication of units (“MPH”, “°F”) is not part of the value stored. 
Therefore, the script author must be sure that the script displays 
units of measure alongside the variables displayed, and that these 
unit labels match the variables and the type of units set by Units:. 

20.3.4 Serial Settings 
 

The controls in the two rows beneath the Units: pop-up are for 
setting the serial communications parameters used for 
communication between the PC and the weather station. 
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Serial Mode 
 
The Serial Mode: pop-up lets you choose between system defined 
and user-defined port settings for the serial port connected to the 
weather station. 
 
When System Defined is chosen, the Communication Port: button is 
enabled and the Port Address and Port IRQ controls are disabled. 
The address and IRQ settings set in Windows for the port number 
you choose (1, 2, 3, or 4) are used. 
 
When User Defined is chosen, the Communication Port: button is 
disabled, and Port Address and Port IRQ are enabled instead. This 
lets you choose a particular address and interrupt setting that is 
independent of the COM port. 
 
Communications Port 
 
When Serial Mode: is set to System Defined, the Communications 
Port: control lets you choose which of the standard COM ports you 
are using. The control is disabled when Serial Mode: is set to User 
Defined. 
 
Port Address 
 
When Serial Mode: is set to User Defined, the Port Address control 
lets you specify a port IO address. The control is disabled when 
Serial Mode: is set to System Defined. 
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Port IRQ 
 
When Serial Mode: is set to User Defined, the Port IRQ control lets 
you specify a port IRQ number. The control is disabled when Serial 
Mode: is set to System Defined. 
 
Baud rate 
 
Use the Baud rate: pop-up to set the serial baud rate recommended 
by your weather station documentation. 

20.3.5 In File and Out File 

 
The Weather EX’s capability to write and read its weather variable 
values to/from a file gives the EX two modes of operation: 
 

� Direct Sensing mode – the EX gets the weather data directly 
from an attached weather station via the serial port 
 
Normally, the Weather EX is in the Direct Sensing mode, 
and collects data from an attached weather station. 
The EX can optionally write the values to an output file. 
 

� Remote mode – the EX gets weather data by reading an 
output file written by a Weather EX in another location 
Remote mode allows multiple independent systems in a 
networked environment to run weather scripts while not 
being directly connected to a weather station. Instead, they 
all refer to the data generated by a single weather station 
and stored in an output file. 
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20.4 Using Direct Sensing mode 
 
To use the Weather EX in the Direct Sensing mode, you only need to 
make sure there is no file path displayed in the In File:... button. If 
there is a path there, click the Clear button next to the In File:... 
button to clear the path. 
 
If the Weather EX is in Direct Sensing mode and you wish to create 
output files for other machines to use in Remote mode, click the 
Out File: button to open the File dialog. Navigate to the location 
where you want the file to be stored, enter a file name ending in 
.SCA in the File: text box and click OK. Be sure to record the location 
and file name, as you will need to be able to find the file from your 
Remote weather script machines. 
 
The next time you run a script while a weather station is attached, 
an output file with the name you gave will be created containing 
current weather variable values. 
 
To stop creating output files, click the Clear button next to the Out 
File:... button to clear the path. 

20.5 Using Remote Mode 
 
To use the Weather EX in the Remote mode, there must be an 
existing Weather EX output file. If necessary, create an output file 
using the Weather EX on a machine that has a weather station 
connected, as described in the preceding section. 
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Click the In File: button to open a File dialog. Navigate to the 
location of the output file generated by the weather station you 
want to monitor. Select the output file (a .SCA file) and click OK. 
 
The Weather EX will update its weather variables by reading the 
values from the output file that you chose. 
 

20.5.1 The Output File 

 
The output file is a simple Scala script that lists the variable names 
and their values. A typical output file looks similar to this and is 
representative of the onscreen data to be expected: 
 
!ScalaScript 
EVENT 
WEATHER.InsideTemp = "73.000"; 
WEATHER.OutsideTemp = "87.500"; 
WEATHER.WindSpeed = "12.300"; 
WEATHER.WindDirection = "NW"; 
WEATHER.Barometer = "31.140"; 
WEATHER.InsideHumidity = "26.300"; 
WEATHER.OutsideHumidity = "75.300"; 
WEATHER.Rain = "1.030"; 
WEATHER.WindChill = "87.500"; 
END 

20.6 Configuring Weather Variables 
 
The Weather EX uses the following variables to store the 
corresponding weather measurements: 
 
WEATHER.InsideTemp 
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WEATHER.OutsideTemp 
WEATHER.WindSpeed 
WEATHER.WindDirection 
WEATHER.Barometer 
WEATHER.InsideHumidity 
WEATHER.OutsideHumidity 
WEATHER.WindChill 
WEATHER.DewPt   (dew point) 
WEATHER.DailyET   (daily evapotranspiration) 
WEATHER.UV    (ultraviolet radiation) 
WEATHER.HeatIndex 
 
All these are text (string) variables. The Weather EX places decimal 
numerical values, converted to text form, into the variables. (See 
the example under “The output file”, above.) 
WEATHER.WindDirection is a special case, in that the weather 
station’s 0-359 degree reading is converted into one of 16 compass-
point directions, such as W, SW, or NNE, before being stored. 

20.6.1 Variable Offsets 

 
The Adjustment Offsets panel of the Weather EX Options dialog 
provides an offset text box for all weather variables. 
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Each variable can be given its own offset value. This lets you 
calibrate its reading to an external reference to correct for slight 
variances in weather station sensitivity, local conditions, etc. 
 
Enter a positive or negative value for any variable that requires 
calibration. Decimal values, such as “1.3”, can be used. The offset 
value is added to the raw value reported by the weather station 
before being stored in its weather variable. Leaving a control blank 
is the same as entering “0”—no change is made to the value from 
the weather station. 
 
The Dew Point, Daily ET, UV, and Heat Index controls are not 
available when the Weather Wizard model is selected. 

20.6.2 Setting Variable Precision 
 

The precision with which weather data are stored in the variables 
can be controlled. Specifically, the number of decimal places used 
for variable values can be set per variable. 
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The controls on the Precision panel of the Weather EX Options 
dialog let you set the number of decimal places used to store the 
values of all the weather variables. The default is 3, meaning that 
three decimal places are shown in the value. 
 

 
 
For example, if a temperature coming from the weather station was 
56.123, then the following precision settings would have these 
results: 
 

 
 
Precision controls are provided for all the weather variables except 
wind direction. The Dew Point, Daily ET, UV, and Heat Index controls 
are not available when the Weather Wizard model is selected. 
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20.7 Using the Weather EX 
 
For the script author, the fundamental effect of having the Weather 
EX installed is that the WEATHER variables become available in the 
Branch menu. 
 
To make use of them, create the page or pages on which you wish 
to display data from the weather station. On such a page, you 
include text elements with these variables embedded in text 
elements that include appropriate labels and unit indications. 
 
For example, you could design a page like this: 
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That page might look like this when played back: 
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||||| 21 Video Control EXes 
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21.1 Licensing 
 
You must obtain an updated license before attempting to configure and 
use any of the Video Control EX Module. 

To obtain an updated license for Designer 5, follow these steps: 

1. Start Designer 5 

2. Click Help > About Designer 

3. Click the Get License File Online button. When prompted to 
overwrite the existing license, click Yes 

4. If you want to Save a copy of the license file in My Documents, 
click Yes. Otherwise click No.  

To obtain an updated license for Content Manager 5, follow these steps:  

1. Login to Content Manager 5 using the Administrator account 
with the password.  

2. Click Settings > License Status . This will take you to the license 
status page.  

3. Click the Get License File Online link.  

4. Click OK to get an overview of the updated license.  

5. Click Accept to install the updated license.  

21.2 Allocating Licenses to Player(s)  
 
Once an updated Content Manager license has been installed, you can 
then choose which players you want to allocate the Video EX licenses to. 
Any players that do not have a Video EX license will not be able to use any 
of the Video EX’es. To allocate a Video EX license for a player, follow these 
steps:  

1. Go to Network > Players 

2. Select a Player, and click Properties  
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3. Click the EX Modules tab. 

4. Click the checkbox next to Video EX Module to enable it for this 
player.  

5. Click Save to keep the changes.  

6. Generate a new plan for the player so that the player gets an 
updated license. 

21.3 Switcher EX Module 
 
The Scala Switcher EX Module allows you to use a variety of 
audio/video switchers, controlling them directly with an Designer 5 
script. Switchers currently supported by this EX include: 
 

� Adrienne AEC-1 
 

� Digital Processing Systems RS-2800 4x1 
 

� Kramer VS-401 4x1, VS-402 4x2, VS-801 8x1, VS-802 8x2, 
VS-601XL 6x1, VS-808XL 8x8, 16x16, 4x4 models (incl. 
“Protocol 2000” models) 

 
� PESA Bobcat 

 
� Sigma SCI-210, SCI-8x8, SLX 

 
� Vicon VPS-1300 

21.3.1 Hardware requirements 
 
You need an audio/video switcher with a serial port, a serial cable 
connected between the switcher and the PC, and the necessary 
audio and video cables. 



Designer5 
 

 
623 

 

21.3.2 Enabling the Switcher EX 
 
To enable the Switcher EX Module, run Designer, and on the Main 
menu click the Tools icon and choose Options. You see the Designer 
Options dialog. 
 
In the Modules tab, you see the Switcher EX Module? button in the 
Optional Modules scrolling list. The EX is not turned on by default, 
so click this button to turn it on ( ). 
 
Then click the Switcher EX Module... button in the Module Settings 
list to open the Switcher Options dialog. It allows you to choose the 
switcher you are using and set up its communication and mapping 
parameters. 
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21.3.3 The Switcher Options dialog 
 
In the Switcher Options dialog, you first need to select a switcher. 
Click the Select button. You see the File dialog open to the Switcher 
folder, which lists configuration scripts for each supported switcher. 
Double-click the config script file for the switcher you are using. You 
see the Switcher Options dialog again, with the chosen switcher’s 
name shown in the title bar. 

21.3.4 Setting communication parameters 
 
The buttons in the dialog are for setting the serial communications 
parameters used for communication between the PC and the 
switcher. The config script files for the supported switchers set 
these parameters to their recommended values for you, and should 
not normally need to be changed.  
 
However, in case of system conflicts or other special needs, all 
parameters can be adjusted if necessary. 

21.3.5 Serial Mode 
 
The Serial Mode: pop-up lets you choose between system defined 
and user-defined port settings for the serial port connected to the 
switcher. When System Defined is chosen, the Communication Port: 
button is enabled and the Port Address and Port IRQ buttons are 
disabled. The address and IRQ settings set in Windows® for the port 
number you choose (1, 2, 3, or 4) are used. When User Defined is 
chosen, the Communication Port: button is disabled, and Port 
Address and Port IRQ are enabled instead. This lets you choose a 
particular address and interrupt setting that is independent of the 
COM port. 
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Communication Port - When Serial Mode: is set to System Defined, 
the Communication Port: pop-up lets you choose which of the four 
standard COM ports you are using. The pop-up is disabled when 
Serial Mode: is set to User Defined. 
 
Port Enabled? - The Port Enabled? button is normally on, indicating 
that the specified serial port and video hardware are attached to 
this machine. However, if you happen to be editing a script with 
switcher events on a machine that does not have the port and 
hardware currently attached, turn off this button while editing to 
prevent error messages from appearing. 
 
Port Address - When Serial Mode: is set to User Defined, the Port 
Address pop-up lets you specify a port IO address. The pop-up is 
disabled when Serial Mode: is set to System Defined. 
 
Port IRQ - When Serial Mode: is set to User Defined, the Port IRQ 
popup lets you specify a port IRQ number. The pop-up is disabled 
when Serial Mode: is set to System Defined. 
 
Baud - Use the Baud pop-up to set the serial baud rate 
recommended by your switcher documentation. 
 
Data Bits - Use the Data Bits pop-up to set the number of data bits 
recommended by your switcher documentation. 
 
Parity - Use the Parity: pop-up to set the serial parity recommended 
by your switcher documentation. 
 
Stop Bits - Use the Stop Bits pop-up to set the number of stop bits 
recommended by your switcher documentation. 
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21.3.6 Mapping switcher inputs 
 
The Switcher EX allows you to map or associate the switcher’s 
inputs with the outputs of any video playback devices you have set 
up using the VCR EX, or with the computer’s output. 
 
Click the Map button at the bottom of the Switcher Options dialog 
to open the Map VCR Devices dialog. 
 

 
 
This dialog contains a pop-up for each video input on the switcher. 
By default each input is Unset, indicating that there is no video 
source for that input. When you click the pop-up, the names of any 
video units you have defined in the VCR Options dialog appear. 
Computer refers to the video output of the PC itself. 
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When you have made the desired settings for each input, click the 
Close button to return to the Switcher Options dialog. 
 
Saving switcher settings 
 
After making all the communication and map settings for your 
chosen switcher, you should click OK to use these settings, or Cancel 
to discard any changes. In either case, the dialog closes. 

21.3.7 The Switcher menu 
 
Click a button in the Switcher column in the Designer Main or 
Design List menus to open the Switcher menu. 
 

 
 
The upper left button is the Command: pop-up. Use the popup to 
select an action, either Switch or None. When Switch is selected, the 
routing settings specified will be applied for the current page before 
the page displays. Select None to eliminate an existing switcher 
event for the page. 
 
When you choose the Switch event, one or more additional pop-ups 
appear to the right. These control the routings for video (and 
possibly audio) sources connected to your switcher. The options 
available, and thus the additional buttons that appear, depend on 
the capabilities of the particular switcher. The button names 
indicate the signals they control. 
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Use the pop-ups to change the input/output routings. The values 
set by the pop-ups are also reflected on the button in the Switcher 
column, separated by commas. 
 
Click Preview to see the switcher routing settings you have made. 
 
Click Close to accept the routing settings (or to eliminate the 
switcher event, if Command: None is selected). Click Cancel to 
discard any changes. In either case, the menu closes. 

21.4 VCR EX Module 
 
Similar to the Switcher EX Module, the VCR EX Module allows you to 
control a serial-equipped videocassette recorder, videocassette 
player, or laserdisc player from within an Designer script. Models 
currently supported by this EX include: 
 

� JVC professional models with RS-232 
� Panasonic AG5700, AG7350 with RS-232 
� Sony UVW models with RS-232 
� RS-422 controlled VCRs such as the Sony DSR-60 (with 

Addenda Electronics 2/3 or 2/8 RS-232 > RS-422 adaptors) 
� Pioneer laserdiscs with RS-232 
� Generic RS-422 

21.4.1 Hardware requirements 
 
You need a videocassette machine or laserdisc player with a serial 
port, a serial cable connected between the unit and the PC, and the 
appropriate audio and video cables. 
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21.4.2 Enabling the VCR EX 
 
To enable the VCR EX Module, run Designer, and on the Main menu 
click the Tools icon and choose Options. You see the Designer 
Options dialog. 
 
In the Modules tab, you see the VCR EX Module? button in the 
Optional Modules scrolling list. The EX is not turned on by default, 
so click this button to turn it on ( ). 
 
Then click the VCR EX Module... button in the Module Settings list to 
open the VCR Options dialog. It allows you to choose the switcher 
you are using and set up its communication and mapping 
parameters. 

21.4.3 Configuring the VCR EX 
 
To configure the VCR EX Module, click the VCR EX Module... button 
in the Module Settings list to open the VCR Options dialog. It allows 
you to choose the VCR you are using and set up its communication 
and timing parameters. 
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In the VCR Options dialog, you first need to select the VCR or 
laserdisc player that you are using. The VCR Name: selector shows 
the name of the currently selected device definition. (If no device 
has been defined yet, all the controls in the dialog except the 
buttons at the bottom are disabled.) 
 
Use the arrows in the selector to pick the name of the device you 
want. The settings and available options in the dialog vary 
depending on the unit you choose. 
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21.4.4 Adding and naming a VCR 
 
The VCR EX supports a variety of different hardware models, and 
lets you define options for multiple units of a given model, or for 
different setups of the same unit. To do this, you choose a 
supported model, then specify various settings for the model, 
including a name for the definition. You then refer to the name to 
specify the desired unit or setup when you use the VCR EX menu to 
place a VCR event in a script. 
 
To define a unit or setup: 
 

1. Click the Add button. You see the Add Unit dialog, which has 
a single pop-up listing all the supported hardware models. 
 

2. From the VCR Model: pop-up, choose the model of device 
for which you wish to define a setup. If your specific VCR 
model is not listed, but it supports standard RS-422 serial 
commands, choose RS-422. 
 

3. Click OK. 
 

4. You see the name you chose in both the VCR Name: selector 
and in the VCR Model: display below it. The option buttons 
in the dialog become enabled and are given appropriate 
defaults. 

 
The default name can be changed if you wish. Select it in 
VCR Name: and type in something more descriptive, like 
“Ad Deck 1”. The name in VCR Model: does not change, so 
that you always know what type of device you are working 
with. 
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5. Make any necessary changes in the settings for the 
definition. 

 
By clicking the Add button again, you can create another 
setup for the same VCR model—if, for example, you have 
several of the same type of VCR on different serial ports—or 
choose a different model. Another entry appears in the VCR 
Name: button. (To create a unique default name, Designer 
adds a numbered suffix to the name if necessary.) When 
there is more than one VCR Name: entry, use the arrows on 
the selector to choose which unit the option buttons apply 
to. 

 
To delete the current name and option set from the list of entries 
shown on the VCR Name: selector, click Delete. Be sure not to 
delete a VCR for which there is a VCR event defined. 

21.4.5 Setting communication parameters 
 
Most of the buttons in the dialog are for setting the serial 
communications parameters used for communication between the 
PC and the video hardware. These options, Serial Mode, 
Communication Port, Port Address, Port IRQ, Port Enabled?, Baud, 
Data Bits, Parity, and Stop Bits, function and are set the same as 
they are in the Switcher Options dialog. 

21.4.6 Setting equipment-specific parameters 
 
There are some parameters available in the VCR Options dialog that 
can vary in their possible settings based on the particular piece of 
equipment you are using. In some cases there are options unique to 
a given device, which appear only for that device. 
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Timing - The Timing: pop-up has three possible settings: 
 

� Timer 
� Counter 
� Time Code 

 
Which of these appears depends on the equipment. Laserdisc 
players operate by means of absolute frame counters, so their only 
possibility is Counter. Most VCRs have at least Timer; more 
advanced models also feature SMPTE time code capability, and so 
also have Time Code available. A device such as the Como Control X, 
which can control various types of equipment, can show all three 
options. 
 
Generally, if Time Code is an option, it is better to use it than Timer 
or Counter, which can fail to work properly if the physical video 
device gets out of sync with the script’s idea of where it is. 
  
PreRoll Time - “Pre-roll” is the video term for the amount of time 
that must be allotted for a video playback device to get up to speed 
after being physically started, to be sure that image and sound 
reproduction are stable. The recommended pre-roll value varies 
from machine to machine, but for most VCRs, pre-roll is from 3 to 5 
seconds. Use the PreRoll Time value control to set the number of 
seconds specified by the manufacturer of your VCR. 
 
For example, when a 4-second pre-roll has been specified, the VCR 
automatically moves the tape to a location 4 seconds before the 
point at which the desired video segment begins, and starts the 
transport. It is assumed that an associated video switcher will be 
used to switch in the VCR’s output at the end of the 4-second pre-
roll, so that actual playback begins at the proper location. 
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Note:  The PreRoll Time and PostRoll Time options cannot 
calculate their locations correctly unless the Frames Per Second 
pop-up in the VCR Options dialog is set correctly to match the 
video standard (NTSC, PAL, or SECAM). 
 
PostRoll Time - Similar to pre-roll, “post-roll” is the number of 
seconds that a VCR transport continues to run after the specified 
video segment has completed. This ensures that sync is not lost 
before a video switcher finishes switching out the VCR after the 
segment. 
 
A post-roll of 1 second is usually sufficient. Use the PostRoll Time 
value control to set the number of seconds specified by the 
manufacturer of your VCR. 
 
ID/Routing Number - This option appears only for devices that 
themselves address more than one playback machine, such as a 
control box that might handle several VCRs. The number you set 
with the value control corresponds to one of the machines. 

21.4.7 The VCR menu 
 
Click a button in the VCR column in the Designer Main or Design List 
menus to open the VCR menu. 
 

 
 
Use the Unit: pop-up in the upper left corner of the menu to choose 
which machine the event should address. The names for any 
playback units you have defined in the VCR Options dialog appear 
here. Click the pop-up to view the units available. 
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The VCR: pop-up specifies the type of event that is sent to the VCR. 
For each event, the selection of options that are available on the 
menu varies. Click the pop-up to choose a different event. 
 
Click Preview to see the VCR settings you have made. 
 
Click Close to accept the settings (or to eliminate the VCR event, if 
Command: None is selected). Click Cancel to discard any changes. In 
either case, the menu closes. 

21.4.8 Play 
 
The VCR: Play event operates the video hardware transport, starting 
and stopping play at In and Out points that you can specify. 
 
The row of buttons under the heading Adjust Now function as a 
remote control to let you immediately execute any transport 
operation you want on the selected playback hardware. 
 

 
 
(These buttons function in real time and are for convenience only. 
They do not affect the script event.) A given piece of hardware may 
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not offer some of these transport operations, such as fast play, so 
you may have to experiment to determine what certain of these 
buttons do on a given machine. 
 
Set In, Set Out - You specify the point in the video at which to begin 
and end play by using the Set In and Set Out buttons and their 
associated value controls. In and Out points are set using the 
method you specified with the Timing: pop-up in the VCR Options 
dialog for the current machine: 
 

� Timer – hours, minutes, seconds, and frames relative to a 
zero point (normally the beginning of the tape or laserdisc) 

� Counter – location in terms of a six-digit frame number 
relative to a zero point (normally the beginning of the tape 
or laserdisc) 
 

� Time Code – hours, minutes, seconds, and frames within the 
current SMPTE time code stripe 

 
Use the value control to the right of the Set In button to enter the 
location at which play should begin. Use the value control on the far 
right to enter the location at which play should stop. 
 
Alternatively, you can click the Set In or Set Out buttons to set the 
location to the current location on the tape or disc. Reverse play is 
possible by setting an In point that is later than the Out point. 
 
Note:  Do not set an In or Out location that is so close to the 
beginning or end of a tape that there is not enough room for the 
defined PreRoll or PostRoll to take place. Insufficient pre-roll space 
will cause a Play event to be skipped. 
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You can display single laserdisc frames by choosing the Counter 
method of timing and making the Set In and Set Out points the 
same. 
 
Wait? - Turn on the Wait? button to prevent the script from 
continuing until this VCR: Play event has completed. 
 
Auto? - The Auto? option appears in the VCR menu to the right of 
the Wait? button if the Switcher EX has also been activated. 
 
When this option is on, the VCR EX and the Switcher EX 
communicate, and for a Play event, cause the Switcher EX to 
automatically switch the input(s) specified for the current playback 
device in and out at the In and Out locations defined in the VCR 
menu. When this option is off, you must insert explicit Switcher 
menu events to handle the routing of video playback. 

21.4.9  Audio 
 
This event is available only for laserdisc players. The VCR: Audio 
event lets you turn one or both audio channels of a video segment 
on or off. Click the Audio Channel 1? and Audio Channel 2? buttons 
to enable and disable their audio playback. 

21.4.10  Play to 
 
The VCR: Play to event is almost identical to the Play event, but it 
has no provision for specifying a starting location; there is no Set In 
button or value control. In addition, the Auto? option is not present. 
The remaining controls function in the same way as on the VCR: 
Play panel. When this event is executed, video playback starts at the 
current location and continues to the point specified by the Set Out 
control. 
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21.4.11   Go to 
 
The VCR: Go to event allows you to change the current location 
within the videotape or laserdisc without beginning play. 
 
This is valuable when used in advance of a Play event, to avoid a 
delay while the machine changes location to the beginning of a play 
segment. Specify the location to move to with the Set control. There 
are no Set Out or Auto? options. 
 
Other controls work the same as on the VCR: Play panel. 
 
21.4.12   Sync 
 
This option helps ensure that the activities associated with an 
element or page are synchronized with a video segment that is 
already playing. 
 
In essence, the Sync event places the element or page on standby 
until the video playback reaches the time or counter setting you 
specify. At that point it allows the script to continue to the next 
event. Rather than the script determining the video activity, as it 
does, for example, in the Play event, the video actually controls the 
script in a VCR: Sync event; the script cannot continue until the 
video reaches a certain point. This is useful, and often necessary, to 
ensure, for example, that a wipe starts at precisely the right time 
relative to a video segment. 
 
Set specifies the location in the video that determines when the 
script runs the page you are working with. 
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The time can be expressed in minutes, seconds and frames, or as a 
counter setting, just as it is in the Set In and Set Out controls in the 
Play event. Unless you specify a setting, the sync time is 
00:00:00.00. (The following explanations assume you will sync to a 
time.) 
 
Use the value controls by the Set button to set the sync point. In 
order to set the time precisely, you must experiment with the 
setting and refine it until the other script activity is synchronized 
with the video as accurately as possible. Use the Preview button in 
the menu and in the List or Main menus to see and hear how the 
setting fits into the scheme of the current page and surrounding 
pages in the script. When the script encounters the Sync event 
before the video reaches the specified time, the script waits at that 
point. When the sync time on the video arrives, the script continues. 
If other events delay the script, however, and it reaches the Sync 
event after the video has passed the sync time, the script just 
continues normally. 
 
This could happen, for example, if a preceding event took more time 
than you had thought when you calculated the sync time—you 
might have reduced the speed of a wipe, making it take longer to 
complete. An element or page associated with the VCR: Sync event 
isn’t lost or overlooked; in this case it just does not appear when 
you planned. To avoid such difficulties, always Preview the script in 
its entirety and be aware of other events that may affect the timing 
and coordination. 
 
21.4.13   Rewind 
 
The VCR: Rewind event places the playback unit into rewind mode, 
effectively changing the current location to the beginning of the 
tape or disc. 
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When the current playback unit has its Timing: pop-up set to Timer, 
this event also zeroes the timer, ensuring that the VCR EX zero point 
(00:00:00.00) corresponds with the beginning of the tape. A Rewind 
event also zeroes a VCR counter (a laserdisc counter, which is 
absolute, returns to the first frame). To ensure accurate positioning 
of Set locations with VCR devices, you should always insert a VCR: 
Rewind event as the first VCR menu command in a script. 
 
21.4.14   Pause 
 
The VCR: Pause event immediately pauses a playing video. It also 
pauses a VCR that is recording. Resume play with a VCR: Play or 
VCR: Play to event. 
 
21.4.15  Stop 
 
The VCR: Stop event immediately stops a playing video. It also stops 
a VCR that is recording. 
 
21.4.16   Wait 
 
Like the Wait? button, the VCR: Wait event causes script execution 
to stop and wait for the completion of a VCR event. 
 
The difference is that the Wait? button is an additional option for 
the current video event (which is generally to play a video). 
 
The VCR: Wait event stands on its own, and causes the script to wait 
for a preceding VCR event to finish playing. It ensures that the 
current element or page is displayed until the current video 
segment is done. 
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In other words, you use the Wait? button only when you want the 
script to pause and wait for this video event. Use the VCR: Wait 
event when you needed the script to continue while a video event 
was taking place—you left its Wait? button off—and you need the 
script to wait at a later point for that video event to finish. 
 
21.4.17  Record 
 
When controlling a VCR, you can use the VCR: Record event to enter 
Record mode. (This event is not available when the machine 
specified by the Unit: pop-up is a playback-only videocassette 
machine or a laserdisc player.) The controls are identical to those in 
the VCR: Play panel, and function in the same way, except that 
there is no Auto? option. 
 
Use the Set In controls to specify the location at which to begin 
recording, and the Set Out controls for the location at which 
recording should stop. 
 
21.4.18  None 
 
To eliminate an existing VCR event, change it to a None event. 
 
21.4.19  Coordinating script and video playback 

 
You should be aware that VCRs, unlike laserdisc players, do not have 
a fixed, frame-accurate method of positioning embedded in the 
medium. This means that it is possible for the script’s idea of where 
it is in the tape to not match the actual location. Thus in order for 
Set points to work correctly with VCR playback, there are steps that 
you should take to be sure that the script does not get “lost” within 
a tape. That could lead to the wrong segments of video being 
played, or segments not being played at all. 
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21.4.20  Tape Timing Methods 
 

A VCR can use any of the three methods of location specified by the 
setting of the Timing: pop-up in the VCR Options dialog. In general, 
using SMPTE time code is preferable. If the tape has been properly 
“striped” with SMPTE, the time code on the tape provides a frame-
accurate random-access location method that is comparable to a 
frame counter, but gives you a better idea of where you are on the 
tape and how fast the tape is moving. However, not all VCRs 
support time code. 
 
21.4.21  Using the Timer Method 
 

Unlike time code or a laserdisc frame counter, the Timer method is 
a relative positioning method. It judges location relative to a single 
absolute reference point, the zero point (00:00:00.00 on the timer). 
 
Successfully using the Timer method depends entirely on the script 
and the VCR remaining in sync with regard to their notion of the 
current location in the tape. Because there is nothing on the tape 
that can tell the VCR where it is, retaining this sync depends on two 
things: 
 

� Establishing the zero point at the beginning of the tape 
 

� The tape’s motion being controlled solely by the script while 
the script is running For these reasons you should always 
take these steps when working with VCRs using the Timer 
method: 
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� Always insert a VCR: Rewind event as the first VCR EX event 
in the script. This both rewinds the tape to its beginning and 
resets the timer to 00:00:00.00. 

 
� While the script is playing, never manually operate the VCR 

transport controls, change tapes, or remove, work with, 
then reinsert a tape in an attached VCR. The VCR EX will 
have no way of knowing that the tape is no longer at the 
last location it remembered. 

 
21.4.22  Using the Counter Method 
 

A VCR might also offer a frame counter, in addition to or instead of 
a timer. Unlike a laserdisc frame counter, the zero point of a VCR 
counter can be reset, just like a timer zero point. Thus it is a relative 
positioning method and you must exercise all of the cautions as 
with the Timer method, described above. 
 
21.4.23  Using the Time Code Method 
 

If available on your hardware, using SMPTE time code (the Time 
Code method) is preferable to the Timer method. 
 
Time code is has superior accuracy, but more importantly, because 
the time code is written onto the tape itself, it is an absolute 
positioning method. This means that the exact location on the tape 
can be determined automatically at any point, regardless of when 
and how the tape has been manipulated. 
 
This eliminates the need for a rewind at the beginning of the script, 
and allows you to operate the tape transport manually without later 
causing the script to become confused. 
 



Designer5 
 

 
644 

 

However, there are certain potential problems with time code. 
Blank tapes do not have time code on them; a tape must be 
“striped”, or have the time code written to it. There are a number of 
options in the striping process, so not all tapes are striped with time 
code in exactly the same way. The operator can stripe only part of 
the tape, place more than one stripe on the same tape, or even 
start a given stripe at an arbitrary time. So, for example, a tape 
could have one stripe from 00:00:00.00 to 00:32:00.00 and a later 
stripe from 00:17:30.00 to 01:45:00.00. Furthermore, the time code 
stripe does not uniquely identify the tape. 
 
Thus you need to beware of situations like the following: 
 

� The current tape location is moved to a section of the tape 
without time code, making positioning impossible 

 
� The current tape location is moved to a time code stripe 

other than the intended one 
 

� The tape in the machine is changed 
 

In such cases, a positioning command could fail, the wrong segment 
of the tape could be played, or the right segment of the wrong tape 
could be played. 
 
To prevent such occurrences: 
 

� If you use time code on any of your tapes, all tapes should 
use time code. This helps prevent confusion. 

 
� No partial striping or multiple striping. All tapes should have 

time code in a single continuous stripe for their full length. 
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� Never change tapes in a machine while that machine is 
being controlled by a running script. 
 

21.5 Leightronix EX Module 
 
Bundled with the VCR and Switcher EXes is the Leightronix EX. This 
EX allows control of several interface devices produced by 
Leightronix Inc.: 
 

� MINI-T-PRO 
� PRO-8 
� PRO-16 

 
The Leightronix devices connect to a wide variety of serial 
controlled VCRs, and provide a combination of switcher functions 
and VCR transport control, making them highly versatile in a budget 
video production environment. 

21.5.1 Hardware requirements 
 
In addition to one of the abovementioned Leightronix models, you 
need one or more serial-controllable VCRs; a PROBUS interface 
compatible with each, connected between the Leightronix device 
and the VCR; a serial cable connected between the Leightronix unit 
and the PC; and the necessary audio and video cables. 
 
Follow the instructions in the documentation for the Leightronix 
device, interface devices, and associated hardware in assembling 
your video installation. Be sure the installation is functioning 
correctly by itself before attempting to control it through the 
Leightronix EX. 
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21.5.2 Enabling the Leightronix EX 
 
To enable the Leightronix EX, run Designer, and on the Main menu 
click the Tools icon and choose Options. You see the Designer 
Options dialog. 
 
In the Modules tab, you see the Leightronix EX Module? button in 
the Optional Modules scrolling list. The EX is not turned on by 
default, so click this button to turn it on ( ). 
 
Then click the Leightronix EX Module... button in the Module 
Settings list to open the Leightronix Options dialog. It allows you to 
choose the switcher you are using and set up its communication and 
mapping parameters. 
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21.5.3 The Leightronix Options dialog 
 
In the Leightronix Options dialog, you need to select the equipment 
model you are using. From the Type: pop-up, choose the correct 
name. 
 
Most of the buttons in the dialog are for setting the serial 
communications parameters used for communication between the 
PC and the Leightronix unit. These options, Serial Mode, 
Communication Port, Port Address, Port IRQ, Port Enabled?, Baud, 
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Data Bits, Parity, and Stop Bits, function and are set the same as 
they are in the Switcher Options dialog. 

21.5.4 Saving settings 
 
After making all the communication settings for your chosen 
Leightronix unit, click OK to save the settings for use in future 
Designer sessions. Click Cancel to discard any changes. In either 
case, the dialog closes. 
 

21.5.5 The Leightronix menu 
 
When the Leightronix EX has been turned on in the Designer 
Options dialog, you see the Leightronix column in the Main menu. 
Click this column for a page or special event to open the Leightronix 
menu. 
 

 
 
Much like the Switcher menu, the Leightronix menu has a 
Command: pop-up in the upper left that you use to specify an 
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action. The menu displays different controls depending on the 
action you choose. Use the pop-up to choose a command. 

21.5.6 Switch 
 
The default choice on the Command: pop-up is Switch. This 
command lets you select one of the video/audio inputs of the 
Leightronix unit and switch it to the output. 
 
Use the Input pop-up on the right to choose the number of the 
desired input. 
 
Note that this command only switches inputs; it does not also start 
playback on the input unit. If there is not already a signal on the 
selected input, you may need to add a Command: Play event as 
well. Place the Play event before the Switch event. For a clean cut, 
the time delay between the two events should last at least as long 
as the input unit’s preroll time. 

21.5.7 Play 
 
The Play command sends a signal to an external device (connected 
through a PRO-BUS interface) to begin video playback. 
 

 
 
You identify the desired playback unit using the ID control to the 
right. 
 
Note that the ID numbers do not necessarily correspond to input 
numbers. The ID numbers are not set within the Leightronix EX. 
Consult the reference materials created by whoever set up your 
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video installation to match up input numbers and ID numbers with 
physical pieces of video equipment. 
 
You can choose “-” on the ID control. This causes the command to 
be sent to all connected devices, regardless of ID. 

21.5.8 Rewind 
 
The Rewind command sends a signal to an external device to begin 
rewinding. 
 
As with the Play command, you identify the desired unit using the 
ID control to the right. 
 
Note:  For the PRO-8 and PRO-16 units, an Output pop-up is also 
available, allowing you to choose the destination output on the 
unit. 

21.5.9 Stop 
 
The Stop command sends a signal to an external device to stop 
playback. 
 
As with the Play command, you identify the desired unit using the 
ID control to the right. 

21.5.10  Record 
 
The Record command sends a signal to an external device to begin 
recording. 
 
As with the Play command, you identify the desired unit using the 
ID control to the right. 
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21.5.11  Wait 

 
The Wait command causes the script to pause until triggered to 
continue with the next event in the script. 
 

 
 
The trigger to continue is the presence or absence of a video sync 
signal at the Leightronix device’s output. The Sync On? option is 
used to specify whether the trigger to resume execution is the 
presence or the absence of sync. 
 
When this option is on ( ), the event waits for video sync to appear 
at a Leightronix video out. When it is off, the event waits for video 
sync to disappear from the video out. For the PRO-8 unit, an Output 
pop-up is also available, allowing you to choose which of the unit’s 
outputs should be monitored for video sync. 
 
This event can be used to synchronize the beginning of the next 
script event with the beginning of a video segment, or to continue 
the script once a segment has ended. This command does not allow 
you to specify an input or ID number. Video sync can appear at the 
video output from multiple sources. To use this command 
effectively, you must be certain that the currently-selected video 
input is the source that you intend to be the trigger. 
 
Note:  Command: Wait is available only for the MINI-T-PRO and 
PRO-8. It is not available when the PRO-16 unit is selected. 
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21.5.12  None 

 
Use the None command to remove an existing Leightronix EX 
command on a particular event, or to exit the menu without 
specifying a command. 
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||||| 22 CORIOgen EX Module 
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Overview 
 
Scala software products support use of the Vine Micros Ltd. 
CORIO®gen Eclipse genlock/overlay unit through the Scala 
CORIOgen EX Module. 
 
To use the CORIOgen unit with Scala, any system with the unit must 
be configured with the CORIOgen EX Module present. 
  
For further CORIOgen-related information, you can also visit the 
Vine Micros Web site at http://www.vinemicros.com. 

22.1 Licensing 
 
Once the hardware has been installed, you must obtain an updated 
license before attempting to configure and use CORIOgen EX 
Module. 

To obtain an updated license for Designer 5, follow these steps: 

1. Start Designer 5 

2. Click Help > About InfoChannel Designer 

3. Click the Get License File Online button. When prompted to 
overwrite the existing license, click Yes 

4. If you want to Save a copy of the license file in My 
Documents, click Yes. Otherwise click No.  

To obtain an updated license for Content Manager 5, follow these 
steps:  

1. Login to Content Manager 5 using the Administrator 
account with the password.  
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2. Click Settings > License Status . This will take you to the 
license status page.  

3. Click the Get License File Online link.  

4. Click OK to get an overview of the updated license.  

5. Click Accept to install the updated license.  

22.2 Allocating Licenses to Player(s)  
 
Once an updated Content Manager license has been installed, you 
can then choose which players you want to allocate the CORIOgen 
EX licenses to. Any players that do not have a CORIOgen EX license 
will not be able to use the CORIOgen EX Module. To allocate a 
CORIOgen EX license for a player, follow these steps:  

1. Go to Network > Players 

2. Select a Player, and click Properties  

3. Click the EX Modules tab. 

4. Click the checkbox next to CORIOgen EX Module to enable 
it for this player.  

5. Click Save to keep the changes.  

6. Generate a new plan for the player so that the player gets 
an updated license. 

22.3 Configuring the CORIOgen EX 
 
To enable the CORIOgen EX, run Designer, and on the Main menu 
click the Tools icon and choose Options. You see the Designer 
Options dialog. 
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In the Modules tab, you see the CORIOgen EX Module? button in 
the Optional Modules scrolling list. The EX is not turned on by 
default, so click this button to turn it on ( ). 
 
Then click the CORIOgen EX Module... button in the Module Settings 
list to open the CORIOgen Options dialog. 
 

 
 
COM port - Use the COM Port: value control to choose the number 
of the COM port to which the CORIOgen is connected. 
 
Baud Rate - The Baud Rate: pop-up gives a selection of baud rates 
for serial communication through the selected COM port. Generally, 
the default value of 9600 baud should be used. 
 
Enable Sync? - The CORIOgen normally requires a video sync signal, 
which it gets from the video source connected to its external video 
inputs. If you need to use the CORIOgen without an external video 
signal, you should turn the Enable Sync? option off, so that the unit 
does not attempt to sync to a missing video source. 
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CORIOgen modes that require synchronized video signals—the 
Genlock, Overlay, and Mix modes—will not function if Enable Sync? 
is off. 
 
Video Source - The Video Source: pop-up lets you choose which of 
the external video inputs you want as the source. Choose either 
Composite Video (the RCA/phono In jack) or S-Video (the 4-pin mini-
DIN In jack). 
 
Freeze On Exit? - The CORIOgen unit’s Freeze function can keep a 
still frame of the last output image visible on the unit’s VGA output 
for as long as necessary. The CORIOgen EX offers the option of 
invoking the Freeze function automatically whenever the Player 
Script is exited by pressing Esc. 
 
Doing so prevents the Windows desktop from appearing on the 
Player’s display screen, which might be visible to the public. This is 
invaluable when doing field maintenance on installed Players, 
preventing the interruption in service from being excessively jarring 
to anyone viewing the Player, and protecting possibly sensitive 
information that could be exposed if the desktop were visible. 
 
By default, the CORIOgen’s video output automatically retains the 
last Player script screen when the Player software exits. To allow the 
same display as is seen on the computer monitor from the PC Out 
jack appear on the video screen when exiting a script, turn off the 
Freeze On Exit? option. 
 
Un-freeze On Startup? - If the CORIOgen’s Freeze function has been 
activated, either by the Freeze On Exit? option or otherwise, it can 
be automatically unfrozen when the Player Script starts, to resume 
normal playback display. The default setting is for this option to be 
on. 
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To keep a frozen display from being disrupted even when the Player 
Script starts again, turn off the Un-freeze On Startup? Option. 
 
Enable Audio Indicator? - The CORIOgen unit has a small built-in 
speaker, which can beep whenever the unit receives a command 
from the Player. When setting up and testing operation of the 
system, this can be helpful in confirming that serial communication 
is functioning. 
To enable audible confirmation of serial commands, turn on ( ) the 
Enable Audio Indicator? option. 

22.3.1 Using and saving settings 
 
Once you have made all the settings in the CORIOgen dialog that are 
needed, you can click OK to close the dialog and save the settings. 
 
The changes you make in the Options dialog will not take effect until 
the next time you open the Designer program. 
 
Click Cancel to close the dialog, discarding any changes you made. 

22.4 CORIOgen EX menu 
 
When the CORIOgen EX has been enabled, a new column appears in 
the Designer Main and Design List menus. The CORIOgen column 
lets you create script events that control the CORIOgen unit. Click in 
this column for a page or a special event to open the CORIOgen 
Eclipse Scan Converter menu. 
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CORIOgen commands 
 
The Command: pop-up lets you choose the command that this 
event sends to the CORIOgen unit. There are four possible 
commands: 
 

� Mode 
� Zoom 
� Freeze 
� None 

22.4.1  Mode 
 
When you choose the Mode command, the menu displays the 
Mode: pop-up, with which you can change the CORIOgen’s display 
mode. This determines what comes out of the CORIOgen’s video 
outputs (either the composite or the Svideo out jacks). 
 
There are four possible settings for Mode:, each of which has 
its own set of options in the CORIOgen menu: 
 
PC Out – (VGA only) - The video outputs display only the scan-
converted image coming in from the computer to the PC In 
connector. External video is not displayed; the image goes to black if 
the computer image is faded out. The VGA signal is not 
synchronized to the video signal. 
 
Genlock – (VGA only) - The video outputs display only the scan-
converted image coming in from the computer to the PC In 
connector. External video is not displayed; the image goes to black if 
the computer image is faded out. However, the PC display is 
synchronized (genlocked) to the external video, so that it can be 
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combined with the external video signal downstream of the 
CORIOgen unit. 
 
Overlay – (VGA and external video) - Overlays the scan-converted 
image from the computer on top of the external video image. The 
degree to which the video image shows through different areas of 
the computer image is controllable. 
 
Mix – (VGA and external video) - Overlays the scan-converted image 
from the computer on top of the external video image. The entire 
images are exchanged, with no areas of either image being more or 
less transparent. 

22.4.2 Zoom 
 
The Zoom command lets you insert a zoom command to enlarge the 
CORIOgen output image, with optional pan adjustments to 
reposition the zoomed image on the screen. 
 
The Zoom? button is available on the menu for this command. 
When it is off, the full image is displayed at normal size. When the 
button is on ( ), the entire image is enlarged to twice its normal 
dimensions, giving the effect of zooming in on the upper left 
quadrant of the image. 
 
To let you zoom in on any area of the image, the Pan X and 
Pan Y value controls appear when Zoom? is on. 
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The Pan controls represent offsets, in pixels, that the image can be 
moved. The default of 0 for both controls leaves the upper left 
corner of the image in the upper left corner of the screen. 
Increasing Pan X moves the image horizontally to the left, letting 
you see the right side of the enlarged image. 
Increasing Pan Y moves the image vertically toward the top, letting 
you see the bottom of the enlarged image. 
 
Executing this command with Zoom? turned off returns the image 
to normal size and position. 

22.4.3 Freeze 
 
The Freeze command makes the Freeze? button available. 
 

 
 
When this option is turned on ( ), the PC portion of the video 
output of the CORIOgen freezes at the moment the command is 
executed. Any changes in the display from the PC—the appearance 
of the Designer authoring environment, or the Windows desktop, 
for example—are not visible on the composite or S-video outputs. 
The external video input, if it is visible, is not affected, and 
continues to play normally underneath the frozen PC image. 
 
Executing this command with Freeze? turned off un-freezes the 
image, so that whatever is coming in to the unit’s inputs once again 
can appear in the video display. This command is useful either for a 
freeze-frame effect as part of script, or as a way of maintaining a 
presentable display (possibly an intro screen, logo, or message) for 
the audience while maintenance is done on the Player machine. 
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22.4.4 None 
 
The None command has no effect on the CORIOgen. Choosing it 
simply removes any CORIOgen EX command that you might have 
already set for the current event. 

22.4.5 Using the Mode options 
 
The different display modes include certain additional options for 
each. 
 
Fade - The Fade: pop-up is available with all of the Mode selections. 
The setting of this control determines what happens to the PC 
image when the command executes. The PC image can be faded in, 
faded out, or it can simply appear or disappear instantly. 
 
External video is not faded in or out by this option. For Overlay and 
Mix modes, the fade is to/from the external video image; for PC Out 
and Genlock modes the fade is to/from black. 
 
Set Fade: to In to cause the PC image to appear gradually over top 
of what is beneath. 
 
Set Fade: to Out to cause the PC image to gradually disappear, 
leaving visible only what is beneath. 
 
When either In or Out is selected, the Speed value control appears, 
letting you set how fast the fade takes place; enter a number from 1 
(slow) to 25 (fast). 
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When Fade: is set to “None”, any Mode change sent to the 
CORIOgen takes place instantaneously, as a “cut”. 

22.4.6 Overlay mode Key controls 
 
In Overlay mode, there are two further controls in the menu, Keyer: 
and Level. They let you adjust how the external video shows 
through the PC In image that overlays it. 
 

 
 
The Keyer: pop-up is for setting the sharpness of the dividing line 
between the transparent and non-transparent areas of the PC 
image. There are four possible settings: V. Soft, Soft, Normal, and 
Hard. 
 
When the Keyer: setting is Hard, all PC-image pixels below the Level 
luminance are completely transparent, and all those above that 
threshold are completely opaque. The other three settings define 
varying ranges of semi-transparent PC-image pixels that are near 
the threshold, softening the edge so that the PC and video images 
can be blended to different degrees. 
 
The Level setting determines the luminance level of the PC In signal 
below which the PC image becomes transparent, so that the 
external video image can show through. This happens on a pixel-by-
pixel basis, so that in any areas of the PC image that are darker than 
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indicated by the Level setting, the corresponding areas of external 
video are visible. 
 
For example, by using a dark page background for clips and text in 
an Designer script, you could overlay that on live video, and have 
the text and clips float over a video background by setting Level 
appropriately. 
 
Level can be adjusted from the default of 0 (nothing in the PC 
image, including pure black, is transparent) to a maximum of 250 
(all but the brightest PC image pixels are transparent). 

22.5 Advanced Features 
 
There are a couple of aspects of using the CORIOgen EX that may 
not be immediately obvious. 

22.5.1 Using Mode commands with fades 
 
If you use back-to-back Mode commands that include fades, you 
should include a brief pause with the CORIOgen EX event to allow 
the fades to complete. 
 
The CORIOgen unit does not have a signal for the end of a fade, so 
without a pause, it is possible for the next Mode command to be 
executed before an immediately preceding Mode (with a slow fade) 
has finished its fade. This would cause the fade to be cut off. 
 
Including a Duration event of 1-2 seconds using the Designer Timing 
menu should be sufficient to prevent a fade from being cut off by a 
following Mode event. 
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22.5.2 Switching the video source using a variable 
 
The current external video signal is normally specified using the 
CORIOgen Options dialog Video Source: setting. Changes to Options 
settings take place only when Designer is restarted. 
 
However, it is possible to switch the video source from within a 
script, using the special variable CORIOGEN.VIDEOSOURCE. In 
effect, this can let you use the CORIOgen as a simple switcher. 
 
To use the variable, you insert a Branch menu special event that 
changes the value of the variable. In the Set Variable section of the 
Branch menu, enter either CORIOGEN.VIDEOSOURCE = “Composite” 
OR CORIOGEN.VIDEOSOURCE = “S-Video” 
 

 
 
The current video source is changed to the external input connector 
you specified. 
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||||| 23 ArsMedia Export Plug-
  in for Adobe Photoshop  
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Overview 

Welcome to ArsMedia Scala Script Export Plug-in (SSE Plug-in) for 
Adobe Photoshop. The SSE Plug-in provides script export services for 
the Scala Designer line of products from Scala Inc. and integrates 
the powerful graphics capability of Adobe's Photoshop with the 
world's most powerful digital signage application. 

23.1 System Requirements 
 
The ArsMedia Scala Script Export Plug-in will require a computer 
with Microsoft Windows 2000 or Windows XP (SP1or later) 
operating system and Adobe® or Photoshop CS or Photoshop CS2 or 
Photoshop CS3 installed. The SSE Plug-in generates scripts com-
patible with the Scala InfoChannel™ Designer 1 and Scala 
InfoChannel Designer 3 and Scala 5 product line. 

23.2 Application Installation 
 
Before installing a registered version of the SSE Plug-in, use the 
standard Microsoft Windows procedure to uninstall any previous 
versions, including any demo versions you may have installed. 
 
To start the installation, double click on the sse_plugin_install.exe. 
The installation will attempt to find the Adobe Photoshop plug-in 
directory on your computer and if successful, will install the 
necessary files in to this directory (the specific directory selected 
will depend on the version of Adobe Photoshop you are using). 
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NOTE: If during the installation of your Adobe Photoshop application 
you selected a directory other than the default selection, you may 
manually point to your unique Adobe Photoshop plug-ins directory 
during the installation of the SSE Plug-in. 

The Scala Script Export Plug-in provides an easy and accurate 
method for users of Scala Designer, to use the powerful graphics 
features of Adobe Photoshop to create Scala compatible scripting 
clips. 

23.3 How the SSE Plug-in Works 
 
The SSE Plug-in works by examining the individual layers within an 
Adobe Photoshop document and generating Scala Script compatible 
objects. Upon execution, the plug-in: 

� Selects clips found within the Adobe Photoshop layer(s) and 
saves each as a new file. 
 

� Generates a "BACKGROUND" file. 
 

� Generates a Scala Script that incorporates the clips on a 
single Designer page. 
 

23.4 SSE Plug-in Tutorial 
 
Following picture illustrates an example image that was created in 
Adobe Photoshop: 
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While creating the image, it was recognized that the SSE Plug-in 
could create individual graphic clips of the work based on the 
contents of each layer. It is important to use a different layer for 
each element of the image that is intended to be used within the 
Designer application. 

To design a background for Scala, either: 

� Name the bottom most layer “Background” or 
“background” 
 
Or 
 

� Use true background layer for the bottom most layer 
 

Otherwise, the SSE Plug-in will automatically generate a plain 
background file. 
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Individual “clips” can be drawn on distinct layers to allow for 
controlled application of effects and to help with image 
organization. The ArsMedia SSE Plug-in captures the clips that are 
not 100% transparent from each of these layers and creates unique 
clip files that can then be used within a Scala Script. 

 

In this example, the intention was to have each individual clip and 
text “fly in” on the final Designer page as individual graphic clips. 
Therefore each element was drawn on its own Adobe Photoshop 
layer. These layers can have virtually any of Adobe Photoshop's 
effects applied to them - such as drop shadows, bevels, and 
gradient fills.  
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Text layers within Adobe Photoshop can also be preserved. Each 
text layer can be exported as either a graphic or a Designer text 
element by the Ars Media SSE Plug-in.  

TIP: To keep a text layer and a specific object element together, 
select both layers then use Adobe Photoshop's Group Into New 
Smart Object command in the Layer Palette. The SSE Plug-in will 
export the grouped elements as a single image file. 

23.4.1 Exporting the Final Image 
 
Once our image editing is complete, use the Scala Script Export 
command found in File>Automate menu. The Export Scala Script 
dialog is shown. Once a File name is entered, click the Save button.  

For this example, the script is saved as “objects.sca”  
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The SSE Plug-in displays a dialog that shows the progress of the 
export process. 

23.4.2 Opening Script in Scala 
 
To open the script, double click on the “objects.sca” file and it will 
be opened in Designer. It is then possible to see that each layer is 
exported as a separate clip, so additional modifications can be made 
to the Scala Script. 
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23.4.3 Understanding Exported File Structure 
 
By default, the SSE Plug-in exports a series of files to the directory 
specified within the Save as Scala Script dialog. In this example, a 
new folder “Project_01” was created and the File name provided 
was “Objects”. The SSE Plug-in generates a folder within the 
“Project_01” folder named “Objects” and then places the newly 
exported clip files within that folder. 
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In the example above, the clip files were created within the 
'Objects' folder: 

1. object_Background_1.jpg  
2. object_Rabbit_2.png  
3. object_RoadRunner_4.png  
4. object_Squirrel_3.png  
5. object_Title_5.png 

 
The first file generated is the background file and is used as the 
background for the newly created script. By default this image is 
saved as JPEG and is the same dimensions as the original Adobe 
Photoshop document. 

Files 2, 3, 4 represent the image clips in the Adobe Photoshop 
document, namely the rabbit, squirrel and roadrunner. By default, 
these images are saved as PNG with transparency preserved. 

The last file created is the Adobe Photoshop text layer. This was also 
saved as a PNG file with transparency preserved. Because the text 
was exported as a graphic, no further editing of the text is allowed 
within the Designer application. 
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During the export process a Scala Script file is created within the 
'Project_01’ directory. This Scala Script file in our example is named: 
'Objects.sca' 

The Scala Script file contains all the scripting instructions to 
reproduce the original Adobe Photoshop document as a Designer 
page. 

23.4.4 Creating Buttons 
 
The Scala Script Exporter Plug-in can automatically recognize Scala 
compatible Buttons created within Adobe Photoshop. 

Adobe Photoshop layers must use layer names with the following 
parameters: 

� BTN_name (normal button state) 
� BTH_name (highlighted button state) 
� BTS_name (selected button state) 

 
The layer prefixes (BTN_,BTH_,BTS_) are used to identify the unique 
button states that are used within Designer. The layers must also be 
in sequential order (BTN_ positioned above the BTH_ which in turn 
must be positioned above the BTS_ layer). 

If a two state button is desired then only use BTN_ and the BTS_ 
naming conventions. If a single state button is desired use only the 
BTN_ naming convention. 

For example, a three state button is created within Adobe 
Photoshop named EXAMPLE: 
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Note the layer order: BTN_ EXAMPLE, BTH_EXAMPLE, 
BTS_EXAMPLE. Each of these layers holds the image clip for the 
particular button state. 

Before exporting Scala Script, position the images one over the 
other, as shown in the example: 
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During the export process, the SSE plug-in will automatically 
generate clips for the button and create a Scala Script that contains 
the button on a Designer page. 

23.4.5 Creating Designer Text objects 
 
It is possible to export Photoshop text layers as Designer text 
objects. To accomplish this, the layer name must be prefixed with 
TXT_ (as shown in the following example): 



Designer5 
 

 
680 

 

 

NOTE: When exporting text layers; only font, font size and font 
colors are preserved. English text is only supported.  

23.5 EXPORT SCALA SCRIPT DIALOG 
 
The Export Scala Script dialog offers a variety of options for 
exporting: 
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23.6 FILE AND CLIP DIALOG OPTIONS 
 

 A  Location of the directory where the SSE Plug-in will save the 
exported files. 
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 B  Files listed are Scala Scripts that exist within the chosen 
directory. 

 C  File Name for the exported Scala Script. This name is also 
used as part of the file name for each file created as well as the 
Scala Script. 

 D  Background clip allows the user to select which file format to 

use for the Background Image. The default value is JPEG. 

The Other clips option allows the user to select which file format to 
use for the clips. By default, this value is PNG. 

For clips, the PNG file format will preserve transparency. Other 
formats use the current Adobe Photoshop background color for the 
background. It is possible to have Designer use this as the 
transparent color. However, this approach is cumbersome com-
pared to using the PNG choice. 

The SSE Plug-in also preserves any opacity settings within an Adobe 
Photoshop layer. This opacity is applied to each clip within Scala as 
the "Overall Opacity". Note that any opacity within an Adobe Pho-
toshop Alpha Channel will not be preserved during the export. 

Any layers that are marked as “hidden” within Adobe Photoshop 
will not be exported. 

 E  Scala Script saving options allows the user to select how the 
exported Scala Script and image clips will be saved within the 
selected directory. One of three options is available: 
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Create a new script: This setting does not allow an export operation 
to overwrite folders and clips that have the same name. Attempting 
to do so generates an error message. This is the default option. 

Append new page to existing script: Allows the user to append 
newly generated scripts to existing Scala Scripts. The newly ex-
ported script becomes an appended page to the existing script. A 
couple of conditions must be met for this to work properly 
however: 

� Both scripts must have the same dimensions. 
� Any events within the script may not have the same name 

as any of the Adobe Photoshop layers. 
 
Overwrite existing script: Allows the user to override the 
“overwrite” protection. Caution should be taken with this setting as 
this will replace all pre-existing scripts and clip files. 

23.7 LAYER EXPORTING OPTIONS  
 

 F  This option provides the user the ability to export Layer Sets 
as a single clip. By default, objects located on layers within a Layer 
set will be saved as individual clips when exported. If Export each 
Layer Set as single clip is selected, then all the objects within a Layer 
Set will be exported as a single clip. In other words, the Layer Set 
will first be flattened by SSE Plug-in, and then exported. 

Note: Adobe Photoshop CS2 has renamed the Layer Set feature to 
Layer Group. 
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 G  This option allows the user to use the Adobe Photoshop 
layer names as the names for the exported clip files. If meaningful 
names are used for the Adobe Photoshop layers, this can be helpful 
when editing the Scala Script generated by the SSE Plug-in.  
However, keep in mind these two important points: 

1. Adobe Photoshop allows the user to use any character in a 
layer's name. (Adobe Photoshop does have some 
restrictions, such as ?, /, \, etc.). 
 

2. Adobe Photoshop allows for two or more layers within one 
document to have the same name. 
 

In order to avoid any conflicts within the SSE Plug-in, the following 
conventions are followed: 

� Unique clip names are generated by the SSE Plug-in using 
the Adobe Photoshop file name as a prefix in the clip name 
and then adding the layer's position as a postfix to the clip 
name. 
 

� The SSE Plug-in checks layer names for restricted characters 
and replaces them with an underscore "_"character. 
 

� If available, the SSE Plug-in uses the Adobe Photoshop layer 
names as names for the exported clips. However, if multiple 
layer names are the same, the SSE Plug-in will create one 
unique clip containing all of the images within it. 
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23.8 ADVANCED SCALA SCRIPT OPTIONS 
 
 H  Clip directory: Allows the user to select a directory, other 
than the default, set by the SSE Plug-in. 

 I  Page Labels: Allows the user to set a specific label for the 

page that is created. 

 J  Duration (ms): Allows the user to set the page duration. The 
value is in milliseconds.  The default duration of “0” is converted to 
“Wait for mouse click”. 

 K  Use absolute path: Allows the user ensure that the file paths 
to the clips are saved in absolute paths instead of relative paths. 

 L  Defaults: Allows the user to reset all options to their default 
values. In order for this setting to take effect the user must shut 
down the SSE Plug-in and restart it. 

23.8.1 Automating the SSE Plug-in 
 
The SSE Plug-in may be used within an Adobe Photoshop action or 
in Adobe Photoshop batch mode. However, the following 
consideration should be kept in mind: 

If the SSE Plug-in is used within an action or in batch mode, Adobe 
Photoshop will append a numerical suffix to the Scala Script name 
(if the export uses a file name that already exists). For example: 
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If an Adobe Photoshop document named “Sample” was exported to 
a directory that contained an existing Scala Script called “Sample”, 
then the SSE Plug-in will rename the exported Scala Script as 
“Sample001”, “Sample002”, etc. This option ensures unique file 
names for Scala Scripts when the SSE-Plug-in is used. 

23.8.2 A Word about Exporting Effects 
 
Many of the various effects that can be applied to a clip within 
Adobe Photoshop, such as drop shadow, inner and outer glow, satin 
etc. are handled by the SSE Plug-in. However, keep in mind the 
following restrictions: 

If a particular effect is applied to a clip layer that changes only inner 
pixels of that layer, any blending mode can be used for these 
effects. For example, if Multiply or Screen Blending mode is used for 
a Gradient Overlay, Inner glow or Inner Shadow effect; the SSE Plug-
in would export a clip that would look identical in Designer as it 
would in Adobe Photoshop. This is because these particular effects 
only modify pixels in the clip that are within the clip boundaries. 

Some Adobe Photoshop effects create pixels outside of boundaries 
of the clip object currently drawn on a layer. Effects such as “Drop 
Shadow” or “Outer glow” are some examples of this. Using these 
types of effects, it is only possible to use the Adobe Photoshop 
“Normal Blending” mode. Designer only recognizes pixels created 
using “Normal Blending” mode, therefore the clip may look 
different in Designer than it does in Adobe Photoshop. 
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23.8.3 Limitations 
 
Some limitations exist within the SSE Plug-in due to the differences 
between Adobe Photoshop and Designer. 

Adobe Photoshop has many layer blending modes, such as multiply, 
overlay, hard, light, etc.  Currently Designer only supports “Normal 
Blending” mode. This does not mean that the other blending modes 
cannot be used when designing an image. It just means that you will 
have to convert layers with the other blending modes to “Normal 
Blending” mode to ensure that your clips maintain the same 
appearance in Designer as they do in Adobe Photoshop. 

Adobe Photoshop Layer Sets (Layer Groups in CS2) are supported 
with one exception: 

The first layer, (the one at the bottom of the layer stack) may NOT 
be a member of a Layer Set. 
 
The SSE Plug-in has an intentional resolution limitation of 3840 
pixels by 2160 pixels. However, if higher resolution images are 
needed, we offer a custom SSE Plug-in that does not have this 
limitation. Contact us via email at: support@arsmedia.tv to request 
it. 

23.8.4 Error Handling 
 
Rather than interrupting the export operation in the event of an 
error occurring, the SSE Plug-in generates an “Error.log” file within 
the clip folder directory. If an Error.log file is found after performing 
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an export, the user should examine the file. It is a plain text file and 
can be opened with any text editing application (such as Windows 
Notepad). The file’s contents will list any operations that failed to 
execute. If there is a fatal error (such as a lack of sufficient memory 
to perform the operations) the SSE Plug-in will abort and Adobe 
Photoshop will report an error. 

23.8.5 Support 
 
ARS Media provides free email support to registered users of any of 
our products. If you have any questions about any of our products, 
please contact us via email at: 

support@arsmedia.tv 

We endeavor to respond to all questions within 24 hours (1 working 
day).  Usually questions are handled much sooner. We don't use 
auto responders, so all questions and requests will be handled by 
our staff of professionals. 

We are always looking for ways to improve our products, so we 
encourage you to let us know what you think. 
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||||| 24  Keyboard and Mouse 
   Shortcuts 
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All tasks in Scala Designer 5 can be done using the mouse, the keyboard or 
a combination of the two. In most cases it is faster to use the mouse for 
example, to drag text to a new location on a page or rearrange the 
sequence of script pages in the Main view. In most instances, there are 
specific Context menus available when selecting an element or area on the  
screen and right-clicking with the mouse. 
 
In other situations, however, it may be more convenient to use the 
keyboard—for example, to access a panel while you are typing in text on 
the screen. There are various shortcuts that allow you to directly access 
options on another Design panel, so that you do not have to switch back 
and forth between Design panels as often.  

24.1   Designer versus Windows Shortcuts 
 
Many keyboard alternatives offered by Designer are similar or identical to 
those common in Windows applications. For example, Cut, Copy, and Paste 
are available through the standard Ctrl + X, Ctrl + C, and Ctrl + V 
combinations. Also, if the name on a button has an underlined letter, you 
can choose its action by holding down Alt and pressing the underlined 
letter. 
 
Many keys or key combinations, however, are specific to Designer and 
the way you work in the Designer environment. 
 
The following tables summarize the keyboard shortcuts in Designer . In 
some cases the function depends on the panel you are working in or the 
task you are doing; these are specified accordingly. 
 
In the tables, as in the rest of this manual, a plus (+) between the keys (for 
example Alt + Z) means to press and hold the first key as you press and 
release the second key. Don’t press the plus key. 
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||||| 25  Using Designer’s  
  Online Help 

  



Designer5 
 

 
701 

 

Designer 5 provides an online help system to assist you as you work. You 
can access online help by clicking on the Help pull-down menu and 
selecting Help, or by pressing F1.  
 

 
 
When you see the Help pointer, notice that as you move the pointer, 
different areas of the screen highlight. You can click on anything that 
highlights to get information on it. You can also use keyboard shortcuts to 
get help on the functions they activate. A Help window appears, containing 
text with a brief description of what you selected and how to use it. 
 
If there is more text than will fit in the Help window, click in the window, or 
press Enter or the spacebar to display more text. When you are finished 
reading the help text, click anywhere, or press Enter, the spacebar, or a 
keyboard shortcut and the Help window disappears. You can continue to 
click the Information button or press F1 to get information on additional 
items on the screen. 
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25.1 Tool Tips 
 
In addition to the descriptions available in the Help window, Designer 
provides “Tool Tips”. Certain controls in Designer, such as the Background 
column button and the Toolbar buttons, are marked only with symbols, and  
not with their names. To help you identify such buttons, Tool Tip labels are 
provided.  
 

 
 
Just move the mouse pointer over any button (including Transition icons) 
and after a moment a small Tool Tip-style reminder pops up next to the 
pointer with the button’s name or other identifying information. 
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||||| 26 Scala End User  
 License Agreement 
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This Software License Agreement (“Agreement”) is entered into between Scala, Inc. (which, for purposes of this Agreement, shall be deemed to 
include any wholly owned subsidiary of Scala, Inc.) (“Scala”), and the purchaser, licensee or user (“Licensee”) of Scala Software (as defined below). The 
terms of this Agreement also apply to any Scala Software Updates, and/or Software Maintenance (as each term is defined below) for the Scala 
software, unless other terms accompany those items. If so, those terms apply. 
 
READ THIS LICENSE CAREFULLY. BY OPENING THE SCALA SOFTWARE PRODUCT PACKAGING 
AND/OR USING THE SCALA SOFTWARE, LICENSEE AGREES TO BE BOUND BY THE TERMS AND 
CONDITIONS OF THIS AGREEMENT. 
 
If Licensee does not agree to the terms of this Agreement prior to opening the Scala Software packaging or installing the Scala Software, Licensee shall 
cease using (or refrain from commencing use of) the Scala Software, and shall, as applicable, uninstall and/or permanently delete the Scala 
Software, Documentation (and any copies thereof) from the computers or computer system(s) on which the Scala Software has been loaded or 
stored, and return the Scala Software and Documentation, all media on which it is stored, all product packaging, and proof of payment to the Scala 
Partner (as defined below) pursuant to such Scala Partner’s return policy. If Licensee does not agree to the terms of this Agreement, and has acquired 
the Scala Software as part of a preconfigured computer system on which the Scala Software has been installed, Licensee must either promptly cease 
using the Scala Software, uninstall and/or permanently delete the Scala Software and Documentation (and any copies thereof) from the computer 
system(s) on which the Scala Software has been preloaded, or return the pre-configured system pursuant to the system vendor’s return policy. 
 
1. DEFINITIONS. 
1.1. “Commencement Date” means the ship date of the Scala Software from Scala or a Scala 
Partner to the Licensee. 
1.2. “Documentation” means the user guides, tutorials, printed instructions, reference 
manuals, and other explanatory materials developed by Scala that accompany or are 
stored on or in the Scala Software for use in connection with the Scala Software. 
1.3. “End User” means, as applicable, Licensee or any person or entity (including, for the 
avoidance of doubt, any employee or agent of Licensee) that uses the Scala Software. 
1.4. “Object Code” means the form of Scala Software wherein computer programs are 
assembled or compiled in magnetic or electronic binary form on software media, which 
are readable and usable by machines, but not generally readable by humans without 
reverse-assembly, reverse-compiling, or reverse-engineering. 
1.5. “Software Maintenance” means the provision of Software Updates. 
1.6. “Scala Partner” means any Scala Certified Partner, reseller or distributor of Scala that sold 
or licensed the Scala Software to Licensee. 
1.7. “Scala Software” means, as applicable, the Object Code form of InfoChannel Starter Kit, 
InfoChannel Designer, InfoChannel Player, InfoChannel Content Manager, InfoChannel 
Broadcast Server, or such other Scala software products as may be identified in a 
purchase order from Scala or a Scala Partner, and shall be deemed to include the 
Documentation for such Scala Software, the license keys, clip art, fonts and multimedia 
files included in such Scala Software, their related software options, software 
extensions, software upgrades and Software Updates, and Third Party Software 
integrated into such identified products. 
1.8. “Software Updates” means bug fixes, documentation improvements and feature 
additions, including all major (i.e., numbered) and minor (i.e., point) releases, when and 
if made available by Scala. 
1.9. “Third Party Software” means software, referred to as redistributable code that is 
licensed to Scala by third party licensors for redistribution with the Scala Software. The 
redistributable code is the property of Scala’s licensors, and protected under United 
States and international copyright, trade secret or other proprietary rights laws, and 
international treaties. 
 
2. GRANT OF LICENSE RIGHTS. 
2.1 License. Subject to the terms, restrictions and limitations set forth herein, Scala hereby 
grants to Licensee a non-exclusive, non-transferable, non-sublicensable license to 
use (and to permit its End Users to use) the Object Code version of the Scala Software, 
including any Third Party Software included therein or therewith, along with any 
graphical, textual, pictorial, audio or visual works or materials incorporated into or 
delivered with the Scala Software, including the Documentation. 
2.2 Term. This Agreement is effective as of the date at which Licensee accepts the license 
terms as set forth above, and will continue unless terminated as provided in Sections 
7.3 or 8. 
2.3. Scope of License and Use 
A. Internal Use. Licensee may use the Scala Software and Documentation only 
for its own internal use and only on one, single-user computer. Licensee may 
internally transfer the Scala Software to a different, single-user computer (a 
“Transferred Installation”), provided that the Scala Software and any copies 
thereof are permanently uninstalled and/or deleted from the computer from 
which the Scala Software is transferred. 
B. Limitations. In connection with the development of content files using the 
Scala Software, Licensee may publish files for use or viewing via web page or 
other file protocol. Licensee expressly acknowledges and agrees that a separate, 
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paid Scala Player end user license is required to display, perform or otherwise 
deliver content files created using Scala Software. Licensee shall not, directly or 
indirectly, distribute or cause to be distributed Scala Software content files in a 
manner calculated to circumvent the license limitation set forth in this Section 
2.3(B). 
C. Copies. Licensee may make one (1) copy of the Scala Software and one (1) copy 
of the related Documentation for archival or back-up purposes, only. 
D. Third Party Software. The license granted hereunder includes the right 
of Licensee to use the Third Party Software in Object Code form, solely in 
connection with the authorized operation and use of the Scala Software in 
conformance with the terms and conditions of this Agreement. For the avoidance 
of doubt, Licensee may not decouple, disassemble or otherwise separate the Third 
Party Software from the Scala Software or use the Third Party Software except 
in connection with the use and operation of the Scala Software as permitted 
hereunder. 
E. Restrictions. The Scala Software is licensed, not sold. This Agreement only gives 
you some rights to use the Scala Software. Scala reserves all other rights. Unless 
and solely to the extent otherwise permitted under applicable law, you may use 
the Scala Software only as expressly permitted in this Agreement. Except as 
expressly permitted under applicable law, or as otherwise agreed to in writing 
by Scala, Licensee shall not, and shall not permit any End User to: (i) work around 
any technical limitations in the Scala Software; (ii) publish the Scala Software 
for others to copy; (iii) make more copies of the Scala Software than authorized 
under this Agreement ; (iv) sell, lease, rent, redistribute, assign, sublicense, or 
transfer the Scala Software and/or Third Party Software; (v) reproduce, decompile, 
reverse engineer or disassemble the Scala Software and/or Third Party Software; 
(vi) offer the use of the Scala Software to third parties as an application service 
provider, service bureau or remote-hosted service; or (vii) deliver, export, transfer 
or otherwise distribute the Scala Software acquired hereunder to, or use the 
Scala Software acquired hereunder in, a country other than the country in which 
the Scala Software was purchased (including, for the avoidance of doubt, in 
connection with a Transferred Installation). 
 
3. LICENSE AND OTHER FEES. Licensee agrees to be bound by and pay the license fee(s) set forth 
in the Scala Software price list in effect as of the date of purchase. License fees for Scala Software and 
maintenance fees for Software Maintenance may be updated and changed at any time. 
3.1 Software Maintenance Coverage. Where Software Maintenance is offered upon 
separate purchase terms from the Scala Software, the Scala Software products are sold 
with one (1) year (the “Initial Maintenance Term”) of Software Maintenance coverage 
included in the price of the product. During the Initial Maintenance Term, Licensee 
shall be entitled to Software Updates if and when made available by Scala. All use of 
Scala Software provided pursuant to Software Maintenance coverage shall be subject 
to the terms of this Agreement. Licensee may elect to continue Software Maintenance 
beyond the Initial Maintenance Term, subject to availability, upon payment to Scala (or, 
as applicable, a Scala Partner) of the Scala annual maintenance fee in effect at the time of 
renewal. 
3.2 Taxes and Duties. Prices to Licensee do not include taxes, duties, tariffs, handling fees, 
or other such assessments of any nature. Whenever imposed, such assessments are 
payable by Licensee. Income or other taxes that are required to be paid or withheld 
by Licensee or Scala under the laws of jurisdictions other than the United States, in 
connection with the license and other fees paid by Licensee hereunder, are the sole 
obligation of Licensee and shall be exclusive of the license and other fees paid by 
Licensee. 
3.3 Other Services. Licensee acknowledges that any additional services offered by Scala, 
such as installation, customization or professional services, are not provided under 
this Agreement, and any such services to be provided by Scala (or, as applicable, a 
Scala Partner) shall be subject to the mutual agreement of the parties, the terms and 
conditions for which shall be set forth in a separate agreement. 
 
4. CONFIDENTIAL INFORMATION, TITLE AND COPYRIGHTS. 
4.1 Licensee acknowledges that the Scala Software, Documentation, Software Updates, 
enhancements, modifications, additions, new releases of or to the Scala Software 
contain confidential information of, are trade secrets of, and are proprietary to Scala 
and its licensors and that title to such materials is and shall remain in Scala and its 
licensors, as the case may be. Licensee shall maintain in strict confidence the Scala 
confidential information, but, at a minimum, to take those precautions that it utilizes 
to protect its own confidential information. Licensee shall have no obligation of 
confidentiality with respect to information that (i) at the time of disclosure is in or 
becomes available to the public through no breach of this Agreement on the part of 
the Licensee; (ii) was lawfully in Licensee’s possession prior to receipt from Scala; (iii) 
is received independently from a third party free to lawfully disclose such confidential 
information to Licensee and who does not owe an obligation to Scala with respect to 
confidential information; (iv) Licensee independently develops without the benefit of 
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any confidential information disclosed hereunder or (v) is required to be disclosed by a 
government agency; provided that the Licensee will use best efforts to minimize such 
disclosure and will notify Scala promptly of any such demand, order or judgment in 
order to permit Scala to seek an appropriate protective order. 
4.2 All applicable rights to patents, copyrights, trademarks and trade secrets in the Scala 
Software and other proprietary materials are and shall remain in Scala and its licensors. 
Licensee shall not assert any right, title or interest in the Scala Software or other 
materials provided to Licensee under this Agreement, except for the limited license 
rights expressly granted to Licensee hereunder. 
4.3 Licensee shall not obscure or remove any copyright or other proprietary notice or 
legend contained on or included in the Scala Software and shall reproduce all such 
information on all copies made hereunder. Licensee shall not, directly or indirectly, 
disclose or distribute any technical information of Scala provided with or in the Scala 
Software without the prior written consent of Scala, which consent may be withheld at 
Scala’s sole discretion. 
 
5. LIMITED WARRANTIES. 
5.1 Media and Documentation. Scala warrants that if the media or Documentation is in 
a damaged or physically defective condition at the time the Scala Software is delivered 
to Licensee, and if such media or Documentation is returned to Scala within thirty 
(30) days of the effective date of this Agreement, Scala will provide Licensee with a 
replacement at no charge. 
5.2 Software Limited Warranty and Remedy. 
A. Provided that Licensee is not in breach of any of its obligations under this 
Agreement, and in addition to the warranty set forth in Section 5.1, Scala 
warrants for a period of thirty (30) days from the Commencement Date 
(“Warranty Period”), that the software will substantially conform to the 
Documentation provided by Scala with the Scala Software. Licensee’s sole remedy 
and Scala’s and Scala Partner’s sole obligation under this Agreement for breach of 
this warranty is, at Scala’s sole option, (i) the remedy of the nonconformity or (ii) 
the authorization of a refund for the price paid for the media and or Scala Software 
by Scala or the Scala Partner from which the Scala Software was originally 
obtained. Any request for the above remedies must be made within the Warranty 
Period and proof of purchase (i.e., copy of the invoice or receipt) is required to 
be presented to Scala. In the event of a refund, this Agreement will immediately 
terminate without further notice, and Licensee will have no further rights or 
license to use Scala Software or Documentation. 
B. Any replacement software or media will be warranted for the remainder of the 
original Warranty Period or for an additional thirty (30) days whichever is longer. 
C. This limited warranty is void if nonconformance of the Scala Software results from 
or is related to the (i) improper installation or operation of the Scala Software 
by or on behalf of the Licensee, (ii) failure of Licensee’s hardware or non-Scala 
software, (iii) incompatibility of such hardware and non-Scala software systems 
with Scala Software, (iv) alteration, modification or unauthorized integration of 
Scala Software by or on behalf of Licensee, or (v) accident, abuse or misapplication 
of Scala Software. 
D. If the Scala Software is provided as a trial or evaluation version, the grant of the 
license to use the Software shall be on an “AS IS” basis and subject to the express 
limitations of the trial. Unless Licensee shall have entered into a separate written 
license agreement prior to the expiration or termination of the trial period, 
Licensee agrees to cease all use of the Scala Software provided on a trial or 
evaluation basis and to return such Scala Software, or to return any license keys 
and destroy or permanently delete any and all copies of such Scala Software. 
5.3 Disclaimer of Warranties. SCALA AND ITS LICENSORS MAKE NO WARRANTY, 
REPRESENTATION OR PROMISE EXCEPT AS SPECIFICALLY SET FORTH IN THIS AGREEMENT. 
TO THE FULLEST EXTENT PERMITTED BY LAW, SCALA AND ITS LICENSORS DISCLAIM AND 
EXCLUDE ANY AND ALL OTHER WARRANTIES, INCLUDING WITHOUT LIMITATION ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR 
RESULTS. SCALA AND ITS LICENSORS DO NOT WARRANT THAT THE SCALA SOFTWARE 
OR DOCUMENTATION WILL SATISFY LICENSEE’S REQUIREMENTS; THAT THE SCALA 
SOFTWARE AND DOCUMENTATION ARE WITHOUT DEFECT OR ERROR; OR THAT THE 
OPERATION OF THE SCALA SOFTWARE WILL BE UNINTERRUPTED. TO THE MAXIMUM 
EXTENT PERMITTED UNDER THE LAW, THE UN CONVENTION FOR THE SALE OF GOODS 
AND THE UNIFORM COMMERCIAL CODE DO NOT APPLY TO THIS LICENSE AGREEMENT. 
 
6. LIMITATION OF LIABILITY. 
6.1 IN NO EVENT SHALL SCALA OR ITS LICENSORS BE LIABLE FOR ANY SPECIAL, 
INCIDENTAL, INDIRECT, PUNITIVE OR CONSEQUENTIAL DAMAGES WHATSOEVER 
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, 
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER 
PECUNIARY LOSS). REGARDLESS OF WHETHER SCALA HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY LAW, 
SCALA’S AGGREGATE LIABILITY ARISING FROM OR RELATING TO THIS LICENSE 
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OR THE SCALA SOFTWARE AND DOCUMENTATION IS LIMITED TO THE AMOUNT 
ACTUALLY PAID FOR THE LICENSE. SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO 
THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY. 
 
7. INDEMNIFICATION. 
7.1 Scala’s Obligation. Subject to the Licensee indemnification set forth at Section 7.2 
and the restrictions and limitations set forth herein, Scala shall indemnify and hold 
harmless Licensee, its officers, directors and employees from and against any costs or 
demands awarded against Licensee by a court of competent jurisdiction pursuant to 
a final judgment as a result of a claim or action by a third party against Licensee that 
the Scala Software or Documentation infringes a registered copyright, trademark, valid 
patent or other intellectual property right of a third party in North America, European 
Economic Area or Japan. The foregoing indemnity is conditioned on Licensee (i) 
promptly notifying Scala of such claim; (ii) permitting Scala to control the response 
thereto and the defense thereof, including any agreement relating to the settlement 
thereof, and (iii) assisting and cooperating with Scala, at Scala’s expense, in the defense 
or settlement thereof. Licensee may participate, at its own expense, in such defense 
directly or through counsel of its choice on a monitoring, non-controlling basis. Scala 
shall obtain Licensee’s prior written consent to any compromise or settlement of any 
claim which would require an admission of liability on the part of Licensee or which 
would subject Licensee to any injunction or other equitable relief. Notwithstanding the 
foregoing, in no event shall Scala or its licensors be liable to indemnify, defend, settle 
or hold Licensee harmless from and against any or all claims which allege infringement 
of intellectual property that reads upon or is infringed by a generally recognized audio, 
video, technology or patent standard, including without limitation MPEG-1, MPEG-2, 
MPEG-4, JPEG, DV, Flash, VC-1, AAC, AC-3, DVCPRO or AVS (each including all profiles, 
options, parts or levels); 
7.2 Scala shall have no obligation under Section 7.1, and otherwise will have no liability for, 
any claim of infringement caused or alleged to be caused by: (i) the use or combination 
of the Scala Software with non-Scala software, hardware, data, or content, including but 
not limited to software, hardware, data, or content of Licensee; (ii) infringement that 
would have been avoided without the use or combination of the Scala Software with 
other non-Scala software, hardware, content, or data; (iii) the presence of any alteration 
or modification of the Scala Software by Licensee or any third party acting on Licensee’s 
behalf; or (iv) the Licensee’s continuing the allegedly infringing activity after being 
notified thereof or after being informed and provided with modifications that would 
have avoided the alleged infringement. 
7.3 In the event that a claim of infringement of a valid North American, European Economic 
Area or Japanese software patent or copyright is made against Scala or Licensee or if 
Scala reasonably believes that such a claim will be made, Scala, at its option and in lieu 
of indemnification, may (a) procure for Licensee the right to use the Scala Software 
without patent or copyright infringement; (b) modify the Scala Software to make it noninfringing; 
(c) replace the Scala Software with substantially equivalent software that is 
non-infringing; or (d) direct Licensee to cease use of the Scala Software, and refund to 
Licensee a percentage of the aggregate fees received for such Scala Software that are the 
subject of such a claim, based on a five (5) year straight line depreciation 
7.4 The foregoing Sections 7.1-7.3 set forth the exclusive remedy and entire liability 
and obligation of Scala with respect to third party claims against Licensee alleging 
intellectual property infringement or misappropriation. 
7.5 Licensee Obligation. Except for the infringement claims set forth in Section 7.1, 
Licensee shall indemnify, defend and hold Scala, its directors, officers, agents and 
employees harmless from any claims, demands, or causes of action whatsoever by 
a third party against Scala arising as a result of Licensee’s use or operation of the 
Scala Software. For the avoidance of doubt, and without limiting the scope of the 
immediately preceding sentence, Licensee shall indemnify, defend and hold Scala, its 
directors, officers, agents and employees harmless from any third party claims, demands, 
or causes of action whatsoever arising from or related to the display, broadcast, 
reproduction, performance or other use or distribution of audio, visual, graphical and 
textual information developed by or on behalf of Licensee and not included in the Scala 
Software. 
 
8. TERMINATION. 
8.1 By Licensee. Licensee may terminate this Agreement at any time without notice to 
Scala. The license fee is not refundable and Scala will have no obligation to refund any 
amounts paid by Licensee under this Agreement upon its termination (except for any 
right of refund as set forth in Sections 5 and 7.3). 
8.2 Scala. Scala may terminate this Agreement and all licenses granted hereunder upon 
thirty (30) days prior written notice if Licensee fails to comply with any of the terms 
and conditions of this Agreement or any Schedule to this Agreement, and such 
noncompliance is not cured within such thirty (30) day period. 
8.3 Return of Software. Upon any termination of this Agreement, Licensee must cease all 
use of the Scala Software, and return to Scala all copies of the Scala Software, including 
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license keys, together with the Documentation, or shall return all license keys and certify 
to Scala’s reasonable satisfaction the destruction or permanent deletion of all copies of 
the Scala Software and Documentation from its computer systems. 
 
9. GENERAL. 
9.1 Audit Rights. Scala shall have the right reasonably to audit the deployment and use of 
the Scala Software by Licensee, including without limitation Licensee’s conformance with 
the provisions of Section 3 herein. Licensee agrees to cooperate with Scala’s reasonable 
request for access to Licensee’s computer systems to ensure Licensee’s adherence with 
the license terms hereunder. 
9.2 Purchase in Canada. If Licensee acquired this software in Canada, Licensee agrees to 
the following: The parties hereto have expressly required that the present Agreement 
and any exhibits hereto be drawn up in the English language. / Les parties aux présentes 
ont expressément exigé que la présente convention et ses Annexes soient rédigées en 
langue anglaise. 
9.3 Notices. Any notice required or permitted to be given by Licensee hereunder shall 
be in writing and shall be deemed to have been duly given (i) upon hand delivery, 
(ii) on the third day following delivery to the postal service as certified mail, return 
receipt requested and postage prepaid, or (iii) on the first day following delivery 
to a recognized overnight courier service, fee prepaid and return receipt or other 
confirmation of delivery requested. Any such notice shall be delivered or sent to Scala 
at the address as set forth below, or to such other address as Scala may designate from 
time to time. Scala, Inc., 350 Eagleview Boulevard, Suite 150, Exton, PA 19341, 
USA. 
NOTICE ABOUT THE MPEG-2 VISUAL STANDARD. This software may include MPEG-2 
visual decoding technology. MPEG LA, L.L.C. requires this notice: USE OF THIS PRODUCT 
IN ANY MANNER THAT COMPLIES WITH THE MPEG 2 VISUAL STANDARD IS PROHIBITED, 
EXCEPT FOR USE DIRECTLY RELATED TO (A) DATA OR INFORMATION (i) GENERATED 
BY AND OBTAINED WITHOUT CHARGE FROM A CONSUMER NOT THEREBY ENGAGED 
IN A BUSINESS ENTERPRISE, AND (ii) FOR PERSONAL USE ONLY; AND (B) OTHER USES 
SPECIFICALLY AND SEPARATELY LICENSED BY MPEG LA, L.L.C. If you have questions 
about the MPEG-2 visual standard, please contact MPEG LA, L.L.C., 250 Steele Street, 
Suite 300, Denver, Colorado 80206; http://www.mpegla.com. 
NOTICE ABOUT THE AVC VISUAL STANDARD. This software may include AVC visual 
decoding technology. MPEG LA, L.L.C. requires this notice: THIS PRODUCT IS 
LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL AND 
NONCOMMERCIAL USE OF A CONSUMER TO (i) ENCODE VIDEO IN COMPLIANCE 
WITH THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS 
ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL 
ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE 
AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP:// 
WWW.MPEGLA.COM 
9.4 Governing Law. 
A. United States Sales. If you acquired the Scala Software in the United States, 
Pennsylvania state law governs the interpretation of this agreement and applies 
to claims for breach of it, regardless of conflict of laws principles. 
B. Sales Outside the United States. If you acquired the Scala Software in any other 
country outside the United States, the laws of the country of the wholly-owned 
Scala subsidiary that sold the Scala Software to you applies, regardless of such 
country’s conflicts of law provisions. 
9.5 Legal Effect. This Agreement describes certain legal rights. You may have other rights 
under the laws of your state or country. You may also have rights with respect to the 
party from whom you acquired the Scala Software. This Agreement does not change 
your rights under the laws of your state or country if the laws of your state or country 
do not permit it to do so. 
9.6 U.S. Government Restricted Rights Legend. The Scala Software, hardware, and 
Documentation provided under this Agreement bear restricted rights. Use, duplication, 
or disclosure by the U.S. Government is subject restrictions as set forth in subparagraph 
(c)(1)(ii) of the rights in technical data and computer software clause at DFARS 252.227- 
7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software Restricted 
Rights clause at 48 CFR 52.277-19, as applicable. Scala, Inc., 350 Eagleview Boulevard, 
Suite 150; Exton, PA 19341 USA. 
9.7 Assignment. Neither party may assign any rights, duties, obligations or privileges under 
this Agreement without the prior written consent of the other party. A change of control 
or ownership shall not be deemed to be an assignment under this Section so long as 
the new owner has expressly assumed in writing all of the duties and obligations of the 
assignor and further provided, that Licensee shall remain liable and responsible to Scala 
(and its licensors) for the performance and observance of all such duties and obligations. 
9.8 Severability. Should any part or provision of this Agreement be held unenforceable 
or in conflict with the law of any jurisdiction, the validity of the remaining parts or 
provisions shall not be affected by such holding. 
9.9 Limitation on Effect of Waiver. Failure on the part of Scala to exercise, or Scala’s delay 
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in exercising, any of Scala’s rights hereunder shall not be construed as a waiver or waiver 
of other breaches of this Agreement. Any single or partial exercise by a party of any right 
shall not preclude any other or future exercise thereof or the exercise of any other right 
in the Agreement. 
9.10 Entire Agreement. This Agreement contains the entire understanding of the parties 
with respect to the transactions contemplated and supersedes any prior agreements 
or understandings among the parties with respect to the subject matter hereof. This 
Agreement may be amended only by a writing that refers to this Agreement and is 
signed by both parties. 
9.11 Export Law Assurances. Licensee acknowledges that the Scala Software included 
herewith is subject to restrictions and controls imposed under the U.S. Export 
Administration Act and Canadian Exportation Laws. Licensee must comply with all 
domestic and international export laws and regulations that apply to the software. 
These laws include restrictions on destinations, end users and end use. Licensee hereby 
expressly agrees to defend, hold harmless and indemnify Scala, its directors, officers, and 
employees, from any claim, suit or dispute alleging that Licensee has exported the Scala 
Software in violation of any domestic or international export laws. 
9.12 Construction. The headings in this Agreement are for convenience of the parties only. 
They do not constitute a portion of this Agreement and shall not be used in interpreting 
the constriction of this Agreement. 
9.13 Third Party Beneficiary. Licensee hereby agrees that the licensors of Third Party 
Software shall be considered third party beneficiaries of this Agreement and shall be 
entitled to bring a direct action against Licensee in the event of breach of any applicable 
provisions of this Agreement, pursuant to the terms and conditions of this Agreement. 
9.14 Force Majeure. Neither party shall be in default if failure to perform any obligation 
hereunder is caused solely by unforeseen supervening conditions beyond that party’s 
reasonable control, which could not have been prevented by the non-performing 
party’s reasonable precautions, commercially accepted processes or substitute services, 
including acts of God, civil disturbances, strikes and labor disputes. 
9.15 Negation of Agency and Similar Relationships. Nothing contained in this Agreement 
shall be deemed to create an agency, joint venture or partnership relationship.
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Clip Transparency, 273 
Cloned on Two screens, 511 
Close button, 65, 68, 89, 219 
Close Button, 65 
Closing a script, 118 
Collect Files, 71, 123, 506 
color palette, 186, 307 
Color processing, 391 
color scheme, 399, 509, 514, 515 

Column Alignment, 500 
Combination Icon, 67 
Combining entries, 464 
compass, 210, 366, 367, 370, 615 
Complex    Scripts, 472 
Condition branches, 431 
Conditional loops, 449 
Configuring the Spell checker, 213 
Connection Type, 481, 483, 485 
Content Manager, 71, 72, 121, 228, 

294, 456, 464, 477, 479, 480, 481, 
590, 591, 608, 621, 655, 656, 705 

Context Menu, 69, 160 
Context Menus, 98, 176, 205, 336 
Contrast, 393, 395, 396, 397, 398, 400 
Copy, 80, 85, 86, 98, 108, 109, 110, 

161, 163, 164, 177, 194, 205, 256, 
325, 337, 471, 572, 691 

Copying pages, 108 
CORIOgen EX Module, 654, 655, 

656, 657 
Correcting flawed images, 396 
Correcting mistakes, 199 
Crawl Speed/Duration, 208 
crawl window, 209, 212, 213, 224 
Creating a color, 384 
Creating a New Script, 78 
Creating guide lines, 180 
crop position, 144, 145 
crop settings, 144, 269 
Cropping, 144, 146, 147, 269, 271, 

272, 293 
Cued Expression, 208, 209, 221, 224 
cued update, 222 
Custom Full Screen Playback, 512 
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Custom Image Size, 139, 142, 143, 144, 
147, 148 

Customizing Columns, 92, 125 
Cut, 86, 91, 98, 109, 110, 161, 163, 

164, 177, 194, 205, 325, 337, 349, 
351, 361, 369, 370, 374, 399, 483, 
572, 691 

Cutting and deleting pages, 109 

D 
dashed rectangular, 192 
Delete, 98, 109, 115, 166, 177, 182, 

194, 199, 200, 204, 216, 325, 337, 
371, 384, 523, 586 

Deleting, 110, 371, 384 
Deleting colors, 384 
Design Animclip, 161, 265, 390 
Design Background panel, 95, 99, 

104, 131, 135, 136, 139, 155, 388, 
392, 409, 411, 414 

Design Clip, 104, 161, 191, 260, 263, 
293, 317, 377, 381, 390, 392 

Design Movieclip, 161, 265, 381, 390 
Design panel, 159, 160, 161, 163, 

167, 170, 171, 173, 176, 215, 218, 
233, 254, 264, 265, 285, 294, 324, 
368, 691 

Design Panel, 160, 173, 176, 177, 215, 
263, 337 

Design Text, 99, 100, 104, 135, 137, 
161, 189, 190, 191, 208, 216, 218, 
231, 234, 235, 237, 241, 244, 251, 
253, 264, 298, 319, 326, 543, 575, 
576, 578 

Designer resources on the web, 41 
Designer Tools, 118 
dictionary, 214, 216, 217, 218, 522, 

523 
digital cameras, 130 
Direction, 210, 365, 366, 367, 369 
Displaying variables, 219, 220, 254 
Dissolve, 370, 374 
Drag a file icon, 101 
drag and drop, 98, 101, 172 
Draw Objects, 252, 258, 285 
Drawing boxes, 286 
Drawing options, 289 
Drawing ovals, 286 
Duration, 92, 208, 341, 343, 344, 345, 

347, 348, 350, 351, 353, 354, 361, 
365, 368, 372, 412, 419 

Duration setting, 92, 345, 347, 412 

E 
Editing a color, 385 
Editing buttons, 572 
Editing in a group, 112 
Editing Selected Text, 204 
Effect, 172, 291, 294, 297, 299, 302, 

305, 309, 565, 709 
Element, 161, 166, 169, 172, 176, 

177, 179, 183, 185, 203, 269, 271, 
279, 280, 301, 312, 313, 316, 321, 
324, 325, 328, 331, 334, 335, 337, 
341, 353, 358, 359, 363, 364, 368, 
372, 388, 442, 541, 564, 565, 576 

Element Levels, 316, 331 
Element Position, 203, 312 
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Element Size, 269, 271, 279, 280, 313, 
576 

Element Transitions, 359, 363 
Elements, 72, 153, 161, 168, 169, 

176, 177, 264, 265, 327, 328, 333, 
337, 343, 344, 353, 371, 372 

End User License Agreement, 44 
enlarging backgrounds, 139 
Enlarging the Designer Window, 96 
event, 75, 77, 80, 81, 85, 87, 91, 92, 

94, 99, 100, 101, 117, 209, 221, 
224, 254, 255, 266, 321, 324, 326, 
327, 329, 330, 331, 333, 335, 336, 
339, 341, 342, 343, 344, 345, 346, 
347, 348, 349, 351, 353, 354, 359, 
365, 371, 372, 374, 377, 405, 415, 
416, 417, 418, 419, 420, 421, 
422, 423, 424, 429, 430, 431, 432, 
433, 438, 440, 443, 444, 445, 447, 
448, 449, 450, 451, 454, 456, 457, 
458, 459, 461, 462, 463, 464, 465, 
466, 467, 468, 469, 470, 471, 473, 
474, 486, 518, 519, 520, 541, 546, 
554, 555, 556, 557, 562, 563, 570, 
573, 577, 584, 585, 597, 600, 601, 
627, 628, 631, 632, 634, 635, 636, 
637, 638, 639, 640, 641, 643, 648, 
649, 651, 652, 659, 660, 663, 665, 
666, 687, 707, 708, 710 

Event, 100, 341, 405, 431, 432, 450, 
468, 469, 471, 545, 546, 548, 555, 
556, 557, 572, 580 

Exiting a sub-script, 456 
Export Functions, 185 
Exporting a Background, 152 

Exporting text, 186, 206 
Exposure, 397 
Expression, 208, 209, 221, 222, 429, 

431, 443, 446 
Expressions, 433, 434, 436 

F 
Factors Affecting Scheduling, 461 
Fade, 357, 375, 417, 418, 419, 421, 

422 
Field Appearance, 577 
File, 71, 79, 99, 100, 101, 105, 109, 

117, 118, 123, 132, 133, 134, 136, 
137, 143, 152, 154, 162, 165, 185, 
206, 208, 209, 220, 255, 260, 261, 
293, 327, 387, 388, 399, 409, 410, 
417, 425, 478, 485, 487, 488, 494, 
506, 516, 528, 547, 563, 564, 565, 
568, 573, 579, 584 

Filled objects, 290 
Flash, 129, 130, 259, 268, 370, 374, 

405, 406, 408, 708 
Flashclip, 259, 261, 293, 405, 408 
Flashclips, 292, 293, 405 
Flip options, 151, 152, 281, 367, 369, 

370 
Flipping the background, 151 
Fly-on, 357, 375 
Focus, 194, 232, 265, 309, 310 
Frames, 267, 410, 411, 414, 501, 502 
full screen mode, 69, 513 
full screen playback, 511, 512 
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G 
Gamma, 393, 396, 397 
Gap, 209, 210, 212, 223, 227 
Getting Started, 59 
GIF, 129, 259, 273, 282, 382, 405 
Global, 72, 213, 317, 566 
Glossary of Terms, 60, 76, 129, 160, 

190, 231, 259, 297, 321, 341, 357, 
381, 405, 429, 477, 509, 542 

graphic handle, 179, 263, 272 
Grid Editor, 178 
Grid options, 178 
Grid Size, 179 
Group, 76, 98, 111, 442, 446, 448, 

502, 584 
Grouping pages, 111, 442 
Guides, 41, 180, 182, 183 

H 
Hide/Unhide, 160, 168, 177 
Hiding the Design panels, 173 
horizontal shadow, 300 
Horizontal Text Alignment, 212, 251, 

253, 577 
HSV, 275, 381, 385 
HTML Slides, 488 
Hue, 381, 385, 392, 393, 394, 398, 

399, 400 
HumanTouch, 63 

I 
Ideographs, 319 

image background, 134, 136, 140, 
152, 389, 410 

image processing, 152, 284, 391, 
396 

Image Processing, 278 
Importing text, 206 
In and Out Transitions, 335 
Include Fonts, 482 
Include Transitions, 483 
Independent elements, 328 
Input, 93, 101, 346, 348, 423, 542, 

563, 581, 582, 583, 584, 585, 586 
install, 42 
Interrupt scheduling, 457, 459, 469, 

472 
Interrupt Scheduling, 460 
interrupt-scheduled event, 470 
interrupt-scheduled page, 460, 461, 

470, 471, 472 
Invisible buttons, 568 
italic, 226, 227, 228, 231, 233, 234, 

243, 297 

K 
Kerning, 194, 231, 238, 240 
kerning options, 240 
Keyboard and Mouse    Shortcuts, 

690 
Keying, 273 

L 
Launch Module, 520, 521 
Layout panel, 497 
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Leading, 231, 241 
Level, 316, 321, 326, 331, 334, 335, 

432, 450, 546, 556, 580, 664, 665 
licensing requirements, 482 
Line breaks, 211 
Line Spacing, 194, 199, 201, 241 
Line Thickness, 288, 290, 291 
Lines and arrows, 288 
List icon, 86, 322 
List Icon, 67 
List mode, 67, 75, 76, 85, 87, 102, 

107, 166, 190, 326, 333, 335 
List Panel, 321, 324, 326 
Local or Shared Folder, 479, 485 
Locked, 195, 318 
Loops, 209, 212, 225, 266, 268, 354, 

412, 413, 417, 418, 420 
luminance controls, 395 

M 
Main view, 62, 63, 64, 65, 75, 76, 77, 

79, 80, 81, 85, 87, 88, 89, 90, 91, 
92, 94, 95, 98, 99, 100, 101, 102, 
103, 104, 105, 106, 108, 110, 111, 
112, 113, 117, 118, 119, 125, 134, 
139, 155, 156, 160, 161, 163, 170, 
180, 189, 190, 214, 321, 324, 326, 
327, 336, 338, 342, 343, 358, 361, 
362, 363, 376, 405, 409, 414, 415, 
416, 421, 424, 430, 446, 447, 448, 
450, 451, 457, 462, 478, 480, 489, 
491, 493, 494, 496, 501, 502, 505, 
509, 515, 518, 521, 527, 691 

Manipulating objects, 291 

margin marker, 249 
Margin Units, 503 
Margins panel, 502 
Matrix, 494, 498, 499, 505 
media, 40, 59, 71, 99, 101, 123, 124, 

131, 139, 156, 160, 259, 294, 351, 
424, 425, 477, 482, 483, 505, 705, 
707 

media file, 99, 156, 424, 425, 505 
Media Item Folder, 481 
Media Item Options, 481 

Microsoft® Windows® operating 
system, 61 

Mode Switches, 513 
Modifying a page, 104 
Module Columns, 95 
Module panels, 88, 103 
Modules, 95, 96, 119, 126, 338, 434, 

510, 518, 521, 523 
monochrome clip, 284, 310 
Mouse buttons, 68 
mouse pointer designs, 563, 583 
movie file, 129, 156, 425 
movieclip, 172, 259, 261, 265, 266, 

267, 268, 321, 382, 408, 490 
Movieclip, 260, 292 
movieclips, 265, 267, 268, 292 
Moving pages, 106 
MPG, 129, 134, 260, 408 
multi-line text alignment, 253 
Multi-line text elements, 199, 253 
multimedia productions, 59 
Multiple language dictionaries, 218 
multiple pages, 102, 103, 155 
multiple scripts, 70, 110 
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Multiple scripts, 79 
Multistyle Button, 65 
Multi-Tile, 129 
Multi-tile Editor, 120, 130, 509, 524, 

525, 527, 528, 536 
music video, 350 

N 
Name, 89, 102, 104, 105, 106, 107, 

111, 112, 125, 126, 135, 337, 362, 
481, 484, 502 

Name column, 89, 125 
negative, 241, 244, 300, 314, 393, 

458 
non-Western language, 318 

O 
object color, 290 
OK button, 68, 516 
online help, 60, 701 
Opacity, 172, 194, 298, 301, 304, 

310, 311 
Opening an Existing Script, 79 
Options column, 479 
Options Dialog, 509 
Orientation, 150, 367, 498, 512 
Out transitions, 289, 331, 332, 335, 

351, 363, 364 
Outline, 176, 194, 278, 285, 289, 290, 

291, 297, 298, 301, 302, 311, 312 
Overlapping Transitions, 365 

P 
Pacing, 372 
Page, 61, 70, 71, 77, 78, 82, 86, 88, 

90, 91, 94, 99, 100, 101, 103, 104, 
105, 110, 112, 113, 131, 136, 137, 
138, 140, 141, 152, 153, 154, 156, 
158, 159, 160, 161, 162, 163, 164, 
166, 170, 172, 173, 174, 176, 177, 
179, 180, 183, 185, 186, 190, 194, 
205, 206, 207, 208, 209, 214, 218, 
219, 234, 251, 252, 255, 256, 259, 
260, 261, 320, 321, 322, 323, 324, 
325, 326, 327, 329, 331, 336, 337, 
344, 345, 348, 358, 359, 361, 362, 
363, 367, 376, 409, 424, 429, 430, 
446, 450, 451, 462, 490, 491, 501, 
515, 531, 545, 548, 555, 556, 557, 
558, 584, 585, 597, 685 

page margin, 253 
Page Names, 491 
Page Number, 501 
Page Transitions, 358, 361 
Palette, 138, 161, 185, 186, 242, 275, 

282, 381, 382, 383, 384, 386, 387, 
388, 389, 401 

passive elements, 328, 329, 333, 
336, 371 

Passive elements, 327, 333 
Password, 481, 484, 485, 486 
Paste, 80, 85, 86, 98, 109, 161, 163, 

164, 165, 177, 194, 205, 256, 337, 
572, 691 

pasted segment, 205 
Pasting styled text, 204 
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Periodic scheduling, 457, 458, 468, 
473 

Periodic Scheduling, 459 
picture background, 99, 144 
pixilation, 291 
plain background, 100, 137 
Play icons, 86 
playback, 39, 40, 69, 71, 72, 86, 116, 

121, 123, 169, 183, 208, 211, 218, 
220, 222, 328, 331, 336, 343, 352, 
354, 373, 417, 458, 460, 465, 469, 
510, 511, 512, 513, 521, 553, 558, 
577, 596, 626, 633, 634, 635, 637, 
638, 639, 640, 641, 649, 650, 658 

PNG, 129, 130, 154, 185, 207, 255, 
273, 275, 524, 527, 528 

Pop-up Button, 66 
Position tab, 279, 280, 293, 312, 313, 

314, 316, 318 
positive values, 241, 300 
pre-designed graphics, 129 
Preview, 72, 86, 98, 108, 115, 161, 

170, 216, 218, 331, 332, 361, 364, 
368, 411, 424, 513, 528, 529, 538, 
539, 546, 548 

Previewing pages, 108 
Print, 86, 121, 493, 494, 496, 504 
Print job, 493 
Print Range, 496 
Printer panel, 503 
Printer Properties, 504 
Printing from Designer, 121 
Process controls, 392 
program directory, 124 
publication of a script, 486 

Publish, 71, 86, 121, 477, 478, 479, 
480, 483, 484, 485, 487, 488 

published scripts, 486 
Publishing a Designer script, 121 
publishing options, 479, 486 
Pull-down Menu, 67, 85 

Q 
Quake, 370, 374 
Quitting Designer, 122 

R 
Radio buttons, 550, 553, 554, 569, 

571, 575 
RandomAlways, 370 
RandomOnce, 369 
Repeat branches, 431, 443 
Replacing a background, 136 
Reset Settings, 504, 524 
resize the Designer window, 69 
Resizing the grid, 178 
RGB, 130, 275, 381, 385 
Rotate Angle, 314 
Rotate value control, 152 
Row Alignment, 499, 500 
Rub, 370, 374 
Running a script, 115 

S 
Saving a Script, 117 
Scala Artwork Folder, 124 
Scala Content Manager, 55 
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Scala on the Web, 120 
Scala TV Tuner EX Module, 589, 590 
ScalaPrint, 114, 492, 493, 494, 495, 

496, 497, 499, 500, 501, 502, 504, 
505 

Scale, 492, 499, 500 
Scale Pages, 492 
scaling, 72, 139, 140, 143, 148, 304, 

352, 509 
Scaling, 139, 140, 148, 499, 512 
Scaling the background image, 139 
Scanners, 130 
Schedule Entries, 463 
Schedule panel, 457, 462, 463, 464, 

465, 466, 467, 468, 469, 471, 472 
schedule range, 466 
Scheduling by week, 466 
Scheduling in Designer, 456 
Script, 60, 72, 78, 86, 87, 113, 121, 

122, 123, 139, 213, 342, 408, 442, 
452, 456, 470, 478, 479, 482, 487, 
505, 516, 555, 557, 658, 659, 669, 
670, 672, 673, 674, 675, 677, 678, 
679, 680, 682, 684, 685, 686 

script default pointer, 584 
Script Information box, 479, 482 
script title bar, 96, 113, 118, 122 
Scripts Play Back, 510 
Scroll Bar, 66 
Select All, 102, 135, 166, 174, 344, 

361, 572, 584 
selected elements, 166, 175, 176, 183, 

185, 206, 264, 265, 303, 338 
Selected Elements, 168, 194 
Selected Segments, 194 

Selecting Elements, 174 
Selecting Pages, 101 
Selecting Text, 195 
Selection and Editing, 192 
Selection frames, 202 
Selector button, 66 
Selector Button, 66 
shading, 130, 536 
shadow, 226, 234, 241, 242, 265, 

285, 293, 297, 298, 299, 300, 301, 
303, 545, 566, 686 

shadow opacity, 298, 301 
Shadow Opacity, 301 
Show If, 431, 432, 443, 449, 452, 454 
simple loop, 445 
Skin, 70, 509, 514 
Slide Number, 502 
Slide Order, 499 
Slides, 488, 493, 496 
Slideshows, 350 
Smart Quotes, 516 
Snap to Grid, 166, 177, 195, 204 
Sound, 94, 95, 100, 101, 134, 162, 

265, 321, 337, 338, 352, 372, 377, 
404, 405, 415, 416, 423, 424, 509, 
561, 579 

Special Event, 100, 101, 162, 327, 
438 

Special event pauses, 336 
special photographs,, 129 
Speed, 208, 267, 268, 341, 351, 354, 

361, 367, 368, 369, 372, 373, 417 
spell checking, 218, 219, 522, 523 
spell-check, 189, 523 
Spell-checking, 213, 214 
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Spelling, 120, 167, 213, 214, 215, 
217, 218, 219, 510, 522, 523 

Spread Tools, 183 
Starting Designer5, 61 
Streaming Video, 101, 156, 163, 425 
streaming video page, 99, 101, 156 
Style, 232, 243, 245, 246, 297 
Style tab, 243, 245 
Sub-script, 76 
Sub-Scripts, 454 
SWF, 129, 130, 259, 405, 408 

T 
tab panel, 234, 358, 510 
Tab panels, 171 
Tab stops, 247 
Tabbed Panels, 64 
Tabs, 80, 86, 160, 171, 172, 176, 430 
Text Crawl, 162, 163, 190, 207, 210, 

212, 213, 222, 223, 224, 227, 228, 
319 

text cursor, 162, 164, 190, 191, 196, 
261, 262, 316, 577 

text editing, 189, 199 
text element, 72, 162, 165, 176, 191, 

192, 193, 194, 195, 196, 197, 198, 
199, 200, 201, 202, 203, 204, 205, 
206, 207, 213, 215, 228, 241, 246, 
249, 250, 252, 253, 256, 264, 304, 
310, 316, 325, 544, 673 

text elements, 172, 176, 186, 191, 
193, 194, 195, 200, 202, 203, 204, 
206, 218, 233, 241, 248, 249, 254, 
264, 278, 297, 305, 564 

Text Elements, 191 
Text Entry Fields, 574, 575, 577 
text items, 64 
Text rotation, 315 
The Color bar, 170 
The Labeling panel, 500 
three-, 130 
Thumbnail mode, 75, 76, 87, 96, 98, 

102, 189, 505 
thumbnail settings, 96 
Thumbnail Size in Pixels, 492 
thumbnails, 67, 75, 76, 77, 80, 81, 88, 

111, 119, 491, 492 
Tiled Image Background, 149 
Timeslot Scheduling, 461 
Timing, 91, 92, 93, 94, 101, 125, 162, 

195, 266, 267, 321, 335, 336, 340, 
341, 343, 344, 345, 346, 347, 348, 
351, 352, 365, 367, 368, 371, 372, 
373, 412, 424, 461, 509, 518, 519, 
520 

Title Bar, 64, 86 
Toggle buttons, 569, 570, 571, 573 
Toolbar, 60, 64, 85, 161, 162, 163, 

514, 702 
toolbar style, 514 
Transition, 76, 90, 91, 94, 103, 125, 

326, 331, 332, 357, 358, 359, 361, 
362, 363, 364, 365, 366, 367, 368, 
369, 371, 372, 373, 374, 376, 446, 
561, 702 

transparency, 255, 268, 274, 275, 276, 
277, 278, 301, 310, 312, 370, 533, 
676, 682 

Transparency tab, 274, 275 
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TrueType, 236, 237, 482 
TV Tuner hardware, 589, 594, 597, 

604 
two Flip options, 151, 280 
typeface, 194, 226, 231, 235, 236, 

237, 238, 515 
Types of scheduling, 457 
Typing Text, 190 

U 
Underline, 194, 232, 244, 245, 246 
Undo options, 163 
Undo Page, 163 
Ungrouping, 113 
Up Button, 65 
URL, 101, 156, 163, 425, 426, 481, 

483, 484, 485, 491, 558 
Usability Improvements, 70 
USB key, 54 
USB slot, 54 
User Interface, 59 
User palette, 171, 186, 241, 382, 

383, 384, 386, 388, 401 
Using Edit options, 163 
Using levels, 333 
Using Text Crawls, 207 
Using the grid, 177 
Using the scroll bars, 173 
Using Undo/Redo, 113 

V 
valid days of the week, 468 
Valid Time of Day, 458, 463, 468, 469 

Value Control, 65 
Variable, 190, 220, 224, 429, 430, 

436, 437, 438, 446, 562, 571, 572, 
574, 575, 577, 580 

variable values, 254, 441, 455, 456, 
569, 607, 612, 613, 616 

Variables, 94, 251, 268, 326, 338, 
346, 371, 428, 433, 434, 436, 437, 
455, 562 

vector files, 130 
Vertical Text Alignment, 212, 577 
Video Clip, 405 
video clips, 129, 156, 352 
Video Control EX Module, 621 
Video editing, 130 
View, 61, 63, 71, 74, 76, 78, 105, 158, 

159, 161, 163, 167, 168, 177, 183, 
205, 234, 320, 324, 336, 461, 471, 
488 

W 
Wait for Element(s), 341 
Wait for elements, 92 
Wait Forever, 343, 345, 346, 544 
Wait?, 209, 224, 225, 266, 268, 357, 

376, 417, 419, 420, 421, 422, 423, 
637, 640, 641 

Weather EX Module, 606, 607, 608 
Western languages, 318 
Whole Element, 301, 312 
windowed operation, 69 
Windows clipboard, 110, 471 
Windows File dialog, 79, 99, 134, 136, 

388 
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Windows Shortcuts, 691 
WMF, 129 
Word Wrap, 194, 249, 250, 577 
Word wrapping, 212, 250 
Working with Pages, 98 

Z 
Zoom, 167, 375 

 

 

 




